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Overview: 8x8 Contact Center for admins

8x8 Contact Center administrators use 8x8 Configuration Manager platform to set up their tenants. Administrators can
use a graphical user interface (GUI) to manage all components in a tenant. 8x8 Configuration Manager is easy to use
and requires no special software or hardware to run. It is 100% cloud-based and accessible from anywhere and anytime
as long as you have a computer and Internet access. Using 8x8 Configuration Manager, administrators can set up
agents and supervisors, create roles and assign tasks, create campaigns, broadcast messages, create wallboards, and
much more.

Use 8x8 Configuration Manager to:

n Create and configure your contact center's communication channels, interaction queues, agent groups, agent
accounts, and the optional Status Code and Transaction Codes features.

n Customize the tools and features available to your agents.

n Define security policies for the tenant.

n Customize the Local CRM to match your customer resource management requirements.

n Provide Internet access to your contact center's channels with a 8x8 Contact Center Support Center.

n Create and run campaigns based on phone media.

n Integrate your 8x8 Contact Center with an External CRM, such as NetSuite or Salesforce.

n Send broadcast messages to your 8x8 Contact Center groups.

n Define status codes to indicate the reasons for agents' change of status.

n Define transaction codes to indicate the purpose or outcome of interactions.

For details about our latest 8x8 Contact Center features, seeWhat's New for Administrators. SeeGet Started and
Understand the Interface in this guide to learn how to start.

Overview: 8x8 Contact Center for admins
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System requirements
Each administrator requires a computer equipped with a browser. We fully support the following browsers for 8x8
Contact Center

n Google Chrome (latest version)

n Mozilla Firefox (latest version)

n Microsoft Edge (Chromium)

We do our best to support the following browsers for 8x8 Contact Center:

n Microsoft Internet Explorer 11 (latest version)

n Apple Safari (latest version)

You can test your current browser's security standard compatibility. For information about agent workstation technical
requirements, see your contact center supervisor, or refer to the Technical Requirements document for Agents.

Known Issue: If you use Internet Explorer to run 8x8 Contact Center applications, youmay encounter
highmemory usage. To resolve this issue, clear your browser cookies and cache, activate the setting to
clear history, clear history on exit, and reboot.

Note:Wedo not support 8x8 Contact Center onmobile browsers.

Note: Firefox requires the QuickTime plug-in for audio features.

Note: Tomaintain uninterrupted access, update your web browsers or SSL libraries to the latest
available versions. Attempts to access 8x8 web portals on a computer without a TLS 1.2+ compliant
browser or SSL library prevents you from configuring your services.

Version 9.14 2
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Note: For APIs customization in the 8x8 Contact Center, check with your system administrators or
developers to ensure that the system SSL libraries are updated to support TLS 1.2 or better. Affected
products may include, but are not limited to, older distributions of Linux-based operating systems (using
old versions of OpenSSL) or Java Runtime Environments (JRE) older than 1.8.
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What's new in the 8x8 Contact Center 9.14 release for
administrators?

In 8x8 Contact Center for administrators, we have introduced the following enhancements to improve the productivity of
agents, supervisors, and administrators in our new release.

Note: The product version in 8x8 Agent Console and 8x8 ConfigurationManager may show up as 10.0
instead of 9.14 while we are working to fine-tune our 8x8 Contact Center applications.

Ability to set up DTMF blacklist
As an 8x8 Contact Center administrator, you can nowmanage your DTMF blacklist by adding, editing, and deleting
phone numbers as well as SIP URIs in your DTMF blacklist. The DTMF blacklist is an existing service to stop recording
a call once connected to a blacklisted destination. It also masks any key presses in the customer experience call flow, so
that payment card data is kept private. Prior to this release, adding an entry to the DTMF blacklist required raising a
ticket with 8x8 support team. For details, see our content on how to set up DTMF blacklist.

Introducing the Chat API 2.0
The 8x8 Contact Center Chat API allows third-party companies to connect directly to an agent from their own system,
this enables them to use their interface to speak to their customers, such as enabling their clients to communicate with
an agent from mobile app-based chat, Desktop web chatbots, and messaging via integrations with other apps or
platforms.

What's new in the 8x8 Contact Center 9.14 release for administrators?
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Features
n Enhanced documentation in developer portal

n Introduction of frontend logging

n Introduction of new user interface for maintaining Chat API channels

n Sending secure webhook callback requests

n Standardizing API to fit in with 8x8 public API approach

For details, see our content on chat workflow for developers.

Support OAuth2 authentication for email channels
The 8x8 Contact Center authenticates email channels via basic authentication, using the simple username and
password. Email service providers like Microsoft announced plans to stop supporting basic authentication for Post
Office Protocol (POP), Internet Message Access Protocol (IMAP), and potentially for outgoing server setups (SMTP).
This requires integrators to migrate their current email client to use modern authentication methods like OAuth2. To
prepare for this security improvement, 8x8 Contact Center now introduces support for OAuth2 authentication for users
of Microsoft. We continue to support basic authentication for existing users. For details, see our content on how to use
OAuth2 authentication for email channels.

Ability to adjust post-processing time for direct agent calls
Post-processing time is the duration agents are allowed, after terminating the calls, to wrap up any pending notes or
actions related to the call. Prior to this release, while processing direct-to-agent calls, agents had a limited duration of
five seconds for post-processing. Depending on your business needs, agentsmay require more time to wrap up notes
on calls. In this release, we are introducing the ability to adjust post-processing time for direct-to-agent calls from five
seconds to a maximum of 60 minutes helping to meet your business needs. For details, see our content on how to
adjust post-processing time for direct agent calls.

8x8 web chat is nowWCAG 2.1 compliant
When websites, tools, and technologies are designed and developed so that people with disabilities can use them, they
are considered web accessible. Web Content Accessibility Guidelines (WCAG) offer recommendations on how to
increase the usability of your website, and how to make it accessible to people with disabilities. Web accessibility
encompasses all disabilities that affect access to theWeb, including auditory, cognitive, neurological, physical, speech,
and visual.

Version 9.14 5
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Prior to this release, 8x8 Contact Center customers who areWCAG 2.1 compliant were restricted from using the web
chat solution due to the lack of compliance. In this release, we have enhanced the 8x8 Contact Center web chat
experience to comply with theWCAG 2.1 guidelines allowing better readability, navigability, and interactivity with our
web chat elements. For details on how to make your chat WCAG compliant, see our content on chat design
enhancements forWCAG 2.1 compliance.

Note:WCAGCompliance is limited to 8x8 Contact Center web chat only. All other features and
applications in the 8x8 Contact Center are not yet WCAG compliant.

To comply with WCAG 2.1, 8x8 Contact Center introduces enhancements to the web chat experience, thus allowing
8x8 customers to beWCAG 2.1 AA compliant. Learn more1

9.13 Release
We have introduced the following enhancements to improve the productivity of agents, supervisors, and administrators
in our new release of 8x8 Contact Center.

Introducing 8x8 Contact Center new APIs
8x8 Contact Center introduces theCall API allowing 8x8 Contact Center customers to place outbound calls for agents
from an external (desktop-based) system. Agents can simply log into the 8x8 Agent Console, place it on a persistent
connection, and handle calls from their external system. Prior to this release, click-to-dial was used to place outbound
calls for the agent. Click-to-dial calls were initiated by agents from within the 8x8 Agent Console application.

The call API allows placing calls, dropping calls, dropping agents from a conference call, and more. It works in
conjunction with the Agent Status API to change the status of the agent, and the SAPI API to publish events on the
8x8 platform. We have also added the following attributes to the SAPI API in this release:

n Additional granularity of the call status

n Additional granularity of the customer hung up reason

n Additional granularity about reasons for call abandonment

For features and limitations, see our content in release notes. For details about API, refer toCall API, Agent Status
API, and SAPI API.

1(Learn more about the compliance levels > Level A: Minimal compliance; Level AA: Acceptable compliance; Level
AAA: Optimal compliance)  
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Enhancing outgoing email settings for channels and agents via SMTP
As an 8x8 Contact Center agent, when you email customers via email channel, you want to ensure that customers
receive the emails without being blocked by your outbound email servers, or the spam filters of the customer’s email
servers.

To ensure the delivery of emails sent by agents, 8x8 Contact Center now supports an enhanced configuration for
outbound mailing systems, only available for custom SMTP servers. This enhancement allows specific configuration for
each and every channel or agent, so that emails actually get signed and sent using the individual accounts. When
sending out emails, the “From” section in the email header must match the actual address used for sending out that
email, which implies using correct accounts and credentials, and the actual sender. When an agent sends an email via a
channel, it uses the channel address. When an agent sends an email via their own address, it uses the agent's
individual email address.

Prior to this release, emails were sent from a unique address and user account configured on the SMTP server. The
email address on the email header did not match the email address used to send the email, causing emails to be
blocked by spam filters. For details, see our content on howwe enhanced our outgoing email settings for channels and
agents via SMTP.

See our content on all Previous releases.
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Previous releases

You can find 8x8 Contact Center previous releases for admins here:
Release 9.12

About 8x8 Auto Dialer: 8x8 Contact Center now introduces progressive and predictive dialing modes to better
manage outbound telephone-based campaigns to meet your business needs. Automate your outbound dialing and
maximize the productivity of your contact center agents. Empower your agents to connect with prospects and
customersmore effectively, and boost conversion rates as well as customer satisfaction. The progressive and predictive
dialing modes call numbers automatically from campaign calling lists, screen for busy signals, voicemail, no-answers,
and disconnected numbers, connecting agents to only live-answered calls.

Learn more about the 8x8 Auto Dialer and its benefits.
Release 9.10

n Controlling call recording on third-party transfers: As an 8x8 Contact Center administrator, you can choose
to stop call recording on the third-party transfers when your last contact center agent leaves the call. Let's say the
contact center agent transfers the call to a customer or a third-party caller who is outside the contact center, via a
warm or cold transfer. Or, the agent decides to drop out of a conference call as the last contact center agent. Using
this feature, stops the call recording to avoid sensitive information to be recorded. Calls to 8x8Work extensions are
also considered third-party calls and therefore affected by this rule.

The call recording control is enabled at the tenant level and cannot be modified per agent. Once enabled, it
becomes the default setting for call recording of the tenant and overrides the existing settings such as agent's
ability to pause recording. Contact 8x8 Support for more information and to enable this feature. For details, see our
content about Agent's Recording Controls.

n Introducing 8x8 Contact Center SMS: In this release, 8x8 Contact Center introduces communication via SMS
inbound channels. SMS has become a popular channel of communication in customer service. Let’s say customers
of a car insurance company want to check their claim status or send related inquiries, they can simply send SMS
messages to an SMS number published by the insurance company. These messages are routed via SMS channels
and chat queues to agents, and offered to them as chat interactions for responses. Agents can look up customer
records if the message is from an existing customer. They can look up outstanding cases and history of interactions
to handle the conversation effectively.

For details, see our content about SMS channels and how to set them up.
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n Introducing agent whisper for phone queues: In this release, 8x8 Contact Center agents can now hear an
audio message (whisper) about the context of the call they have dialed or received via a queue. Agent whisper is an
audio file that can be uploaded and assigned by the tenant administrator to an inbound or outbound queue to
inform the agent, upon connection, about the connected call. Let’s say John serves support calls as well as sales
calls. Upon receiving calls, the system plays a brief message stating if it is a sales or a support call. Agent whisper
can be implemented for both inbound and outbound calls such as campaign calls. For details, see our content on
how to create Agent whisper for phone queues.

n Transferring a chat interaction with contextual information: When your agents knowwho your customers
are, what they’re looking for, and what they’ve already spoken to another agent about, they can give better service,
faster. Contextual information informs live agents so they can have more productive conversations while handling
customer issues. 8x8 Contact Center introduces the ability to hand off the conversation with interaction details
when transferring a live chat.

This feature is available to all agents by default. It does not require admin configuration. Learn more about how
agents benefit from contextual information during chat transfer.

n Intelligent routing of chat interactions based on customer data: Before initiating a chat interaction,
customer information such as account numbers or case numbers collected via the pre-chat form, can now be used
to determine routing of the chat interaction. You can now collect customer data, store them into system and user-
defined variables, and use values stored in these variables to direct the interaction to the appropriate queue. This
improves the efficiency of handling chat interactions.
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Let’s say your company wants to route interactions based on the customer language. Collect the preferred
language choice in a variable, and use this data in the IVR to direct them to the appropriate language queue. Let’s
say your company wants to route interactions based on the department such as Sales or Support, you can collect
this information during the pre-chat, and use it to route the interaction to the right queue.

Learn more about how to define custom variables and use them in chat channels.

These variables can be used to store data in advanced interaction routing involving external IVR. To learn more see
our content on enhanced data augmentation.

You can also use variables to present personalized greeting messages based on the customer input. If the
customer enters their name, then greet them by name.

Note: The variables are also supported in the Embedded Chat API.

Let’s say your contact center has implemented the 8x8 web-chat solution. Your users log into the website so you
already have information about the customer based on their account, e.g. language of the account or the browser
language. You do not have to ask the customer for this information in the pre-chat form again. Use the 8x8
Embedded Chat API to post this information using variables. The contact center admin has to make sure to define
the same name for variables in the IVR script as used in the API, to ensure routing based on this customer
information.

n Enhancing data augmentation: Data collected by External CRMs and third party integrations can now be used in
a meaningful way. The data augmentation API allows you to tie data between external applications and call data.
This facilitates greater resolution on what drives call volumes and handling times. Prior to this release, the two
nodes: 8x8 IVR , and Forward to External IVR, have been limited in terms of data variables. To forward calls to an
external IVR such as intelligent IVR, you need to forward an incoming call to the external IVR, assign a queue ID,
check the queue ID in the phone script, and forward the call to the right queue. For details, see our enhanced data
augmentation example workflow and the required steps to forward calls to an external IVR.
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n Announcing end of life for Support Center functionality: In this release, 8x8 Contact Center is retiring the
Support Center functionality. Support Center previously offered communication channels and information services
for your customers to reach your contact center agents and get help. We offered direct URLs to the default or
custom Support Center which could be embedded in your company website.
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In this release, access to Support Center functionality is not provided through Support Center, but through new
tools and interfaces as seen below:

Feature Description Access

FAQ FAQ was a repository of frequently-
asked questions and answers for
customers which was accessed via a
user interface.

Use the CRM API to add, modify, get, delete, and list FAQs.
For details, see our CRM API documentation.

Collaborate Collaborate was a mechanism for
agents to remotely access and
control a customer's computer.

The control functionality is no longer available, however,
the remote access and user guidance functionality is
replaced by the improved Co-browsing feature to offer
remote customer access.

Chat In the Support Center, chat provided a
user interface for customers to
initiate a chat with live contact center
agents.

We now offer chat, SMS, and social media channels with
better chat workflow and design. For details about chat,
see our documents for the Embedded Chat Channels. To
take advantage of social media to service customers, such
as Facebook and Twitter, see our guide about Social
Media Integration.

Email The Email functionality in the Support
Center offered a user interface for
customers to send emails to agents.

Customers can now publish the email addresses for
support, as configured in the email channels on
Configuration Manager. Or, implement their own email
submission forms on their websites and forward them to
the inbound email server as configured for 8x8 Contact
Center. For details, see how to set up email channels.

My
Account

My Account was a portal for
customers to submit information
requests or open cases and receive
responses to requests. Customers
could check the status of their cases,
or close their cases using this portal.

We are no longer offering My Account, by default, for Local
CRM. However, for more advanced implementations we
offer the CRM API which can be used by Contact Centers
to implement their own portal similar to My Account. For
details, see our CRM API documentation.

Release 9.9

n Introducing 8x8 Secure Pay: 8x8 Contact Center now offers customers a secure integration to support the
processing of bank card information via our partner PCI Pal. 8x8 Secure Pay enables an agent and customer to
stay in contact on a call while masking the card input from the customer's handset so that the sensitive card data
stays secure and out of the contact center. The service can be integrated with a CRM, Enterprise Resource
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Planning (ERP), or a billing system and the customer's payment gateway to process the payment. The service can
also feed information about the payment back to the originating system.

This new integration offers agents a secure payment page for processing customer transactions. The secure
payment page can be configured to include pre-populated data or data that the agent addsmanually. When this
page is opened, the customer audio is rerouted via PCI Pal, which allows them to mask the keypad input both
visually and audibly.

The agent hears the conversation and controls the card input, but only hears a single-tone DTMF and sees starred
out digits for the card number, date, and Card Verification Value (CVV). In the event of erroneous data input by
customers, agents can reset the relevant data field in the payment page, allow customers to fix the input, and
facilitate a successful transaction.

When on an active call during the card payment, the agent hears the conversation and controls the card input, but
only hears a single-tone DTMF and sees starred out digits for the card number, date, and Card Verification Value
(CVV). The agent can reset any field if a mistake is made, and once the data is ready they can take a payment and
receive the confirmation or rejection of the transaction. For detials, see our content in the release notes.
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n Introducing the Answer Machine Detection (AMD) Service: In 8x8 Contact Center when the dialer is used in
its aggressive mode, it can call more numbers than available agents to maximize agent efficiency. The dialer needs
a service which detects the calls answered by a machine instead of people, and to filter them. We have now
introduced the Answer Machine Detection (AMD) service to identify such calls and allocate the calls answered by
people to the available agents. When the AMD service identifies a machine-answered call, it sends a one-way
message to the call routing to end that call and resolve it automatically. AMD is a learning service and it needs
some time to build an effective library of known audio samples before it reaches the maximum efficiency. Once this
is done, the AMD service resolves a machine-answered call quicker than the manual effort of an agent.

Once AMD is provisioned for your tenant, the contact center administrators can activate it for the desired
campaigns. For details, see our content on the AnswerMachine Detection (AMD) service.

AMDworks in conjunction with our new Auto-TCL. The transaction code for such calls appears asAnswer
machine detected in CRM Cases or under Historical reports.

Note: The AMD service is only applicable to the calls routed via campaigns, but not the outbound
calls placed by an agent.

n Ability to Detect TCPA-Listed Phone Numbers via Carrier Call Blocking (CCB): 8x8 Contact Center is
now able to detect TCPA-listed phone numbers via Carrier Call Blocking (CCB) service. This feature is available for
US customers only. The Telephone Consumer Protection Act (TCPA) designed to safeguard consumer privacy
restricts telemarketing communications via calls, SMS texts, and fax. To comply with TCPA, we have introduced
Carrier Call Blocking (CCB) service for campaign calls which allows the campaign manager in the Dialer to apply
special routing to two carriers: Brightlink and RSquared. They will then run dialer calls through a service that checks
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whether or not the phone number is listed on a Do Not Call (DNC) or mobile block list. If listed, the call is
terminated by the carrier and an appropriate Session Initiation Protocol (SIP) code response is sent back to the
interaction router. The call is then handled by our Auto-TCL and completed. Once provisioned, CCB can be
enabled at the campaign level. If CCB is enabled, the campaign dialer checks whether the outbound call’s phone
number is listed on TCPA list.

Once CCB is provisioned for your tenant, the contact center administrators can activate it for the desired
campaigns. If CCB is enabled, the campaign dialer checks whether the outbound call’s phone number is listed on
TCPA list. For details, see our content onCarrier Call Blocking.

n Improved Call Handling via Phone Connection Mode and Auto Answer:

Note:Auto Answer is currently on limited availability. Contact 8x8 Support for more help.

8x8 Contact Center has improved the existing call handling capability via two features: Phone Connection Mode
and Auto Answer. With Phone Connection Mode, agents set up their phone connection before they start working
on calls and remain connected throughout their working day. It allows them to respond to incoming and outbound
phone calls with a simple click on the user interface improving their call handling efficiency. There is no audio
indication with the Phone Connection Mode. For details, see our content on Phone ConnectionMode.

With Auto Answer, however, every phone interaction that is offered to an agent is automatically connected
eliminating the need to accept it manually. Agents receive an audio prompt to alert them of a call as it connects.
Auto Answer is paired withWorkplace Setting Validation and is configurable at the tenant level. To enable Auto
Answer, you must also enable workplace setting validation. For details, see our content on Auto Answer.
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Once Phone Connection Mode is provisioned for your tenant, the contact center administrators can activate both
Phone Connection Mode and Auto Answer for your tenant. Auto Answer is only supported on line 1 for phone
interactions.

n Introducing Workplace Setting Validation: When changing workplace setting (Workplace Phone and
Workplace SIP URI), agentsmust validate their changes to be able to handle the calls. When they click to validate
the change, it triggers a phone call to the updated phone number. A PIN code is then communicated to the agent.
The agent must enter the PIN code to validate the changes and continue. If they are unable to confirm the PIN,
theymust exit and revert to their last validated setting. The workplace setting validation is offered as a mandatory
security feature with Auto Answer, or it can be deployed as a stand-alone feature. For details, see our content on
Workplace setting validation.
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n Ability to Automatically Apply Transaction Code (Auto-TCL): 8x8 Contact Center automatically assigns
transaction codes to campaign calls when the destination party is not available to answer the call, or the call cannot
be completed, such as when there is a busy tone or dead line. The new feature also identifies the calls that are
answered by a machine. Auto-TCL works with AnsweringMachine Detection (AMD) service to identify such calls
and automatically disposition them. It then moves onto the next call with minimal agent disruption. This feature
allows agents to be more efficient with their time.
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Once Auto-TCL is provisioned for your tenant, the contact center administrators can activate it for the desired
campaigns. For details, see our content on how to Automatically Apply Transaction Codes (Auto-TCL).

n Dynamic Campaigns: Ability to Update Live Campaigns: Dynamic Campaigns allow you to add or remove
records from an active campaign via API. Prior to this release we could not add or remove records from a campaign
after it started running. This supports integrated lead capturing systemswhich feed new prospects into the
corresponding campaign in real time so they can be dialed within five minutes. Removing a campaign record will
not delete it from the list but will keep the record for future reports.

For details, see our content on dynamic campaigns. For API configuration details, see our support article on how
to configure 8x8 Contact Center Dynamic Campaign API.

n Allow Agents to Skip Campaign Calls While on Auto Answer: 8x8 Contact Center is now offering agents
the option to skip the campaign calls during a campaign. To give the agents this capability, you must enable this
option underCampaign > Properties .

Version 9.14 18

Previous releases

https://support.8x8.com/us/cloud-contact-center/virtual-contact-center/developers/virtual-contact-center-dynamic-campaign-api-configuration


For details, see our content on how to skip campaign calls while on Auto Answer.

n Ability to Clone Queues: 8x8 Contact Center now offers customers the ability to clone queues. With this new
enhancement, administrators can copy inbound phone queues, outbound phone queues, chat queues, email
queues, as well as voicemail queues with a simple click. Cloning queues allows Contact Center administrators to
create multiple queues in a short time.

When you clone a queue, the queue properties, members, interactions, SLA, and email settings are copied. A
queue name is automatically generated. You can modify or make changes to the new queue, if required. To clone
a queue, in 8x8 Configuration Manager, go toQueues/Skills to display a list of queues, select a queue and click

Copy. For details, see our content on how to clone queues.
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Release 9.8

n Enhanced Usability of Co-browsing: With Co-browsing, you offer live, hands-on assistance to customers, take
control of their cursor, and demonstrate how to perform the action while the customer observes. Via co-browsing,
you can securely connect to remote computers, access, and troubleshoot problems over the 8x8 Contact Center
platform. For details, see our content on how to get remote customer assistance.

Customers, who use 8x8 Co-browsing for remote assistance, can now enjoy better usability with the following
enhancements.
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o A refreshed user interface.
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o Better visibility to the status of co-browsing session on customer side.
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o The auto-minimized status window allows the customer to keep an eye on the status of the shared screen at all
times. The customer can move the status window to the desired location while in a live session.

o Agents receive feedback when the co-browsing session is interrupted, or takes time to load.
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n Ability to Reset the Agent's Idle Timer: In 8x8 Contact Center, idle time refers to the length of time agents
have been idle and is measured for each agent by the agent's idle timer. By default, an agent is considered idle
from the time he ends post processing of a system-delivered, queued interaction and becomes available. When
multiple agents with the same queue and skill level assignments are idle, the system routes the call to the agent
who has been idle the longest. The agent’s idle timer is reset every time they end post processing of a system-
delivered, queued interaction. Agent-initiated interactions do not reset the idle timer.

To supplement the default behavior, in the new enhancement we allow 8x8 Contact Center administrators to reset
the idle timer when agents transition from one status to another. For example, The idle timer resets when agents
change their status from On Break to Available when they log in. For details, see our content on reset agent's idle
timer.

n Ability to Autodial Campaign Calls after Preview: In this release, we have introduced the ability to autodial
campaign calls when an agent has spent all the preview time without taking an action. Autodialing campaign calls
after previewing a campaign record is controlled by a campaign setting.

Note: This feature enhancement is only applicable if your company uses 8x8 Contact Center
campaigns.

Prior to this release, agents handling a campaign could view the campaign record for the specified preview period
and manually start, reject, or skip the interaction. They were not forced to take the interaction in the time allowed.
Additionally, the need for a manual action to initiate a call was repetitive and inefficient. With the autodial feature,
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however, at the end of the preview time if no action is taken, calls are initiated automatically eliminating the need
for manual action by the agent. The 8x8 Contact Center administrators can enable autodialing for each campaign
when an agent’s preview countdown ends. The minimum preview duration is 15 seconds. For details, see our
content on how to set up autodial for campaign calls.

n Efficient Voice Channel Workflow via off-Hook Mode: With off-hook connection mode agents can instantly
and seamlessly connect to customers and improve their productivity. Off-hook is a persistent connection from the
agent’s device to 8x8 Contact Center. It removes the need to connect the agent’s workplace phone for every call
handled. Agents set up their voice connection before they start working on calls and remain connected throughout
their working day. It allows them to respond to incoming and outbound phone calls with a simple click on the user
interface.

In the previous behavior, after agents log in to 8x8 Contact Center and make themselves available, they have to
accept the interaction for every call that comes through the queue. If theymiss the ringing phone, they will no
longer be available to take the interaction.

To enable off-hook connection mode for the tenant, log in to 8x8 Configuration Manager as an administrator and
clickEnable Off-hook Connection Mode inHome > Profile. If enabled by the contact center administrators,
agents can clickEnable Off-hook Connection in their 8x8 Agent Console's user profile. For details, see our
content on off-hook connectionmode.
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Release 9.7.3

We have introduced a brand-new look for 8x8 Contact Center applications in this release. Additionally, we have a new
feature enhancements for administrators:

Ability to Filter Campaign Lists Based on Do Not Call Preferences: While creating a campaign filter, you can
filter those numbers from Local CRM records that are registered with the Telephone Preference Service (TPS) and
Corporate Telephone Preference Service (CTPS), to be compliant with TPS and CTPS. This feature is currently
supported for UK phone numbers, but will be extended to other countries in future releases.

This feature helps customers to be TPS/CTPS compliant, but does not guarantee it. Customers are responsible for
their own compliance. It is recommended not to run campaigns longer than 28 days. For details, see our content on
Filter Campaign Lists Based on DoNot Call Preferences.
Release 9.7.1

We have introduced the following new enhancements to improve the productivity of agents, supervisors, and
administrators.

n Ability to Set the Browser Language as the Pre-Chat Language: In 8x8 Configuration Manager,
administrators can now set the browser language as the language visible in the pre-chat form. A pre-chat survey
form serves to gather information from a chat user before initiating a chat. Using the form, you can collect
information from an existing user, such as their preferred language. With this enhancement, the customer's
browser language can optionally overwrite the pre-chat default language, eliminating the need for the customer to
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answer an extra question. When the translation is not available for the browser language, the pre-chat selected
language will be in effect. See Translation in pre-chat form.

n Ability to Bypass Automatic Translation in Greeting Messages: In 8x8 Configuration Manager, the
administrator can configure the greeting messages to bypass the automatic translation. Greeting messages are
routinely used to invite the customers to a chat session. You can type your message in the chat window, and select
to automatically translate. With the new enhancement, however, you can bypass the automatic translation and let
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the user provide a customized translation instead. SeeGreetingMessages in the summary table.

Release 9.6

n Refreshed New Look for 8x8 Contact Center: Whether you are an agent, a supervisor, or an administrator of
8x8 Contact Center, you will certainly love the new refreshed user interface of all our applications. Look out for the
notifications when you launch your application. Please note that we have kept all our functionality workflows intact
so there is no learning curve for you.
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n Ability to Message Customers via Facebook and Twitter: Take advantage of Facebook and Twitter to service
customers directly and increase customer satisfaction with 8x8 Contact Center Social Integration. By unifying the
agent experience, 8x8 Social allows users to channel their messages from social media into 8x8 Contact Center.
Customers can contact the businesses and receive support from within their social platform. 8x8 Contact Center
Social supports messaging via Facebook and Twitter in this release.To receive chat interactions, agentsmust be
assigned to an enabled chat queue and be in Available state. See Social Media Integration.

n Increased Length of Email Addresses: You can now save email addresses exceeding 55 characters. The
maximum limit now stands at 254 characters. This change allowsmany areas such as saving longer email IDs of
agents, customers in Local CRM, setting up email notification for voicemails, and more. See User Profile.
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For the complete list of areas that benefit from this enhancement, see below.

Release 9.5.2

New features and enhancements to VCC-8x8 Configuration Manager impact supervisors and agents. Some of these
features are available to agents and supervisors by default, while others need to be enabled by administrators to benefit
from the functionality.
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n Enhanced Queued Callback: Our phone IVR scripts can now provide increased callback time, time granularity,
and efficiency:

o Increased callback time: The cancel callback time can be set to an increased maximum of six hours. The
requested callback remains in an outbound queue for the duration of that time. Any callback attempt is
prevented after the time expires. The callback request is removed from the outbound queue after Cancel
Callback duration has expired.

o Improved granularity for callback retry delay:You can set callback retry attempts using minutes, and
seconds.

o Improved granularity for Cancel callback after:You can set the time duration to cancel call back using
hours, minutes, and seconds.

o Improved efficiency for selecting the callback channel number:Using the new option [Current Channel]
for CLI/CN, you can display the original channel number, which the caller used as the caller ID for the callback.
This option is selected by default. If you wish to display any other channel number during the callback, you can
select from the list of available channels.

n Ability to Reserve Idle Agents for Inbound Queues: This feature only applies to outbound calls that are
assigned to go through an outbound queue. The Reserve Idle Agents feature allows a configurable number of
agents to be reserved in available and idle state, to improve the probability of quickly attending to a new inbound
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call. While there are fewer than the assigned number of reserved “Available and idle” agents, no queued outbound
calls will be presented to agents. Whenever the “Available and idle” agents reserve is exceeded then the most idle
agent will receive a queued outbound call.

n Enhanced Voicemail Email Notification: The voicemail email notification providesmore data allowing you to
track the queued voicemails better. The following information is captured in the voicemail email notification:
Transaction ID, tenant name, cluster ID, phone queue ID, voicemail queue ID, calling name, interaction GUID of
the inbound phone queue, transaction ID of the inbound phone interaction, voicemail begin offset, filename, agent
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name, and voicemail retrieval delay.

n Ability to Prevent Agents from Rejecting Interactions: Improved the ability in 8x8 Configuration Manager to
allow or prevent agents from rejecting interactions. You can set up this ability for the entire tenant, an agent group,
or individual agents. By default, this option is enabled allowing agents to reject interactions. When disabled, the
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Reject button in 8x8 Agent Console is disabled preventing agents from rejecting the interactions they are offered.
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n Ability to Define Playback Speed of Text-To-Speech Prompts: You can define the playback speed of IVR
Text-To-Speech (TTS) prompts when using the Say object. The Say object converts programmed text and variable
objects such as phone number and queue position into speech. You can play these prompts slowly, at a normal
speed, or at a faster pace. Using the playback rate option, you can control the speed of the speech that reads your
text so your callers do not miss the important information such as names, numbers, or account balances. The
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default speed is Normal. The playback speed is set per IVR Say node.

n Enhanced Email Routing Based on Customer Data: Emails can now be routed based on the CRM customer
field of picklist type. For example, if a company wishes to prioritize their premium customers and offer to assist
them quickly, agents can prioritize and route the emails from customers based on their account type, say Platinum,
Gold, and Bronze. Emails received from Platinum customers can be routed to a dedicated queue for faster
processing. Using the Check Picklist object in the email script, you can filter emails based on the customer type and
send them to their respective queues for better customer experience. To take advantage of the check picklist
object, you must first define the desired customer field of picklist data type in the Local CRM and then select this
field in the email script.
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Release 9.5

In this release, we have introduced a few enhancements and fixed many bugs:
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n ImprovedTest Queue and Forward to Queue: Our scripts can now provide in-queue treatments, checking the
status of a call in-queue, such as how long the current call has been waiting in the queue. We can also check the
agent's availability in the queue at a more granular level in both Test Queue and Forward to Queue objects.
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n Enhanced Edit and View inside scripts: The new enhancement adds double-click capability inside a script.
This enhancement provides a quick way to view the object's details without opening it in the edit mode.
To edit the object, click edit inside the View details window, or click the edit link next to the object inside the script.
This enhancement applies to all scripts including phone, email, and chat.

n Ability to generate PDF images for scripts: You can now generate a PDF image of the script in a printable
format and save it locally. It gives developers the ability and flexibility to review and design the script at a later time.

Version 9.14 39

Previous releases



This enhancement applies to all scripts such as phone, email, and chat.

n Allow agents to change Display Name: This new improvement allows agents to present themselves with a
customized display name. The new feature ensures agents privacy and helps them save time and effort to
introduce themselves to customers every time they start a new chat. The display name also shows up in the chat
log. Display Name can be modified by the 8x8 Contact Center administrator in the 8x8 Configuration Manager, or if
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permitted, by the agents in 8x8 Agent Console. The changes immediately appear in both applications.

Release 9.4.3

Enhanced Control for CRMReports: As an administrator, you have the ability to allow or prevent agents from creating
or downloading reports for customers, cases, and tasks in Local CRM. By default, agents are allowed to create and
download reports.
Release 9.4

This release offers Global Reach for 8x8 Contact Center. The Single Tenant Global Reach initiative from 8x8 Contact
Center provides best call quality on VoIP across the globe. If your contact center has agents and customers distributed
globally, serving your customers 24/7 with the right skilled agents and providing smooth call quality can be a challenge
given the global operation. The last thing you want is to distress customers with poor call quality when they need help.
The Single Tenant Global Reach initiative from 8x8 Contact Center provides best call quality on VoIP across
continents.
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With Single Tenant Global Reach, 8x8 Contact Center houses all your agents on a single platform and on a single
tenant irrespective of their geographic location. The single-tenant architecture eliminates the need to log in to multiple
tenants to manage traffic from different continents. An agent logging in from North America can service customer
interactions not only from North America, but also from Europe and Asia Pacific with a single login and with little
compromise on the interaction quality.

Benefits of global reach
n Single tenant for a global contact center

n Best call quality for global audience

n Availability of media servers in US, Canada, Europe, Australia, and Asia Pacific

n Call flow based on the media server closest to the point of call origination

n Eliminated need for multiple tenants to serve geographically-distributed agents

n Smooth call quality and agent interaction experience

For details on Global Reach use cases, refer to Single Tenant Global Reach.

Improvements

In addition to Global Reach, the release offers key improvements in IVR capabilities, improving caller experience:

n In-Queue Treatments and Controls: Ability to provide better in-queue experience to callers.

n Queued Callback: Ability to call back customers who opted out of waiting in the queue.

n Text to Speech: Ability to announce free text or dynamically collected data using the text to speech engine.

n Agent Menu: Enhanced experience for callers in direct agent routed calls.

n IVR Variables: The ability to set variables allows programming abilities within IVR scripts enabling better caller
experience. You can use variables to store the user input and use them to drive the call flow.

Other features and enhancements include:

n Time Zone Enhancements: Support for multiple time zones to better handle global operation of the contact center.

n Co-browsing via Chat: Ability to initiate Co-browsing via chat sessions.

n Improvements in Local CRM: The Local CRM now gives the ability to mark fields asmandatory, customize the
display order of these fields, and even hide them.

n Optimized call quality and routing: We allow agents to input their country of location that helps optimize call quality
and routing.

n Localization: We support European French and German languages.

n Browser Support: We support Microsoft Edge browser.
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Release 8.1

n Multi-Chat

n Embedded Chat Design

n Enhanced Chat Script

n Direct Agent Routing

n Script Decoupling

n Single Sign-On Access for NetSuite Integration

n Single Sign-On Access for Zendesk Integration

n HandlingMultilingual Chat

n Common Identifier for Pre-Chat Forms inMultiple Languages

n Enhanced Awareness of Queue Status

n Enhanced System Access Authentication

n SharedWallboard Authentication
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Get started

8x8 Contact Center administrators use 8x8 Configuration Manager to get started with:

n Understand basic entities of 8x8 Contact Center

n Plan 8x8 Contact Center entities

n Before You Start

n How to Log In and LogOut

n Reset Password

n Change your language settings

n Update email address

Get started
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Understand basic entities of 8x8 Contact Center

The primary call-handling characteristics of your 8x8 Contact Center are determined by four interaction processing and
reporting entities. When a phone, chat, or email interaction enter 8x8 Contact Center, appropriate channels receive
them, direct them to the desired queues, and lastly to agents who are members of the queue. The following image
shows an overview of 8x8 Contact Center entities and relationships.

The following table lists the entities in the order they process an incoming service request:

Call handling or
reporting entity

Description of inputs, operation, and outputs

Channels n Receive new service requests (calls or interactions) from phone, email, or chat
communications media.

n Categorize each incoming service request.

n Send incoming service requests to the appropriate queue.

Queues n Receive service requests from one or more channels.

n Prioritize each service request.
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Call handling or
reporting entity

Description of inputs, operation, and outputs

n Send service requests to the agents assigned to the queues.

Agents n Receive prioritized service requests from queues.

n Service the incoming interaction.

n Complete the interaction.

Groups Specify organizational categories, such as Sales or Support, used to analyze and report upon the
performance of the contact center's Channels, Queues, and Agents.
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Plan 8x8 Contact Center entities

8x8 Contact Center consists of a series of configuration entities.

To use 8x8 Configuration Manager most efficiently, and to create and configure your contact center's entities, follow a
top-down hierarchy. The following image illustrates the contact center planning and configuration hierarchy, and lists
the contact center planning considerations you use when creating and configuring those entities.

Because the Groups, Agents, Queues, and Channels entities are interrelated, you can save time if you create and
configure the entities in the following order:

1. Create Groups for the categories that use 8x8 Contact Center.
Groupsmay be functional (Support or Sales), or organizational (by team or management entity).
Creating Groups first enables you to completely create new Agent profiles.
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2. Create Agent accounts for all of your contact center agents.

3. Define your contact center's Phone, Email, Chat, and Voicemail Queues.
To enable you to assign voice mail rollover to your Phone queues, create your Voicemail queues first.
When you create Queues, you can assign one or more previously defined Agents to the Queue.

4. Configure your Phone Channels, then create Email, or Chat Channels.
To create a Phone Channel, contact 8x8, Inc.'s provisioning department.

5. Configure your Local CRM.
Add customized customer, case, and follow-up fields to your CRM.
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Before you start

To configure your 8x8 Contact Center, you need to:

n Review technical requirements: More1

n Create a maintenance notification distribution list: More2

n Compile a list of users: More3

n Gather physical phone number, soft or SIP phone IDs: More4

n Diagram automated call processing rules: More5

1To ensure your infrastructure is best configured to interoperate with 8x8 Contact Center, refer to the 8x8 Contact
Center Technical Requirements document.
28x8 Contact Center sendsmaintenance notifications via email. We recommend you ask your email administrator to
set up an email distribution list that includes all employees in your company who want to be notified of contact center
maintenance. You can then enter the email list under Home > Profile.
3Compile a list of employees who will use 8x8 Contact Center to interact with customers. The list should include the
first and last name, email address, login name, and phone number the user uses as their agent number in 8x8 Contact
Center.
4If agents use physical phones to process contact center calls, gather agents' phone numbers. If agents use softphones
(such asBria), the software must be downloaded and installed. Gather the SIP phone IDs.
5Draft a diagram on how you would like your call flow to be. This helps you configure an interaction flow to achieve the
best customer experience.
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Log in

8x8 Contact Center administrators need a login URL and credentials to access 8x8 Configuration Manager. 8x8
Provisioning provides you with the URL, username, and password to log in to your 8x8 Configuration Manager account.

Before you begin
Before you log in to 8x8 Configuration Manager:

n For the latest browser requirements, refer to the 8x8 Contact Center Technical Requirements document.

n Acquire the URL, username, and password for your 8x8 Contact Center tenant's 8x8 Configuration Manager.

Log in roles
You can log in to 8x8 Configuration Manager in various roles. For details, refer toRoles and Administrators.

n Primary administrator: an administrator with unrestricted administrative privileges to 8x8 Configuration
Manager.

n Role-based or Secondary administrator: an administrator who assumes a role with full or partial configuration
rights to 8x8 Configuration Manager.

n Wallboard Access: a Secondary administrator to access and run 8x8Wallboards.

Log in as the Primary administrator

The 8x8 Provisioning communicates information required to log in to your tenant by email. The email provides:

n URL to log in to your tenant

n URL to log in as an agent

n Login credentials

To log in as a Primary administrator:

1. Initiate a browser session.

2. Enter the URL provided by 8x8, such as https://vcc-na8.8x8.com/CM/login.php.

8x8 Configuration Manager displays the Administrator login page.
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3. In the Login page, enter your Login ID and password:

n Login ID: <TenantName>

n Password: <TenantPassword>

4. Click Login.
8x8 Configuration Manager launches theHome >Summary page.

Log in as a Secondary administrator

As a Secondary administrator, you inherit privileges defined for the role you are assigned to. For example, if you are a
campaign manager with administrative rights to the Campaigns object, you can create, edit, and manage campaigns.

To log in as a Secondary administrator:

1. Go to the 8x8 Configuration Manager login page.

2. Enter the login credentials communicated to you.
If the login URL does not contain the tenant name (as in https://vcc-na8.8x8.com/CM/login.php); add the tenant
name in the Login ID:

n Login Id: <AdministratorUserName>@<TenantName> as in nwayne@AcmeJets

n Password: <AdministratorPassword>

Log in for Wallboard Access

Use the 8x8 Configuration Manager login credentials to access and run wallboards. For details, refer to Run a
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Wallboard.

To Access Wallboards:

1. In the 8x8 Configuration Manager login screen, selectWallboard Access from the drop-downmenu.

2. Enter the 8x8 Configuration Manager login credentials, and click Login. TheWallboard launches displaying the
list of configured wallboards.
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Log out

As an 8x8 Contact Center administrator, click Logout in the header bar to log out of the 8x8 Configuration Manager.

Additionally, 8x8 Configuration Manager forces you to log out during:

n Idle Time: When your session is idle for longer than 45 minutes, the session logs you out automatically.

n Concurrent Session: Your login credentials allow you access to a single session only. Invoking a second session
using the same credentials logs you out of the first session.
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Reset password

As an 8x8 Contact Center administrator, you can change your password and security question by going to your profile in
8x8 Configuration Manager.

To change the password or your security question:

1. Log in to 8x8 Configuration Manager.

2. From the top navigation menu clickMy Profile.

3. Enter theOld Password and theNew Password.

4. Enter a Security Question for additional password protection.
The security question is offered when you request your password to be reset. You must answer the security
question to receive a link with the temporary password.

5. ClickSave.

Forgot password
If you forget your password during login, you can reset the password. When you reset the password, you receive an
email communication with a temporary password. The reset password is your gateway to change the password. When
you log in with the reset password, you are prompted to change the password. The changed password takes effect from
the next login session. The login fails if you do not change the password.

To reset the password:
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1. Go to the 8x8 Configuration Manager login screen.

2. Click Forgot?.

A Reset Password window appears and you are prompted to enter your user name.

3. Enter theUser Name, and clickContinue.
A message indicates that the reset password will be communicated to your email instantly.

4. Retrieve the temporary reset password from the email communication. If you have set the security question, you
must answer it first in order to receive the link with a temporary password.

5. Log in to 8x8 Configuration Manager with the reset password.

You are prompted to change the password.

6. Enter a new password, and clickChange.
The changed password takes effect from the next login session.
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Change your language settings

8x8 Contact Center administrators can select their preferred language for 8x8 Configuration Manager. To change the
language from English (default) to a different language, go to My Profile in 8x8 Configuration Manager.

To change the language you use to see Configuration Manager:

1. Log in to 8x8 Configuration Manager.

2. From the top navigation menu clickMy Profile.

3. Select a different Language from the list and clickSave. The new language is in effect the next time you log in to
8x8 Configuration Manager. We support the following languages:

n English

n Japanese

n French

n Canadian French

n German

n Spanish

n Dutch

n Italian

n Portuguese
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Update email address
As an administrator, you can update your email address by going to My Profile in 8x8 Configuration Manager.

To update the administrator email:

1. Log in to 8x8 Configuration Manager.

2. From the top navigation menu clickMy Profile.

3. Enter your newEmail.

4. ClickSave.
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Tour the 8x8 Configuration Manager interface

As an 8x8 Contact Center administrator, when you log in to 8x8 Configuration Manager, you see the Configuration
Menu, the Home page, and some tabs. 8x8 Configuration Manager organizes the user interface into three functional
areas:

The following table summarizes the functional areas in 8x8 Configuration Manager. For details about each area, see
Summary of the 8x8 ConfigurationManager Tabs.

Functional Area Description

1) Configuration
Menu

Use the Configuration Menuon the left to configure a desired functionality for your contact center.
The Configuration Menu lists features your company has subscribed to.

2) Configuration
tabs

Select a desired item in the Configuration Menu, such as Profile or Audio Files, to configure the
feature.

3) Header Bar n My Profile: Allows the Secondary administrator to change their 8x8 Configuration Manager
interface language to French or Japanese, for example, edit their email address, change
password and set up a security question using this link. For more information refer to How to
change the role-base administrator password. The supported languages are: English,
Japanese, French, Canadian French, German, Spanish, Dutch, Italian, and Portuguese.

n Co-browsing: Allows 8x8 Contact Center customers using 8x8 Configuration Manager to
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Functional Area Description

seek hands-on assistance from 8x8 customer support or deployment team. To initiate a Co-
browsing session from 8x8 Configuration Manager:

1. Click Co-browsing.

2. A pop-up window appears with a session ID that helps you establish a secure
connection with the customer support agent.

3. Communicate the Session ID to the agent, and click Start. See Get Remote Customer
Assistance.

n Logout: Logs you out of 8x8 Contact Center.
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Get remote customer assistance

8x8 Contact Center Co-browsing allows customer support agents to assist customers remotely via a shared browser.
With Co-browsing, 8x8 Contact Center administrators can empower a website or any browser-based application, and
offer live, hands-on assistance to customers. A customer in need of assistance must initiate the remote session,
generate a unique session code, communicate it to an agent via phone or chat. The agent then uses the code to
establish a remote session. Co-browsing session co-exists with a call or a chat for communicating the session code.

Features
n Visual, real-time web page assistance: Monitor and assist customers in real time through browser instance shared

by the customer.

n Mouse tracking: As a customer, easily follow along by viewing the agent’s mouse location and movement.

n Platform details: Access information about the customer’s platform.

n Sub-domain support: The Co-browsing session continues working if the user navigates to a site that is hosted in a
sub-domain, assuming that Co-browsing snippet is also included on that new sub-domain.

n Form co-filling: Co-fill forms on websites.

n Customer privacy and security: During a Co-browsing session, if the customer is filling a form and entering sensitive
information such as SSN in a form, it can be encrypted and hidden from the agent.

n Highlighting: Agents can highlight content on web pages and call out information to customers during Co-browsing.
Highlight key elements on the page with drawing tools.

n Auto-fit: Agents can automatically scale the browser view to fit customer's view settings. If the customer's screen is
bigger than the agent during a Co-browsing session, agents will have to scroll constantly. With the ability to auto-fit,
agents can enable “Auto-fit” to automatically scale the view to fit agent's view settings or manually
increment/decrement the zoom level to the desired value.

n Privilege control: You can control the extent of remote help agents can offer using Co-browsing mode. It varies
from a basic view only mode to complete control of the browser instance. Take control of the customer’s screen,
with their permission.
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Limitations
n Co-browsing only works in HTTP secure web pages.

n Adobe Flash components, including videos, and Java applets are not supported.

n Anything that is external to the current page is not supported. This includes the file browser window that is open
when selecting a file to be uploaded.

n WYSIWIG editors (AceEditor, CodeMirrorEditor, CKEditor, tinymceEditor) are not supported.

n Native tool tips are not visible between the two parties.

n Mouse hover texts do not show in the Agent side.

n Web pages with iframes with different domains are not supported.

n If the web pages open new browser window and the content has Co-browsing, this newwindow replaces the
content in the Agent side.

Supported browsers
See the system requirements for co-browsing supported browsers.
Use Case

The following example demonstrates how a given website can be empowered with 8x8 Co-browsing.

Let us review an example of a travel company website visited by customers wanting to book their dream vacations. The
website offers many travel packages and options to choose from. It requires customers to identify themselves by filling
in a form. If a customer traversing through this website seeks hands-on assistance, he can initiate a remote session with
a customer support agent in couple of clicks. Click on a help link on the web page to generate a code. Communicate this
code to the representative. The representative uses this code to establish a two-way hands on Co-browsing session.
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Co-browsingmodes
By setting up a Co-browsing mode, administrators can control the extent to which agents can assist customers
remotely. Co-browsing can be enabled in one of the following modes via code snippet. If you do not provide a mode in
the code snippet, full-control is the default mode:

n full-control (default): In this mode, agents have full control of the customer's browser session, including
synchronized navigation and the ability to highlight and co-fill a form on the web page. The agent's cursor
movements and mouse clicks are in sync with the customer, and vice versa. This is the default mode. If you do not
provide a mode in the code snippet, full-control is the default mode.

n partial-control: In this mode, agents can highlight and control the browser navigation, but do not have the
privileges to fill any forms on the Co-browsed page. All HTML form elements are disabled on the agent side,
alerting agents with the message "Forms cannot be edited on the agent side".

n no-control: This is a view-only mode. Agents can observe the customer’s navigation, highlight, and offer
guidance.

Notes:
-The highlighter works in all modes.
-In the full-control and partial-control modes, we cannot prevent agents from controlling form elements
that are not native to the browser, such HTML drop-down.

How do I get remote customer assistance?

Co-browsing in 8x8 Configuration Manager offers 8x8 Contact Center customers using 8x8 Configuration Manager to
seek hands-on assistance from 8x8 customer support or deployment team. Let us assume you are on a phone call with
8x8 customer support agent seeking assistance for configuring your tenant.

To initiate a Co-browsing session from 8x8 Configuration Manager:

1. Log in to 8x8 Configuration Manager.

2. From the header bar, click onCo-browsing link.
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3. In the pop-up window, clickStart sharing to generate a code that helps you initiate a secure connection with the
customer support agent.

4. Communicate the code you just generated to the agent.
The agent, on the other hand, selects Co-browsing option from the 8x8 Agent Console menu. This triggers a new
browser window prompting for the code. Enter the code received from the customer to initiate Co-browsing. The
agent can view the 8x8 Configuration Manager session open by customer, co-browse, and observe the mouse
movements and events of customer or offer hands-on assistance if needed. The session also respects the browser
size set by the customer. Both parties can observe each other's mouse movements and events.
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See how you can enable Co-browsing via chat as an administrator in 8x8 Configuration Manager.
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Summary of the 8x8 Configuration Manager tabs

8x8 Contact Center administrators find the following table summarizing the Configuration Menu, Configuration tabs,
and their functionality in 8x8 Configuration Manager.

8x8
Configuration
Manager
Page

Tabs Directly Accessible from the Page

Home View or modify the following information in Home page:

n Summary: View a summary of your tenant channels, groups, and queues.

n Profile: Configure account and tenant settings.

n Audio Files: Upload and manage audio files for greetings, pre-recorded phone menu
messages, and Agent whisper audio files.

n Schedules: Configure the schedules for the contact center. For example, you can have a
separate schedules for Support staff and Sales.

n Dial Plans: Configure the tenant default dial plan or create a custom dial plan.

n Agent's Idle Timer: Refers to the length of time agents have been idle. By default, an agent is
considered idle from the time he ends post processing of a system-delivered, queued
interaction and becomes available. It can be configured to reset when agents transition from
one status to another.

Security Security options include:

n Password Policies: Set up up password policies for Administrator, Agent and Supervisor
accounts, and set up account lockup.

n Roles: Create roles, define privileges or permissions, add and assign administrators to the
roles.

n Administrators: Add or edit administrators and enter their user names and password.

n SMTP Servers: Configure a custom SMTP server for better security and HIPAA compliance in
addition to the tenant SMTP server.

n IP Address Restriction: To identify secure IP addresses from which agents and
administrators can connect to the 8x8 Contact Center network.
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8x8
Configuration
Manager
Page

Tabs Directly Accessible from the Page

n DTMF Blacklist: To add, edit, and delete phone numbers as well as SIP URIs in your DTMF
blacklist. The DTMF blacklist is an existing service to stop recording a call once connected to a
blacklisted destination and mask any key presses in the customer experience call flow.

Agent Groups Groups are organizational categories, such as Sales or Support. A group includes a collection of
agents who report to a supervisor. For details, refer to Create Agent Functional Groups.

Agents Agents use the 8x8 Agent Console to view and manage customer interactions. 8x8 Contact Center
supports agents and supervisors. You can add agents and configure their workplace phone, assign
queues, grant supervisor rights, and enable CRM and tab permissions using the Agents tab.

Queues/Skills A queue is an ordered collection of interactions waiting to be served by agents qualified to respond to
these interactions. Queues direct incoming interactions to agents.
In Queues you can:

n Create, edit, copy, and delete queues of all media types: inbound and outbound phone, chat,
email, and voicemail.

n Assign members to queues

n Define targeted service level
For details, refer to Create and configure queues.

Channels n Phone: Process inbound and outbound phone interactions using the phone channels. A phone
channel is automatically crated when a number is ordered for the tenant through provisioning

n Email: Process inbound and outbound email interactions using the email channels. Email
channels are created by the 8x8 Contact Center administrator in 8x8 Contact Center.

n Chat: Process incoming chat requests using the chat channels and direct chat requests from
customers to contact center agents. Chat channels are created by the 8x8 Contact Center
administrator in 8x8 Contact Center.

n Social: Process incoming chat requests from Facebook and Twitter and allow agents to accept
and handle chat requests from social media. Social channels are created by the 8x8 Contact
Center administrator in 8x8 Contact Center.

n SMS: Process messages routed via SMS channels and chat queues to agents, and offered to
them as chat interactions for responses. Agents look up customer records from an existing
customer. They can look up outstanding cases and history of interactions to handle the
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8x8
Configuration
Manager
Page

Tabs Directly Accessible from the Page

conversation effectively.

n Chat API: Connect directly to an agent from your own system such as enabling your clients to
communicate with an agent from mobile app-based chat, Desktop web chatbots, and
messaging via integrations with other apps or platforms. See our content on chat workflow for
developers.

Phone, web chat, and email interactions arrive at a tenant on a channel. Email and chat channels are
created in the Channels page. You can add a new email and chat channels and edit the existing
phone channels. For details, refer to Create channels.

Note: To create a Phone channel, contact the 8x8, Inc. provisioning department.

Scripts IVR scripts define how 8x8 Contact Center processes Phone, Chat, Email, Social, or SMS inter-
actions. They provide the capability of guiding incoming interactions to self-direct them to the
desired destination within the contact center. Create a user-defined script or use a system default
script such as IVR script default.

CRM The CRM page allows agents and supervisors to manage customers, cases, follow-ups, and tasks.
For details, refer to Configure Local CRM.

Outbound
Setup

For campaigns to function successfully, they need to connect to the 8x8 Contact Center CRM or an
External CRM, extract data from a specific CRM object, and generate a target call list. The Outbound
Setup allows defining global properties for campaign management.
For details, refer to Configure Outbound Setup.

Campaigns A campaign is an outbound phone based dialer that enables you to search, generate, and feed a call
list to an outbound queue facilitating automated outbound dialing. The Campaigns page allows defin-
ing new campaigns, or controlling or managing existing campaigns.
For details, refer to Create a Campaign.

Broadcast Use the Broadcast page to send a message to one or more Agent Groups. The page contains only
the Broadcast tab.
For details, refer to Broadcast Messages.

Integration 8x8 Contact Center offers integration capabilities with Local CRM and third party Customer Resource
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8x8
Configuration
Manager
Page

Tabs Directly Accessible from the Page

Management (CRM) systems.
For details, refer to Integrate with External CRM.

Status Codes Status codes allow contact center supervisors to track how an agent functions through a workday.
For details, refer to Status Codes Overview.

Transaction
Codes

Transaction codes offer a means to apply call disposition to inbound as well as outbound inter-
actions.
For details, refer to Transaction Codes Overview.

Outbound
Phone Codes

Outbound Phone Codes allows you to define and configure Outbound Phone Code lists.
For details, refer to Outbound Phone Codes Overview.

Wallboard Wallboard allows you to get the real-time metrics of your contact center operations.
For details, refer to Wallboards Overview.

Chat Design Chat design allows you to design a custom chat to match your company's requirements and to create
a custom chat script to control the chat flow.
For details, refer to Configure Embedded chat design.
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Configure accounts and profiles

As an 8x8 Contact Center administrator, use the 8x8 Configuration ManagerHome page to:

n View Channels, Groups, andQueues Summary

n Configure Profile Settings

n Configure Audio Files and RecordedGreetings

n Define Business Hours and Schedules

n Understand Tenant Dial Plans

n Reset Agent's Idle Timer

Configure accounts and profiles
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View 8x8 Contact Center summary

Admins can have a quick view of their 8x8 Contact Center channels, queues, and agent groups by going to Home >
Summary. A channel facilitates communication of interactions in and out of a 8x8 Contact Center tenant. A queue is an
ordered collection of interactions waiting to be served by agents who are qualified to respond to these interactions. An
agent group is a collection of agents who report to a supervisor. A single group may serve your entire call center or may
be dedicated to one or more products, services, queues, or to a specific communication channel such as phone, email,
or chat. 8x8 Contact Center uses skill-based routing rules to place interactions to the appropriate queues.

The Summary page provides a quick statistical summary of:

n Phone, email and chat channels configured for your tenant.

n Inbound and outbound queues for all media, such as phone or email.

n Agent groups, with the number of agents in each group.
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Summary page options
The following table summarizes the information you can find underHome > Summary. You can view a summary of
incoming channels, inbound and outbound queues, and agent groups in this page.

Summary tab option Description

Incoming Channels For each type of Channel, summarizes the number of Channel definitions of that type.
For details on Channels, refer to Create and configure channels.

Inbound Queues Summarizes the number of Inbound Queue definitions of that type.
For details on Queues, refer to Create and configure queues.

Outbound Queues Summarizes the number of Outbound Queue definitions of that type.
For details on Queues, refer to Create and configure queues.

Agent Groups For each Group definition, summarizes the number of Agents assigned to that group.
For details on Groups, refer to Create agent functional groups.
For details on Agents, refer to Add agents.
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Configure profile settings

8x8 Contact Center administrators can find their tenant name, tenant language, support level, and other tenant
subscription information besides the account preferences under Home > Profile in 8x8 Configuration Manager.

The information in the Profile page is grouped under the following areas:

n Administration and File Transfer Passwords: The current password required to set a new password for either
8x8 Configuration Manager, or Secure File Transfer Protocol (FTPES).
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n Configuration Manager - change password: Allows the Primary administrator to change 8x8 Configuration
Manager password. You must enter the current password first and then enter a new password.

n Secure File transfer Protocol (FTPES) - set password: Allows the Primary administrator to set up a password
to access agent call recordings through FTPES (Secure File Transfer Protocol).

n Miscellaneous tenant settings: Groups information on the tenant time zone, tenant label, and options to allow
agents to change name, enable SSL API, change screen pop settings, and enable agent's workplace setting
change validation.

n Service Notifications - email addresses: Specify email addresses for administrator and maintenance email
distribution list.

n Tenant email - SPAM filtering parameters: Defines threshold level to filter unwanted emails and allows listing
Spam Black Lists1 and SpamWhite Lists2.

n Tenant - Logo: Allows you to upload an image logo for branding 8x8 wallboards. ClickBrowse and upload an
image.

n Phone Connection Mode: With Phone Connection Mode, agents set up their voice connection before they start
working on calls and remain connected throughout their working day. Admins can set the tenant's default
connectionmode to Persistent or On Demand. Admins can also allow agents to change their Phone Connection
Mode in 8x8 Agent Console if needed. Admins can enable Auto Answerfor agents and increase the DAR post-
processing timeout.

For a detailed summary of your tenant settings, refer to Summary of Profile Settings. See the following topics to learn
how to configure your tenant settings:

n Allow multiple time zones

n Enable Phone ConnectionMode

n Enable Auto Answer

n EnableWorkplace Setting Validation

1List of email addresses whose communications should be filtered.
2List of email addresses whose communications are classified as legitimate.
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Summary of profile settings

8x8 Contact Center administrators find the following table in 8x8 Configuration Manager summarizing the options
available under Home > Profile:

Profile tab option Description

Tenant Name Shows the name of your tenant. It can be your company name. 8x8 Con-
figuration Manager adds the value of the Company Name text entry
area to the top of the 8x8 Configuration Manager browser window.

Support Level Indicates your tenant's support level.

Concurrent Access
Limit

Indicates the maximum simultaneous users that can log into 8x8
Agent Console or 8x8 Supervisor Console. Each Concurrent Access
requires a Named User. One Concurrent Access and one Named User
is synonymous with an agent seat. Named User can also be equivalent
to an additional login.

Default Caller ID Specifies the default caller ID for the tenant. This number is displayed
to the dialed party as the caller’s phone number when placing an out-
bound call from 8x8 Contact Center.

Version Package Specifies the version of 8x8 Contact Center.

Named Users Limit Indicates the maximum number of named users that can be added to
the tenant. This field displays your current subscription plus one or two
for authorized customer support users. Named User functionality
provides for unique personal identity with roles (agent or supervisor)
and permissions.

Note:Each Tenant is pre-configured with one or two
NamedUsers at no charge. These are used by
authorized customer support personnel for
troubleshooting purposes. You can identify the pre-
configured users by an assigned group of 8x8 Contact
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Profile tab option Description

Center support.

Language  Read-only reminder of the language used to display the 8x8 Con-
figuration Manager user interface. This language setting was applied
as requested when your 8x8 Contact Center tenant was originally cre-
ated, and it cannot be changed.

Note:Your agents can select their preferred language
separately in 8x8 Agent Console.

Revision Represents the revision number of 8x8 Contact Center.

Configured Users Indicates the number of Named Users currently setup in the tenant.
The difference between the Named Users Limit and Configured Users
are the remaining Named Users quantity that can be profiled.

Administration & File Transfer Passwords

Current Configuration
Manager Password

Allows the Primary Administrator to change 8x8 Configuration Manager
password. The new password must have minimum of 8 characters.

Configuration Manager - Change Password

New Password Enter a new password for 8x8 Configuration Manager.

Retype New Pass-
word

Retype your new password for 8x8 Configuration Manager.

Secure File Transfer Protocol (FTPES)- set password

Password (min.8
chars.)
Retype Password

Enables setting up a password for Secure File Transfer Protocol of
agent call recoding files.
For details on agent recording files, refer to Configure Phone Settings.
For details on downloading agent recordings, refer to Access Agent
Recorded Calls.

Miscellaneous Tenant Settings

Default Time Zone Refers to your contact center's local time zone. Specifying the time
zone enables 8x8 Configuration Manager to:
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Profile tab option Description

n Correctly interpret the hours of operation specified in the
Schedule tab.
For details on the Schedule tab, refer to Define Business Hours
and Schedules.

n Display time-stamped events in local time.

Other Time Zone 8x8 Contact Center supports time zone for global operation by allowing
multiple time zone selections within the same tenant. Multiple time
zones helps tenants with offices across the world. Supervisors can
monitor queue and agent activities based on the local time zone.

Tenant Label Refers to the Tenant Label that appears on top of 8x8 Configuration
Manager browser window. You can label the tenant differently from
the Tenant ID.

Default Agent Display
Name

Select whether you want to display the word Agent or the agent's first
name such as <Robin>. The agent's display name appears in 8x8
Agent Console. Reset all agents, clears all custom display names.
You can also select to overwrite the group settings at this time.

Allow Agents to
Change Name

Allows agents to change their login name from My Profile page after
they log in to 8x8 Agent Console and save.

Allow Agents to
Change Display
Name

Allows agents to change their display name in the 8x8 Agent Console's
Profile page. Display Name helps agents save time and effort to intro-
duce themselves to customers every time they start a new chat. The
agent's display name appears in the 8x8 Agent Console's control panel,
Profile page, chat window, and CRM case created after a chat session.
It can be modified by the 8x8 Contact Center administrator in the 8x8
Configuration Manager, or if permitted, by the agents in 8x8 Agent Con-
sole. The changes immediately show up in both applications. To pre-
vent agents from changing their display name at the tenant level, clear
the Allow Agents to Change the Display Name checkbox under
Home > Profile.

n To prevent agents from changing their display name at the tenant
level, clear the Allow Agents to Change the Display Name
checkbox under Home > Profile. If disabled, this option does not
appear at the agent groups level.
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Profile tab option Description

n To prevent agents from changing their display name at the group
level, clear the Allow Agents to Change the Display Name
checkbox from the Agent Group. This option only appears if it is
enabled at the tenant level.

Allow Agents to
Change Screenpop

Allows agents to change screen pop window properties, such as open-
ing a new screen pop window, and modifying the size and position of
the window from 8x8 Agent Console.

Allow Agents to
Reject Interactions

This option is enabled by default allowing agents to reject interactions.
If disabled, the Reject button in 8x8 Agent Console is disabled pre-
venting agents from rejecting the interactions they are offered. The
Reject button in 8x8 Agent Console appears when an interaction is
offered to the agent. You can set up this ability for an agent group, or
individual agents. If you disable this option at the tenant level, the
checkbox will not show up for agent groups or individual agents.

Enable SSL for Agent
GUI

By default, the Enable SSL for Agent GUI check box is selected and
8x8 Configuration Manager uses secure communications.
8x8 strongly recommends that you always use secure com-
munications when working with 8x8 Configuration Manager. If you tem-
porarily need to disable secure communications for purposes of
troubleshooting, clear the check box.

Enable Workplace set-
ting change validation

When changing workplace setting (Workplace Phone and Workplace
SIP URI), agents must validate their changes to be able to handle the
calls. When they click to validate the change, it triggers a phone call to
the updated phone number. For details see our content on how to
enable workplace setting change validation.

Enable Enhanced
Ringtone

If enabled, the caller hears continued queue music until an agent
accepts the call. Once the call is accepted, a short alerting ringtone is
played back to the caller to signal the start of the interaction. At the
same time, the agent hears a beep notification to prepare them for the
call.

Enable Agent's My
Recording Func-
tionality

If enabled agents can access the My Recording feature from the 8x8
Agent Console main menu. This option allows agents to record a voice
message for the incoming calls.
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Profile tab option Description

Enable transferring to
queues with no work-
ing agents

If enabled, allows agents to transfer interactions to an unattended
queue. If disabled, prevents agents from transferring interactions to an
unattended queue.

Allow agents to con-
figure warning mes-
sage popup

If enabled, agents can disable the warning message before trans-
ferring the interaction to an unattended queue.

Enable agents to
return to available
status after pulling
email

If enabled, agents can go back to the Available status after pulling an
email from the queue. If this option is disabled, agent's status remains
working offline after pulling emails from the queue.

Service Notification - Email Addresses

Administrator's Email
(s)

Lists the Primary administrator's email address.
If an Email Channel attempts to retrieve queued emails, and that
retrieval attempt fails, then 8x8 Configuration Manager sends email
notification to the administrator.
For details on Email Channels, refer to Set up Email Channels.

Maintenance Email
Distribution List(s)

Lists the email distribution list(s) to which maintenance issues regard-
ing the tenant are mailed.

Tenant Email - SPAM filtering parameters

Spam Threshold
Level

Choose how strictly 8x8 Configuration Manager filters administrative
email messages for unsolicited junk email or spam. By default, 8x8
Configuration Manager sets the Spam Threshold Level equal to 5.
Choose a lower number to apply stricter spam filtering.
Do not choose a spam threshold setting lower than 3 or higher than 7
unless directed to by 8x8 Contact Center support.

Spam Black / White
List

If the Email Script tab in the Email Channel page includes a Check
Spam script object, then:

n Spam Black List: Enter the email addresses whose
communications should be classified as spam.

n Spam White List: Enter the email addresses which should not be
classified as spam.

Both the Spam Black List and Spam White List text entry areas support
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Profile tab option Description

the use of asterisks (*) as wild-card characters.

Tenant Logo

Select an image logo for branding 8x8 wallboards. Click Choose Files
and upload an image.

Phone Connection Mode

Default Connection
Mode

Administrators can choose one of the following Phone Connection
Modes for agents: On Demand or Persistent. For details, see our con-
tent on how to enable phone connection mode.

Allow Agents to
change Phone Con-
nection Mode

Agents are able to change their Phone Connection Mode from within
the 8x8 Agent Console. For details, see our content on how to change
your phone connection mode.

Enable Auto Answer With Auto Answer, every phone interaction that is offered to an agent
is automatically connected eliminating the need to accept it manually.
If Auto Answer is provisioned for your tenant, you can enable it at the
tenant level, agent group level, or agent level. For details, see our con-
tent on how to enable Auto Answer.
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Allow multiple time zones

8x8 Contact Center supports time zones for global operation by allowing multiple time zone selections within the same
tenant. Access to multiple time zones in 8x8 Configuration Manager, helps tenants with offices across the world. For
example, if a business has offices in the US, the UK, and China, the administrator can select the US Pacific time zone
as the default, and select UK and China as additional time zones. Agent supervisors in the UK office can monitor queue
and agent activity based on their local time zone, and a wallboard manager in China can apply the Asia Pacific time
zone to the desired wallboard.

To allow multiple time zones for a tenant:

1. From the Configuration Menu, openHome.

2. Go to the Profile tab.

3. UnderOther Time Zone, clickEdit. You can add more time zones are in addition to your default time zone as
desired.

4. Select the desired time zone(s) from the list, and clickOK.
A time zone that is being used shows up as highlighted.

5. ClickOK.
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6. ClickSave.
The tenant now hasmultiple time zones. The time zones can be selected when creating a wallboard, or in 8x8
Agent Console, and by supervisors when monitoring queues and agents. In monitoring, time zone is applicable if
you select to view data from beginning of day.
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Enable Phone Connection Mode

8x8 Contact Center has improved call handling capability via Phone Connection Mode. With this feature, agents set up
their voice connection before they start working on calls and remain connected throughout their working day. It allows
them to respond to incoming and outbound phone calls with a simple click on the user interface improving their call
handling efficiency.

8x8 Contact Center administrators can choose one of the following Phone Connection Modes in 8x8 Configuration
Manager for agents: 

n On Demand: On Demand Connection Mode creates a temporary connection from the agent’s workplace phone to
the system. The agents have to manually accept the call in their soft or hard phone.

n Persistent: Previously referred to as off-Hook ConnectionMode, Persistent Connection Mode creates a constant
connection from the agent’s workplace phone to the system. Once the connection is open, it will stay active until
logged out. Any changes to the setting will remain in effect for the whole duration of the agent’s Persistent
connection. Agents set up their voice connection before they start working on calls and remain connected
throughout their working day. It allows them to respond to incoming and outbound phone calls with a simple click
on the user interface, improving their call handling efficiency.

Renaming off-hook connectionmode to Persistent ConnectionMode
The Off-hook connection mode that was first introduced in 9.8 has been renamed to Persistent Connection Mode.
There is no change to the functionality, just to the naming of the feature.

About Persistent ConnectionMode
If your tenant is provisioned with Persistent Connection Mode, you can see this feature under Home > Profile. With
Persistent Connection Mode, agents can instantly and seamlessly connect to customers and improve their productivity.
Persistent Connection Mode provides a constant connection from the agent’s device to 8x8 Contact Center. It removes
the need to connect the agent’s workplace phone for every call handled. Agents set up their voice connection before
they start working on calls and remain connected throughout their working day. It allows them to respond to incoming
and outbound phone calls with a simple click on the user interface.
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Without the Persistent Connection Mode, after agents log in to 8x8 Contact Center and make themselves available,
they have to accept the interaction for every call that comes through the queue. If theymiss the ringing phone, they will
no longer be available to take the interaction.

Note: There is no audio prompt or audio indication for Persistent ConnectionMode.

Features
n Agents can immediately and seamlessly connect to customers.

n Offers a persistent connection from the agent's device to VCC that is ready for outbound dialing.

n Removes the need to connect the agent's workplace phone for every call handled.

n Increases productivity from a higher throughput of calls.

Enable Persistent ConnectionMode
If Persistent Connection Mode is provisioned for your tenant, you can enable at the tenant, agent group, or the agent
level:
Enable Persistent Connection Mode at the Tenant Level

1. In 8x8 Configuration Manager, go toHome > Profile.

2. Select Persistent under Phone Connection Mode. It makes the Persistent Connection Mode available for all
agents in that tenant.
Reset all allows you to standardize the default connection mode when there are different settings for this feature
within the tenant, for agents and agent groups.

3. Select Allow Agents to Change Phone Connection Mode. Agents are able to change their connection mode
from within the 8x8 Agent Console.
Reset all allows you to reset all agents and agent groups to the tenant setting.
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4. ClickSave.

Note: TheReset all button shows when there are amixture of settings for that mode or option at
the Tenant level.

Enable Persistent Connection Mode at the Agent Group Level

1. In 8x8 Configuration Manager, go toAgent Groups from the main menu.

2. Click to edit or create a new agent group.

3. Select Persistent under Phone Connection Mode.
Reset all agents allows you to standardize the default connection mode for all agents when there are different
settings for it within the agent group. For example, you see Reset all if you have enabled agents to choose their
mode. Reset all is not available when all settings are the same.

4. Select Allow Agents to Change Phone Connection Mode if you want to enable all agents at the agent group
to change their connection mode.
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Note: TheReset all agents button only shows when there are amixture of settings for that mode
or option within the Agent Group.

Enable Persistent Connection Mode at the Agent Level

1. In 8x8 Configuration Manager, go to theAgentspage.

2. Click to edit or create a new agent and open theGeneraltab.

3. Select Persistent under Phone Connection Mode.

4. Select Allow Agents to Change Phone Connection Mode if you want to enable this agent to change their
connection mode.
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5. ClickSave.

Combinations for Persistent ConnectionMode and Auto Answer settings
Auto Answer can be combined with the Persistent feature to create an on/off combination of the two features. Auto
Answer settings combined with Persistent can be configured at multiple levels depending on the features availability:

Connection Behavior

Persistent Off,
Auto Answer Off

Phone Connection Mode is On Demand and Auto Answer is off, so the agent needs to answer
the phone for every phone interaction.

Persistent Off,
Auto Answer On

Phone Connection Mode is On Demand and Auto Answer is on, so the agent phone auto-
matically connects, and the interaction is auto answered when offered.

Persistent On,
Auto Answer Off

Phone Connection Mode is Persistent, so the agent media path is always connected but for
every phone interaction the agent needs to click the Accept button.

Persistent On,
Auto Answer On

Phone Connection Mode is Persistent, so the agent media path is always connected, and the
interaction is automatically answered when offered.

Version 9.14 86

Enable Phone Connection Mode



Enable Auto Answer

8x8 Contact Center has improved the call handling efficiency of agents via Auto Answer. Using Auto Answer in 8x8
Configuration Manager, every phone interaction that is offered to an agent is automatically connected eliminating the
need to accept it manually. This new configurable option enhances agents efficiency by quickly connecting the calls and
reducing the number of clicks an agent has to make. Auto Answer also helps prevent agents from rejecting or missing
calls on their workplace phone. When in Auto Answer mode, agents receive an audio prompt to alert them of a call as it
connects.

Note:Auto Answer is currently on limited availability. Contact 8x8 Support for more help.

Considerations when using Auto Answer:

n The agent’s audio may be connected before any visual notification is made on the screen for the interaction or any
screen pop can be enabled.

n Direct Agent Access (DAA) or Direct Agent Routing (DAR) calls are only sent in an Auto Answer mode to an
enabled agent if they are on an Available state.

n An Auto Answer agent with a post-processing time set to zero could potentially find themselves with a non-stop
succession of calls.

n If a supervisor is in Auto Answer mode monitoring an agent who is not, the supervisor may be connected first, but
the customer will continue to hear queue music or the ring tone until the agent is connected.

n Auto Answer is supported by 8x8Work for Desktop and 8x8Work for Mobile. If the device is not supported, then
the system defaults to the standard manual answer.
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n The Auto Answer feature is visually indicated with anA in the phone tab which persists in all agent states.

Note: If Auto Answer is enabled, theAnswer Call button is absent in the user interface when
agents are offered calls.

Note:Auto Answer is only supported on line 1 for phone interactions.

Enable Auto Answer for your 8x8 Contact Center
With Auto Answer, every phone interaction that is offered to an agent is automatically connected eliminating the
need to accept it manually. If Auto Answer is provisioned for your tenant, you can enable it at the tenant level,
agent group level, or agent level:
Enable Auto Answer at the Tenant Level

1. In 8x8 Configuration Manager, go toHome > Profile.

2. Under Phone Connection Mode, select Enable Auto Answer. If you are enabling this feature for the first
time, a confirmation dialog box prompts notifying you that a mandatory validation will also be turned on for
security reasons.
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3. ClickOk to continue. Auto Answer is enabled at the tenant level for all agents. By accepting the mandatory
validation, Enable Workplace setting change validation is selected and cannot be changed.
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4. ClickSave to activate Auto Answer at the tenant level. You have also enabled the workplace setting
validation.

Enable Auto Answer at the Agent Group Level

Note:Auto Answer is visible at the agent group level only if you have enabled it at the tenant level.

1. In 8x8 Configuration Manager, go toAgent Groups from the main menu.

2. Click to edit or create a new agent group.

3. In theGeneral tab, select Enable Auto Answer if not enabled already. Auto Answer is now enabled at the
agent group level for all agents. A confirmation message notifies you when the operation is completed
successfully.
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4. ClickSave to activate Auto Answer at the agent group level.

Enable Auto Answer at the Agent Level

1. In 8x8 Configuration Manager, go to theAgentspage.

2. Click to edit or create a new agent and open theGeneraltab.

3. Select Enable Auto Answer to allow agents answer their calls using the Auto Answer feature. Auto Answer
is visible at the Agent level only if it is enabled at the tenant and Agent Group level.

4. ClickSave to activate Auto Answer at the agent level.
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Combinations for Persistent ConnectionMode and Auto Answer settings
Auto Answer can be combined with the Persistent feature to create an on/off combination of the two features. Auto
Answer settings combined with Persistent can be configured at multiple levels depending on the features
availability:

Connection Behavior

Persistent Off,
Auto Answer Off

Phone Connection Mode is On Demand and Auto Answer is off, so the agent needs to
answer the phone for every phone interaction.

Persistent Off,
Auto Answer On

Phone Connection Mode is On Demand and Auto Answer is on, so the agent phone
automatically connects, and the interaction is auto answered when offered.

Persistent On,
Auto Answer Off

Phone Connection Mode is Persistent, so the agent media path is always connected but for
every phone interaction the agent needs to click the Accept button.

Persistent On,
Auto Answer On

Phone Connection Mode is Persistent, so the agent media path is always connected, and
the interaction is automatically answered when offered.
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Adjust post-processing time for direct agent calls

8x8 Contact Center post-processing time is the duration agents are allowed, after terminating the calls, to wrap up any
pending notes or actions related to the call. Prior to this release, while processing direct-to-agent calls, agents had a
limited duration of five seconds for post-processing. Depending on your business needs, agentsmay require more time
to wrap up notes on calls. In this release, we are introducing the ability to adjust post-processing time for direct-to-agent
calls from five seconds to a maximum of 60 minutes helping to meet your business needs.

Features
n Allow agents a suitable time to wrap up calls.

n Set up post-processing time at the tenant, agent group, and agent levels.

Configure the post-processing timeout
As an 8x8 Contact Center administrator, you can set up the post-processing timeout for direct-to-agent calls in 8x8
Configuration Manager. You can set the post-processing time at the tenant level, agent group level, or agent level.

To set up post-processing time at the tenant level:

1. Log into 8x8 Configuration Manager.

2. Go toHome > Profile.
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3. Scroll down and select a desired time forDAR Post-processing Timeout.

4. ClickSave.

5. If you click theReset all link, it alerts you that all existing agent group and agent level settings for DAR post-
processing timeout will reset to the tenant level setting. ClickOk to proceed orCancel.

To set up post-processing time at the agent group level:

1. From the menu, go toAgent groups.

2. UnderGeneral, select a desired time forDAR Post-processing Timeout.

3. ClickSave.

4. To reset the individual agent setting to agent group-level setting, click theReset all agents link. It alerts you that
all existing individual agent-level settings for DAR post-processing timeout will reset to the agent group level
setting. ClickOk to proceed orCancel.

To set up post-processing time at the agent level:
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1. From the menu, go toUsers.

2. From the list of users, select a desired user.

3. Go to the Phone tab and select a desired time forDAR Post-processing Timeout.

4. ClickSave. This sets the post-processing time for the individual user.

Priority rules
By default, here are the priorities for DAR post processing timeout:

n Agent level settings override agent-group, and tenant level settings.

n Agent-group level settings override tenant-level settings.

n If agent-level is not set, the agent inherits the agent-group level setting.

n If agent-level is not set and if agent-group level is not set, agents inherit the tenant-level setting.

n If post-processing timeout is not set at the tenant-level, agent-group level, as well as agent level, then the value is
set to five seconds by default.
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Introducing workplace setting validation

8x8 Contact Center administrators can enable workplace settings validation for agents via 8x8 Configuration Manager.
When changing workplace settings (Workplace Phone andWorkplace SIP URI), agentsmust validate their changes to
be able to handle the calls. When they click to validate the change, it triggers a phone call to the updated phone
number. A PIN code is then communicated to the agent. The agent must enter the PIN code to validate the changes
and continue. If they are unable to confirm the PIN theymust exit and revert to their last validated setting. The
workplace setting validation is offered as a mandatory security feature with Auto Answer, or it can be deployed as a
stand-alone feature.

Features
8x8 Configuration Manager workplace setting validation:

n Is mandatory while Auto Answer is enabled.

n Is offered as stand-alone feature. Admins can remove or disable this feature in 8x8 Configuration Manager with no
restrictions.

n Reverts to the agent's last validated setting if unable to validate the newworkplace setting.

Enable workplace setting validation in 8x8 ConfigurationManager
The workplace setting validation is applicable to a tenant for all agents and groups. To validate the workplace setting,
agents require a phone and an audio access for the PIN code to be played to them. Moreover, the agentsmust be in
Work offline status to change their workplace setting.
Enable workplace setting validation paired with Auto Answer

1. Log in to 8x8 Configuration Manager.

2. Go toHome > Profile.

3. Under Phone Connection Mode, select Enable Auto Answer.
If Auto Answer is enabled for the first time and without enabling the workplace security feature, a confirmation
dialog box prompts notifying you that a mandatory validation feature will also be turned on for security reasons:
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n If you clickOk, Auto Answer is enabled. By accepting the mandatory validation, Enable Workplace setting
change validation is also turned on and cannot be changed independently while the Auto Answer feature is
enabled. Workplace setting validation is enabled at the tenant level for all agents. You can configure Auto
Answer at the agent group or agent level as well.
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Note: If you disable Auto Answer. Workplace setting change validation is still enabled but can
be disabled if required.

n If you clickCancel, Auto Answer is not enabled.

4. ClickSave.

Enable Workplace Setting Validation as Stand-alone Feature

1. Log in to 8x8 Configuration Manager.

2. Go toHome > Profile.
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3. Select Enable workplace setting change validation.

Note: If you have enabled Auto Answer, workplace setting validation is already enabled. You can
disable Auto Answer, but keep the workplace setting change validation enabled.

4. ClickSave. Workplace setting change validation is now enabled at the tenant level for all agents.
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Configure audio files and recorded greetings

In a typical phone menu, callers direct themselves to the desired destination using choices from the menu. 8x8 Contact
Center phone menu is driven by pre-recorded audio messages. Audio files serve to automate a contact center's phone
menu. 8x8 Contact Center offers a number of pre-recorded messages to serve your business needs. You can also
upload customized messages to suit your specific needs. Use the Audio Files tab in 8x8 Configuration Manager to
manage the recorded messages used by your phone channels.

To display the Audio Files:

1. From the Configuration Menu, openHome.

2. Go to theAudio Files tab.
By default, each tenant includes a repository of pre-recorded audio files and user audio files. You may use the
readily available messages or record and upload your customized messages.

Note: 8x8 Contact Center supports the 8 KHz, 16-bit, monaural WAV file format only.
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Upload audio files

In a typical phone menu, callers direct themselves to the desired destination using phone choices from the menu. The
8x8 Contact Center phone menu is driven by pre-recorded audio messages. Audio files serve to automate a contact
center's phone menu. 8x8 Contact Center allows you to upload customized messages in 8x8 Configuration Manager to
serve your contact center's needs.

To upload audio files:

1. From the Configuration Menu, openHome.

2. Go to theAudio Files tab.

The following table summarizes file types listed inAudio Files.
Audio Files Option Description

User Lists the customized audio files uploaded by your 8x8 Contact Center
administrator into this tenant. When you initially configure a tenant instance, the
User folder does not contain any audio files. When you use the Audio Files tab to
upload your company's customized audio files into 8x8 Configuration Manager,
the uploaded files are stored in the User folder.

Pre-recorded Lists the set of default audio files available for the tenant. By default, a new
tenant includes a set of placeholder audio files. These files provide examples of
voice Channel greetings and messages used in a variety of contact center
contexts. When you upload the customized audio files required by your contact
center, you replace a pre-recorded audio file assignment so that it uses your
customized audio file.

User-Agent whisper Lists the audio files that can be uploaded and assigned by the tenant
administrator to an inbound or outbound queue to inform the agent, upon
connection, about the connected call. Upon receiving calls, the system plays a
brief message stating the nature of the call such as sales or support.

3. Open theUser folder under Audio Files.
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4. ClickAdd to upload a new audio file.

5. Enter aName for the message you wish to upload.
The following table summarizes the options available under Voice file description.
Voice File Description
Option

Description

Name A descriptive name for the contents of the customized audio file.

Description Enter a meaningful description for the customized audio file to help you
remember it later.

Upload new To upload a customized audio file to your tenant, select a 8 KHz, 16-bit, monaural
WAV file. After you upload an audio file, you must verify that 8x8 Contact Center
can play the audio file before referencing the file in an IVR script. 8x8
Configuration Manager does not upload the file until you click Save. For details
on playing uploaded IVR files, refer to Verify Audio Files Deployment.

Save To finish uploading the audio file you must click Save. 8x8 Configuration
Manager only allows you to save user audio files.

Delete To delete a customized audio file under User folders, click Edit > Delete.

View To view details about a customized audio file such as type, file name, date of
upload, size and file information, click View.
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Note: For best practices, insert a special prefix at the front of the user-created audio names so they
can be distinguished from the system audio files.

6. Enter a transcript or a brief description of the message in theDescription box.

7. ClickChoose Files to select an audio file in WAV format.

8. ClickPlay Audio to play back the uploaded message.

9. ClickSave.

Edit audio files
You can edit custom audio files at any time. However, you cannot edit the default pre-recorded audio messages.

To edit custom audio files:

1. From the Configuration Menu, openHome.

2. Go toAudio Files.

3. Select the desired audio file in theUser folder.
The description of the voice file displays in the View tab.

4. Click the Edit tab and make the desired changes. You can also upload a new audio file from Edit mode.

Delete audio files
You can delete custom audio files at any time. However, you cannot delete the default pre-recorded audio messages.

To delete custom audio files:

1. From the Configuration Menu, openHome.

2. Go toAudio Files.

3. Select the desired audio file in theUser folder.
The description of the voice file displays in the View tab.

4. Click the Edit tab and make the desired changes. You can also upload a new audio file from Edit mode
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5. ClickDelete to remove the message from the tenant.

Note: To order professionally-recordedmessages, click the link at the bottom of theVoice file
description area. You are sent to a service provider in professional voice recordings.
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Verify audio files deployment

By default, a new 8x8 Contact Center tenant includes a set of default pre-recorded placeholder audio files. These files
provide examples of voice Channel greetings and messages used in a variety of contact center contexts.

When you upload the customized audio files required by your contact center and before you can place your 8x8 Contact
Center in production, you must go toHome > Audio Files to replace the 8x8 Contact Center placeholder audio files
with your own production-quality audio files. Any time you upload an audio file to 8x8 Configuration Manager, you must
verify that the embedded audio player can play the file. Playing an uploaded audio file verifies that 8x8 Contact Center
has finished deploying the uploaded file to your contact center tenant. Audio filesmust be deployed before they can be
referenced in an IVR script. You must verify the deployment of an uploaded audio file before referencing the file in an
IVR1 script.

For details on IVR scripts, refer toCreate a Phone IVR Script.

1Interactive Voice Response is a technology that automates interactions with phone callers.
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Create agent whisper for phone queues

8x8 Contact Center agents can now hear an audio message (whisper) about the context of the call they have dialed or
received via a queue. Agent whisper is an audio file that can be uploaded and assigned in the 8x8 Configuration
Manager by the tenant administrator to an inbound or outbound queue to inform the agent, upon connection, about the
connected call. Let’s say John serves support calls as well as sales calls. Upon receiving calls, the system plays a brief
message stating if it is a sales or a support call. Agent whisper can be implemented for both inbound and outbound calls
such as campaign calls.

Features
n Assign to both inbound and outbound queues.

n Alert agents when a call is being connected.

n Notify the agent on the call, and not the customer.

n Play an uninterrupted prompt for the agents. The whisper can be talked over by both parties.

n Agent whisper is not suppressed when the agent or customer talks.

n Agent whisper can be set up for all queued calls. It is not available for numbers dialed by the agent, direct agent
calls (DAA/DAR), or agent-to-agent calls.

Known limitations
n In Auto Answer mode and in the process of validating a Persistent connection, at the verymoment a call is offered,

an agent will only hear the bleep and not the whisper for this interaction.

n In Persistent Connection Mode alone, if the call terminates before the whisper has finished playing, the agent will
still hear the remainder of the whisper. In On Demand Connection Mode the above scenario does not apply.

n Supervisors hear the full whisper when they join an active call to monitor an agent and customer.

n With inbound and outbound calls, the whisper is played to the agent upon connection, however, when working in
the previewmode, the whisper is played to the agent just before the call is connected.

Version 9.14 106

Create agent whisper for phone queues



Set up Agent whisper
Agent whisper provides a useful prompt to the agent. For example, in Auto Answer mode, agents typically do not have
time between calls. The whisper helps them identify the context of the incoming call even before the customer
information pops for preview, thus allowing them to prepare for the call. Agent whisper messages can be heard on both
inbound and outbound calls.

To set up Agent whisper, you must upload the Agent whisper file first and then assign the file to a queue:
Step 1: Upload Agent whisper files

Adminsmust add an audio file to a global folder underHome > Audio Files > User - Agent whisper. Any audio
files added to that folder can be selected at queue level. Any file added to the standard User folder, is not part of the
drop-down for Agent whisper in Queue settings.

To upload a new audio file for Agent whisper:

1. Log in to the 8x8 Configuration Manager.

2. OpenHome > Audio Files > User - Agent whisper.

3. With User - Agent whisper highlighted, click to add + Audio Files.

4. In theAdd window, clickChoose Files.

5. Find and add a file to upload. There is no limitation for the size of the Agent whisper file, however we recommend
you to keep the message short. The file format must be .wav or .au.

6. Enter aName andDescription for the file.

7. Click to Save your changes. The new file is saved under the User - Agent whisper folder. You can click to play

the audio file.

Step 2: Assign the Agent whisper file to a queue

After uploading an audio file for Agent Whisper, you must assign the audio file to a phone queue.

To assign the Agent whisper file to a queue:

1. Log in to the 8x8 Configuration Manager.

2. Go toQueues/Skills.

3. Open an outbound or inbound phone queue.

4. Under Properties, select an audio from theAgent whisper audio drop-down. By default there is no audio file
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selected. You can click to play the audio.

5. Click to Save your changes.

Delete Agent whisper audio files

To delete an Agent whisper audio file:

1. Log in to the 8x8 Configuration Manager.

2. Go toHome > Audio Files > User- Agent whisper.

3. Open an audio file and clickEdit.

4. ClickDelete.

Note:A warning alerts you if a file is still associated with a queue. Remove the Agent whisper
audio file first before you can delete it from the tenant.

Replace Agent whisper audio files for a queue
If you have uploaded other Agent whisper audio files, you can simply change the audio file for the queue:

1. Log in to the 8x8 Configuration Manager.

2. Go toQueues/ Skills.

3. Open an outbound or inbound phone queue.

4. Go to Properties > Agent whisper audio and select another audio file from the drop-down.
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5. ClickSave.

Remove Agent whisper audio files from a queue

To remove an Agent whisper file from a queue:

1. Log in to the 8x8 Configuration Manager.

2. Go toQueues/ Skills.

3. Open an outbound or inbound phone queue.

4. Go to Properties > Agent whisper audio and select None from the drop-down.

5. ClickSave.
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Define business hours and schedules

8x8 Contact Center administrators can define schedules for their contact center staff by going to the 8x8 Configuration
Manager Schedules tab. Define business hours, holidays, and special events that are followed by your company's
departments. For example, if your sales and support teams have different hours of operation, use the Schedules tab to
create separate schedules for each team.

Limitations
n The Date Picker in the Special Events and Holidays calendar allows you to select a date up to three years ahead of

the current year. To select a date beyond three years, enter it manually on the date field.

n Scheduling a campaign with an Intra Day Schedule with multiple recurring events follows the first Open schedule
only and stops for the rest of the events for the day. If you configure a campaign to follow a schedule as shown in
the example below, the campaign executes for the first open schedule from 7 AM to 12 PM, and ceases for the rest
of the day. You then need to manually run the campaign for the rest of the day.
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Add a new schedule
The Intra Day Scheduling feature provides you the flexibility to create multiple schedules within a day, and introduce
multiple breaks without having to create nested schedules. You can select multiple call treatment choices to specify the
desired call treatment in the IVR tree.

Creating a tenant schedule with the enhanced Intra Day Scheduler is simple and easy. The process involves:

1. Gathering your contact center business hours and breaks

2. Gathering your Special Events and Holidays schedule

3. Defining a weekly schedule calendar

4. Defining Special Events and Holidays calendars

5. Configuring call routing and call treatment choices

To better understand the process, let us create a sample schedule for our fictitious contact center; AcmeJets. The
Sales team at AcmeJets observes the following schedule:

n Monday to Friday: 7 AM to 6 PM

n Monday to Friday: Lunch break 12 PM to 1 PM

n Saturday: 8 AM to 4 PM

n Sunday: Always Closed

Create Weekly Schedule

To create a weekly schedule:

1. From the Configuration Menu, openHome.

2. Go to the Schedules tab.

3. Click to add a new schedule, or to edit theDefault Schedule.

OR
ClickCopy to create a duplicate. You can make changes later.
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TheWeekly Schedule calendar opens. It also allows you to add a Special Events and Holidays calendar.

4. Enter a Schedule Name and select a Time Zone from the list.
The following table summarizes options underHome > Schedules:
Schedules
Tab Option

Description

Schedule
Name

Type a name that describes the part of your organization using a non-default schedule.
You can associate a named schedule with a particular IVR script behavior. For example, if you
plan to use your 8x8 Contact Center to manage both sales and support interactions, and those
two teams have different hours of operations, you can create two schedules for Sales and
Support.

Weekly
Schedule
(Monday-
Sunday,
from-to)

For each day of the week, select a time that operation begins and ends, and a call treatment
choice as defined in the script. A call treatment choice refers to a choice within a schedule which
allows a time-based selection of treatment choices when interactions enter a tenant. The call
treatment choices for a schedule include:

n Open: Call treatment typically used when the business is open.

n Choice 1 to Choice 6: Six alternate options that define more refined choices other than
Open or Closed for the day.

n Closed for the day: Call treatment when the business is closed for the entire day.
When you design a Voice Channel's IVR script or an Email Channel's Email script, you can
associate one or more schedules with the customer-facing behavior of the Channel.
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Schedules
Tab Option

Description

Add Day Click Add Day to create exceptions to the days and times specified in the Monday-Sunday, from-
to area.
Exceptions enable you to specify alternative automated processing of phone and email
interactions. More specifically, use schedule exceptions to modify the open and closed hours
specified in the From and To areas. For example, for holidays or other periods when the
schedules default hours of operation do not apply.

Special
Events and
Holidays

Click Add Day to create a new exception:

n Enter the date of schedule exception.

n From the drop-down menu, select:

o Open to specify that the exception uses the contact center's open hours to process
phone and email interactions.

o Closed to specify that the exception uses the contact center's closed hours to process
phone and email interactions.

o A numeric scheduling label from #1 to #6.

n Choose the beginning and end day and times for the exception.

n Click to remove the exception condition from the list of conditions.
If you choose a numeric label, in the IVR or Email script that references the schedule, you can
specify what the script should do during the period when the exception condition is in effect.

5. Under theWeekly Schedule, click each row to edit the call treatment and time.

6. Select business hours for the week. For example:

a. For Monday, enter <7:00 to 12:00> and chooseOpen from the drop-downmenu of call treatment choices.

b. Click to add a new row.

c. Add lunch break hours from 12:00 to 13:00, specify an option from choice 1 through 6, and set up this choice
with desired call treatment in the IVR. You can play a message for callers during the lunch hour: <Welcome
to AcmeJets. We are currently closed for lunch between 12 pm and 1 pm. Please leave a message with your
name and account number and we will get back to you as soon as possible. Thank you for your patience.>
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The following IVR image shows an IVR tree with a call treatment choice #1 for the Sales schedule.

d. Click to add another row.

e. Add after lunch hours from 13:00 to 18:00.

f. Repeat steps a to e to define the daily schedule until Friday.

g. Specify hours for Saturday with no lunch break.

h. For Sunday, a weekly holiday, chooseClosed for the day.

7. Save your settings.

You have now successfully created your weekly schedule. The next step is to define exceptions to your weekly schedule
in the Holidays and Special Events calendar on the right-hand panel of the Schedules tab. A holiday indicates the
business closure, while a special event observes a schedule different from the regular weekly schedule.
Create Holidays and Exceptions

To create holidays and exceptions:

1. In the Holidays and Special Events calendar on the right-hand panel of the Schedules tab, select the desired date
and specify the exception.

n For holidays, select the date and create an event with exit point CLOSED from 0:00 to 24:00.

Version 9.14 114

Define business hours and schedules



n For an exception to the schedule, specify the desired time intervals and the appropriate call treatment
choices.

2. Save your settings.
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Understand tenant dial plans

An 8x8 Contact Center dial plan specifies how to interpret phone number sequences dialed by an agent using the phone
tab, click-to-dial (or through API), and how to convert them into an ITU-T E.164 normalized outbound dial string. Dial
plans can be used to include country codes and area codes, support extension-based dialing, correct the numbers from
an external entity, and more.

Dial plans take numbers dialed by users, or numbers originating from other 8x8 Contact Center components such as:
IVR callback, web callback, click-to-dial, workplace phone, etc., and apply editing rules to yield one of the following:

n A valid global public phone number (known as E.164)

n A valid PBX number

n A call disallowed message number

n A warning tone generating number

Dial plans change the interpretation of dialed digits within a tenant to correspond to familiar national, local, or private
phone switch dialing conventions. A dial plan establishes the expected number and pattern of digits for an outbound
phone call, and validates the agent-dialed sequence. It consists of a collection of calling number patterns and treatment
pairs. When a user dials a series of digits, each calling number pattern in the dial plan is tested as a possible match. If
the agent-dialed sequence matches a pattern, corresponding treatment applies. The treated sequence is then
transmitted to initiate a call or rejected as invalid.

For example, the dialing sequences to reach the Crystal Jade Restaurant in Shanghai, China from home phones in the
United States, United Kingdom, Nigeria, and Beijing use different leading digits:

n NewYork City, USA dials 011862163858752→ North American Dial Plan = +862163858752

n London, England dials 008621 6385 8752→ UK National Dial Plan = +862163858752

Understand tenant dial plans
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n Abuja, Nigeria dials 009862163858752→ Nigerian National Dial Plan = +862163858752

n Beijing, China dials 02163858752→ Peoples Republic National Dial Plan = +862163858752

In each case, a different national dial plan is used to remove the local prefix digits and restore the country code when
necessary to yield an unambiguous international number.

Previous releases
8.4 Release

The following features and capabilities are added in this release:

n Ability to use private PBX numbers

n Ability to change the order of the custom rules

n Ability to use system variables and user-defined variables

n Dial plan editing results are no longer automatically prefixed with a plus (+) sign. All prior dial plans are
automatically adjusted to compensate for the plus (+) sign change.

Backward Compatibility:
-All prior dial plans are automatically adjusted to compensate for the plus (+) sign change.
-The original International Numbering Plan (ITU-T E.164) allowed any digit sequence starting with a
plus (+) sign to pass through without any digit modifications. The updated equivalent dial plan now
includes E.164 number validity checks along with some special and premium number blocking. In
some cases, users of this planmay experience a change of behavior if their customary dialing
included non-E.164 number patterns.

8.1 Release

The following features and capabilities are added in this release:

n Ability to create and apply multiple dial plans within the same tenant:
You can apply dial plans for each agent based on their location. If your contact center employs agents in different
countries, you can create custom dial plans suitable for each country and apply the appropriate plan to agents.
Each agent can dial from their familiar national dialing plan. Until now, you were limited to applying a single tenant-
based dial plan to all agents based in different countries forcing them to manually dial out.
Similarly agents in different domestic officesmay have different dialing privileges or different in-house PBX, or in-
state local dialing preferences which can be addressed using per agent dial plans.

n Ability to apply dial plans to an agent’s dial out, verification call, forward to external call, and more:
Tenant Dial Plans apply to the Make Verification call, web callback, or IVR forwarding a call to external number
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scenarios. In these scenarios, the outbound calls must be dialed as defined in the ITU-T E.164 specification. For
example, in the United States, the number +1 (650) 292-8618 can be dialed as 6502928618, and in the United
Kingdom, the number +44 (0) 2088524140, can be dialed as 2088524140.

n Ability to apply dial plan editing to calls beginning with +:
Dialing inputs regardless of the originating calling method (agent, agent profile, click-to-dial, campaigns, and web
callback) are subject to dial plan editing including those beginning with "+".

n Ability to select a desired dial plan during click-to-dial or web callback:
The click-to-dial and web callback APIs accept a new optional parameter to select a particular dial plan or if omitted
applies the tenant default dial plan. These APIs cannot dial numbers without, at a minimum, filtering the number
through the tenant default dial plan or a specific dial plan. No more API exposure to allow any number to be dialed
without restrictions.

n The dial plan now applies to all outbound calls:

Call Type Default Dial Plan Overriding Dial Plan

Agent dial Tenant dial plan Agent dial plan

Click-to-dial Tenant dial plan Dial Plan specified as API parameter

Web callback Tenant dial plan Dial Plan specified as API parameter

Verification call Tenant dial plan Agent dial plan

Forward to external Tenant dial plan N/A

Campaign call Tenant dial plan Dial Plan specified in properties

n Ability to associate agents with a custom dial plan based on their location
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Types of dial plans

8x8 Contact Center offers two types of dial plans accessible via 8x8 Configuration Manager:

n System Pre-Configured Dial Plans: Predefined national and international dial plans available to all tenants.
They allow PBX dialing and local, long distance, and international calls. You cannot make any changes to these
plans except for opting a default plan. You can select a national plan that best suits your needs or use the standard
international plan. The System Pre-Configured dial plans are predefined and do not allow changes. Every tenant is
required to select one and only one dial plan to suit their location. By default, your contact center may come with
some system pre-configured dial plans, such as:

o International Numbering Plan (ITU-T E.164): Allows tenants across the globe to place domestic and
international calls. The International Numbering Plan does not allow unfiltered pass-through dialing.

o US North American Numbering Plan (US NANP): Allows tenants across North America to place
domestic and international calls. NANP identifies various calling number patterns and applies corresponding
treatment to user-dialed numbers.

n Custom Dial Plans: In addition to system pre-configured dial plans, you can create your own custom dial plan if
you have subscribed to this feature. Custom dial plans, in many situations, can mimic the abbreviated dialing
conventions of a private office phone system or internal corporate dialing plan. You can configure multiple custom
dial plans.

Notes:
-You can activate only one dial plan per tenant at a time.
-8x8 Contact Center reports present dialed numbers in the standard international format.

About the North American Numbering Plan (USNANP)
The North American Numbering Plan identifies various calling number patterns and applies the following treatment to
user-dialed numbers:
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n Filters international calls with country codes incorrectly entered starting from "0".

Note:Country codes do not begin with 0.

n Removes the North American access code 011 if added to a North American phone number. For example, the
number 01116505551212 is dialed out as 16505551212, removing 011.

n Filters local and long-distance calls with incorrect area codes starting from "0".

Note:North American area codes do not begin with 0.

n Filters calls to emergency and special services, such as 911 in the US and 112 in the UK.

n Prefixes the country code "1" to all local and long-distance calls within North America.

n Requires country codes and area codes for international calls.

n Allows input of spelled-out numbers, and converts alphabetic characters to the telephone keypad equivalent digits
according to North American Telephone standards.
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Access a system dial plan

System Pre-Configured dial plans are provided to 8x8 Contact Center administrators via 8x8 Configuration Manager.
You can use the view option to change a default plan on your tenant.

To view or edit a system dial plan:

1. Log in to 8x8 Configuration Manager.

2. From the Configuration Menu, openHome.

3. Go to theDial Plans tab.

4. Select a dial plan and double-click to view the details.

5. In the details view, you can see the following information:

Dial Plans Description

Dial Plan
Name

Enter a name for the new dial plan.

Test
Number

Enter a telephone number to test your plan. A indicates which rule is being applied.

Default
Plan

Check the option to mark this as the default dial plan.

Order Indicates the order of the rules applied to each number. You can change the order of the rules in
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Dial Plans Description

custom plans by dragging and dropping them in the desired location.

Dialed
String
Match
Pattern 

Define a calling number pattern to apply the dial plan using regular expressions. A regular
expression provides a concise and flexible means for matching strings of text, or patterns of
characters. Most commonly used regular expressions are:
^ - Matches the starting position of the string.
. - Matches any single character.
* - Matches the preceding element 0 or more times.
$ - Matches the ending position of the string.
[ ] - Matches a single character contained within the brackets. For example, [2-9] specifies any
digit from 2 through 9.
( ) - A marked sub-expression within which you define a string to match.
For example, the pattern ^([2-9][0-9][0-9][0-9][0-9][0-9][0-9])$ defines a 7-digit sequence where the
first digit is not 0 or 1.

Note:Defining a dial plan requires sound knowledge of regular expressions.

Rewrite
Translation 

Define the treatment for the number that matches the specified calling number pattern. For
example, the pattern ^([2-9][0-9][0-9][0-9][0-9][0-9][0-9])$ and treatment 1650$1 prepends a 7-digit
input with "1650". $1 represents pattern within the (). If you input 5551212, the treatment converts
the number to 16505551212.

Rule
Comment

Gives a brief description of the treatment received by the rule.

Delete
Rule

Allows you to delete the rule. This applies to user-defined rules only.

Test
Match

Indicates if the rule applies to the test number.

How do I copy a system pre-configured rule?

1. From the Configuration Menu, openHome.

2. Go to theDial Plans tab.

3. Click next to a default system rule that you wish to modify.

A message appears asking you to clickSave to keep a copy.
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4. ClickOK.
The dial plan creates a copy of the default plan.

5. Enter a new name for theDial Plan.

6. ClickSave.
A copy of the default dial plan is created and added to the list of available dial plans. You can modify the new
dial plan according to your tenant needs.

How do I test a dial plan?

You can test a dial plan to check how the plan treats user-dialed sequences, and to learn the sequences identified
by the dial plan.

To test a dial plan:

1. From the Configuration Menu, openHome.

2. Go to theDial Plans tab.

3. Select a dial plan and click to edit.

4. In the edit screen, enter a phone number sequence in the Test Number text box and click Test to validate.

A indicates what dial plan is being used. If the dialed phone number matches a calling number pattern,

the corresponding treatment is applied.
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Create custom dial plans

Creating a custom dial plan in 8x8 Contact Center requires a good understanding of regular expressions. This section
gives a brief overview of creating a custom plan. You may seek guidance from professional services for creating a
custom plan from scratch.

To create a custom dial plan via 8x8 Configuration Manager:

1. Log in to 8x8 Configuration Manager.

2. From the Configuration Menu, openHome.

3. Go to theDial Plans tab.

4. Click to add a new dial plan.

5. In theAdd New Dial Plan window, enter the following information:

Dial Plans Description

Dial Plan
Name

Enter a name for the new dial plan.
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Dial Plans Description

Test
Number

Enter a telephone number to test your plan. A indicates which rule is being applied.

Default
Plan

Check the option to mark this as the default dial plan.

Order Indicates the order of the rules applied to each number. You can change the order of the rules in
custom plans by dragging and dropping them in the desired location.

Dialed
String
Match
Pattern 

Define a calling number pattern to apply the dial plan using regular expressions. A regular
expression provides a concise and flexible means for matching strings of text, or patterns of
characters. Most commonly used regular expressions are:
^ - Matches the starting position of the string.
. - Matches any single character.
* - Matches the preceding element 0 or more times.
$ - Matches the ending position of the string.
[ ] - Matches a single character contained within the brackets. For example, [2-9] specifies any
digit from 2 through 9.
( ) - A marked sub-expression within which you define a string to match.
For example, the pattern ^([2-9][0-9][0-9][0-9][0-9][0-9][0-9])$ defines a 7-digit sequence where the
first digit is not 0 or 1.

Note:Defining a dial plan requires sound knowledge of regular expressions.

Rewrite
Translation 

Define the treatment for the number that matches the specified calling number pattern. For
example, the pattern ^([2-9][0-9][0-9][0-9][0-9][0-9][0-9])$ and treatment 1650$1 prepends a 7-digit
input with "1650". $1 represents pattern within the (). If you input 5551212, the treatment converts
the number to 16505551212.

Rule
Comment

Gives a brief description of the treatment received by the rule.

Delete
Rule

Allows you to delete the rule. This applies to user-defined rules only.

Test
Match

Indicates if the rule applies to the test number.
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6. Click to add a new rule. Click to delete a rule.

Examples of dial plan rules shown above can be interpreted as follows:

a. The pattern ^([2-9][0-9][0-9][0-9][0-9][0-9][0-9])$ and treatment 1650$1 converts a 7 digit input to 10 digits.
For example, if you input 5551212, the number gets prefixed with the area code and converts to
16505551212.

b. The pattern ^(55[0-9][0-9])$ and treatment 1650292$1 converts all 4 digit extension number starting with 55
to 165029255XX, where X is a mandatory single digit.

7. Enter a sequence of digits and click Test to validate the calling number pattern and treatment you defined. The

first matched rule shows to indicate a match.

8. ClickSave.

Variables
We have two types of variables in dial plans:
System variables

The following set of new variables are introduced in dial plan. The system variables cannot be edited. 

System Variable Used for

$TENANT Tenant name

$AGENTLOGIN Agent username, if available for the call

$ORIGNUMBER Original dialed number

Note: The E.164 system dial plan is no longer a pass-through. A new rule is added to validate the dialing
number.

User-Defined variables

Users can create variables based on their specific needs. For example, a user defines the variable
SET MYAREACODE for their area code. When they enter a telephone number, the system dials the area code (1510)
first, and then dials the number.
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Dialed String Match Pattern Rewrite Translation Rule Comment

SET MYAREACODE 1510 my area code

^([1-9][0-9][0-9][0-9][0-9][0-9][0-9])$ $MYAREACODE$1 add area code

Change the order of custom rules

1. From the Configuration Menu, openHome.

2. Go to theDial Plans tab.

3. Click or Edit to open a rule.

4. Click to select the custom rule, and drag it to the desired location.

5. ClickSave.

Note:You cannot edit system dial plans.
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Select a default dial plan

One of the pre-configured dial plans in 8x8 Contact Center is selected as default for your contact center tenant. As an
8x8 Contact Center administrator, you cannot edit the default dial plan unless you have created a custom dial plan and
would like to select it as the default instead. To revert to a pre-configured dial plan, select the desired plan in 8x8
Configuration Manager and edit it.

To select a default dial plan in the tenant:

1. From the Configuration Menu, openHome.

2. Go to theDial Plans tab.

3. Choose the dial plan you want to make the default, and double-click to open.

4. Select theDefault Plan check box to mark it as the default.

5. ClickSave.
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Reset idle timer for agents

In 8x8 Contact Center, idle time refers to the length of time agents have been idle, and is measured for each agent by
the agent's idle timer. When multiple agents with the same queue and skill level assignments are idle, the system
routes the call to the agent who has been idle the longest. The agent’s idle timer is reset every time the agent ends post
processing of a system-delivered, queued interaction. Agent-initiated interactions do not reset the idle timer.

To supplement the default behavior, a tenant-wide setting allows resetting the idle timer when agents transition from
one status to another. By default, an agent is considered idle from the time he ends post processing of a system-
delivered, queued interaction and becomes available. However, you can customize the contact center to reset your
agent’s idle timer based on a combination of agent and system-initiated status changes. For example, in addition to the
default reset, you can configure the idle timer in 8x8 Configuration Manager to reset when agents change their status
from On Break to Available.

Assumptions
In 8x8 Contact Center we assume:

n Resetting idle timer does not change the underlying default behavior, it simply adds an overlay and when selected
they additionally update the timer setting when an agent changes status. An example is when the agent returns
from On Break to Available or from Login to On Break each morning.

n Resetting idle timer does not change the interactions that reset in the default behavior, or inbound and outbound
that are system-generated. Calls that are excluded from the reset, such asmanual dials and agent-to-agent calls,
remain excluded.

n Agent skill level is a default behavior. An agent with a higher skill level takes precedence over any lower-skill-level
agent with a more recent status transition that has reset their timer.

Set up idle timer for agents

To set up the supplementary settings for agent idle timer:

1. Log in to 8x8 Configuration Manager, go toHome > Agent’s Idle Timer.

2. Select the transitions for which you want the timer to reset, such as when an agent goesOn Break from Available.
You can also select a combination of agent-generated and system-generated actions. These changes are
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immediate and do not require agents to log out and log back in.

Note: The agent's idle timer is reset at the end of a non-busy Direct Agent Routing (DAR) call. By
default, the agent's status changes to Busy when a call is transferred to the agent unless this
option is disabled by the tenant administrator inside the Phone script IVR.
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3. ClickSave.

4. If you clickReset to Default, it removes all your custom settings and goes back to the default Post Processing.

Use cases
The following use cases provide an insight into the default behavior as well as the new extended capability.

n Use Case 1: Idle timer resets after an interaction ends (Agents with varying skill levels)
The default behavior resets the idle timer after an interaction ends. In the following scenario, Agent John has a
higher skill level than Mary. They both process an inbound call, end the call and make themselves available. Mary
ends the call two minutes before John. Mary is idle for 12 hours and 10 minutes while John is idle for 12 hours and 8
minutes. Even though Mary is idle 2 minutes longer than John, the next inbound call is offered to John since he has
a higher skill level.

n Use Case 2: Reset idle timer after an interaction ends (Agents with identical skill levels)
In this scenario, Fred, Mary, John, and Sarah serving the same queue have identical skill levels. After processing
the inbound calls at varying times, they all log out. Mary and John log in first followed by Fred and Sarah. John
goes on break while the rest of the team get on calls. Sarah ends the call and becomes available. A fewminutes
later, John returns from break. The incoming call is now offered to John, but not Sarah since John has been idle the
longest. The default behavior resets the idle timer after an interaction ends.
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n Use Case 3: Reset idle timer after a status change
In this case, the idle timer resets after an interaction ends and again after an agent logs in.

Sarah and Fred, with the same skill level, process an incoming call and end the call at varying times. The idle timer
resets. Later they log out. Fred logs back in (Idle timer is reset). He goes on break and then changes his status to
available. Later Sarah logs in and changes her status to available. The next incoming interaction is offered to Fred
since he logged in before Sarah and the idle timer is reset at login.

n Use Case 4: Reset idle timer after a status change
The idle timer is reset after an interaction ends by default. Additionally, the idle timer is configured to reset when an
agent logs out from On Break status.
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Mary and Fred process an inbound call. Fred ends the call first (the idle timer is reset) followed byMary. Mary goes
on break and logs out shortly after (the idle timer is reset). Fred follows suit. Later in the day Fred logs back in
followed byMary. The incoming interaction is now offered to Mary, since she logged out before Fred and the idle
timer is reset at logout.

n Use Case 5: Reset idle timer after a status change
The idle timer is reset after an interaction ends by default. Additionally, it resets when agents change their status
from work offline to On Break.

Fred and John, with the same skill level, process an inbound call, end the call. The idle time is reset. They then log
out at the same time. John logs back followed by Fred. Fred is offered an incoming call while John changes his
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status to working offline. Fred ends the call (Idle timer is reset). Shortly after John goesOn Break (idle timer is
reset). The next incoming call is offered to Fred who is idle the longest.

n Use Case 6: Reset idle timer after a status change
The idle timer is reset after an interaction ends by default. Additionally, it resets when agents change their status
from working offline to available.

Mary and John process an inbound call, end the call at varying times. The idle timer is reset for Mary followed by
John. They both log out and log back in. The next incoming call is offered to Mary since she has been idle the
longest. John then goes to work offline, makes himself available (Idle time is reset) shortly after. Mary who is on a
call ends the call, makes herself available. The next incoming call is offered to John who has been available the
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longest.

Work with agent's idle timer
As an 8x8 Contact Center agent, you are ready to process new interactions when you change your status to Available. If
you are assigned to a queue, you are offered the interactions waiting to be served in that queue.

To accept an interaction:

1. Log in to 8x8 Agent Console and change your status toAvailable.

2. When you accept an interaction, your status changes toBusy.

3. Process the interaction and then clickEnd.

4. If required, select the Transaction Code before ending the transaction.

5. ClickEnd Post Processing to make your statusAvailable, or clickWork Offline if you need more time to
complete any post processing tasks.

The system routes the next interaction to the agent who has been idle the longest. By default, agents are
considered idle from the time they end post processing of a system-delivered, queued interaction. Depending on
the back-end configuration, the idle time can also be reset when the agents change their status. For example, in
addition to the default reset, the idle timer can be reset when agents change their status from On Break to
Available.

Note: The agent’s idle timer is reset every time:
- An interaction comes to an agent via a queue
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- An agent ends post processing of a system-delivered, queued interaction (default).
- An agent changes their status (if configured by the tenant administrator).
- An agent transfers an interaction that comes via a queue to another agent, it resets the timer for
Agent A but not for Agent B.
- DAR/DAA interactions reset the idle timer by default, if not disabled by the tenant administrator
inside the Phone script IVR.
See the following table for the complete list of activities that may or may not reset the agent's idle
timer.

An agent's idle
timer is reset by:

An agent's idle timer is not reset by:

Inbound call via
an inbound voice
queue

Accepting Direct-to-Agent (DAR or DAA) calls

Note: The agent's idle timer is reset at the end of a non-busy Direct Agent
Routing (DAR) call. By default, the agent's status changes to Busy when a
call is transferred to the agent unless this option is disabled by the tenant
administrator inside the Phone script IVR.
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An agent's idle
timer is reset by:

An agent's idle timer is not reset by:

Inbound
voicemail call via
an inbound
voicemail queue

Dialing agent-to-agent calls

IVR callback call
via an outbound
queue

Dialing a manual outbound call even if it makes the agent busy using an Outbound Phone
Code (OPC) queue

Web callback call
via an outbound
queue

Making a click-to-dial outbound call

Campaign call via
an outbound
queue

Agent-to-agent chat

Inbound chat via Changing between logged in states such as Available, Working Offline, and On Break (not
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An agent's idle
timer is reset by:

An agent's idle timer is not reset by:

an inbound chat
queue

reset by default unless it is configured by the tenant administrator)

Inbound email via
an inbound email
queue

Log in or log out (not reset by default unless it is configured by the tenant administrator)
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Define password policies

8x8 Contact Center password policies allow the contact center administrator to define rules to enhance tenant security
by encouraging users (administrators, agents, and supervisors) to employ strong passwords and ensure proper usage.
Password policies define a mechanism to secure user accounts.

Note: 8x8 Contact Center administrators cannot create passwords for new users. Account information
such as the system-generated password is automatically communicated with new users via email.
Administrators, however, can help users reset their passwords during lockout by sending a system-
generated email that contains the password reset link.

Features
The following features in password policies of 8x8 Configuration Manager allow users to define passwords and increase
their account security:

n Timed password expiration forcing a periodic password change.

n Password history to remember a specified number of previously used passwords and prevents re-use.

n Minimum password length of 5, 8, or 10 characters.

n Password complexity requirements, such as a mix of alphanumeric characters or a mix of upper and lowercase
alpha with numeric characters.

n Security questions to reset a forgotten password. You can prevent agents from answering the security question
with a password.

Define password policies
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n Password reset for any user at any time. An administrator can initiate the password reset that is automatically
communicated with users via email.

n Account lockout for a specific time or until unlocked by administrator in case of invalid login attempts.

n Lockout alert notification for administrator.

Version 9.14 140

Define password policies



Configure password policies

The Security page in 8x8 Configuration Manager allows you to define password policies. As an 8x8 Contact Center
administrator, you can set rules on password length, formation, password duration, and common password practice for
users to follow while creating their passwords. These rules are enforced on users to protect their accounts from being
hacked.

To configure password policies:

1. From the Configuration Menu, open Security.

2. Go to the Password Policies tab.

3. Configure the desired settings.
The following options are available for password policies:

Password
Policies -
General

Description Policy Options

Password
Expires (In
days) 

Defines how long a password is alive. After the specified duration, the
password expires and needs to be changed.

Note:SelectingNever Expires keeps the password alive as
long as you desire.

n 30 days

n 60 days 

n 90 days

n 180 days

n One Year

n Never
expires

Enforce
Password
History

Defines the number of previous passwords (or no passwords) to be
remembered by the system. It prevents users from using the previous
passwords when creating a new one.

n No
passwords
remember
ed

n 3
passwords
remember
ed
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Password
Policies -
General

Description Policy Options

n 5
passwords
remember
ed

n 10
passwords
remember
ed

Minimum
Password
Length 

Defines a minimum length for a password. Restricts agents from choosing
a password less than the specified length.

n 8
characters

n 10
characters

n 12
characters

Password
Complexity
Requirement 

Defines if a password must be set with a certain complexity. n Must mix
alpha and
numeric

n Must mix
upper and
lower case
alpha and
numeric

n Must
contain 3
out of 4:

o upper
case
alpha

o lower
case

Version 9.14 142

Configure password policies



Password
Policies -
General

Description Policy Options

alpha

o nume
ric

o symb
ols
(*@&
#!?)

Email system
generated
passwords for
new
agents/admins
and reset

Determines if a system-generated password is sent to the agents or
Secondary administrators to reset their passwords. The system default is
No. If you select Yes, the Reset Password button appears under Agents >
General. If you click Reset Password, an email containing a temporary
username and password is sent to the user.

n Yes

n No

Password
Question
Requirement

Defines if the answer to a security question in the agent profile can be the
same as the password or not.

Note:SelectingNone lets an agent answer the security
question same as the password.

n Answer
cannot be
same as
password

n None

4. ClickSave.
For Lockout policy, see Lock and Unlock User Accounts.

Note: Theminimum password length is 8 characters. Existing agents and supervisor accounts
with passwords shorter than 8 characters are not impacted until the next password change.
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Lock and unlock user accounts

The Security page in 8x8 Configuration Manager allows you to define lockout policy. As an 8x8 Contact Center
administrator, you can set rules for maximum invalid login attempts before the system locks you out. These rules are
enforced on users to protect their accounts from being hacked. An administrator can also unlock a user account to give
immediate access to the locked-out user. This prevents the user from being idle during an accidental lockout.
Lock a User Account
Locking out a user account is a mechanism to ensure account security. When you set password lockout policies, you can
specify:

n the number of invalid login attempts that locks out an account.

n the duration of the lockout.

n an email lockout alert to the administrator.

Specifying the number of invalid logins and lockout duration locks an account for the specified duration when the
number of invalid login attempts is reached. For example, you can set lockout policy to lock an account with three
invalid login attempts for a period of 30 minutes.

To define agent Lockout settings:

1. From the Configuration Menu, open Security.

2. Go to the Password Policies tab.

3. Configure the desired settings under Lockout.

The following options are provided by the password lockout policies:
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Password Policies -
Lockout

Description Policy Options

Maximum Invalid
Login Attempts

Defines the number of invalid login attempts to lockout an
administrator/agent/supervisor account.

n 3 attempts

n 5 attempts

n 10 attempts
(default)

Lockout interval after
max invalid login
attempts

Specifies the duration for which an account is locked out after
invalid login attempts. After the specified time, the agent is
allowed to login.

Note:Selecting Forever (must be reset by admin)
requires the administrator to unlock an account
and/or reset the password.

n 2.5 minutes

n 5 minutes

n 10 minutes

n 15 minutes

n 30 Minutes

n 60 Minutes

n Forever (must
be reset by
admin)
(default)

Send Lockout alert to
administrator 

Enables sending an email alert of an account lockout to the
administrator.

n Yes

n No (default)

Lockout behavior disables the login and password fields and prevents user's further attempts to log in. After the lockout
duration, the login screen allows the user to log in again with the right credentials, or to reset the password. The reset
password is communicated to the email address specified in the account.
Unlock a User Account

During a lockout, a user is prevented from logging in to the account for a specified period of time. An administrator can
unlock a user account to give immediate access to the locked-out user. This prevents the user from being idle during an
accidental lockout.

n Any administrator in the Super User role or a role with full privileges to Agents object is capable of unlocking an
agent/supervisor account.

n Any administrator in the Super User role or a role with full privileges to the Security tab is capable of unlocking an
administrator role.

Note: To unlock the Primary administrator role, youmust contact 8x8 Contact Center support staff.
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To unlock a user account:

1. From the Configuration Menu, openAgents.

2. Locate the user account with that requires unlocking.

3. Click to open user details.

4. Open theGeneral tab. Depending on whether you have enabled Email system generated passwords for new
agents/admins and reset under Security > Password Policies, you must do the following:

n If enabled: ClickReset Password. An automatic email is generated and sent to the user's email address on
file. The user then has to click the link in the email to reset the password.

n If disabled: Enter a new password for the user, and save. From the list of users, click next to the user to

unlock them. Notify the user of their new password so that they can log back in.
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Roles and administrators

8x8 Contact Center role-based management allows a tenant to distribute the configuration management functionality
among multiple roles. Role-based management allows you to create roles, define privileges or permissions to manage
varying scope of tenant configuration, and add and assign administrators to the roles. For example, you can define a
campaign manager role with exclusive permissions to create, edit, delete, and control campaigns, and restrict access to
any other functionality in 8x8 Configuration Manager. To create a campaign role, you must grant permissions to
Campaigns only.

Features
Role-based management offers the following features in 8x8 Configuration Manager:

n Ability to distribute tenant configuration among multiple roles and administrators.

n Ability to create and manage multiple administrator roles.

n Availability of predefined Super User role with unrestricted access to the tenant configuration. The tenant's Primary
administrator inherits the Super User role.

n Ability to assign multiple administrators to the Super User role.

n Ability to assign administrative privileges to selective groups, or queues, or channels.

n Each administrator can assume a single role at a given time.

n Each role can have multiple administrators assigned to it.

n Password security policies common to agents and administrators.

n Ability to filter and sort roles list by different fields facilitating quick access to data.

n Ability to filter and sort administrators list by different fields.

Roles and administrators
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Type of roles
The following administrator roles exist in 8x8 Contact Center. The roles are accessed and configured via 8x8
Configuration Manager:

n Super User: Every 8x8 Contact Center tenant has a predefined Super User role that has unrestricted
administrative rights to configure and manage all objects in 8x8 Configuration Manager. The Primary administrator
assumes the Super User role. You cannot edit or revoke permissions of the Super User role, but you can assign
multiple administrators to the role. Any administrator in the Super User role inherits configuration rights to all
administrative areas. When they log in to 8x8 Configuration Manager, they have access to all the functionality
available to the tenant.

n Custom Role: Any administrator with permissions to the Security tab is capable of creating roles and
administrators. You can create a custom role with custom privileges and assign administrators to that role. A
custom role is any role defined by an administrator, while the Super User role is system-defined. An administrator
assigned to a custom role may be referred to as the Secondary administrator. Based on the permissions, a
Secondary administrator may have full or partial configuration rights. When this administrator logs in to 8x8
Configuration Manager, they have access to areas granted for the role only. For example, a campaign manager
who is granted privileges to create campaigns only sees Campaigns in the Configuration Menu.
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Create roles and assign administrators

To take advantage of role-based management in 8x8 Configuration Manager, the 8x8 Contact Center Primary
administrator must create a role, define permissions, add administrators, and assign one or more administrators to the
role.
The process involves the following steps:
Step 1: Create a role and define permissions

A role allows administrative privileges or permissions in 8x8 Configuration Manager. Creating a role requires definition
of permissions to list, view, create, edit, delete, and/or control a specified configuration object. For example, you can
define a Campaign Manager role with permissions to create, manage, and supervise wallboards or campaign
functionality. Go to Security > Roles to add or edit roles.

By default, every tenant is bundled with a Super User role assigned to the tenant's Primary administrator. A Super User
role provides all permissions to configure tenant functionality. You can assign any number of administrators to the
Super User role.

To add a custom role:

1. From the Configuration Menu, open Security.

2. Go to theRoles tab.

Note:You can assign the role of an administrator when creating a new user. As soon as you
choose a user to be an administrator, the option to select a specific role appears. You can continue
to define the Roles and Administrators in Security tab.

3. Click Add Role.
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Note:By default, every tenant is bundled with aSuper User role. A Super User has all
permissions to configure tenant functionality. You can assign any number of administrators to the
Super User role.

4. Enter aRole Name.

5. Determine the permissions to be given to the role.

6. Select functionality objects such asWallboards and check the appropriate permissions.
The available permissions are: list, details, create, edit, delete, and control a functionality. The following table
summarizes the role permissions:

Role
Permission

Description

List Lists all the entities pertaining to an object. For example, List permission in the Agents tab allows
an administrator to list all existing agents in the tenant.

Details Allows to view details of each entity. For example, with the permission to view details, you can
view agent account details.

Create Allows you to create a specific subset of a Menu Object functionality or an entire Menu Object. For
example, you may create a role with permissions to create Inbound and Outbound queues, but not
Email and Chat queues within the Queues Menu Object.
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Role
Permission

Description

Edit Allows you to edit a specific subset of a Menu Object functionality or an entire Menu Object.

Delete Allows you to delete a specific subset of a Menu Object functionality or an entire Menu Object.

Control Allows you to control a Menu Object based on its functionality. Control permissions are available
to:

n Start, schedule, stop, pause, purge, and resume campaigns

n Import CRM data

n Broadcast messages to agents and Supervisors

7. ClickSave to add the new role.
The next step is to assign an administrator.

Step 2: Add administrators

An administrator inherits permissions assigned to a role and can assume a single role at a time. You cannot assign
multiple roles to an administrator, but multiple administrators may function in a single role.

To add an administrator:

1. From the Configuration Menu, open Security.

2. Go to theAdministrators tab.

3. Click Add Administrator.
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4. Fill in the following mandatory fields:

Field Name Description

First Name Enter the first name of the Administrator.

Last Name Enter the last name of the Administrator.

Email Address Enter an Email ID to communicate with the Administrator.

Role Select a role from the list of defined roles.

User Name Enter a username used to log in to the administrator role.

Password Enter a password.

Note:Password shouldmatch the password policy
requirements.

Retype Password Confirm the password.

Language Enter a language of choice for the Administrator user interface.

Enabled Select the check box to activate the Administrator.

Comment Enter any comments.

5. ClickSave to create an administrator.

Step 3: Assign administrators to the role

After creating a role, you can assign an administrator to the role. The administrator inherits all permissions assigned to
the role. By logging in to 8x8 Configuration Manager, the Secondary administrator gets access to the functionality
permitted for the role. You can also reassign an administrator to a new role.

To assign an administrator to a role:

1. From the Configuration Menu, open Security.

2. Go to theRoles tab.

3. From the Roles List, select a role to assign an administrator to.

4. Click or Edit.

5. Click theAssignment tab.
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6. From the list of administrators, select and assign an administrator to the role. Click here to learn how to create
administrators.

Note:You can assignmultiple administrators to a role, but assign only one role per administrator.
Assigning a new role to an administrator removes him from the previous role.

7. Save your changes.

Step 4: Log in and validate role permissions (optional)

After assigning an administrator to a role, you can log in and validate that the Secondary administrator account has the
intended permissions. For details, refer to Log In.

Change the administrator password
A Secondary administrator can change password and set up a security question by clicking Profile on the top bar of the
8x8 Contact Center application.
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1. Log in to 8x8 Configuration Manager.

2. ClickMy Profile at the top of the screen.

3. Enter a new password or security question.

4. ClickSave.
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Define a role with granular control

Managing a large number of agents and queues in a contact center can be challenging. 8x8 Contact Center admins can
define administrator roles with granular control to administer and manage an individual agents group, a queue, or a
channel. For example, if the contact center experience large inbound call volume to the support queue, admins can
create an administrator role to configure and manage the support queue exclusively.

The following objects in 8x8 Configuration Manager offer individual settings for role permissions:

n Agents: allows you to control agents belonging to individual or selective groups

n Queues: allows you to control an individual queue or selective queues

n Scripts: allows you to control an individual script or selective scripts

n Channels: allows you to control an individual channel or selective channels

To define a role with granular control:

1. From the Configuration Menu, open Security.

2. Go to theRoles tab.

3. Create a new role, or edit an existing role.
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4. In the Permissions tab of the role settings, select the Edit Individual Settings check box for Agents, Queues,
Scripts, or Channels.

5. From the list of available items, assign individual permissions such as details, edit, or delete.
The Individual Permissions Assignmentwindow opens.

6. ClickOK. The definition of individual settings is complete for the role.

7. ClickSave to save the role and assign an administrator.

Version 9.14 156

Define a role with granular control



Change roles for an administrator

An 8x8 Contact Center Secondary administrator can assume a single role at a given time. However, that role can be
changed by the Primary administrator in the 8x8 Configuration Manager at any time. Assigning a new role to an
administrator removes them from the previous role.

To change roles for an administrator:

1. From the Configuration Menu, open Security.

2. Go to theRoles tab.

3. From the roles list, select a role.

4. ClickEdit, or double-click to open the role details.

5. Go to theAssignment tab.

6. From the administrators list, find an administrator and assign to the role.

Note:You can assignmultiple administrators to a role, but assign only one role per administrator.
Assigning a new role to an administrator removes them from the previous role.
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Filter and sort roles

If your 8x8 Contact Center defines numerous roles and administrators, you may find it hard to track them in a scrollable
list. Role-based management allows you to search and filter roles and administrators lists in 8x8 Configuration Manager
by specific criteria, such as Role ID, Role Name, and administrators.

To filter roles:

1. From the Configuration Menu, open Security.

2. Go to theRoles tab.

3. Click Filter Roles List.

4. Specify the criteria to filter the roles from the drop-downmenu.

5. Add the desired filtering criteria and select an appropriate parameter.

6. Click Filter.
The search result shows.

Sorting roles list
You can sort the Roles list in the desired order by applying sort parameters. You can sort by Role Name, Role ID, and
the number of administrators assigned to a role by applying suitable parameters. You can sort the list in ascending or
descending order with just a single click on the header bar. You have the option to sort bymultiple fields by clicking
Configure Sort.

n To sort by a single field:
Click the header bar for the desired field to sort in the ascending or descending order automatically.

n To sort by multiple fields:

a. Click theConfigure Sort link.
The Sort dialog box appears.

b. ClickAdd Level to specify a field name and the order to sort by.
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c. ClickDelete Level to eliminate the desired sorting criteria.

d. ClickApply.
The sorted list appears.
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Filter and sort administrators

If your 8x8 Contact Center defines numerous roles and administrators, you may find it hard to track them in a scrollable
list. Role-based management allows you to search and filter the list of Secondary administrators by specific fields, such
as Name, Username, Role, Email, Language, and locked or enabled administrators inside 8x8 Configuration Manager.

To filter the list of administrators:

1. From the Configuration Menu, open Security.

2. Go to theAdministrators tab.

3. Click Filter Administrators List.

4. Specify the criteria to filter the administrators from the drop-downmenu.

5. Add the desired filtering criteria and select an appropriate parameter, such as the combination <Role, Equals,
Super User>.

6. Click Filter.
The search result appears.

Sorting roles list
You can sort the administrators list in the desired order by applying sort parameters. You can sort by name, username,
role, email, language, and enabled or locked administrators. You can sort the list in the ascending or descending order
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with just a single click on the header bar. You have the option to sort bymultiple fields using the Configure Sort option.

To sort by a single field, click once on the header bar above that field to sort in the ascending or descending order
automatically.

To sort by multiple fields:

1. ClickConfigure Sort. The Sorting dialog box appears.

2. ClickAdd Level to specify a field name and the order to sort by.

3. Add or delete levels to sort as you desire.

4. ClickApply.
The sorted list shows.
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Enhance system access authentication

8x8 Contact Center allows users to connect to the tenant from anywhere in the world. We offer the ability to limit the
access to a white list of IP addresses. A white list identifies secure IP addresses from which agents, supervisors, and
administrators can connect to the 8x8 Contact Center network. Any login attempt outside of the white list is denied
access and triggers a notification to the administrator about the unauthorized access attempt.

Features
n Ability to authorize specific IP addresses.

n Ability to list, add, edit, and delete allowed IP ranges.

n Ability to validate IP ranges (non-duplicate, valid start and end IP addresses, and non-negative range).

n Ability to enable/disable an individual IP address or a range of IPs.

n Ability to enforce IP address restriction to access 8x8 Configuration Manager, 8x8 Agent Console, andWallboard.

n Ability to create an admin role and assign the IP address restriction permission to the administrator.

n Ability to notify administrators of an unauthorized access attempt by email. By default, this option is disabled.

n Extended support for Single Sign-On (SSO) in Salesforce, Zendesk, and NetSuite.

Limitations
8x8 supports IP version 4.0 (IPv4).

Create an authorized IP addresses
8x8 Configuration Manager allows administrators to create, edit, and delete white list entries using the Security page.

Enhance system access authentication
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To add a white list entry:

1. From the Configuration Menu, open Security.

2. Go to the IP Address Restriction tab.

3. Click Add Allowed IP Range.

Note: This feature only works with public IP addresses. If no IP address is selected, all IP
addresses are allowed to access the tenant.

4. Enter Start IP and End IP address and type aDescription.

5. Select This IP address is enabled to enable an individual IP address or a range of addresses.
This feature is helpful if you need to grant access to an agent in a remote location or a temporary consultant.

6. ClickSave.
If the agent tries to log in with a different IP address, a message appears showing that access is denied.

7. Click or to edit and delete the IP addresses.

Access 8x8 Contact Center when locked out
Contact the support team at 8x8, Inc. to help you regain access to your 8x8 Contact Center.
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Authorize IP access via email

8x8 Contact Center administrator is able to add or authorize an agent's IP address via email authorization. This feature
enables agents using a new and unidentified IP address to connect to their tenant. The administrator controls the ability
to send or block this email notification via 8x8 Configuration Manager.

Note: The authorization is supported for 8x8 ConfigurationManager, 8x8 Agent Console, andWallboard
access tokens.

Features
n Automatic email: The administrator receives an automatic email when an agent is denied access.

n Quick access: The agent gains access as soon as the administrator clicks a URL in the email.

n Prevent email spam: Only one notification email is sent to the administrator per hour, irrespective of the number
of login attempts.

n Improved security: The authorization URL expires in 24 hours, whether the administrator has authorized the
address or not.

n Description: A description added for the IP address allows the administrator to keep a reminder for future
references.

How the authorization process works
1. The agent tries to access 8x8 Contact Center from an unauthorized IP address, but access is denied.

2. An email notification is sent to the administrator, containing information such as the agent's username, IP
address, and the date of attempted access. The email also contains a URL.
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Note:UnderSecurity > IP Address Restriction, the administrator must enableSend access
control e-mail to receive the email.

3. The administrator clicks the URL link in the email to authorize the IP address.

4. The administrator receives a confirmation that the IP address is authorized successfully.

Note: For security reasons, the URL expires after 24 hours. If the administrator uses the URL the
second time or after the expiry, a message indicates the token has expired.

5. The agent can now log in using the IP address.
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Set up DTMF blacklist

As an 8x8 Contact Center administrator, you can nowmanage your DTMF blacklist by adding, editing, and deleting
phone numbers as well as SIP URIs.. The DTMF blacklist is an existing service to stop recording a call once connected
to a blacklisted destination. It also masks any key presses in the customer experience call flow, so that payment card
data is kept private. Prior to this release, adding an entry to the DTMF blacklist required raising a ticket with 8x8 support
team.

Features
n Puts the customers in charge of their own DTMF blacklist needs.

n Accelerates the process of adding a new entry to the DTMF blacklist.

n Covers various call routing and looping scenarios to make sure that all recordings stop, and the key presses are
masked when connected to the blacklisted number.

n Improves the speed of blacklist entry identification bymaking the detection within the call routing process.

Add phone numbers to the blacklist
8x8 Contact Center administrators can now add numbers to the DTMF blacklist via 8x8 Configuration Manager and the
new tab on the Security page.

To add a phone number to the blacklist

1. Log in to 8x8 Configuration Manager.

2. Go to Security > DTMF Blacklist tab.

3. ClickAdd blacklist entry.

4. Add a Telephone number or a SIP URI. The entries will be added to the blacklist. The telephone number is
validated against E.164 format such as +14151231234 for the US or +442071838750 for the UK. A message
notifies you if the format is wrong before you save.
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Notes:
- There is no validation for SIP URI.
- You cannot update a saved entry. To change an existing entry youmust remove it first then add
the revised entry.

5. Add aComment to describe the entry. It can be up to 256 characters long. You can update the comment later.

6. Save your changes. The entry is added to the blacklist.

7. To edit the comment only, clickEdit next to the entry.

8. To delete the entry, clickDelete next to the entry andConfirm.

Changes in 8x8 Customer Experience Call Flow
With the ability to blacklist DTMF, any key presses captured during the call flow are masked and represented by (?) in
the 8x8 Customer Experience call flow so that the payment card data is kept secure. This is a change of behavior from
our previous release where the numbers were masked by showing (#).
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Create agent functional groups

In 8x8 Contact Center, an agent group is a collection of agents who report to a supervisor. A single group may serve
your entire call center or may be dedicated to one or more products, services, queues, or to a specific communication
channel such as phone, email, or chat. Use groups to organize agents on the basis of function, skill set, or media they
use.

As an 8x8 Contact Center administrator, you can see the groups, number of agents in each group, outbound phone
codes assigned to each group, and if the agent's recording is enabled. Outbound Phone Codes offer a means to set a
specific calling line identifier (caller ID) and to set an optional outbound queue for outbound calls from your tenant.
Outbound Phone Codesmay also be used to track the purpose of an outbound call. For details on the functionality and
configuration of Outbound Phone Codes, refer toOutbound Phone Codes Overview.

Administrators go to the Agent Groups tab in 8x8 Configuration Manager to:

n Add a group and assign it to outbound phone codes

n Edit or delete a group

Note:As amember of an agents group, you can view the status and availability of fellow group
members in the status tab of your 8x8 Agent Console.

Add an agent group and assign to outbound phone codes
To add an agent group you need to complete a two-step process: define group properties, and assign outbound phone
codes.

To add a new agent group:

Create agent functional groups

Version 9.14 169



1. From the Configuration Menu, openAgent Groups. You can mark and select your default agent group. You can
also clone, edit, or delete the agent groups from this page.

2. Click to add anAgent Group.

3. In theGeneral tab enter aGroup Name. Enter the required information and clickSave. The Outbound Phone
Codes tab opens.

The following table summarizes the options found underAgent Groups > General andAgent Groups >
Outbound Phone Codes:

Option Description

General tab

Group Name Indicates the descriptive name for the group such as Sales or Support groups. Members of one
group are not able to view members of any other group.

Comment A description of the group's purpose of specialty.

Default
Agent
Display
Name

Select whether you want to display the word Agent or the agent's first name such as <Robin>.
The agent's display name appears in 8x8 Agent Console. Reset all agents, clears all custom
display names. This group setting can be overwritten at the tenant level.

Allow
Agents to
Change
Display

Allows agents to change their display name in the 8x8 Agent Console's Profile page. Display
Name helps agents save time and effort to introduce themselves to customers every time they
start a new chat. The agent's display name appears in the 8x8 Agent Console's control panel,
Profile page, chat window, and CRM case created after a chat session. It can be modified by the
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Option Description

Name 8x8 Contact Center administrator in the 8x8 Configuration Manager, or if permitted, by the agents
in 8x8 Agent Console. The changes immediately show up in both applications. To prevent agents
from changing their display name at the tenant level, clear the Allow Agents to Change the
Display Name checkbox under Home > Profile.

n To prevent agents from changing their display name at the tenant level, Clear the Allow
Agents to Change the Display Name checkbox under Home > Profile. If disabled, this
option does not appear at the agent groups level.

n To prevent agents from changing their display name at the group level, clear the Allow
Agents to Change the Display Name checkbox from the Agent Group. This option only
appears if it is enabled at the tenant level.

Enable
Agent's My
Recording
Functionality

Indicates if the agent can record the conversation. This option allows agents to record a voice
message for the incoming calls.

Allow
Agents to
Reject
Interactions

This option is enabled by default allowing agents to reject interactions. If disabled, the Reject
button in 8x8 Agent Console is disabled preventing agents from rejecting the interactions they are
offered. The Reject button in 8x8 Agent Console appears when an interaction is offered to the
agent. You can set up this ability for an agent group, or individual agents. If you disable this
option at the tenant level, the checkbox will not show up for agent groups or individual agents.

Phone
Connection
Mode

Default Connection Mode can be On Demand or Persistent:

n On Demand connection mode: On Demand Connection Mode creates a temporary
connection from the agent’s workplace phone to the system. The agents have to manually
accept the call in their soft or hard phone.

n Persistent Connection mode: Persistent Connection Mode creates a constant connection
from the agent’s workplace phone to the system. Once the connection is open, it will stay
active until logged out. Any changes to the setting will remain in effect for the whole
duration of the agent’s persistent connection.

Enable Auto
Answer

If enabled, every phone interaction that is offered to an agent is automatically connected
eliminating the need to accept it manually.

Outbound
Phone
Codes tab
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Option Description

Assign Select a check box to assign an outbound phone code to your tenant. Note that you need to
create an outbound code list before being able to assign it.

Active Displays a read-only indication of the active outbound phone codes.

Outbound
Phone list

Indicates the outbound phone name assigned to that group.

Number of
Agents

Number of agents in that group.

4. ClickSave to successfully create a new agent group.

Clone agent groups

Administrators can copy the group name, default agent display name, recording functionality, ability to reject
interactions, Phone Connection Mode, and Auto Answer settings with a simple click. Cloning agent groups allows 8x8
Contact Center administrators to create multiple agent groups in a short time. The assigned outbound code list is also
copied for the new group. The default agent group remains the same until changed.

To clone an agent group:

1. Log in to 8x8 Configuration Manager.

2. Go toAgent Groups to display the list of groups.
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3. Select an agent group and click Copy.

A single copy is generated. The cloned group has the original group name plus a number appended to the name.
For example, Acme-Billing agent group becomes Acme-Billing -1, Acme-Billing -2, and so on. You can rename
the group by going to theAgent Group > General > Group Name. The agent groups are listed in the
alphabetical order, but you can sort and change their order.

Note:
- Agents assigned to an agent group do not automatically transfer to the cloned agent group.
- The cloned agent groups show up in the Agent Group reports.
- Agents with Supervisor access can see all cloned agent groups assigned to them.

4. If required, modify the agent group properties and Save.

5. Make sure the right agent group isSet As Default.

6. Click to delete the queue. A confirmation message appears for you to confirm.

Edit agent groups

To edit a group:

1. Double-click the desired group from the list view or click .

2. Make the desired changes and Save.

Delete agent groups

Deleting a group with assigned members requires you to reassign the members of the group to another group.

To delete a group:

1. Select a group, and click .

You are prompted to confirm your action. If the group hasmembers, a message indicates the inability to delete the
group.
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2. Reassign the members to another group and then delete the group.

3. ClickOK to confirm the deletion.
For details on how to reassign an agent to a different group, refer toReassign an Agent's GroupMembership.

Reassign an Agent GroupMembership

To reassign an agent to a different group:

1. Log in to the 8x8 Configuration Manager.

2. From the Configuration Menu, openAgents.
A list of agents and their groups appears.

3. Look for the group you are planning to delete, and click .

4. In theGeneral tab, go toAgent Group.
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5. Select a different group from the drop-downmenu.

6. ClickSave to assign the agent to the new group.

7. Continue the above search and reassignment for all the agents belonging to the group you are planning to delete.
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Filter group list

If your 8x8 Contact Center has numerous groups, you may find it hard to track them in a single scrollable list. You can
search and filter the Group list in 8x8 Configuration Manager by specific fields such asGroup Name, Comment,
Number of Agents, and Assigned OutPhone List.

To filter the Group list:

1. Log in to 8x8 Configuration Manager.

2. From the Configuration Menu, openAgent Groups.
A list of existing agent groups appears.

3. Click Filter Agent Group List.

4. Choose the desired filtering criteria from the drop-downmenu to filter the group.

5. Click Filter.
The filtered list appears.

Sorting group list
You can sort the Group list in the 8x8 Configuration Manager by desired order and applying sort parameters. You can
sort by Group Name, Comment, Number of Agents, and Assigned OutPhone List by applying suitable parameters. You
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can sort the list in the ascending or descending order with just a click on the header bar. You have the option to sort by
multiple fields using Configure Sort.

To sort by a single field:

Click the header bar of a field. The list sorts automatically in ascending or descending order based on the content of the
field.

To sort by multiple fields:

1. ClickConfigure Sort.
The Sorting dialog box appears.

2. ClickAdd Level to specify a field name and the order to sort by.
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3. Add or delete levels to sort as you desire.

4. ClickApply. The sorted list shows.
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Add agents

To add or define a new agent in 8x8 Configuration Manager, as a 8x8 Contact Center administrators, you require to set
up an account, phone connectivity details, and outbound calling preferences. You also need to assign queues,
supervisor privileges, and ability to view case and contact management data.

Use the Agents tab in the Configuration Menu to:

n Add new agents

n Edit and delete existing agents

Adding an agent involves:

1. Creating accounts and configuring properties

2. Configuring phone settings

3. Assigning agents to queues

4. Granting supervisor rights

5. Granting Local CRM and Tab permissions

6. Defining the number of concurrent chats

Add agents
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Create agent accounts

8x8 Contact Center agents require login credentials to log in to 8x8 Agent Console. The General tab in 8x8
Configuration Manager allows the 8x8 Contact Center administrator to specify an agent's user information including
login credentials, email address, group assignment, and more.

To create an agent account:

1. From the Configuration Menu, openAgents.

2. Click Agent to add a new agent.

TheGeneral tab opens.

3. Enter the required information.
The following table summarizes the options in 8x8 Configuration Manager underAgent > General:
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General Tab
Option

Description

Enabled If selected, allows the agent to log in to 8x8 Agent Console using the agent's username and
password.

First Name Enter the agent's first name.

Last Name Enter the agent's last name.

Display Name Allows agents to present themselves with a customized display name. The display name can
be modified by the 8x8 Contact Center administrator here, or if permitted, by the agents in 8x8
Agent Console. The changes immediately appear in the other application. To prevent agents
from changing their display name at the tenant level, clear the Allow Agents to Change the
Display Name checkbox under Home > Profile.

Email Address Enter the email address 8x8 Contact Center uses to send agents copies of their direct access
voicemail messages. You can save email addresses with up to 254 characters.

Outgoing Mail
Server

A user’s outgoing mail server is automatically populated with the tenant's default SMTP server.
The default server can be either a VCC Internal server or a custom server. You can change the
SMTP server. The changes are kept unless a new default server is set.

8x8 Contact Center administrators can configure users outgoing mail servers in three ways:

n Using the VCC Internal server

n Using a custom server

n Using a custom server but overriding with the specific account's user name and
password (recommended)

If you use the VCC Internal server, you cannot override the server's default configuration,
therefore, using the email address of the server. The emails sent by this user originate from
the tenant’s default address which is not recommended.

Whereas a user that is configured to use a custom server configuration, such as [AcmeJets
SMTP Server], overrides the default server configuration . The emails sent by this user
originate from the address of the new server. By overriding the server’s default configuration
you make it more specific to the agent.

Override Server
Configuration

This option gives you the ability to direct your emails via the user specific email address. If you
do not choose to override, the emails are directed via the custom SMTP server address and
not the default server configured for this specific user. To ensure the secure email delivery
sent by the user, we recommend you to choose override.
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General Tab
Option

Description

Software
Language

Choose the language used by the 8x8 Agent Console interface.

Username Enter the account name the agent must use to log in to 8x8 Agent Console.
Agent usernames are case sensitive: When an agent logs into their 8x8 Agent Console, they
must use the same combination of upper and lowercase characters as those in the Username
text entry area.

Note:The usernamemust be unique within the same tenant, but not across all
tenants and globally.

Password,
Retype
Password

If enabled, enter the password the agent must use to log in to 8x8 Agent Console.
After logging in to 8x8 Agent Console for the first time, an agent can use My Profile to change
their password.
Contact center administrators can use the Password text entry areas to change or reset an
agent's password.

Note: This field is disabled if you have turned onEmail system generated
passwords for new agents/admins and reset underSecurity >Password
Policies. For details, refer to Configure Password Policies.

Comment Enter a description for the agent account.

Agent Group Select the agent's group assignment, such as Sales, Support, Marketing, etc.

Current
Country

By selecting the country of an agent, you can optimize call quality and routing. It hints the
system about the agent's location, and offers improved call quality.

Interaction
Offer Timeout 

Specify the duration (in seconds) for which an agent is offered an interaction before the
interaction times out. After the specified time, the agent status changes to Take Break
automatically.
Note: If the interaction offer timer runs out for an agent and the caller is back to the queue, the
caller's position in the queue will remain the same and not changed or reset.

Agent Primary Select the agent primary language. If the agent speaks the same language as the customer
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General Tab
Option

Description

Language does, they can choose to handle the conversation without the aid of the translation tool.

Agent
Secondary
Language

Select the agent secondary languages. If the chat request is in one of these languages, the
agent can chat in the requested language.

Status-change
Coding 

Indicates the agent has no status code list assigned while defining a new agent.

Note: If an existing agent is assigned with a code list, the code list name shows
here.

Allow agents
to change
Enable/Disable
settings in
Assigned
Queues

Control an agent's ability to change queue assignment from the agent profile.

Allow agents
to pull e-mails
from queue

By default, 8x8 Contact Center presents emails to agents on the basis of first-in-first-out. To
enable agents to selectively pull email messages from their email queues, select Allow
agents to pull e-mails from queue.

Allow agents
to Delete
pending e-
mails

If disabled, agents are prevented from deleting pending email in 8x8 Agent Console. By default,
agents have the privileges to delete pending email.

Allow Agents
to Reject
Interactions

This option is enabled by default allowing agents to reject interactions. If disabled, the Reject
button in 8x8 Agent Console is disabled preventing agents from rejecting the interactions they
are offered. The Reject button in 8x8 Agent Console appears when an interaction is offered to
the agent. You can set up this ability for an agent group, or individual agents. If you disable this
option at the tenant level, the check box will not show up for agent groups or individual agents.

Enable and
show options
menu button

The Options menu in 8x8 Agent Console gives access to transaction codes, dial pad, and call
recording options during a call. Select Enable and show options menu button. If selected,
the Options menu shows during a call.

Version 9.14 183

Create agent accounts



General Tab
Option

Description

Hide Customer
Email and
Voice (Phone
Number) in
CRM

Default
Connection
Mode

Administrators can choose one of the following Phone Connection Modes for agents: On
Demand or Persistent. For details, see our content on enable phone connection mode.

Allow Agents
to change
Phone
Connection
Mode

Agents are able to change their connection mode from within the 8x8 Agent Console. For
details, see our content on how to change your phone connection mode.

Enable Auto
Answer

With Auto Answer, every phone interaction that is offered to an agent is automatically
connected eliminating the need to accept it manually. If Auto Answer is provisioned for your
tenant, you can enable it at the tenant level, agent group level, or agent level. For details, see
our content on how to enable Auto Answer.

4. ClickSave before you move away from this tab.

Note:You can view the outgoing email server for each user under theAgents > User list. To show
this column, openUsers, right-click the header bar of the Users list and select Columns >
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Outgoing Mail Server.
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Configure phone settings

8x8 Contact Center administrators can define agent workplace phone settings and outbound calling preferences, and
specify direct agent access details and call recording settings in 8x8 Configuration Manager via Agents > Phone.

The following table summarizes the Phone settings categories:

Phone Settings
Category

Description

Workplace Enter the agent's Workplace phone or Workplace SIP URI at which agent wishes
to be reached. An agent requires a standard wired, cellular, or VoIP phone to pro-
cess phone interactions. The workplace phone number can be set to any ded-
icated extension number or a DID number as needed. The workplace SIP URI is
used when the agent has a soft phone approved by 8x8 installed on their work-
station. Note that the agent's extension number appears in the Workplace
Phone field when you first assign an extension to a user. You can also control
the ability of agents to change their phone number or SIP Phone URI from the Pro-
file tab in 8x8 Agent Console. The agents are granted the permission to change
their workplace phone or SIP URI by default.

Outbound
Calling

Outbound Calling preferences let you select a dial plan per agent to translate out-
bound dialing numbers. It allows you to define a custom Calling Line ID for all
calls placed by the agent.

Agent Access
Number and
Voicemail

The settings allow you to activate direct agent access for an agent, enter an
extension number to reach an agent directly by passing the IVR, and activate the
agent's voicemail.

Automatic Call
Recording

If call recording is permitted for the tenant, you can specify the desired per-
centage of inbound, outbound, and direct agent access calls to record.

Agent's Record-
ing Controls

These settings determine whether or not an agent can record calls.

Note:As the 8x8 Contact Center administrator, you can choose to
stop call recording on the third-party transfers when your last
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Phone Settings
Category

Description

contact center agent leaves the call. This setting is enabled at the
tenant level and cannot bemodified per agent. Contact 8x8 Support
to enable the feature and for more information. For details see
Control call recording on third-party transfers.

To configure phone settings:

1. From the Configuration Menu, openAgents.

2. Click or to add or edit an agent's account.

3. Enter or select the desired settings from the available options.
The following table summarizes the options underAgents > Phone:
Phone Tab
Option

Description

Workplace

Workplace
phone

If the agent uses a standard wired or cellular telephone, then in the Workplace phone enter the
full telephone number. 8x8 Contact Center uses that number to connect Phone interactions to the
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Phone Tab
Option

Description

agent's telephone:

n In the United States, phone numbers must be 1+(three-digit area code)+(seven-digit phone
number). When typing numbers in 8x8 Agent Console text entry areas, always preface the
area code with 1.

Note: The NANP dial plan translates phone numbers without the prefix as well.

n Outside the United States, phone numbers must be (Country Code)+(phone number).

If enabled by the administrator, agents may use the My Profile tab in 8x8 Agent Console to
change their phone number later.

Workplace
SIP URI 

If the agent uses a VoIP telephone, then in the SIP phone URI text entry area, type the
VoIP phone's full URI. 8x8 Contact Center uses that URI to connect phone interactions to the
agent's VoIP telephone. If enabled by the administrator, agents may use the My Profile tab in
8x8 Agent Console to change their phone number later.

Allow agent
to change
phone
Number

Control agents' ability to change their phone number. If selected, agents can change their
workplace phone number in the My Profile page of 8x8 Agent Console.

Allow agent
to change
SIP Phone
URI

Control agents' ability to change their phone number. If selected, agents can change their SIP
Phone URI phone number in the My Profile page of 8x8 Agent Console.

Outbound Calling

Outbound
Phone
Codes

By default, an agent inherits the Outbound Phone Code List assigned to the group they belong to.
You can change the selection here.

Calling Line
ID

Select an Outbound Phone Code list or None from the drop-down menu to indicate a calling Line
ID for outbound calls. Select a Calling Line ID for all outbound calls placed by the agent. You can
select from:
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Phone Tab
Option

Description

n Channel numbers

n Agent's phone number

n Anonymous

Note: The agent's Calling Line ID is overridden by Calling Line ID set by Outbound
Phone Codes.

Dial Plan Choose a Dial Plan to translate outbound dialing numbers. Select from the International
Numbering Plan, North American Numbering Plan, or any custom plan defined for the tenant.
For details on dial plans, refer to Understand Tenant Dial Plans.

Agent Access # and Voicemail

Enable in
IVR

If enabled, allows the agent extension number to be recognized in the IVR during a Menu or Get
Value input operation. You can reach the agent directly by entering a two- to eight-digit extension.

Enable
Agent
Voicemail

If enabled, activates an agent's voicemail and routes direct agent access calls to the agent's
voicemail if the agent fails to accept an interaction within the interaction offer timeout period. 8x8
Contact Center uses the email address specified under Agents > General to email Direct Agent
Access voicemails to the agent.

Note: If the agent's telephone has a private voicemail box, ensure that the 8x8
Contact Center voicemail timeout threshold occurs before the agent's voicemail box
seizes the call.

IVR Direct
Agent
Access #
(Maximum
8 digits)

Allow a caller to use an extension number to directly contact this agent. Enter a two- to eight-digit
extension number that callers can use to reach the agent directly.

Automatic Call Recording

% of n % of inbound calls: Specify the percentage of automatic call recording for the agent. Enter
a percentage of inbound calls.
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Phone Tab
Option

Description

inbound/
outbound/
direct agent
access
calls

n % of inbound calls: Specify the percentage of automatic call recording for the agent. Enter
a percentage of outbound calls.

n % of direct agent access calls: Specify the percentage of automatic call recording for the
agent. Enter a percentage of direct agent access calls.

Agent Recording Controls

Agent does
not have
recording
controls

Prevents an agent from recording a call by taking away the recording control in the Control Panel.
A call may still be recorded based on the automatic call recording settings.

Agent is
able to start
recording

While on a call, an agent can start recording the call anytime. The recording ends on terminating
the call, or when the agent leaves a call that is transferred to a third-party user.

Note:As the 8x8 Contact Center administrator, you can choose to stop call
recording on the third-party transfers when your last contact center agent leaves the
call. This setting is enabled at the tenant level and cannot bemodified per agent.
Contact 8x8 Support to enable the feature and for more information. For details see
Control call recording on third-party transfers.

Agent is
able to start
and pause
recording

An agent can start and pause recording a call any number of times. An agent may be denied
recording rights with certain IVR settings. Visual feedback in the 8x8 Agent Console Control Panel
always reflects the true recording status.

4. ClickSave to save the settings.

The next step is to assign queues to the agent.
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Access agent recorded calls

8x8 Contact Center administrators can use any secure FTP client that is compliant with Transport Layer Security (TLS)
1.2 or higher to download agent's recorded calls from the tenant. You can determine the percentage of the automatic
call recording via 8x8 Configuration Manager underAgents > Phone. If the last agent leaves the conference call or a
call that has been transferred to the customer via warm transfer, the call recording may have been stopped
automatically.

For details, refer toConfigure Phone Settings.
Configure a Secure FTP Client

You can use the secure FTP client to download agents' recorded calls. The following FTP clients are available for
download at no charge:

n FileZilla: available from http://filezilla-project.org/

n Core FTP LE: available from http://www.coreftp.com/

The following table summarizes the secure FTP configuration requirements for an FTP client to access the audio files
directory on your tenant:

FTP
Setting

Description

Host
name

n In US-West, enter <vcc-ftps-us1.8x8.com>.

n In US-East, enter <vcc-ftps-us2.8x8.com>.

n In Canada, enter <vcc-ftps-ca1.8x8.com>.

n In United Kingdom EU2, enter <vcc-ftps-uk2.8x8.com>.

n In United Kingdom EU3, enter <vcc-ftps-uk3.8x8.com>
For a complete list of the available platform URLs, refer to the Platform URL Guide.

Username For the username, enter the tenant name found in Home > Profile > Tenant Name. It is the username
used by the tenant's Primary administrator to log in the 8x8 Contact Center. You may access this inform-
ation from the initial communication email that shares the tenant login credentials. For example, if the
Primary administrator logs in to 8x8 Configuration Manager with the username <AcmeJets>, then type
the same username in your FTP client.

Password Enter the same password you entered in Home > Profile > SFTP Password. For details, refer to Sum-
mary of Profile Settings.

Version 9.14 191

Access agent recorded calls

http://filezilla-project.org/
http://www.coreftp.com/
https://support.8x8.com/@api/deki/files/2500/Platform-URL-Guide-Virtual-Contact-Center.pdf?revision=2


Using FileZilla to Download Audio Files

The following figure illustrates the FileZilla 3 settings used to connect to the 8x8 Configuration Manager agent
recording directory.

Refer to the above table for information about the User and Password text entry areas in your FileZilla Site Manager.
Using Core FTP LE to Download Audio Files

The following figure illustrates the Core FTP LE 2 settings used to connect to 8x8 Configuration Manager agent
recordings directory.
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Refer to the above table for information about theUser and Password text entry areas in your Core FTP LE 2 Site
Manager.
Browse and Locate Recording Files

You can browse and locate your contact center's recorded calls stored under your tenant directory. Your 8x8 Contact
Center tenant saves and stores each day's recording files in a time-stamped directory named Syyyymmdd, where
yyyyspecifies the year,mm specifies the month, and dd specifies the day. In addition, a date-stamped index file is
generated at the local tenant time between 12 AM and 1 AM at the end of each day. Each index file containsmetadata
about the call recordings.

At the root level, the tenant directory contains:

n An Index directory which contains one or more date-stamped, comma-separated values (CSV) index files named
Iyyyymmdd.csv, where I indicates index.
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n Time stamped sub-directories grouped by day. Each sub-directory contains one or more time-stampedWAV audio
files and index files with metadata about the audio files. Audio files are namedRyyyymmddttttttssss.wav, where
R indicates recording, and the timestamp includes the date (yyyymmdd) and 24-hour Coordinated Universal Time
(UTC) ttttttwhen the file was recorded by hour, minute and second, and ssss indicates a sequence to differentiate
multiple files recorded at the same second. The directory structure of call recordingsmay be represented as
follows:

Note: The filenames and sub-directory names are time stamped by UTC and not by the local tenant
time.

Locating Call Recordings

Locating your recorded calls requires understanding the time difference between your local tenant time and UTC. For
example, if your tenant is located in the Pacific Daylight Time zone (PDT), you are behind the UTC by 7 hours. At 12
AM UTC, you local tenant time is 5 PM PDT.
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To obtain recordings of your tenant for 06/06/2016, download recordings in subdirectories S20160606 and S20160607.
The calls recorded after 5 PM PDT on 06/06 are stored under the sub-directory S20160607.

Note: The daily recording batch index file created between 00:00 and 01:00 local tenant time references
calls in two different UTC daily sub-directories unless your local tenant time happens to be UTC.

To access the Index files:

1. Double-click the Index directory. The directory consists of index files time stamped by day. You may view or
download the index files in the directory.

Note: Index files for a specific day are stored under the relevant sub-directory as well as the index
directory. Two types of index files exist. One file contains more details than the other.
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Each CSV index file lists the following information about that day's agent recording files:

n CALL TYPE: Inbound Outbound, or Direct Agent Access call

n START TIME, STOP TIME: Local Tenant Time at which the call was answered and terminated by the agent

n AGENT NAME: Name of the agent who took the call

n CUSTOMERNUMBER: Phone number associated with the customer

n PHONE CHANNEL: Phone Channel number processing the call

n CALLEDNUMBER: A phone number to which a call was placed (applicable to outbound calls)

n CASEID: Case number associated with the caller

n DURATION: Duration of the phone call

n FILENAME: Filename of the audio recording of the call

n DIRECTORY: The sub-directory in which the audio recording of the call is stored

n ACCOUNT: Account number associated with the caller

n START TIME UTC: Time represented in UTC at which the call was answered by the agent

n STOP TIME UTC: Time represented in UTC at which the call was terminated by the agent
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n QUEUE: Queue type indicates outbound or inbound queue

n QUEUE NAME: Name of the queue the call was channeled to

n TRANSACTION ID: Unique number that identifies the phone call

n EXTERNAL VARIABLE 1&2: Data collected during the Interactive Voice Response

n OUTDIAL CODE: Codes associated with outbound calls

n WRAP UP CODE: Codes representing the call outcome

2. Go to the specified directory and download the call recording files.

You can view the CSV index file in most spreadsheet programs including Microsoft Excel or OpenOffice Calc.
Download Agent Call Recordings

You can download the index files and the call recordings by folders or by individual files.

To download call recordings or index files:

1. Select a directory, and right-click to open the menu.

2. Select Download from the right-click menu.

The SFTP client indicates a successful transfer.

3. To play downloaded call recordings, select a WAV file, and double-click to play the recording.
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Assign agents to queues

All interactions flowing to 8x8 Contact Center are channeled through queues. The queues in turn direct them to agents
based on their skill level and availability. An 8x8 Contact Center agent has to be a member of a queue to receive any
interaction from the queue.

8x8 Contact Center provides sophisticated logic for matching customers to the agent who can best solve their problem.
Queues direct interactions based on the skill level of agents serving the queue. If you have an agent with high skill level
vs. an agent with low skill level, the interaction will be directed to the high-skilled agent based on their availability.

As an 8x8 Contact Center administrator, you can assign the selected agents to previously defined phone, email, chat,
and voicemail queues. Once assigned, the agent receives interactions channeled through these queues. You can
access queues in 8x8 Configuration Manager via Agents > Queues.

To define queue assignments:

1. From the Configuration Menu, openAgents.

2. Find an agent and click .

3. Open theQueues tab.

4. Select a Skill Level for the agent serving the queue.
The skill level can be selected from 10 to 100 (lowest to highest).

5. ClickAssign All to assign the agent to all queues, or select individual queues and click the check box to assign.
You can disable any queues by clearing the Enabled check box.
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The following table summarizes the options available under theQueues tab:

Queues
Tab
Option

Description

Assign
All

Select the option to assign an agent to all the available queues defined in the tenant.
For custom queue assignments, select individual queues, specify the agent's skill level, and assign.
You can also assign agents to queues at the same time you create the queue.
For details on assigning agents to a phone queue as part of queue creation, refer to Assign Inbound
Phone Queue Members. The same concept applies to all other types of 8x8 Contact Center queues.

Enable
All

Enables interactions from all queues automatically on assigning.

Media Displays the type of media queue such as Chat, Email, Outbound Phone, Inbound Phone, or
Voicemail.

Queue
Name

Displays the name of queue, such as Support or Sales.

Skill
Level
(Click to
change)

Indicates the skill level of the agent for that queue. The skill level determines the routing of
interactions within a queue. 8x8 Contact Center attempts to direct interactions to an agent with a
higher skill level before directing them to an agent with a lower skill level. Skill levels are now
indicated by ten numerical values ranging from 10 to 100 with an increment of 10, with 10 being the
lowest value and 100 being the highest. Assign the agent's skill level from the drop-down menu of
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Queues
Tab
Option

Description

options.

Agents
Enabled

Indicates the total number of agents in each queue whose accounts are enabled.

Assigned If selected, assigns an agent to the selected queue and automatically enables interactions from that
queue. You can assign agents to queues at the same time you create the queue.
For details on assigning agents to a phone queue as part of queue creation, refer to Assign Inbound
Phone Queue Members. The same concept applies to all other types of 8x8 Contact Center queues.

Enabled Allows the agent to receive interactions from a selected queue. You can assign a queue but choose
to temporarily disable it.

6. ClickSave to save your settings.

The next step is to define supervisor privileges for the agent.
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Grant supervisor rights

8x8 Contact Center administrators can grant special privileges to an agent, and allow agents to perform as 8x8 Contact
Center supervisors. A supervisor has all the rights of an agent in addition to the ability to:

n Create and delete FAQ categories and answers.

n Monitor agents, queues, groups, and campaigns.

n Create and run historical reports for contact center metrics.

In addition to supervisory features, supervisorsmay choose to perform, or at least guide and validate the use of certain
operations that agents have access to, such as agent profile configuration. These include the following optional
features:

n Delete customer and case records from the Local CRM.

n Pull and delete pending email interactions from a queue.

n Use the Monitoring tab to remove agents from queue assignments.

8x8 Contact Center administrators grant supervisor privileges to an agent and allow permissions to monitor groups,
queues, and campaigns in 8x8 Configuration Manager and viaAgents > Supervisor.

To enable supervising ability for an agent:

1. From the Configuration Menu, openAgents.

2. Find an agent and click .
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3. Open the Supervisor tab.

4. Select This user is supervisor.

5. Open theQueues, Groups, andCampaigns tabs for more configuration.
The following table summarizes the options available under the Supervisor tab in the Queues, Groups, and
Campaigns pages:

Supervisor
Tab Option

Description

This user is
supervisor

If enabled, the user is granted supervisor rights.

Allow this
supervisor to
monitor calls

If enabled, the supervisor can join agents phone calls in progress for monitoring purposes.

Restrict report
privileges

If enabled, restricts the data a supervisor views in historical reports. The supervisor views the
groups and queues they monitor, or are a member of.

Assign All If enabled, the agent is assigned to all available queues, groups, or campaigns defined in the
tenant.

Media Displays the type of media queue such as Chat, Email, Outbound Phone, Inbound Phone, or
Voicemail.

Name Displays the name of a queue, group, or campaign, such as Chat Channel or Support Queue.
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Supervisor
Tab Option

Description

Default
Priority

Indicates the priority number of the queue as set under Queues > Properties > Default
Priority. This number determines the priority of all interactions for a queue where 1 specifies
lowest priority and 10 specifies highest priority.
For details, refer to Define Inbound Phone Queue Properties.

Agent Count Indicates the number of agents in a group.

Comment Displays the description or comment of a group entered when creating a group and under
Group > General.

Status Shows the campaign status, such as completed, running, or stopped.

Enabled Shows if the campaign is enabled.

Queue Displays the queue associated to a campaign. You can specify the queue in Campaign
> Properties.

Caller ID Displays the campaign's caller ID specified when defining a campaign. The campaign's caller
ID can be a channel number.

CRM Object Displays the campaign's CRM Object, such as customer, specified when defining a campaign.

Assigned If selected, assigns an agent to the selected queue, group, and campaign.

6. ClickSave.
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Grant Local CRM permissions

8x8 Contact Center administrators grant Local CRM permissions to agents and supervisors to manage customer data
such as cases, customers, and tasks accessible to agents via 8x8 Agent Console. 8x8 Contact Center administrators
grant the permissions to view, create, edit, or delete customer data in 8x8 Configuration Manager viaUsers > CRM.

To grant Local CRM permissions to an agent or supervisor:

1. From the Configuration Menu, openAgents.

2. Find an agent and click or .

3. Grant the desired permissions to the agent.
The following table summarizes the permissions:

CRM Tab Description

Case Select or change from the following permissions to define an agent's access to case data:

n View

n Create

n Edit
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CRM Tab Description

n Delete

n Create a Follow-up

n Change status

n Create a report

n Download a report: Agents can continue to run the report even if the ability to download a
report is disabled.
If you disable any of the above controls, the agent cannot see the corresponding feature in
8x8 Agent Console.

Note: To revoke or edit the case permissions, you have to unsubscribe the agent
from all queues to avoid any conflict. Only supervisors can view aMonitoring tab.

Task  Select or change from the following permissions to define an agent's access to Task data:

n View

n Create

n Edit

n Delete

n Change status

n Create a report

n Download a report
If you disable any of the above controls, the agent cannot see the corresponding feature in
8x8 Agent Console.

Note:An agent is able to clone tasks in 8x8 Agent Console if the administrator grants
the permission to create and edit tasks to that agent.

Customer Select or change permissions to view, modify, and delete customers data.

n View

n Create
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CRM Tab Description

n Edit

n Delete

n Create a report

n Download a report
If you disable any of the above controls, the agent cannot see the corresponding feature in
8x8 Agent Console.

Monitoring Select the permission to view monitoring.
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Configure multi-chats

8x8 Contact Center multi-chat allows an agent to handle up to six concurrent chats with customers at any time. There is
no limit on the number of concurrent chats among agents. Using the Interactions tab in 8x8 Configuration Manager, 8x8
Contact Center administrators can configure the maximum number of concurrent chats with customers for each agent.
They can also enable agent-to-agent chat from within the Interactions tab. There is no limit on the number of agent-to-
agent chats.

To define maximum number of concurrent chats with customers:

1. From the Configuration Menu, openAgents.

2. Find an agent and click .

3. Open the Interactions tab.

4. Select Max # of concurrent chats from the list.

5. Select Enable agent to agent chat.
It allows this agent to chat with other agents. There is no limit on the number of concurrent chats among agents.

6. ClickSave.
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Create and configure queues

An 8x8 Contact Center queue is an ordered collection of interactions waiting to be served by agents who are qualified to
respond to these interactions. The 8x8 Contact Center administrator can customize how incoming interactions are
prioritized and routed in 8x8 Configuration Manager. Queues ensure that interactions are never lost or discarded.

Queues serve to present interactions flowing into 8x8 Contact Center to agents based on skill set and availability. 8x8
Contact Center provides sophisticated logic for matching customers to the agent who can best solve their problem.
Queues direct interactions based on the skill level of agents serving the queue. If you have an agent with high skill level
vs. an agent with low skill level, the interaction will be directed to the high skilled agent based on their availability.

By going to theQueues/Skills tab, you can:

n Create, edit, copy, and delete queues of all media

n Assign members to queues

n Define targeted service level

To access Queues:

Create and configure queues
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1. In the Configuration Menu, clickQueues/Skills to display a list of queues.

2. In the list view:

n Click Add to create a new queue for Inbound Phone, Chat, or Email.

n Click Edit to view or modify an existing queue.

n Click Copy to clone an existing queue.

n Click Delete to delete an existing queue.

3. Configure the queue settings, and Save.

Clone queues
Aministrators can copy inbound phone queues, outbound phone queues, chat queues, email queues, as well as
voicemail queues with a simple click. Cloning queues allows Contact Center administrators to create multiple queues in
a short time.

When you clone a queue, the queue properties, members, interactions, SLA, and email settings are copied. A queue
name is automatically generated. You can modify or make changes to the new queue, if required.
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To clone a queue:

1. Log in to 8x8 Configuration Manager

2. Go toQueues/Skills to display a list of queues.

3. Select a queue and click Copy.

A single copy is generated. The cloned queue has the original queue name plus a number appended to the name.
For example, AcmeSalesChatQ becomes AcmeSalesChatQ -1, AcmeSalesChatQ -2, and so on. You can rename
the queue by going to theQueues/Skills > Properties > Queue name. The queues are listed in alphabetical
order, but you can sort and change their order.

4. If required, modify the queue properties and Save.

5. Click to delete the queue.

Note: To delete a queue, youmust remove the agents from the queue first.

Configuring a queue varies based on the media of the queue. The following sections describe:

n Creating inbound phone queues

n Creating outbound phone queues
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n Creating chat queues

n Creating email queues

n Creating voicemail queues
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Create inbound phone queues

Configuring an 8x8 Contact Center inbound phone queue in 8x8 Configuration Manager involves:

n Defining inbound phone queue properties

n Assigning inbound phone queuemembers

n Configuring inbound phone queue voicemail

n Setting up inbound phone queue call priority

n Defining inbound phone queue SLA
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Define inbound phone queue properties

8x8 Contact Center categorizes phone queues by the direction of the phone calls.

n An inbound phone queue accepts incoming phone calls and directs them to skilled agents. Agents either process
these phone calls, or reject them, routing them back to the queue, thus ensuring calls are not discarded.

n An outbound phone queue processes all outgoing interactions including campaign calls, click-to-dial calls, and web
callback calls.

To define an inbound phone queue, 8x8 Contact Center administrators need to define the primary properties, such as
queue name, default priority, post-processing timeout, and more. Open the Properties tab to define the properties.

To define inbound phone queue properties in 8x8 Configuration Manager:

1. From the Configuration Menu, openQueues/Skills.

2. Click or Inbound Phone.

3. Enter the desired properties in the Properties tab.

The following table summarizes the options underQueues/Skills > Inbound Phone > Properties:
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Properties
Tab Option

Description

Queue type Read-only reminder of the type of queue.

Queue
direction

Read-only reminder of the phone queue direction. Specifies if it is inbound or outbound. It is
applicable to phone media only.

Queue
name

Type a name for the queue.

Default
Priority

Choose the priority for this queue, where <1> specifies the lowest priority and <10> specifies the
highest priority. This defines the priority for interactions of all media.
By default, 8x8 Contact Center prioritizes the queues as follows:

n Phone queue = 8 (highest default priority)

n Chat queue = 6

n Voicemail queue = 4

n Email queue = 2 (lowest default priority)
Based on your business needs, you can assign the desired priority for each queue.

Transfer
Incoming
Calls To

If enabled, 8x8 Contact Center transfers phone interactions from this queue to an external
telephone number (that is not managed by the contact center). The external telephone number
must have the following format:

n In the United States:
1 + three-digit area code + seven-digit phone number

n Outside the United States:
Country Code +phone number

The telephone number may contain optional dashes, spaces, or parentheses.

Post-
Processing
Timeout

Choose how long 8x8 Contact Center must wait before assigning a new interaction from the queue
to an agent who has just completed an interaction.
The post-processing timeout enables agents servicing the selected queue to perform any
necessary post-interaction tasks before receiving a new interaction. Choose Manual to enable
agents assigned to this queue to use their 8x8 Agent Console to explicitly make themselves
available for new interactions. When there are multiple agents available with the same queue and
skill level assignment waiting to receive the next interaction, 8x8 Contact Center routes the call to
the agent who has been idle the longest. For details, see our content on how to reset idle timer for
agents.
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Properties
Tab Option

Description

Voice
Recording
%

Specify the percentage of interactions from this queue recorded by 8x8 Contact Center.

Waiting
Music

Choose the audio file played when a caller must wait for an agent to become available. The
Waiting Music lists all files defined in the Audio Files tab.
For details on the Audio Files tab, refer to Configure Recorded Greetings.

Agent
whisper
audio

Select an audio file from the drop-down for Agent whisper. By default there is no audio file

selected. You can click to play the audio. Agent whisper helps agents identify the context of the

incoming call even before the customer information pops for preview, thus allowing them to
prepare for the call. Agent whisper messages can be heard on both inbound and outbound calls.
To set up Agent whisper, you must upload the Agent whisper file first and then assign the file to a
queue. For details Agent whisper files see details on how to create agent whisper for phone
queues.

4. ClickSave.After you define the queue properties, you are ready to assign members to the queue.
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Assign inbound phone queue members

When 8x8 Contact Center administrators assign members to an inbound phone queue, they allow them to process the
phone interactions that enter the queue. The queue uses skill-based routing to route the inbound phone calls based on
the agent's skill set. An agent with a higher skill level receives an interaction before an agent with a lower skill level.

Go to Queues/Skills > Inbound Phone > Members in 8x8 Configuration Manager to add, modify, or remove agents.

To assign members to an inbound phone queue:

1. From the Configuration Menu, openQueues/Skills.

2. Find the inbound phone queue you wish to assign members to, and click .

3. Go to theMembers tab.

4. Select Assign All to assign all agents to the queue.
OR
Select Agents assigned to choose the desired agents only.

5. Click the Skill level for the agent serving the queue.
The skill level can be selected from 10 to 100 (lowest to highest).
The following table summarizes the options underQueues/Skills > Inbound Phone > Members:
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Members
Tab
Option

Description

Assign
All

Assigns all existing agents to this queue.

Enable All To activate routing of interactions from this queue to all agents assigned to the queue.

Agents For the selected queue, in the list of agents:

n Select Assign All to assign all agents to the queue.

n Select an individual agent to add that agent to the queue.

Skill
Level

Indicates the skill level of the agent for that queue. The skill level determines the routing of
interactions within a queue. 8x8 Contact Center attempts to direct interactions to an agent with a
higher skill level before directing them to an agent with a lower skill level. Skill levels are now
indicated by ten numerical values ranging from 10 to 100 with an increment of 10, with 10 being the
lowest value and 100 being the highest. Assign the agent's skill level from the drop-down menu of
options.

Agents
Assigned

Assigns the selected agents to this queue.

Agents
Enabled

Activates routing of interactions from this queue to selected agents assigned to the queue. You can
assign but temporarily disable an agent.

6. Select Agents enabled or Enable All to activate routing of interactions from this queue to the selected agents.

7. ClickSave.
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Configure inbound phone queue voicemail

Stagnating calls in an 8x8 Contact Center queue for too long is not desirable to callers. 8x8 Contact Center admins can
direct calls that have been waiting in a queue longer than a specified time to voicemail, allowing callers to leave a
message. By going to the voicemail tab in 8x8 Configuration Manager, you can also:

n Enable voicemail for a queue.

n Specify a duration after which to direct the waiting calls to voicemail.

n Select a message for voicemail.

n Select a voicemail queue to direct the calls to.

To configure voicemail for a queue:

1.  From the Configuration Menu, openQueues/Skills.

2. Find the inbound phone queue you wish to modify, and click .

3. Go to the Voice Mail tab and select or enable voicemail settings.
The following table summarizes the options underQueues/Skills > Inbound Phone > Voicemail.

Voicemail Tab Option Description

Enable Voice Mail Select to enable voicemail for this phone queue.

Force Voice Mail after Choose how much time 8x8 Contact Center permits a caller to wait before
redirecting the call to a 8x8 Contact Center voicemail queue.

Voice Mail Message
(played to customer)

Choose the recorded message 8x8 Contact Center plays when redirecting a caller to
a voicemail queue.

n Upload Custom: You can replace the current message with an existing WAV
file from your picklist.

n Play Audio: Click to listen to the audio voice message.

Route Voice Mail to
queue

Choose a 8x8 Contact Center voicemail queue.

4. ClickSave.
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Set up inbound phone queue call priority

8x8 Contact Center administrators can set up custom priority for interactions in the queue based on the conditions they
define. If an interaction meets the condition, it takes a higher or a lower priority than the default priority of the queue. To
take advantage of this feature, you must use the Local CRM. Go to the Interactions tab in 8x8 Configuration Manager
to customize how the selected queue prioritizes specific types of interactions.

For example, AcmeJets has an inbound support queue with a default priority set to 6.

This queue handles support inquiries from all customers. To better serve its premium customers before others,
AcmeJets can define a higher interaction priority for interactions from premium customers by setting a condition to
determine the customer type. When an interaction meets the condition, the interaction priority overrides the default
priority of the queue, allowing agents to serve the premium customers faster.

To define custom priority for interactions:

1.  From the Configuration Menu, openQueues/Skills.

2. Find the inbound phone queue you wish to modify, and click .

3. Go to the Interactions tab.

4. Select a value for Set Default Interaction Priority within the Queue.
The following table summarizes the options underQueues/Skills > Inbound Phone > Interactions:

Interactions Tab
Option

Description

Set default
interaction priority
within the queue

To customize the priority for specific types of interactions within this queue, choose a
non-default priority level, then in the condition area, specify the conditions that receive
the non-default priority.
In the list, 1 equals the lowest default interaction priority, and 100 equals the highest
interaction priority.

Add Interaction Rule Click to create an interaction priority rule.

If the value of the
field

Choose a Local CRM field to enable the options available in the equals list such as Case:
Priority.
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Interactions Tab
Option

Description

For details, refer to Configure CRM Fields.

equals The values in this field varies based on what field you choose for Local CRM. For
example, for Case: Priority in the CRM field, you can choose Low, Medium, or High.

Set interaction
priority to

Choose a priority level for the interaction from 1 (lowest) to 100 (highest).

Enable priority
routing rule

Select to enable the routing rule in your 8x8 Contact Center.

5. Define an interaction rule to specify a matching condition.

a. Click or Interaction Rule.

b. Select a CRM field for If value of the field, such as Case: Priority.

c. Select a value for equals. For example, for Case: Priority in the CRM field, you can choose Low, Medium, or
High.

d. Choose a value for Set interaction priority to from 1 to 100.
This number sets the priority of the interactions that match the rule. For example, a platinum support customer
gets a high priority, such as 90.

e. Select the Enable priority routing rule check box to activate the rule.

f. ClickAdd this Rule.
The interaction rule appears in the list.

6. Repeat the above procedure to add more rules.

7. ClickSave.
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Define inbound phone queue SLA

The Service Level Agreement (SLA) of an 8x8 Contact Center queue defines the target performance metrics of the
queue. It includes the percentage of interactions processed within a specified time interval. You can set a target service
level for each queue via 8x8 Configuration Manager, and periodically evaluate the service level. You can also set up an
alert notification to show if the service level falls below the specified threshold.

To define SLA for an inbound phone queue:

1. From the Configuration Menu, openQueues/Skills.

2. Find the inbound phone queue you wish to modify, and click .

3. Go to the SLA tab.

The following table summarizes the options underQueues/Skills > Inbound Phone > SLA:

SLA Tab Option Description

% of interactions
should be
processed
within

To specify the Service Level Agreement (SLA) threshold for the selected queue:

1. Type a percentage value as an integer from 0 to 100 percent, such as 40.

2. Type an integer number to indicate the time interval.

3. Choose the units of time specified by this value.
The valid time intervals are:
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SLA Tab Option Description

n For Phone and Chat queues: Seconds, Minutes, or Hours

n For Email and Voicemail queues: Minutes or Hours

Evaluate service
level every

Choose how frequently 8x8 Contact Center compares the queue's performance to the SLA
threshold defined for the queue.

Send email
notification to

Type one or more comma-separated email addresses that should receive email notifications
from 8x8 Contact Center. The email is sent when the queue's performance level falls below
the performance threshold specified for the queue.

4. ClickSave.
With this step, the queue configuration is complete.
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Create outbound phone queues

8x8 Contact Center outbound queue is used to channel agent-initiated outbound calls to the destination. These calls
may be:

n Agent-dialed from the Control Panel: Must be configured via Outbound Phone Codes.

n Requests for web callback: API accepts Queue ID as a parameter.

n Via click-to-dial: API accepts Queue ID as a parameter.

n Campaign calls: Must be directed via an Outbound Phone queue.

When an outbound call is directed through an 8x8 Contact Center queue, an agent's status changes to busy preventing
any calls being offered to the agent.

Configuring an outbound phone queue in 8x8 Configuration Manager involves:

n Defining outbound phone queue properties

n Assigning outbound phone queuemembers

n Setting up outbound phone queue call priority

n Defining outbound phone queue SLA

n Viewing campaign assignments
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Define outbound phone queue properties

8x8 Contact Center categorizes phone queues by the direction of the phone calls.

n An inbound phone queue accepts incoming phone calls and directs them to skilled agents. Agents either process
these phone calls, or reject them, routing them back to the queue, thus ensuring calls are not discarded.

n An outbound phone queue processes all outgoing interactions including campaign calls, click-to-dial calls, and web
callback calls.

To define an outbound phone queue, you need to specify the primary properties, such as queue name, default priority,
post-processing timeout, and more. The Properties tab in 8x8 Configuration Manager under Outbound Phone queues
allows you to define these properties.

To define outbound phone queue properties:

1. From the Configuration Menu, openQueues/Skills.

2. Click orOutbound Phone.

3. Enter the desired properties in the Properties tab.
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The following table summarizes the options underQueues/Skills > Outbound Phone > Properties:

Properties
Tab Option

Description

Queue type Read-only reminder of the type of queue.

Queue
direction

Read-only reminder of the phone queue direction. Specifies if it is inbound or outbound. It is
applicable to phone media only.

Queue
name

Enter a name for the queue.

Default
Priority

Choose the priority for this queue, where 1 specifies the lowest priority and 10 specifies the
highest priority. This defines the priority for interactions of all media.
By default, 8x8 Contact Center prioritizes the queues as follows:

n Phone queue = 8 (highest default priority)

n Chat queue = 6

n Voicemail queue = 4

n Email queue = 2 (lowest default priority)
Based on your business needs, you can assign the desired priority for each queue.

Post-
Processing
Timeout

Choose how long 8x8 Contact Center must wait before assigning a new interaction from the queue
to an agent who has just completed an interaction.
The post-processing timeout enables agents servicing the selected queue to perform any
necessary post-interaction tasks before receiving a new interaction. Choose Manual to enable
agents assigned to this queue to use their 8x8 Agent Console to explicitly make themselves
available for new interactions. When there are multiple agents available with the same queue and
skill level assignment waiting to receive the next interaction, 8x8 Contact Center routes the call to
the agent who has been idle the longest. For details, see our content on how to reset idle timer for
agents.

Voice
Recording
%

Specify the percentage of interactions from this queue recorded by 8x8 Contact Center.

4. ClickSave.

After you define the queue properties, you are ready to assign members to the queue.
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Assign outbound phone queue members

When 8x8 Contact Center admins assign members to an outbound phone queue, they allow the members to process
campaign calls and web callback requests that enter the queue. The queue uses skill-based routing to route the
outbound phone calls based on the agent's skill set. An agent with a higher skill level receives an interaction before an
agent with a lower skill level.

Go to Queues/Skills > Outbound Phone > Agents in 8x8 Configuration Manager to add, modify, or remove agents.

As a member of an outbound queue, an agent is offered:

n Campaign calls

n Customer requests for web callback

To assign members to an outbound phone queue:

1. From the Configuration Menu, openQueues/Skills.

2. Find the outbound phone queue you wish to assign members to, and click .

3. Go to theAgents tab.
A list of existing agents appears.
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4. Select Assign All to assign all agents to the queue.
OR
Select Agents assigned to choose the desired agents only.

5. Click the Skill level for the agent serving the queue.
The skill level can be selected from 10 to 100 (lowest to highest).

The following table summarizes the options underQueues/Skills > Outbound Phone > Agents:

Members
Tab
Option

Description

Assign
All

Assigns all existing agents to this queue.

Enable All To activate routing of interactions from this queue to all agents assigned to the queue.

Agents For the selected queue, in the list of agents:

n Select Assign All to assign all agents to the queue.

n Select an individual agent to add that agent to the queue.

Skill
Level

Indicates the skill level of the agent for that queue. The skill level determines the routing of
interactions within a queue. 8x8 Contact Center attempts to direct interactions to an agent with a
higher skill level before directing them to an agent with a lower skill level. Skill levels are now
indicated by ten numerical values ranging from 10 to 100 with an increment of 10, with 10 being the
lowest value and 100 being the highest. Assign the agent's skill level from the drop-down menu of
options.

Agents
Assigned

Assigns the selected agents to this queue.

Agents
Enabled

Activates routing of interactions from this queue to selected agents assigned to the queue. You can
assign but temporarily disable an agent.

6. Select Agents enabled or Enable All to activate routing of interactions for the selected agents.

7. ClickSave.
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Set up outbound phone queue call priority

8x8 Contact Center administrators can set up custom priority for interactions in the queue based on the conditions they
define. If an interaction meets the condition, it takes a higher or a lower priority than the default priority of the queue. To
take advantage of this feature, you must use the Local CRM. Go to the Interactions tab in 8x8 Configuration Manager
to customize how the selected queue prioritizes specific types of interactions.

For example, AcmeJets has a web callback outbound phone queue with a default priority set to 20.

This queue handles support inquiries from all customers. To better serve its premium customers before others,
AcmeJets can define a higher interaction priority for interactions from premium customers by setting a condition to
determine the customer type. When an interaction meets the condition, the interaction priority overrides the default
priority of the queue, allowing agents to serve the premium customers faster.

To define custom priority for interactions:

1. From the Configuration Menu, openQueues/Skills.

2. Find the outbound phone queue you wish to modify, and click .

3. Go to the Interactions tab.

4. Select a value for Set Default Interaction Priority within the Queue.
The following table summarizes the options underQueues/Skills > Outbound Phone > Interactions.
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Interactions Tab
Option

Description

Set default
interaction priority
within the queue

To customize the priority for specific types of interactions within this queue, choose a
non-default priority level, then in the condition area, specify the conditions that receive
the non-default priority.
In the list, 1 equals the lowest default interaction priority, and 100 equals the highest
interaction priority.

Add Interaction Rule Click to create an interaction priority rule.

If the value of the
field

Choose a Local CRM field to enable the options available in the equals list such as Case:
Priority.
For details, refer to Configure CRM Fields.

equals The values in this field varies based on what field you choose for Local CRM. For
example, for Case: Priority in the CRM field, you can choose Low, Medium, or High.

Set interaction
priority to

Choose a priority level for the interaction from 1 (lowest) to 100 (highest).

Enable priority
routing rule

Select to enable the routing rule in your 8x8 Contact Center.

5. Define an interaction rule to specify a matching condition.

a. Click or Interaction Rule.

b. Select a CRM field for If value of the field, such as Case: Priority.

c. Select a value for equals. For example, for Case: Priority in the CRM field, you can choose Low, Medium, or
High.

d. Choose a value for Set interaction priority to from 1 to 100.
This number sets the priority of the interactions that match the rule. For example, a platinum support customer
gets a high priority, such as 90.

e. Select the Enable priority routing rule check box to activate the rule.

f. ClickAdd this Rule.
The interaction rule appears in the list.

6. Repeat the above procedure to add more rules.

7. ClickSave.
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Define outbound phone queue SLA

The Service Level Agreement (SLA) of an 8x8 Contact Center queue defines the target performance metrics of the
queue. It includes the percentage of interactions processed within a specified time interval. You can set a target service
level for each queue via 8x8 Configuration Manager, and periodically evaluate the service level. You can also set up an
alert notification to show if the service level falls below the specified threshold.

To define SLA for an outbound phone queue:

1. From the Configuration Menu, openQueues/Skills.

2. Find the outbound phone queue you wish to modify, and click .

3. Go to the SLA tab.

The following table summarizes the options underQueues/Skills > Outbound Phone > SLA.

SLA Tab Option Description

% of interactions
should be
processed
within

To specify the Service Level Agreement (SLA) threshold for the selected queue:

1. Type a percentage value as an integer from 0 to 100 percent, such as 40.

2. Type an integer number to indicate the time interval.

3. Choose the units of time specified by this value.
The valid time intervals are:
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SLA Tab Option Description

n For Phone and Chat queues: Seconds, Minutes, or Hours

n For Email and Voicemail queues: Minutes or Hours

Evaluate service
level every

Choose how frequently 8x8 Contact Center compares the queue's performance to the SLA
threshold defined for the queue.

Send email
notification to

Type one or more comma-separated email addresses that should receive email notifications
from 8x8 Contact Center. The email is sent when the queue's performance level falls below
the performance threshold specified for the queue.

4. ClickSave.
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View campaign assignments

8x8 Contact Center requires you to direct all campaign calls through outbound queues. While defining a campaign, you
must specify an outbound queue to direct the calls to. When a campaign executes, a target call list fetched from the
Local CRM is fed to an outbound phone queue. The queue offers calls to its members based on their skill set and
availability.

The Campaigns tab in 8x8 Configuration Manager for an existing outbound phone queue shows the campaigns
assigned to the queue. The list shows all new, running, completed, purged, and stopped campaigns.

To view campaign assignments:

1. From the Configuration Menu, openQueues/Skills.

2. Find the outbound phone queue with a campaign assignment you wish to view, and click .

3. Go to theCampaigns tab.

All campaigns assigned to this outbound queue are listed. For details on creating and assigning campaigns to a
queue, refer toCreate a Campaign.
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Create chat queues

8x8 Contact Center supports chat media, allowing agents to process chat interactions with its customers in a timely
manner similar to processing phone calls. Chat interactions directed to your contact center enter a chat queue. In turn,
the queue offers these interactions to its members based on their skill set and availability.

Configuring a chat queue in 8x8 Configuration Manager involves:

n Defining chat queue properties

n Assigning chat queuemembers

n Configuring chat queue greetings

n Setting up chat queuemessage priority

n Defining chat queue SLA

n Configuring chat queue email fallback
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Define chat queue properties

8x8 Contact Center administrators define chat queues by specifying primary properties such as queue name, default
priority, post-processing timeout, and more. The Properties tab in 8x8 Configuration Manager under Queues/Skills >
Chat allows administrators to specify these properties.

To define chat queue properties:

1. From the Configuration Menu, openQueues/Skills.

2. Click orChat.

3. Enter the desired properties in the Properties tab.

The following table summarizes the options underQueues/Skills > Chat > Properties:

Properties
Tab Option

Description

Queue type Read-only reminder of the type of queue.

Queue
name

Type a name for the queue.

Default
Priority

Choose the priority for this queue, where 1 specifies the lowest priority and 10 specifies the
highest priority. This defines the priority for interactions of all media.
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Properties
Tab Option

Description

By default, 8x8 Contact Center prioritizes the queues as follows:

n Phone queue = 8 (highest default priority)

n Chat queue = 6

n Voicemail queue = 4

n Email queue = 2 (lowest default priority)
Based on your business needs, you can assign the desired priority for each queue.

Queue
Description

Enter a description or note to remind you of the purpose of this queue.

Post-
Processing
Timeout

Choose how long 8x8 Contact Center must wait before assigning a new interaction from the queue
to an agent who has just completed an interaction.
The post-processing timeout enables agents servicing the selected queue to perform any
necessary post-interaction tasks before receiving a new interaction. Choose Manual to enable
agents assigned to this queue to use their 8x8 Agent Console to explicitly make themselves
available for new interactions. When there are multiple agents available with the same queue and
skill level assignment waiting to receive the next interaction, 8x8 Contact Center routes the call to
the agent who has been idle the longest. For details, see our content on how to reset idle timer for
agents.

4. ClickSave.

After you define the queue properties, you are ready to assign members to the queue.
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Assign chat queue members

When 8x8 Contact Center administrators assign members to a chat queue, they allow them to process chat interactions
that are initiated by customers and enter the queue. The queue uses skill-based routing to route the chat interactions
based on the agent's skill sets. An agent with a higher skill level receives an interaction before an agent with a lower skill
level does.

Go to Queues/Skills > Chat > Members in 8x8 Configuration Manager to add, modify, or remove agents.

To assign members to a chat queue:

1. From the Configuration Menu, openQueues/Skills.

2. Find the chat queue you wish to assign members to, and click .

3. Go to theMembers tab.

4. Select Assign All to assign all agents to the queue.
OR
Select Agents assigned to choose the desired agents only.

5. Click the Skill level for the agent serving the queue.
The skill level can be selected from 10 to 100 (lowest to highest).
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The following table summarizes the options underQueues/Skills > Chat > Members:

Members
Tab
Option

Description

Assign
All

Assigns all existing agents to this queue.

Enable All To activate routing of interactions from this queue to all agents assigned to the queue.

Agents For the selected queue, in the list of agents:

n Select Assign All to assign all agents to the queue.

n Select an individual agent to add that agent to the queue.

Skill
Level

Indicates the skill level of the agent for that queue. The skill level determines the routing of
interactions within a queue. 8x8 Contact Center attempts to direct interactions to an agent with a
higher skill level before directing them to an agent with a lower skill level. Skill levels are now
indicated by ten numerical values ranging from 10 to 100 with an increment of 10, with 10 being the
lowest value and 100 being the highest. Assign the agent's skill level from the drop-down menu of
options.

Agents
Assigned

Assigns the selected agents to this queue.

Agents
Enabled

Activates routing of interactions from this queue to selected agents assigned to the queue. You can
assign but temporarily disable an agent.

6. ClickSave.
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Configure chat queue greetings via ICR

Interactive Chat Response (ICR) refers to an automatic response from 8x8 Contact Center to a customer's new chat
request. Alternatively, you can use a chat script to design and control the chat flow. For details, refer to Enhanced Chat
Script.

You can configure your chat response to collect some key data that identifies the customer before channeling the chat
request to the chat queue. For example, you can gather a customer's unique account number and pass this information
to agents while offering the chat interaction. Based on the account number, an agent can quickly view the customer
information, and then accept the request. If an agent rejects a chat request, the request enters the queue again to be
offered to the next available agent.

If a customer submits a chat request during closed hours, you can configure an alternative greeting to inform the
customer of business hours.

The ICR capability allows you to specify:

n CRM data to collect from a choice of options.

n A greeting to welcome customers, and a question to collect the desired CRM data.

n An open hour schedule for the chat media.

n An optional alternative greeting based on the specified schedule.

Go to Queues/Skills > Chat > ICR to specify a unique message for the chat interactions received during the open and
closed hours.

To configure chat queue greetings:

1. From the Configuration Menu, openQueues/Skills.

2. Find the chat queue you wish to modify, and click .
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3. Go to the ICR tab.

4. (Optional) ClickData to collect to select a field from the CRM customer data.
You can allow a chat request to enter the queue without collecting any customer data.

5. (Optional) Type yourMain Greeting to welcome customers.
You can also add a question to collect the desired CRM data.

6. EnableOpen hour schedule to specify a custom schedule and process chat interactions.

7. Enter anAlternative Greeting for the closed business hours. Alternative greetings do not apply to businesses
that operate 24/7.
The following table summarizes the options underQueues/Skills > Chat > ICR:

ICR Tab
Option

Description

Data to
Collect

Choose the CRM data 8x8 Contact Center prompts the user to submit before originating a new chat
interaction.
Choosing an entry enables the Main Greeting text entry area.

Main
Greeting

To enable the Main Greeting text entry area, select a value for Data to Collect.
In the Main Greeting, type a greeting message sent by 8x8 Contact Center at the start of a new chat
interaction.
By default, 8x8 Contact Center responds to a new chat interaction with the contents of the Main
Greeting text entry area during both open and closed hours. To enable 8x8 Contact Center to
respond with an alternative greeting during closed hours of operation, select Open Hour Schedule,
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ICR Tab
Option

Description

described later in this table.

Open Hour
Schedule

If enabled, both scheduling and Alternative Greeting are activated. Choose the hours of operation
for the chat queue. 8x8 Contact Center responds to new chat interactions with the greeting from
the Main Greeting text entry area during open hours, and from the Alternative Greeting area during
closed hours.

Alternative
Greeting

To enable Alternative Greeting, you must enable Open Hour Schedule.
In Alternative Greeting, type a greeting message sent by 8x8 Contact Center in response to a new
chat interaction received during closed hours.

8. ClickSave.
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Set up chat queue message priority

8x8 Contact Center administrators can set up custom priority for interactions in the queue based on the conditions they
define. If an interaction meets the condition, it takes a higher or a lower priority than the default priority of the queue. To
take advantage of this feature, you must use the Local CRM. Go to the Interactions tab in 8x8 Configuration Manager
to customize how the selected queue prioritizes specific types of interactions.

For example, AcmeJets has a support chat queue with a default priority set to 6.

This queue handles support inquiries from all customers. To better serve its premium customers before others,
AcmeJets can define a higher interaction priority for interactions from premium customers by setting a condition to
determine the customer type. When an interaction meets the condition, the interaction priority overrides the default
priority of the queue, allowing agents to serve the premium customers faster.

To define custom priority for interactions:

1. From the Configuration Menu, openQueues/Skills.

2. Find the chat queue you wish to modify, and click .

3. Go to the Interactions tab.

4. Select a value for Set Default Interaction Priority within the Queue.
The following table summarizes the options underQueues/Skills > Chat > Interaction:
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Interactions Tab
Option

Description

Set default
interaction priority
within the queue

To customize the priority for specific types of interactions within this queue, choose a
non-default priority level, then in the condition area, specify the conditions that receive
the non-default priority.
In the list, 1 equals the lowest default interaction priority, and 100 equals the highest
interaction priority.

Add Interaction Rule Click to create an interaction priority rule.

If the value of the
field

Choose a Local CRM field to enable the options available in the equals list such as Case:
Priority.
For details, refer to Configure CRM Fields.

equals The values in this field varies based on what field you choose for Local CRM. For
example, for Case: Priority in the CRM field, you can choose Low, Medium, or High.

Set interaction
priority to

Choose a priority level for the interaction from 1 (lowest) to 100 (highest).

Enable priority
routing rule

Select to enable the routing rule in your 8x8 Contact Center.

5. Define an interaction rule to specify a matching condition.

a. Click or Interaction Rule.

b. Select a CRM field for If value of the field, such as Case: Priority.

c. Select a value for equals. For example, for Case: Priority in the CRM field, you can choose Low, Medium, or
High.

d. Choose a value for Set interaction priority to from 1 to 100.
This number sets the priority of the interactions that match the rule. For example, a platinum support
customer gets a high priority, such as 90.

e. Select the Enable priority routing rule check box to activate the rule.

f. ClickAdd this Rule.
The interaction rule appears in the list.

6. Repeat the above procedure to add more rules.

7. ClickSave.
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Define chat queue SLA

The Service Level Agreement (SLA) of an 8x8 Contact Center queue defines the target performance metrics of the
queue. It includes the percentage of interactions processed within a specified time interval. You can set a target service
level for each queue via 8x8 Configuration Manager, and periodically evaluate the service level. You can also set up an
alert notification to show if the service level falls below the specified threshold.

To define Service Level Agreement for a chat queue:

1. From the Configuration Menu, openQueues/Skills.

2. Find the chat queue you wish to modify, and click .

3. Go to the SLA tab.

The following table summarizes the options underQueues/Skills > Chat > SLA:You can also choose to alert an
agent if a customer has been waiting for a reply in chat for a certain amount of time.

SLA Tab Option Description

% of interactions
should be
processed
within

To specify the Service Level Agreement (SLA) threshold for the selected queue:

1. Type a percentage value as an integer from 0 to 100 percent, such as 40.

2. Type an integer number to indicate the time interval.

3. Choose the units of time specified by this value.
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SLA Tab Option Description

The valid time intervals are:

n For Phone and Chat queues: Seconds, Minutes, or Hours

n For Email and Voicemail queues: Minutes or Hours

Evaluate service
level every

Choose how frequently 8x8 Contact Center compares the queue's performance to the SLA
threshold defined for the queue.

Send email
notification to

Type one or more comma-separated email addresses that should receive email notifications
from 8x8 Contact Center. The email is sent when the queue's performance level falls below
the performance threshold specified for the queue.

4. ClickSave.
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Configure chat queue email fallback

Stagnating chat requests in a queue for too long is not desirable to customers. If an 8x8 Contact Center chat request
has been waiting in the queue for too long, as a fallback option, you can offer to send it as an email rather than continue
waiting for a chat agent.

in 8x8 Configuration Manager, admins can:

n Enable email fallback for a chat queue.

n Specify a duration after which to offer the waiting chat requests the option to send an email.

n Select a message prompting for email, and a message confirming the sent mail.

n Specify after-hours email settings.

To configure email fallback for a chat queue:

1. From the Configuration Menu, openQueues/Skills.

2. Find the chat queue you wish to modify, and click .

3. Go to the Email tab.

The following table summarizes the options underQueues/Skills > Chat > Email:
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Email Tab Option Description

Enable Email If selected, 8x8 Contact Center offers the option of sending an email message for
the overflow chat interactions instead of waiting.

Offer Email after Select a time period from the menu to indicate how long a chat interaction must wait
in the chat queue before being offered the option of sending an email.

Email Prompt Msg Type the question 8x8 Contact Center asks the users when offering the overflow
chat interactions the option of sending email.
For example: "All our agents are busy. Would you like to send an email?"

Email Sent Msg Type the confirmation message sent by 8x8 Contact Center after receiving an email
message from an overflow chat interaction.
For example: "Thank you; your email has been sent."

Send Email to Channel Select the destination email channel to send messages sent from an overflow chat
interaction.

Force email after office
hours

Select to automatically direct the user to send an email message whenever the chat
queue is closed for business.
For details on configuring chat queue hours of operation, refer to Configure Chat
Queue Greetings via ICR.

Enable survey when
forcing after office hours
email

This option is enabled only if you select Force email after office hour first.
If enabled, the overflow chat interaction is offered the opportunity to complete a
customer chat survey. This requires the chat survey to be set up in the Support
Center.
For details on setting up chat survey in the Support Center, refer to Summary of
Support Center Properties Tab Options.

Force email header
message

This option is enabled only if you select Force email after office hour first. Type
the header of the email messages you want to send.
For example: "A chat interaction could not be serviced because it was received
during the closed hours."

4. ClickSave.
With this step, the chat queue configuration is complete.
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Create email queues

8x8 Contact Center supports email media allowing agents to process email interactions in a timely manner similar to
processing phone calls. Emails directed to a specified email address of your contact center enter an email queue. In
turn, the queue offers these interactions to its members based on their skill set and availability. You can set up any
email address to serve as your email channel.

Configuring an email queue in 8x8 Configuration Manager involves:

n Defining email queue properties

n Assigning email queuemembers

n Setting up email queuemessage priority

n Defining email queue SLA
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Define email queue properties

8x8 Contact Center administrators define an email queue with the primary properties, such as queue name, default
priority, email processing timeout, and more. The Properties tab in 8x8 Configuration Manager under Queues/Skills
> Email allows administrators to define these properties.

To define email queue properties:

1. From the Configuration Menu, openQueues/Skills.

2. Click or Email.

3. Enter the desired properties in the Properties tab.
The following table summarizes the options underQueues/Skills > Email > Properties:

Properties
Tab Option

Description

Queue
Type

Read-only reminder of the type of queue.

Queue
Name

Enter a name for the queue.

Default
Priority

Choose the priority for this queue, where 1 specifies the lowest priority and 10 specifies the
highest priority. This defines the priority for interactions of all media.
By default, 8x8 Contact Center prioritizes the queues as follows:

n Phone queue = 8 (highest default priority)

n Chat queue = 6

n Voicemail queue = 4

n Email queue = 2 (lowest default priority)
Based on your business needs, you can assign the desired priority for each queue.

Email
Processing
Timeout

Choose how long 8x8 Contact Center must wait before assigning a new interaction from the queue
to an agent who has just completed an interaction.
The post-processing timeout enables agents servicing the selected queue to perform any
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Properties
Tab Option

Description

necessary post-interaction tasks before receiving a new interaction. Choose Manual to enable
agents assigned to this queue to use their 8x8 Agent Console to explicitly make themselves
available for new interactions. When there are multiple agents available with the same queue and
skill level assignment waiting to receive the next interaction, 8x8 Contact Center routes the call to
the agent who has been idle the longest. For details, see our content on how to reset idle timer for
agents.

Queue
Signature

Type the default signature appended to all email responses sent by an agent in response to an
email interaction.

4. ClickSave.

After you define the queue properties, you are ready to assign members to the queue.

Version 9.14 249

Define email queue properties



Assign email queue members

When 8x8 Contact Center administrators assign members to an email queue, they allow the members to receive emails
that enter the queue. The queue uses skill-based routing to route the emails based on the agent's skill set. An agent
with a higher skill level receives an interaction before an agent with a lower skill level does.

Go to Queues/Skills > Email > Members in 8x8 Configuration Manager to add, modify, or remove agents.

To assign members to an email queue:

1. From the Configuration Menu, openQueues/Skills.

2. Find the email queue you wish to assign members to, and click .

3. Go to theMembers tab.

4. Select Assign All to assign all agents to the queue.
OR
Select Agents assigned to choose the desired agents only.

5. Click the Skill level for the agent serving the queue.
The skill level can be selected from 10 to 100 (lowest to highest).

The following table summarizes the options underQueues/Skills > Email > Members:
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Members
Tab
Option

Description

Assign
All

Assigns all existing agents to this queue.

Enable All To activate routing of interactions from this queue to all agents assigned to the queue.

Agents For the selected queue, in the list of agents:

n Select Assign All to assign all agents to the queue.

n Select an individual agent to add that agent to the queue.

Skill
Level

Indicates the skill level of the agent for that queue. The skill level determines the routing of
interactions within a queue. 8x8 Contact Center attempts to direct interactions to an agent with a
higher skill level before directing them to an agent with a lower skill level. Skill levels are now
indicated by ten numerical values ranging from 10 to 100 with an increment of 10, with 10 being the
lowest value and 100 being the highest. Assign the agent's skill level from the drop-down menu of
options.

Agents
Assigned

Assigns the selected agents to this queue.

Agents
Enabled

Activates routing of interactions from this queue to selected agents assigned to the queue. You can
assign but temporarily disable an agent.

6. Select Agents enabled or Enable All to activate routing of interactions from this queue to the selected agents.

7. ClickSave.
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Set up email queue message priority

8x8 Contact Center administrators can set up custom priority for interactions in the queue based on the conditions they
define. If an interaction meets the condition, it takes a higher or a lower priority than the default priority of the queue. To
take advantage of this feature, you must use the Local CRM. Go to the Interactions tab in 8x8 Configuration Manager
to customize how the selected queue prioritizes specific types of interactions.

For example, AcmeJets has an email support queue with a default priority set to 2.

This queue handles support inquiries from all customers. To better serve its premium customers before others,
AcmeJets can define a higher interaction priority for interactions from premium customers by setting a condition to
determine the customer type. When an interaction meets the condition, the interaction priority overrides the default
priority of the queue, allowing agents to serve the premium customers faster.

To define custom priority for interactions:

1. From the Configuration Menu, openQueues/Skills.

2. Find the email queue you wish to modify, and click .

3. Go to the Interactions tab.

4. Select a value for Set Default Interaction Priority within the Queue.
The following table summarizes the options underQueues/Skills > Outbound Phone > Interactions:
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Interactions Tab
Option

Description

Set default
interaction priority
within the queue

To customize the priority for specific types of interactions within this queue, choose a
non-default priority level, then in the condition area, specify the conditions that receive
the non-default priority.
In the list, 1 equals the lowest default interaction priority, and 100 equals the highest
interaction priority.

Add Interaction Rule Click to create an interaction priority rule.

If the value of the
field

Choose a Local CRM field to enable the options available in the equals list such as Case:
Priority.
For details, refer to Configure CRM Fields.

equals The values in this field varies based on what field you choose for Local CRM. For
example, for Case: Priority in the CRM field, you can choose Low, Medium, or High.

Set interaction
priority to

Choose a priority level for the interaction from 1 (lowest) to 100 (highest).

Enable priority
routing rule

Select to enable the routing rule in your 8x8 Contact Center.

5. Define an interaction rule to specify a matching condition.

a. Click or Interaction Rule.

b. Select a CRM field for If value of the field, such as Case: Priority.

c. Select a value for equals. For example, for Case: Priority in the CRM field, you can choose Low, Medium, or
High.

d. Choose a value for Set interaction priority to from 1 to 100.
This number sets the priority of the interactions that match the rule. For example, a platinum support customer
gets a high priority, such as 90.

e. Select the Enable priority routing rule check box to activate the rule.

f. ClickAdd this Rule.
The interaction rule appears in the list.

6. Repeat the above procedure to add more rules.

7. ClickSave.
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Define email queue SLA

The Service Level Agreement (SLA) of an 8x8 Contact Center queue defines the target performance metrics of the
queue. It includes the percentage of interactions processed within a specified time interval. You can set a target service
level for each queue via 8x8 Configuration Manager, and periodically evaluate the service level. You can also set up an
alert notification to show if the service level falls below the specified threshold.

To define SLA for an email queue:

1. From the Configuration Menu, openQueues/Skills.

2. Find the email queue you wish to modify, and click .

3. Go to the SLA tab.

The following table summarizes the options underQueues/Skills > Email > SLA:

SLA Tab Option Description

% of interactions
should be
processed
within

To specify the Service Level Agreement (SLA) threshold for the selected queue:

1. Type a percentage value as an integer from 0 to 100 percent, such as 40.

2. Type an integer number to indicate the time interval.

3. Choose the units of time specified by this value.
The valid time intervals are:
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SLA Tab Option Description

n For Phone and Chat queues: Seconds, Minutes, or Hours

n For Email and Voicemail queues: Minutes or Hours

Evaluate service
level every

Choose how frequently 8x8 Contact Center compares the queue's performance to the SLA
threshold defined for the queue.

Send email
notification to

Type one or more comma-separated email addresses that should receive email notifications
from 8x8 Contact Center. The email is sent when the queue's performance level falls below
the performance threshold specified for the queue.

4. ClickSave.
With this step, the queue configuration is complete.
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Create voicemail queues

8x8 Contact Center supports processing voicemails similar to phone calls. Voicemails left for 8x8 Contact Center are
directed to a voicemail queue. In turn, the queue offers voicemails to agents based on their skill set and availability.

Configuring a Voicemail queue in 8x8 Configuration Manager involves:

n Defining voicemail queue properties

n Assigning voicemail queuemembers

n Configuring voicemail delivery message

n Setting up voicemail queuemessage priority

n Defining voicemail queue SLA

n Configuring voicemail notification
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Define voicemail queue properties

8x8 Contact Center administrators define a voicemail queue by specifying the primary properties such as queue name,
default priority, post-processing timeout, and more. The Properties tab in 8x8 Configuration Manager under
Queues/Skills > Voice Mail allows administrators to specify the primary properties of the voicemail queue.

To define voicemail queue properties:

1. From the Configuration Menu, openQueues/Skills.

2. Click or Voice Mail.

3. Enter the desired properties in the Properties tab.

The following table summarizes the options underQueues/Skills > Voice Mail > Properties:

Properties
Tab option

Description

Queue type Read-only reminder of the type of queue.

Queue
name

Enter a name for the queue.

Default
Priority

Choose the priority for this queue, where 1 specifies the lowest priority and 10 specifies the
highest priority. This defines the priority for interactions of all media.
By default, 8x8 Contact Center prioritizes the queues as follows:

n Phone queue = 8 (highest default priority)

n Chat queue = 6
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Properties
Tab option

Description

n Voicemail queue = 4

n Email queue = 2 (lowest default priority)
Based on your business needs, you can assign the desired priority for each queue.

Post-
Processing
Timeout

Choose how long 8x8 Contact Center must wait before assigning a new interaction from the queue
to an agent who has just completed an interaction.
The post-processing timeout enables agents servicing the selected queue to perform any
necessary post-interaction tasks before receiving a new interaction. Choose Manual to enable
agents assigned to this queue to use their 8x8 Agent Console to explicitly make themselves
available for new interactions. When there are multiple agents available with the same queue and
skill level assignment waiting to receive the next interaction, 8x8 Contact Center routes the call to
the agent who has been idle the longest. For details, see our content on how to reset idle timer for
agents.

4. ClickSave.

After you define the queue properties, you are ready to assign members to the queue.
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Assign voicemail queue members

When 8x8 Contact Center administrators assign members to a voicemail queue, they allow them to process voicemail
interactions that enter the queue. The queue uses skill-based routing to route the voicemail based on the agent's skill
set. An agent with a higher skill level receives an interaction before an agent with a lower skill level does.

Go to Queues/Skills > Voice Mail > Members in 8x8 Configuration Manager to add, modify, or remove agents.

To assign members to a voicemail queue:

1. From the Configuration Menu, openQueues/Skills.

2. Find the voicemail queue you wish to assign members to, and click .

3. Go to theMembers tab.

4. Select Assign All to assign all agents to the queue.
OR
Select Agents assigned to choose the desired agents only.

5. Click the Skill level for the agent serving the queue.
The skill level can be selected from 10 to 100 (lowest to highest).

The following table summarizes the options underQueues/Skills > Voicemail > Members:
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Members
Tab
Option

Description

Assign
All

Assigns all existing agents to this queue.

Enable All To activate routing of interactions from this queue to all agents assigned to the queue.

Agents For the selected queue, in the list of agents:

n Select Assign All to assign all agents to the queue.

n Select an individual agent to add that agent to the queue.

Skill
Level

Indicates the skill level of the agent for that queue. The skill level determines the routing of
interactions within a queue. 8x8 Contact Center attempts to direct interactions to an agent with a
higher skill level before directing them to an agent with a lower skill level. Skill levels are now
indicated by ten numerical values ranging from 10 to 100 with an increment of 10, with 10 being the
lowest value and 100 being the highest. Assign the agent's skill level from the drop-down menu of
options.

Agents
Assigned

Assigns the selected agents to this queue.

Agents
Enabled

Activates routing of interactions from this queue to selected agents assigned to the queue. You can
assign but temporarily disable an agent.

6. Select Agents enabled or Enable All to activate routing of interactions from this queue to the selected agents.

7. ClickSave.
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Configure voicemail delivery message

When an 8x8 Contact Center agent accepts a voicemail interaction, a voicemail deliverymessage is played to inform
the agent that a voicemail message is being offered. With the default setting, a prompt is offered to the agent to press 1
to receive the voicemail as an email attachment, or hang up to delete the voicemail. However, you can upload a custom
voicemail deliverymessage and configure it to suit your contact center's needs. You can also configure to email the
voicemail to one or multiple email addresses using 8x8 Configuration Manager.

To define interactive voicemail in 8x8 Configuration Manager:

1. From the Configuration Menu, openQueues/Skills.

2. Find the voicemail queue you wish to modify, and click .

3. Go to the IVR tab.

The following table summarizes the options underQueues/Skills > Voicemail > IVR:

IVR Tab Option Description

Voice Mail
Delivery
Message
(Played to
Agent)

Select a message to be played by 8x8 Contact Center to inform the agent of a voicemail
message waiting in the queue.
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IVR Tab Option Description

Upload Custom Click Upload Custom to upload a custom voicemail delivery message.

Play Audio Click Play Audio to play the currently selected voicemail delivery message.

Delete Voice
Mail

To enable Delete Voice Mail, you must upload a custom voicemail delivery message first.

n Select On hang up to delete a queued voicemail message after the agent hangs up.

n Select On agent confirmation to delete a queued voicemail message after the agent
presses the telephone's * key.

Send Voice Mail
by E-mail

To enable Send Voice Mail by Email, you must upload a custom voicemail delivery
message first. You can enter the agent's email address, or send it to more than one email by
entering multiple addresses separated by comma (,) or semicolon (;).

n Select Never to never send a queued voicemail message to an agent as an email
attachment.

n Select On request to enable an agent to request that 8x8 Contact Center send a queued
voicemail message as an email attachment.

n Select Always to always send a queued voicemail message to an agent as an email
attachment.

4. ClickSave.

Version 9.14 262

Configure voicemail delivery message



Set up voicemail queue message priority

8x8 Contact Center administrators can set up custom priority for interactions in the queue based on the conditions they
define. If an interaction meets the condition, it takes a higher or a lower priority than the default priority of the queue. To
take advantage of this feature, you must use the Local CRM. Go to the Interactions tab in 8x8 Configuration Manager
to customize how the selected queue prioritizes specific types of interactions.

For example, AcmeJets has a support voicemail queue with a default priority set to 50.

This queue handles support inquiries from all customers. To better serve its premium customers before others,
AcmeJets can define a higher interaction priority for interactions from premium customers by setting a condition to
determine the customer type. When an interaction meets the condition, the interaction priority overrides the default
priority of the queue, allowing agents to serve the premium customers faster.

To define custom priority for interactions:

1. From the Configuration Menu, openQueues/Skills.

2. Find the voicemail queue you wish to modify, and click .

3. Go to the Interactions tab.

4. Select a value for Set Default Interaction Priority within the Queue.
The following table summarizes the options underQueues/Skills > Voicemail > Interactions:
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Interactions Tab
Option

Description

Set default
interaction priority
within the queue

To customize the priority for specific types of interactions within this queue, choose a
non-default priority level, then in the condition area, specify the conditions that receive
the non-default priority.
In the list, 1 equals the lowest default interaction priority, and 100 equals the highest
interaction priority.

Add Interaction Rule Click to create an interaction priority rule.

If the value of the
field

Choose a Local CRM field to enable the options available in the equals list such as Case:
Priority.
For details, refer to Configure CRM Fields.

equals The values in this field varies based on what field you choose for Local CRM. For
example, for Case: Priority in the CRM field, you can choose Low, Medium, or High.

Set interaction
priority to

Choose a priority level for the interaction from 1 (lowest) to 100 (highest).

Enable priority
routing rule

Select to enable the routing rule in your 8x8 Contact Center.

5. Define an interaction rule to specify a matching condition.

a. Click or Interaction Rule.

b. Select a CRM field for If value of the field, such as Case: Priority.

c. Select a value for equals. For example, for Case: Priority in the CRM field, you can choose Low, Medium, or
High.

d. Choose a value for Set interaction priority to from 1 to 100.
This number sets the priority of the interactions that match the rule. For example, a platinum support customer
gets a high priority, such as 90.

e. Select the Enable priority routing rule check box to activate the rule.

f. ClickAdd this Rule.
The interaction rule appears in the list.

6. Repeat the above procedure to add more rules.

7. ClickSave.

Version 9.14 264

Set up voicemail queue message priority



Define voicemail queue SLA

The Service Level Agreement (SLA) of an 8x8 Contact Center queue defines the target performance metrics of the
queue. It includes the percentage of interactions processed within a specified time interval. You can set a target service
level for each queue via 8x8 Configuration Manager, and periodically evaluate the service level. You can also set up an
alert notification to show if the service level falls below the specified threshold.

To define Service Level Agreement for a voicemail queue:

1. From the Configuration Menu, openQueues/Skills.

2. Find the voicemail queue you wish to modify, and click .

3. Go to the SLA tab.

4. Enter values for SLA.
The following table summarizes the options underQueues/Skills > Voicemail > SLA:

SLA Tab Option Description

% of interactions
should be
processed
within

To specify the Service Level Agreement (SLA) threshold for the selected queue:

1. Type a percentage value as an integer from 0 to 100 percent, such as 40.

2. Type an integer number to indicate the time interval.

3. Choose the units of time specified by this value.
The valid time intervals are:

n For Phone and Chat queues: Seconds, Minutes, or Hours

n For Email and Voicemail queues: Minutes or Hours

Evaluate service
level every

Choose how frequently 8x8 Contact Center compares the queue's performance to the SLA
threshold defined for the queue.

Send email
notification to

Type one or more comma-separated email addresses that should receive email notifications
from 8x8 Contact Center. The email is sent when the queue's performance level falls below
the performance threshold specified for the queue.

5. ClickSave.
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Configure voicemail notification

By default, 8x8 Contact Center voicemails are sent to the queues and offered to the next available agent. 8x8 Contact
Center administrators can configure voicemail to be sent asWAV file attachments directly to an email address. With
this setup, agents do not have to retrieve voicemails from a queue. Or, you can configure voicemail in 8x8 Configuration
Manager to be automatically removed from a queue. An email notification for a voicemail is generated as a result of:

n Voicemail Queue Notification:When a caller leaves a voicemail via a voicemail queue, an email notification is
sent to the email address configured for the voicemail queue.

n IVR Settings for Voicemail:A voicemail being sent to an agent from the voicemail queue. The agent requests
an email to be sent to the agent.

n Transferring to Agent Voicemail:A voicemail being sent to an agent after the caller calls and leaves a voicemail
in the agent’s voice box.

The voicemail email notification provides the transaction ID, allowing you to track the queued voicemails better.
Additionally, you can retrieve the following information from a voicemail notification sent by email:

n Tenant name

n Cluster ID

n Phone queue ID

n Voicemail queue ID

n Calling name

n Interaction GUID of the inbound phone queue

n Transaction ID of the inbound phone interaction

n Voicemail begin offset

n Filename

n Agent name
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n Voicemail retrieval delay

To configure voicemail notification:

1. From the Configuration Menu, openQueues/Skills.

2. Find the voicemail queue you wish to modify, and click .

3. Go to theNotification tab.

4. Select Enabled to enable the notification.

5. Specify the Email Address(es) to which voicemail attachmentsmust be sent.
The following table summarizes the options underQueues/Skills > Voicemail > Notification:

Notification
Tab Option

Description

Enabled To enable voicemail notification sent by email regardless of the agent status.

Email
Addresses

To send voicemail in an email attachment to the specified email addresses.

Delete
from

If enabled, it automatically removes the voicemail from the queue after sending an email
attachment.
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Notification
Tab Option

Description

Queue If disabled, it sends a voicemail to the specified email address and forwards it to the voicemail
queue. When the agent logs in to 8x8 Agent Console, the voicemail is presented in the queue.

6. CheckDelete from queue to delete the voicemail from the voicemail queue after sending the email attachments.

7. ClickSave.
With this step, the configuration of a voicemail queue is complete.
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Create and configure channels

An 8x8 Contact Center channel facilitates communication of interactions in and out of a 8x8 Contact Center tenant.
When an interaction comes to the channel via phone, email, chat, or social media, it is directed to the appropriate
queues via skill-based routing rules. For example, a phone channel directs inbound phone calls from customers to
contact center agents, or an email channel is an email address that your customers use to send email requests to the
contact center.

8x8 Contact Center supports interactions of all media via 8x8 Configuration Manager:

n Phone: Process inbound and outbound phone interactions using the phone channels. A phone channel is
automatically crated when a number is ordered for the tenant through provisioning

n Email: Process inbound and outbound email interactions using the email channels. Email channels are created by
the 8x8 Contact Center administrator in 8x8 Contact Center.

n Chat: Process incoming chat requests using the chat channels and direct chat requests from customers to contact
center agents. Chat channels are created by the 8x8 Contact Center administrator in 8x8 Contact Center.

n Social: Process incoming chat requests from Facebook and Twitter and allow agents to accept and handle chat
requests from social media. Social channels are created by the 8x8 Contact Center administrator in 8x8 Contact
Center.

n SMS: Processmessages routed via SMS channels and chat queues to agents, and offered to them as chat
interactions for responses. Agents look up customer records from an existing customer. They can look up
outstanding cases and history of interactions to handle the conversation effectively.

n Chat API: Connect directly to an agent from your own system such as enabling your clients to communicate with
an agent from mobile app-based chat, Desktop web chatbots, and messaging via integrations with other apps or
platforms. See our content on chat workflow for developers.

Create and configure channels
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Features
n Facilitate communication of interactions in and out of a 8x8 Contact Center tenant.

n Interact directly with the appropriate queues via skill-based routing rules.

n Create automatic phone channels through provisioning with every new order of telephone numbers.

n Configure existing phone numbers and email addresses to function as 8x8 Contact Center channels.

n Direct messages received in Facebook and Twitter to the chat channels in 8x8 Contact Center.

n Create, edit, and delete email, chat, and social channels, while the phone channels can only be edited.

Creating channels involves:

n Setting up phone channels

n Setting up email channels

n Setting up chat channels

n Setting up social channels

n Setting up SMS channels

n Assigning scripts to channels

Note:You can add email and chat channels from 8x8 ConfigurationManager, but not any phone
channels.
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Set up phone channels

An 8x8 Contact Center phone channel processes inbound phone interactions in an 8x8 Contact Center tenant via
Service Channels. A Service channel is a regular phone channel associated with a telephone number. It is
automatically created when a number is ordered for the tenant through provisioning. You can edit a service channel,
and enable or disable it in 8x8 Configuration Manager. An IVR script is linked to the service channel by default.

Phone channels in the 8x8 Contact Center define phone numbers that your customers use to call your contact center.

Service phone channels can only be added or removed from your 8x8 Contact Center tenant by a 8x8 Contact Center
representative. The representative coordinates the acquisition and routing of the phone number to the 8x8 platform that
hosts your tenant.

Features
n Facilitate inbound phone interactions in a 8x8 Contact Center tenant via Service channels.

n Interact directly with the appropriate phone queues via skill-based routing rules.

n Automatic creation of Service channels with numbers ordered for the tenant through provisioning.

n Ability to edit enable, and disable Service channels via 8x8 Configuration Manager.

n Access to a default IVR script linked to the Service channel.

Setting up a phone channel involves:

n Configuring phone channel properties

n Creating a phone IVR script

n Assigning a script to the phone channel
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Configure phone channel properties

Configuring an 8x8 Contact Center phone channel involves:

n Configuring channel properties.

n Creating a phone IVR script.

To configure the properties for a phone channel in 8x8 Configuration Manager, you must specify the channel name,
choose a phone format, and select the phone script for the channel. You can define a new script or copy an existing one
in the tenant. A script refers to instructions that specify call treatment choices.

Go toChannels > Phone > Properties to specify the primary properties of the phone channel. 8x8 Configuration
Manager displays a list of Service Channels under Channels > Phone.

To configure phone channel properties:

1. From the Configuration Menu, openChannels.

2. Go to the Phone tab.

3. From the list of channels, select a Service phone channel, and click .

The Properties tab opens.

4. Enter or select values for the channel.
The following table summarizes the options underChannels > Phone > Properties:
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Service
Phone
Channel
Property

Description

Channel Type Read-only reminder of the type of channel.

Number Read-only reminder of the channel's phone number.
8x8 defines your phone numbers when it provisions your 8x8 Contact Center tenant.

Calling Name
Display

Read-only reminder. Refers to the Calling Name Display (CNAM) that is used when the
outbound calls use the associated public number as outgoing Calling Line ID (CLI).

Channel name Type the name of this phone channel.
Read-only agent name; also represents the channel name that is linked to the agent's public or
PBX number. 8x8 Agent Console displays the channel name when the agent receives an
incoming phone interaction.

Display phone
format

Select the phone display format. 8x8 Agent Console uses this format to display the inbound
phone numbers:

n US standard [x-xxx-xxx-xxxx] (the default display mode)

n US short [xxx-xxxx]

n Australian (6 digits) [xx-xx-xx]

n Australian (8 digits) [xxxx-xxxx]

n Australian (10 digits) [xx-xxxx-xxxx]

n French standard [xx-xx-xx-xx-xx]

n No format [*]

IVR Script You can select the default IVR script from the drop-down menu or select any existing IVR script
in the tenant.

Note: for best practice, create an IVR script first, and then configure the channel.

Link Channel
to an agent

Allows you to link this phone channel to an agent. By clicking the link, a list of agents shows up.
You can select an agent and click Assign to create a personal channel to the agent.

This channel
is enabled

Select to enable this channel for service.
Enable a channel only after your contact center is ready to receive interactions on the channel.
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5. ClickSave.
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Set up email channels

An 8x8 Contact Center email channel defines an email address that your customers use to send email requests to the
contact center, such as support@acmejets.com. When you configure an email channel in 8x8 Configuration Manager,
you specify the POP3 or IMAP protocols for receiving email or use modern authentication methods likeOAuth2 for
users of Microsoft.

Features
n Facilitate communication of email interactions in and out of a 8x8 Contact Center tenant.

n Interact directly with the appropriate queues via skill-based routing rules.

n Configure existing email addresses to function as 8x8 Contact Center channels.

n Create, edit, and delete email channels.

n Email channel's script specifies which 8x8 Contact Center queues receive the retrieved messages

Use dedicated contact center email channels
The email accounts used in conjunction with your 8x8 Contact Center must be used only for that purpose. Do not log in
or access your contact center's email channel from outside of 8x8 Contact Center.

The email channel's email script specifies which 8x8 Contact Center queues receive those retrieved messages.

Setting up an email channel involves:

1. Configuring email channel properties

2. Creating an email script

3. Assigning a script to the email channel
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Configure email channel properties

Configuring an 8x8 Contact Center email channel involves:

n Configuring an email channel properties

n Creating an email script

To configure properties for an email channel go toChannels > Email > Properties in 8x8 Configuration Manager.
You must enter a channel name, an incoming email address, authentication type, the incoming mail server properties,
POP3 or IMAP protocol, user ID and password for the email account, and the email script used for the channel. An
email script directs emails entering 8x8 Contact Center to agents via email queues.

For details, see our content about Enhance outgoing email settings for channels and agents via SMTP.

To configure email channel properties:

1. From the Configuration Menu, openChannels.

2. Go to the Email tab.
A new column shows the Outgoing Mail Server. You can sort or filter your channels list.

3. In the list of email channels, click Add new email channel click to edit.

4. Enter or select values for the channel.
The following table summarizes the options underChannels > Email > Properties:

Email Channel
Property

Description

Channel type Read-only reminder of the type of channel.

Channel name Type the name of this email channel such as [AcmeJets Email Channel].
8x8 Agent Console displays the channel name when the agent receives an email.

Email Address Enter the full email address used by customers to submit interactions to this email channel. 

Note: When setting up an email channel with Gmail address, youmust enter an
App password in 8x8 ConfigurationManager. Without the App password you will
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Email Channel
Property

Description

get an authentication failure.

Email script If you have more than one email channel, choose another channel's previously defined
IVR script.
Choose an email script from the drop-down menu. If you do not select any scripts, the default
email script is automatically assigned to your email channel.

This Channel
is enabled

Select to enable this email channel for service.
Enable a channel only after your contact center is ready to receive interactions for this channel.

Incoming Mail Configuration

Authentication
type

n Microsoft Exchange: supports OAuth2 authentication for users of Microsoft.

n Normal: supports basic authentication for other email channels such as gmail, etc.

Incoming Mail
Server

Enter the network address of the mail server such as [imap.gmail.com]. This mail server
receives the email messages sent to the address entered for Incoming Email Address.

Protocol Choose the email protocol supported by the server.
The mail protocol valid choices are:

n POP3, POP3 over SSL

n IMAP, IMAP over SSL
When you choose an email protocol, 8x8 Configuration Manager automatically enters the
protocol's default port number under Port.

Port By default, 8x8 Configuration Manager uses the following default port numbers based on the
email protocol you select from the list:

n 110 if you select POP3

n 995 if you select POP3 over SSL

n 143 if you select IMAP 

n 993 if you select IMAP over SSL
You can enter a non-default port number if your email server uses one.

User ID Enter the username required to retrieve the email address entered for Incoming Mail Server.

Password Enter the password required to retrieve the email address entered for Incoming Mail Server. For
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Email Channel
Property

Description

email channels with a Gmail address, see how to generate and use App passwords.

Retype
Password

Verify the password required to retrieve the email address entered for Incoming Mail Server.

Outgoing Mail Configuration

Outgoing Mail
Server

A user’s outgoing mail server is automatically populated with the tenant's default SMTP server.
The default server can be either a VCC Internal server or a custom server. You can change the
SMTP server. The changes are kept unless a new default server is set.

8x8 Contact Center administrators can configure users outgoing mail servers in three ways:

n Using the VCC Internal server

n Using a custom server

n Using a custom server but overriding with the specific account's user name and password
(recommended)

If you use the VCC Internal server, you cannot override the server's default configuration,
therefore, using the email address of the server. The emails sent by this user originate from the
tenant’s default address which is not recommended.

Whereas a user that is configured to use a custom server configuration, such as [AcmeJets
SMTP Server], overrides the default server configuration . The emails sent by this user originate
from the address of the new server. By overriding the server’s default configuration you make it
more specific to the agent.

Override
Server
Configuration

This option gives you the ability to direct your emails via the specific email channel address. If
not selected, it will direct your emails via the custom SMTP server address.

Note: To ensure delivery of emails sent by agents, 8x8 Contact Center
recommends admins to use a custom SMTP server and select to override the
server configurations. The channel’s user name and password is required for this
option.

Password Enter the password required to retrieve the email address entered for Outgoing Mail Server.

Retype
Password

Verify the password required to retrieve the email address entered for Outgoing Mail Server.
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5. Click Test connection to check the connection with the mail server.
If the connection to the server is successful, a message appears to show the connection to the outgoing mail
server is successful.

6. ClickSave.

The outgoing email channel is now configured and the emails sent via this channel originate from the configured
address in your outgoing mail server. The default outgoing email channel appears under Channel list > Email. In
8x8 Agent Console, when sending an email to the customers, the agent can select this outgoing email channel.

Set up App passwords
For email channels with a Gmail address, you need to set up an App password.
To generate and use App passwords

1. Open your browser and Google Account.

2. ClickManage your Google Account.

3. On the left navigation panel, select Security.

4. On the Signing in to Google, select App passwords. If you don’t see this option, check one of the following:

n 2-Step verification is not set up for your account.

n 2-Step verification is set up for security keys only.

n Your account is through work, school, or other organization.

n You have turned on Advanced Protection for your account.
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5. In the App password window:

n ClickSelect app and choose the app you are using such asMail.

n ClickSelect device and choose the device you are using such asWindowsComputer.

6. ClickGenerate. The App password, the 16-character code is generated.

7. Follow the instructions to enter the App password.

8. ClickDone.

Enter the App password as the Gmail account password for your email channel and clickSave before testing your
connection.
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Support OAuth2 authentication for email channels

The 8x8 Contact Center authenticates email channels via basic authentication, using the simple username and
password. Email service providers like Microsoft announced plans to stop supporting basic authentication for Post
Office Protocol (POP), Internet Message Access Protocol (IMAP), and potentially for outgoing server setups (SMTP).
This requires integrators to migrate their current email client to use modern authentication methods like OAuth2. To
prepare for this security improvement, 8x8 Contact Center now supports OAuth2 authentication for users of Microsoft.
We continue to support basic authentication for existing users.

Features
n Improved security without compromising the performance on the fetching and processing of emails.

n Ability to change basic authentication to OAuth2 without any impact on the service.

n Ability to switch from OAuth2 to basic authentication if required.

Limitations
n The OAuth2 authentication is not yet implemented for SMTP.

n The OAuth2 authentication is not implemented for shared mailboxes (Microsoft)

Set upOAuth2 authentication for Microsoft Exchange
The OAuth2 authentication requires changes in the email channel configuration via 8x8 Configuration Manager. As an
8x8 Contact Center administrator, you need to select Microsoft Exchange for the incoming mail server and save.

This new feature does not impact agents. Administrators need to modify the email channels for the existing users to
implement this change. 8x8 Contact Center agents will continue to receive emails as before.

To set up OAuth2 authentication for Microsoft Exchange:

1. Log in to 8x8 Configuration Manager.

2. Go toChannels > Email.

3. In the list of email channels, clickAdd new email channel.
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4. Enter aChannel Name.

5. If you have a Microsoft Email Address, enter it here.

6. ForAuthentication type, click the drop-down list.

7. Select Microsoft Exchange.

8. ClickConnect.
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9. ClickYes to allow the 8x8 app to access your Microsoft email account.
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10. If connected to your Microsoft account successfully, your email address appears in theAccount field of 8x8
Configuration Manager.

11. ClickSave. Your email channel with OAuth2 authentication is now saved for your tenant without any impact on the
service or agents workflow.

12. To test if your email account is connected, click Test connection. A message shows the connection was
successful along with the number of received messages on the server.

If there is a connection problem, an error message notifies you. Enter the correct email address and try again.
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Note:Youmay experience some delay. Please allow a few minutes and then click test connection
again.

You can edit or delete the email channel from the main email Channel list.
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Enhance outgoing email settings for channels and agents
via SMTP

As an 8x8 Contact Center agent, when you email customers via email channel, you want to ensure that customers
receive the emails without being blocked by your outbound email servers, or the spam filters of the customer’s email
servers.

To ensure the delivery of emails sent by agents, 8x8 Contact Center now supports an enhanced configuration for
outbound mailing systems, only available for custom SMTP servers. This enhancement allows specific configuration for
each and every channel or agent, so that emails actually get signed and sent using the individual accounts. When
sending out emails, the “From” section in the email header must match the actual address used for sending out that
email, which implies using correct accounts and credentials, and the actual sender. When an agent sends an email via a
channel, it uses the channel address. When an agent sends an email via their own address, it uses the agent's
individual email address.

Prior to this release, emails were sent from a unique address and user account configured on the SMTP server. The
email address on the email header did not match the email address used to send the email, causing emails to be
blocked by spam filters.

Features
n Prevents the agent’s emails from being blocked by the outbound email servers.

n Prevents the agent's emails from going to the customer's spam and junk folder, or being blocked by spoofing filters.

n Uses one or more custom SMTP servers specifically configured for each email channel or agent.

n Uses the channel email address when agents send emails via a channel.

n Uses the agent email address when agents send email via agent's email.

Set up custom SMTP servers and configure email channels
Setting up a custom outgoing SMTP email server involves four steps. The first three steps are performed by 8x8
Contact Center administrators in the 8x8 Configuration Manager application. The fourth step is performed by the
agents in 8x8 Agent Console to complete the setup and utilize their custom email server for sending emails:
Step 1: Set up a custom outgoing SMTP email server

SMTP servers control the email delivery process of your contact center. You may use the 8x8 default VCC Internal
SMTP Server, or configure a custom server. Having a default server ensures that all outgoing emails originating from

Version 9.14 289

Enhance outgoing email settings for channels and agents via SMTP



email channels or agents will be using the default server and a single default account. Having a custom SMTP server,
however, allows email channels and agents to use distinct accounts for outgoing emails, as configured individually.

For details on server set up, see how to define a custom SMTP server.
Step 2: Configure a custom outbound server for the email channel

An email channel can be set up to use either the VCC Internal server or a custom server. A channel that is configured to
use the VCC Internal server cannot override the server's default configuration and uses the email address of the server.
Whereas a channel that is configured to use a custom server can override the default server configuration. In this case,
a user name and password is required for the channel.

We can configure email channels in three ways:

n Using the VCC Internal server

n Using a custom server

n Using a custom server but overriding with the individual agent username and password

To create and configure a custom outgoing email channel, go toChannels > Emails.

For details on setting up a custom outbound server for the email channel, see our content on configure email channel
properties.
Step 3: Configure a custom outbound server for the users

You can also configure an outgoing mail server for each user in 8x8 Configuration Manager and underUsers >
General. A user’s outgoing mail server can be either a VCC Internal server or a custom server. If you use the VCC
Internal server, you cannot override the server's default configuration, therefore, using the email address of the server.
The emails sent by this user originate from the tenant’s default address. This configuration is NOT recommended.

Whereas a user that is configured to use a custom server configuration, such as [AcmeJets SMTP Server], overrides
the default server configuration. The emails sent by this user originate from the address of the new server. By overriding
the server’s default configuration, you make it more specific to the agent.

8x8 Contact Center administrators can configure users outgoing mail servers in three ways:

n Using the VCC Internal server

n Using a custom server

n Using a custom server but overriding with the specific account's user name and password

To create and configure a custom outgoing mail server for each user, go toUsers > General.
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For details on setting up a custom outbound server for agents, see our content on how to create agent accounts.
Step 4: Complete configuration in Agent Console (by agents)

This final step is performed by agents in 8x8 Agent Console. If an 8x8 Contact Center administrator has configured the
user’s outbound email servers to override the server configuration, the user is required to enter their individual email
address and password in the Profile page. For details, see our content for agents on how to configure workplace email.
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If there is no password set up, a message prompts notifying the agent that there is no email password configured for
your email account. To send an email from the custom email server, the agent must select their individual email
address to send emails from.

Note: This step is necessary only when the user's outbound server is set to a custom SMTP server and
configuration override. For default configuration, the agent is not prompted for their email credentials.
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Define a custom SMTP server

SMTP servers control the email delivery process of your contact center. You may use the 8x8 default VCC Internal
SMTP Server, or configure a custom server. By default your tenant outbound email communication is routed via the
pre-configured 8x8 Contact Center Internal SMTP Server. 8x8 Contact Center also offers the flexibility to configure a
custom SMTP server for better security and HIPAA compliance. The tenants can leverage their own infrastructure and
ensure the delivery of emails to the final recipient. 8x8 Contact Center establishes a secure connection with the tenant
SMTP server. Having a default server ensures that all outgoing emails originating from email channels or agents will be
using the default server and a single default account. Having a custom SMTP server, however, allows email channels
and agents to use distinct accounts for outgoing emails, as configured individually. The SMTP server must be
configured with authentication and STARTTLS protocol to ensure emails are not hijacked on their way to the tenant
facilities. Follow the instructions below to configure a custom SMTP server.

To configure a custom SMTP server in 8x8 Configuration Manager:

1. From the Configuration Menu, open Security.

2. Go to the SMTP Servers tab.

Note:By default, your outbound email communication is routed via the pre-configured 8x8 Contact
Center Internal SMTP Server.

3. Click SMTP Server.

Define a custom SMTP server
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4. Enter the following information:

SMTP Server Definition Description

Name Label for the SMTP server; a name for your custom SMTP server such as [AcmeJets
SMTP Server].

Default Select this option to make this SMTP server the default server of your tenant.

Server Name Name of the SMTP server as registered such as [smtp.gmail.com].

Port Specific port number that varies with the choice of connection security method (the
default port for SMTP server is 25). For STARTTLS, the port number is 587 , and for
SSL/TLS the port number is 465.

Connection Security Preferred way to encrypt communication, using SSL/TLS or STARTTLS protocols.

Authentication Method Authentication method that decides how to bundle the password:

n Password, transmitted insecurely (PLAIN): Offers a less secure (PLAIN)
password authentication method without encryption.

n Password, transmitted insecurely (LOGIN): Offers a less secure (LOGIN)
password authentication method without encryption.

n Encrypted password (CRAM-MD5): Offers a secure password authentication
method with encryption.

User Name User name is usually the email address. For example, the username for Gmail SMTP
is your Gmail address.

Password Password for the email address. Enter the Gmail password for your Gmail account.

Enter an email address
to test the SMPT server
configuration

Enter a working email address to send a test mail. The test verifies if the SMTP
server is configured correctly.

5. Click Test to verify the setup. If the configuration is correct, you receive a test email in the test email account.
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6. If you have not already, set up the SMTP server as theDefault server. You can also set the server as default later
once you save the new SMTP server.

7. ClickSave.

Check your inbox to see if the test message has been successfully delivered.

The default server is marked under the SMTP servers. If you have not selected your new SMTP server as default,
you can select it under the Set as default column.
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When you change the default server, all email channels and agents that are not configured to override the default
server with their individual configurations, will change to the new default server.

Note:You cannot delete the default server unless you set another server as default first.

8. To see the channels and users currently using the server, click the number underUsed by Users orUsed by
Channels lists.

Note: If 8x8 Contact Center fails to deliver emails when the remote SMTP server is down or when
configuration parameters are invalid, 8x8 Contact Center attempts to determine the reason for failure,
and retries a few times before sending a failure notification.
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Set up chat channels

8x8 Contact Center chat channels serve to direct chat requests from customers to contact center agents via chat
queues. 8x8 Contact Center provides options to embed links to chat channels on your website. Customers can initiate a
live chat session with the agents by clicking the link.

Features
n Facilitate communication of chat interactions in and out of a 8x8 Contact Center tenant.

n Process incoming chat requests using the chat channels and direct chat requests from customers to contact center
agents.

n Interact directly with the appropriate queues via skill-based routing rules.

n Ability to embed links to chat channels on your website or on the Support Center.

n Create, edit, and delete chat channels.

Setting up a chat channel in 8x8 Configuration Manager involves:

1. Configuring chat channel properties

2. Configuring embedded chat design

3. Creating a chat script

4. Assigning a script to the chat channel
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Configure chat channel properties

Configuring a chat channel in 8x8 Contact Center involves:

n Configuring chat channel properties.

n Creating a chat script to define chat flow.

To configure properties for a chat channel, you must specify the channel name, description, and chat script. A chat
script defines the chat behavior from the time a website visitor enters the website, and initiates and completes a chat.
UseChannels > Chat > Properties to specify the primary properties of the chat channel.

To configure chat channel properties:

1. From the Configuration Menu, openChannels.

2. Go to theChat tab.

3. In the list of chat channels, click to edit, or to add a new chat channel.

The Properties tab opens.

4. Enter or select values for the channel.
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The following table summarizes the options underChannels > Chat > Properties:

Chat
Channel
Property

Description

Channel
type

Read-only reminder of the type of channel.

Name Type the name of this chat channel.
8x8 Agent Console displays the channel name when the agent receives an email.

Description Enter a summary or purpose of the chat channel.

Chat Script If you have already defined a chat script, select the script from the list. If not, proceed to save the
properties without a chat script. Next, create a chat script and add the channel you just created.
For details on chat scripts, refer to Create a Chat Script.
The script defines the chat behavior from the time a website visitor enters the website, and
initiates and completes a chat.

This
Channel is
enabled

Select to enable this chat channel for service.
Enable a channel only after your contact center is ready to receive interactions on the channel.

5. ClickSave.
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8x8 Contact Center: Social media integration

Take advantage of Facebook and Twitter to service customers directly and increase customer satisfaction with 8x8
Contact Center Social Integration. By unifying the agent experience, 8x8 Social allows users to channel their messages
from social media into 8x8 Contact Center. Customers can contact the businesses and receive support from within their
social platform.

8x8 Contact Center social supports messaging via Facebook and Twitter in this release.

Features
With 8x8 Contact Center social integration, you can:

n Set up social channels in your contact center application.

n Direct messages received in Facebook and Twitter to the chat channels in 8x8 Contact Center.

n Allow agents to accept and handle chat requests from social media.

n Set up social scripts to identify existing customers using the social ID and greet them accordingly.

n Learn more about the customer and direct them to the agents with the right skills.

n Create new customer records in the Local CRM.

n Access chat transcripts in the Local CRM.

n Access chat history during a live chat.

Limitations
n Support for an external CRM is not offered in this release.

n Agent cannot initiate outbound chats to the social media.

n Multimedia messaging is not within the scope, only text messaging is supported.

n Chat auto translate is not supported for Twitter interactions.

n Messaging from guest users via the Facebook Chat Plugin is not supported, but messaging only from users logged
in to their Facebook accounts is supported.
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Use case
Let’s say your business has set up Facebook and Twitter accounts to communicate with your customers effectively.
Customers visiting your Facebook page can simply initiate a chat with a live agent in your contact center via the
FacebookMessenger. Agents in your contact center receive the chat request via the contact center chat queue. Upon
accepting the chat request, agents can interact with the customer and assist them immediately.

To provide the business context, we will use the example of Robin’s Fashions, a fictitious company. This company
specializes in selling shoes, handbags, and cosmetics. They offer membership based services to help serve their
customers better. They have set up business pages on Facebook and Twitter. The company connects with their
customers through their social media pages and wishes to serve them more efficiently via their chat channels. We refer
to this business use case throughout this guide.
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Configure social media integration

As an 8x8 Contact Center administrator of your business, you can set up the social channels, configure a social scripts
and assign the channel via 8x8 Configuration Manager.

Preparation
n Gather the social media account details of your business (login ID and password).

n Plan how you want to route interactions from social media. The following questionsmay provide you tips.

o Does your business support live chat 24/7 or based on schedule?

o Do you have a lot of traffic to your social media pages?

o Do you want to direct all your social interactions to the same queue or to skill based queues?

o Do you want to identify existing customers and provide context to agents?

o Do you want to automatically create customer records for new customers in the Local CRM?

n Create chat queues to direct the social chat requests.

Configuring the 8x8 Contact Center social media integration
STEP 1: Set up 8x8 Contact Center social channels in 8x8 Configuration Manager.

1. Log into 8x8 Configuration Manager for 8x8 Contact Center.

a. Go to https://login.8x8.com.

b. Enter your login credentials to launch the application panel.

c. Select 8x8 Contact Center 8x8 Configuration Managericon to launch the application.

2. Go toChannels in the navigation menu.

3. Select the Social tab.

4. Click + Add new Facebook channel or +Add new Twitter channel to add a new social channel.
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5. At the prompt, enter the email address and the respective password associated with the social account. Click
Login (In Facebook) orAuthorize App (In Twitter).

You have now successfully created the social channel. The social channel appears in the list of Social channels on
your tenant.

Note: You can connect an 8x8 Contact Center tenant with a single Facebook or Twitter channel
only.

STEP 2: Define the social chat routing by configuring a social script.

A social script allows you to define the routing of chats received on social media. You can define when and how to
interact with customers using the specific IVR objects. 8x8 Contact Center social introduces the following core social
objects to facilitate interaction routing.
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Social Object Description

Check Social ID Allows you to check the social ID of the customer and identify if it is an existing customer in
the Local CRM and trigger screen pop. If it is a new customer, it automatically creates a new
customer record in the Local CRM. The following exit points are available for this IVR object.
Contact Found: If this is an existing customer record in the CRM, the system , presents the
Agent the customer record for preview. Allows agent to edit and update case associated with
customer.
Contact Not Found: If it is a new customer’s first visit, the CRM, automatically creates a new
customer record in the Local CRM. Add first name and last name based on their social media
ID.

Send Prompt Allows you to display predefined greetings or messages in the chat window.

Example: Welcome to Robin’s Fashions. How may I help you?

Get Customer Info Requests additional information such as Customer ID, Case ID, email, phone number to learn
more details about the customer.
Example: Robin’s Fashions serves membership based services offering early access to their
product lines and better discounts to their members. To offer premium quality service to their
members, the company collects the membership ID information, identify premium customers,
and direct them to a fast serving queue.
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Social Object Description

Note:Custom fields in the Local CRM are not supported for data dip.

Question Allows you to pop a question to the customer on the social media. You can design these ques-
tions to get more information about the customer’s needs. The following question types are
supported:

n Open ended

n Single Answer only

n Yes/No
Let’s say, Robin’s fashions has set up dedicated queues to specific line of products - hand-
bags, shoes, and cosmetics. When a customer initiates a chat, you want to know the product
for which the customer is seeking assistance. Add a question to collect this information from
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Social Object Description

the customer. Based on the response received, direct the chat to the respective queue.

Skip Queue Use this object to allow customers to opt out of waiting in the chat queue and send an email
offline. Upon initiating a chat, if the customer chooses not to wait for an agent, then they can
simply send an email.
Emails can be sent via an email channel or as plain emails to the specified email address.
You can even predefine the email subject to conveniently filter the messages received.
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Social Object Description

At Robin’s Fashions, customers visit the social media pages to learn about the new deals, new products, sale offers,
and inquire about their current orders. The following stepsmodel a typical workflow:

1. Customer initiates a chat in the Messenger during their business hours.

2. Customer is greeted with a welcomemessage.

3. Customer is prompted to enter the membership ID to validate if it’s an existing member.

4. If it is a member, they are then prompted: you need assistance with an existing order?

n If Yes, direct them to the Sales Orders queue.

n If No, direct them to the General Inquiries queue.

5. If it is a non-member, customers are directed to the new customers queue.

Crafting the social script
1. In the 8x8 Contact Center 8x8 Configuration Manager , go to Scripts.

2. Select the Social tab.

3. ClickAdd new social media script.
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4. Enter the general properties and save.

5. In the Script tab, you are now ready to craft the script.

a. Customer initiates a chat in the Messenger during their business hours. Add and select an existing
[Schedule].

b. Using the social ID, validate the customer and check if it’s an existing customer. [Check Social ID]

c. Customer is greeted with a welcomemessage. Under theContact Found exit point, add a message using
[Send Prompt - Welcome back to Robin’s Fashions. Howmay I help you?].

d. Customer is prompted to enter the member ID to validate businessmembership. [Get Customer Info -
Collect Customer ID]

e. If it is a member, customer is prompted: Do you need assistance with an existing order? [Question -
Yes/No]

n If Yes, direct them to the Sales Orders queue. [Forward to Queue]

n If No, direct them to the NewOrder queue. [Forward to Queue]

f. Upon checking the social ID in step b, if it is found to be a new customer, - customer is directed to the new
customers queue.

6. Save the script.

The following images show two sample IVR social scripts.
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8x8 Contact Center SMS

8x8 Contact Center introduces communication via SMS inbound channels. SMS has become a popular channel of
communication in customer service. Let’s say customers of a car insurance company want to check their claim status or
send related inquiries, they can simply send SMS messages to an SMS number published by the insurance company.
These messages are routed via SMS channels and chat queues to agents, and offered to them as chat interactions for
responses. Agents can look up customer records if the message is from an existing customer. They can look up
outstanding cases and history of interactions to handle the conversation effectively.

Availability
The 8x8 Contact Center SMS feature is available to X Series customers (X7/X8) only. SMS channels for receiving
SMS messages can be configured in 30 countries (see appendix). SMS messages can be sent to most countries in the
world (note that the cost of sending messages to different countries varies based on the country, with the US and
Canada being the least expensive).

Features
n Connect and Communicate: As contact center agents, receive SMS messages from customers and

communicate in real time.

n Publish SMS numbers: Publish phone numbers having SMS-only or voice+SMS capabilities ( voice+SMS is
available only in the US and Canada) which can be provisioned as SMS inbound channels by 8x8.

n Route messages: Based on agent skills, route SMS messages via chat queues to available agents. Direct these
messages to available agents based on rules/schedules/skills.

n Engage with customers effectively: Allow agents to multitask and maximize their productivity by handling
messages from up to six customers at a time.

n Handle interactions more efficiently by accessing the customer record via screen pop. When an existing
customer sends a message, quickly look up the popped customer record and learn about recent cases.

n Track past activity: Save the SMS interactions in a chat transcript and automatically link it as a case to the right
customer record for future reference. Agents always end SMS interactions.
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Limitations
n SMS conversationsmust be initiated by the customer (the external party). At this time, the agent cannot initiate an

SMS conversation with a customer (or other external party).

n We do not support SMS messaging to short code numbers currently. We support messaging to toll-free and regular
phone numbers.

n The messaging does not support images or emojis. It is plain text only.

Use case
Acme Insure is a car insurance company that processes claims from insurers for traffic incidents. Their clients often
reach out to their agents to file claims, inquire about the status of their claims, and other related questions. An
insurance agent at Acme Insure, Robin, receives SMS messages from clients and responds to them in real time. During
business hours, Robin and other agents interact with multiple customers simultaneously, increasing their productivity.
For messages received during offline hours, Acme Insure sends an automatic response notifying the sender of Acme
Insure’s business hours and requests them to connect during business hours. The company also wants to keep track of
the communication trail with their clients. Hence, agents save their chat transcript before ending the conversation and
link it to the customer record. This helps all agents to review the cases, understand the status, and assist the returning
customers effectively.

Learn more about how to configure SMS channels.
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Configure SMS channels

Note: This section is applicable to 8x8 Contact Center administrators only.

8x8 provisions SMS aswell as voice+SMS channels. Note that SMS phone numbers that support both voice and SMS
are only available in the US and Canada. Once the channels are provisioned, you see them in the Contact Center
Configuration Manager application. As a next step, you need to configure these channels to receive SMS messages
from customers and route them to available agents based on interactive response rules and agent skills.

Follow the steps to configure an SMS channel:

Step 1: View SMS channels in the 8x8 Contact Center Configuration Manager
1. Log in to your 8x8 account.

2. In the application panel, select Virtual Contact Center - Configuration Manager. The application launches.

3. Go toChannels from the navigation menu.

4. Select to view SMS channels.

5. From the list of SMS channels, select to edit an SMS channel.
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6. Add the properties, and save.

Step 2: Add an SMS script
Use SMS scripts to prompt customers for more information, match against Local or External CRM customer records,
forward the conversation to a queue of agents based on specific rules, or queue metrics.

The following IVR nodes are available:

n Schedule: Use the Schedule node to determine if the business is open or closed, and add appropriate actions.

n Send Prompt: Use to auto-respond with predetermined greetings and messages.

n Check ANI: Use to identify customers based on phone numbers in the customer records.

n Get Customer Info: Use to collect information about the customer, such as Customer ID and Case ID, which
helps in routing the interaction.

n Test Condition of Queue: Use to check the condition of a queue before directing messages to the queue. Test
queue provides a set of conditions which, when met, triggers specified actions.

n Forward to Queue: Use to forward SMS messages to a specific chat queue (SMS messagesmust be routed via
chat queues).

To add an SMS script:
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1. Go to Scripts from the navigation menu.

2. Go to SMS, click to add a new SMS script.

3. Add a name for the script, a comment, and select a category.

4. Enable the script by checking the box.

5. ClickSave. It launches the script definition window.

6. Use the following steps to create a simple script that checks if a message is received during the business hours,
checks if it is from an existing customer, forwards them to an available agent via a chat queue, pops the matching
customer record for review. If the message is received during closed hours, sends a response indicating the same.

IVR Node Description

Add Schedule Check if the business is open or closed.
Add appropriate action nodes.

If (Schedule) is Open, add Send Prompt. If the message is received during
business hours, send a greeting.

Example: Welcome to Acme Insure.
How may I help you?

Add Get Customer Info The Get Customer Info collects data
such as customer ID and case ID,
retrieves the matching CRM record and
presents it to the agent allowing them to
handle the interactions better. Check if
the message received is from an
existing customer by prompting them for
a customer ID.
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IVR Node Description

Example: Collect information about a
pending case ID to quickly open and
review the case details.

Add Send Prompt The Send Prompt node allows you to
send predefined greetings or messages.

Send a message that an agent will
respond shortly.

Example: Thank you for contacting us.
We will be with you shortly.

Add Forward to Queue Direct the message to a chat queue. It is
then presented to an available agent
serving the queue.

If (Schedule) is closed, add Send Prompt to indicate the business
is closed.

If the message is received when the
business is closed, send a response
indicating the same.
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IVR Node Description

Example: Thank you for contacting
Acme Insure. We are currently closed.
Please contact us during our business
hours 9 AM to 5 PM PST.

Step 3: Assign the SMS script to the SMS channel
You can assign the SMS script to a channel in two ways:

n Via Channels: Go toChannels > SMS. Select to edit a channel. Under Properties, select the SMS script from
the list of available scripts.
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n Via Scripts: Go to Scripts > SMS. Select to edit an SMS script. Under Properties, clickAssign new channels
and follow the prompts to select channels to assign the script.

Step 4: Add users to the chat queue
SMS messages sent to a channel are directed to a chat queue to be processed by agents serving the queue. In this
step, you can add agents to the chat queue used in the script.

1. Go toQueues/Skills from the navigation menu.

2. Select to edit the chat queue to which the SMS interactions are forwarded.

3. UnderMembers, assign and enable agents to the queue.
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With these steps complete, the SMS channel in your contact center is now set up to process SMS interactions.
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SMS: list of supported countries

The 8x8 Contact Center SMS service is currently supported in the following countries.

Note: 8x8 Contact Center SMS can send SMS messages tomost countries in the world. However,
SMS channels for receiving SMS messages into the contact center can only be configured in the
countries listed below.

n Australia

n Austria

n Belgium

n Brazil

n Canada

n Chile

n Croatia

n Czech Republic

n Denmark

n Estonia

n Germany

n Hong Kong

n Hungary

n Israel

n Latvia

n Lithuania

n Malaysia

n Netherlands

n Norway

n Poland
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n Portugal

n Puerto Rico

n Spain

n Republic of Korea

n Philippines

n Singapore

n Sweden

n Switzerland

n United Kingdom

n United States
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Create and configure scripts

8x8 Contact Center phone, chat, and email scripts allow administrators to design and control the interaction flow in a
contact center via 8x8 Configuration Manager. Quickly connect callers with agents and streamline customer flow with
the 8x8 Interactive Voice Response (IVR) scripts.

IVR is a critical component of any contact center, allowing customers to get quick answers to simple questions and
helping companies identify the right resource to help a customer with a given issue.

Features
8x8 has powerful IVR capabilities that help in a number of ways:

n Improve the customer service experience
o Help customers find the information they need through self-service functions.

o Identify who is calling and route them to the best available agent.

o Give callers access to information even after business hours.

n Provide value to your organization
o Lower costs by automatically answering common questions.

o Easily manage your IVRs online for complete control.

o Create custom schedules for holidays and special events.

o Make changes to your IVR on the fly.

n 8x8 Contact Center can use CRM information to personalize customer interactions and significantly increase the
efficiency of every call center interaction.

n 8x8 provides our customers with three options for IVR:

Create and configure scripts
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o Basic IVR: Easy-to-create menus, and simple self service capabilities that allow the contact center manager
the agility to keep up with changing requirements through simple edits to the IVR flow.

o eIVR: A powerful, full-function IVR that can access data from multiple sources and support speech driven
applications.

o Intelligent IVR: 8x8 provides speech recognition and natural language processing on all incoming calls. To
learn more, refer to our content on how to create intelligent IVR.

Designing a script can be simple or complex, depending on your business operation. Before sitting down to design your
script, you need to prepare your plan for the interaction routing.

Go to the Scripts tab in 8x8 Configuration Manager to create or edit scripts. Phone scripts are grouped under the
Phone tab, and chat and email scripts are each grouped under their respective tabs. Scripts can be associated with one
or more channels. You can create a user-defined script, or use our system default script.

To learn how to create or edit phone, email, and chat scripts, refer to:

n Create a Phone IVR Script

n Create an Email Script

n Create a Chat Script

To learn how to create social scripts, refer to our Social chapter.
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Create a phone IVR script

An 8x8 Contact Center phone Interactive Voice Response (IVR) script can be an inbound phone script, outbound phone
script, or Post Call Survey script. Here are the types of phone scripts accessed via 8x8 Configuration Manager:

n Inbound phone script: Guides the inbound callers through the options to self-direct themselves to the desired
destination within the contact center. You can create a new script and assign it to any number of channels.

n Outbound phone script: Improves handling process of inbound phone queues when the inbound queue agents
are also members of an outbound phone queue, such as campaign calls. Whenever the inbound phone queues
have higher priority over your outbound phone queues, you can reserve agents for the inbound phone queue so that
they handle inbound calls first before handling outbound calls.

n Post Call Survey: A questionnaire presented to the caller at the end of a call, typically to collect feedback about
the quality of service offered by the company. You can plan and build a Post Call Survey script using IVR-controlled
survey, agent-assisted survey, and stand-alone survey. To build a Post Call Survey script, go to Scripts > Phone
and add a new phone script. Select Post call survey for the script type and enter parameters. Follow the
instructions on Post Call Survey User Guide to learn about types, use cases, and how to configure a Post Call
Survey.
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Overview of IVR script objects and operation

8x8 Contact Center IVR scripts define how 8x8 Contact Center processes an inbound phone interaction. The contact
center administrator, guided by the center's business requirements, constructs an IVR script by choosing scripting
objects to define the automated processing of your inbound calls.

Types of IVR script objects
IVR scripts consist of an ordered series of script objects. Each script object includes parameters and exit points.

n Parameters: Parameters are an object instruction set. Depending on the purpose of the object, parameters define
what schedule to use, voice prompt to play, or Local CRM data to evaluate. The first parameter of all objects is the
Object Tag, which uniquely identifies that object within the IVR script.

n Exit points: Exit points are an object response to the conditions detected by the object parameters. Exit points
enable an object to perform different actions in response to different conditions. For example, an object can route
or otherwise process an interaction in one way when the contact center is open, and process the interaction a
different way when the contact center is closed. When designing an IVR script, note that if a script logic routes a
phone interaction to a script object's exit point, and that exit point does not contain any script objects, then the 8x8
Contact Center disconnects the interaction.

IVR script operation
When a new phone interaction arrives, the channel hands the call off to the top-level MainIVR script object. Beginning
at MainIVR, the interaction begins flowing through the IVR script objects. Each script object parameters and exit points
perform real-time processing of an interaction in response to conditions. For a basic IVR script that plays a greeting
message and forwards the call to a queue when the call center is open, see IVR Phone Script Examples for building a
simple greeting and routing a call to a queue. If the call center is closed, the script notifies the caller and routes the
interaction to an off-hours voicemail queue.
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Summary of phone IVR script objects

The following table summarizes the objects available in 8x8 Contact Center phone scripts accessed via 8x8
Configuration Manager:

Phone
Script
Object

Description

Schedule Use the Schedule object to perform a particular sequence of script operations when the contact cen-
ter is either open or closed.
Parameters:

n In the Label text entry area, type the alphanumeric label used to uniquely identify the element in
the IVR script.

n Labels can contain a maximum of 21 characters, and must be unique within a script.

n In the Select schedule list, choose a schedule definition.
Exit points:
The Schedule object uses the Select schedule value to transfer control to the script sequence spe-
cified within the following exit points:

n open equals true if the phone interaction has been received within the selected schedule's open
hours.

n close equals true if the phone interaction has been received outside the selected schedule's
open hours.

n #1 through #6 equal true if the schedule specified in Select Schedule includes an exception
condition, numbered 1 through 6, and today's date is within the exceptions from and to dates.

For details on creating schedules, refer to Define Business Hours and Schedules.

Check ANI Use the Check ANI object to use the phone number of the inbound caller to perform a lookup in the
customers file. If a matching phone number is found in the Customer file, the record is loaded in
memory and can be used to check the value of picklist fields to determine how to route the call.
Parameters:

n In the Label text entry area, type the alphanumeric label used to uniquely identify the element in
the IVR script. Labels can contain a maximum of 21 characters, and must be unique within an IVR
script.
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n In the contact found item, define the call processing steps to be performed if a Local CRM
customer record was found.

n In the contact not found item, define script call processing steps to be performed if a Local
CRM customer record was not found.

Exit points:
The Check ANI object uses the value of the caller's ANI phone number to transfer control to the script
sequence specified within the following exit points:

n contact found equals true if the caller's phone number matches one in the Local CRM.

n contact not found equals true if the caller's phone number does not match one in the customer
file.
When using the Check ANI object, both exit points should be configured. An exit point does not
have any processing steps, and the object exits on that exit point the caller will be disconnected.

Get Value Use the Get Value object to request or require the caller to use their telephone's keypad to provide the
following Local CRM data:

n A Local CRM customer AccountNumber

n A Local CRM CaseID

n An agent's extension number: On selecting this option, the Entry is mandatory check box is
checked automatically and grayed out. You are given the option to set the maximum length of the
extension. By default, the maximum is eight digits.

n A numeric Customer or Case custom field.

n An external Variable1 or Variable2 that can then be passed to an external program for screen pops
or integration with third-party or custom systems.
For details on screen pop, refer to Define Screen Pop Settings for External CRM.

Parameters:

n In the Label text entry area, type the alphanumeric label used to uniquely identify the element in
the IVR Script.
Labels can contain a maximum of 21 characters, and must be unique within an IVR script.

n In the Invite message list, choose the audio file the IVR script plays to prompt the caller to enter
specific numerical information.

n In the Invalid message list, choose the audio file the IVR script plays if the caller responds to the
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invite message prompt with an invalid entry.

n In the Empty message list, choose the audio file the IVR script plays if the caller does not
respond to the invite message prompt within 10 seconds.

n In the Data to collect list, select the CRM data to request or require from the user.

n Select Entry is mandatory to require that the user supply a valid response to the prompt before
enabling them to proceed beyond the Get Value object.

Exit points:
The Get Value object uses the value of the caller's response to transfer control to the script sequence
specified within the following exit points:

n found equals true if the caller's numerical entry matches the CRM data that was specified in the
Data to Collect list.
If Entry is Mandatory is disabled, or the value to be matched is stored in an external variable, the
script exits.

n empty equals true if Entry is Mandatory is enabled, and the caller does not supply a value.

n too many invalid equals true if Entry is Mandatory is enabled and the caller made three incorrect
attempts to supply a valid response.

Get Digit This object is used after Play and Say messages that prompt for digit tone input. Get Digit is a menu
optimized for the input of a single digit. Use Get Digit to receive the caller's DTMF input after prompt-
ing the caller for input.
Parameters: None
Exit Points:

n 0-9, *, # label the script operations performed after the caller has pressed the corresponding key
on their telephone's keypad.

n Unassigned digit: Actions defined under Unassigned digit are followed when the caller enters a
digit that has no assigned action.

n empty contains the script operations performed if the caller does not respond to an IVR menu
prompt within 10 seconds, and the empty exit point is not configured.

Check Pick-
list

Use the Check Picklist object to evaluate the value of a particular item from the CRM database.
Perform a Check Picklist comparison after you have used the Check ANI or Get Value object to load a
customer or case record into memory.
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Parameters:

n In the Label text entry area, type the alphanumeric label used to uniquely identify the element in
the IVR Script.
Labels can contain a maximum of 21 characters, and must be unique within an IVR script.

n In the Data to test list, choose the picklist field to evaluate.

n In the Select operator list, choose the equal to or not equal to comparison operator.

n In the Select values list, choose the picklist values for the data element specified above by the
Data to test list.

Exit points:
The Check Picklist object transfers control to the script sequence specified within the following exit
points:

n matched equals true if one of the selected values equals the value of a record in the Local CRM.

n not matched equals true if one of the selected values does not equal the value of a record in the
Local CRM.

Play Use the Play object to play an audio file in a particular location in the IVR script.
Parameters:

n Object Tag: Enter the alphanumeric label used to uniquely identify the element in the IVR Script.

n Audio File: Select from the default audio files or from the choice of custom uploaded files.

n Playback Options: The playback option can be interrupted by a DTMF input or not. Select from
one of the following options:

o Uninterruptible (Input ignored): The playback continues, ignoring the DTMF input.

o Interruptible (Input captured): The playback is interrupted, and the DTMF input is captured.
Exit points: None

Say This object converts programmed text and variable objects such as phone number and queue position
into speech. The Say object is also interruptible or not. For details, see our content on Text To Speech.
Parameters:

n Object Tag: Enter the alphanumeric label used to uniquely identify the element in the IVR script.
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n Language: Select the language from the available choices.
Available Languages are: 1

n Voice: Select a suitable voice from the library of digital voices. These voices are available in
female and male tone.

n Value to Play: Select to play free text or variables, such as phone number and queue position.

o Callback phone number: Plays the call back number entered by the caller. It is retrieved via
Get Value.

o Caller phone number: Plays the calling line ID of the caller fetched automatically.

o Queue position: Plays the queue position of the call.

n Text to Play: Enter the text string to be played.

n Data type: Select from the available data types: Text, Number, Phone number, Date, Time, and
Currency. For example, if you select Date as the data type, the system announces the data in the
date format.

n Playback rate: Select a value: Slow, Normal, or Fast. The default rate is Normal. You can define
the playback speed of IVR Text-To-Speech (TTS) prompts when using the Say object. The Say
object converts programmed text and variable objects such as phone number and queue position
into speech. You can play these prompts slowly, at a normal speed, or at a faster pace. Using the
playback rate option, you can control the speed of the speech that reads your text so your callers
do not miss the important information such as names, numbers, or account balances. The default
speed is Normal. The playback speed is set per IVR Say node.

n Playback Options: The playback option can be interrupted by a DTMF input or not. Select from
one of the following options:

o Uninterruptible (Input ignored): The playback continues, ignoring the DTMF input.

o Interruptible (Input captured): The playback is interrupted, and the DTMF input is captured.

1Arabic, Bahasa, Basque, Cantonese, Catalan, Czech, Danish, Dutch, English (AU), English (GB), English (India),
English (Ireland), English (Scotland), English (South Africa), English (US), Finnish, French (Canada), Galician,
German, Greek, Hebrew, Hindi, Hungarian, Italian, Japanese, Korean, Mandarin (China), Mandarin (Taiwan),
Norwegian, Polish, Portugese (Brazil), Portugese (Portugal), Romanian, Russian, Slovak, Spanish (Castillan), Spanish
(Colombia), Spanish (Mexico), Swedish, Thai, Turkish, and Valencian.
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Menu Use the Menu object to present a list of options to the caller.
Parameters:

n In the Label text entry area, type the alphanumeric label used to uniquely identify the element in
the IVR script.
Labels can contain a maximum of 21 characters, and must be unique within an IVR script.

n In the Invite message list, choose the audio file the IVR script plays to offer menu options to a
caller.

n In the Invalid message list, choose the audio file the IVR script plays if the caller responds to the
prompt with an invalid entry.

n In the Empty message list, choose the audio file the IVR script plays if the caller does not
respond to an IVR menu prompt within 10 seconds.
In a Menu script object, the Empty message parameter and the empty exit point (described below)
are mutually exclusive: If you configure the empty exit point, then the Menu object will not play the
audio file specified in the Empty message list.

Exit points:
The Menu object contains the following labeled exit points:

n 0-9, *, # label the script operations performed after the caller has pressed the corresponding key
on their telephone's keypad.

n extension contains the script operations performed if the caller supplies a valid three-digit
extension number.
The 8x8 Contact Center permits only agents with the Direct Agent Access Feature enabled to be
directly accessed by extension number.

Note: Extension (Obsolete) is a legacy feature that will be deprecated. We
recommend using the enhancedmethod for direct agent routing.

n empty contains the script operations performed if the caller does not respond to an IVR menu
prompt within 10 seconds, and the empty exit point of the Menu object is not configured.
In a Menu script object, the empty exit point and the Empty message parameter (described above)
are mutually exclusive; if you configure the empty exit point, then the Menu object will not play the
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audio file specified in the Empty message list.

n too many invalid labels the script operations performed if the caller makes three invalid
responses to the menu prompts.
Invalid responses include three incorrect keypad entries or no response to the menu within 10
seconds.

Voice
Recording
Settings

If your 8x8 Contact Center operates in jurisdictions which require seeking the caller's permission
before recording a call, the caller's choice must be able to override the queue and agent level recording
settings as well as the agent's record on demand capability. Use the Voice Recording Settings
object to determine the circumstances under which a call may be recorded.
Parameters:

n In the Label text entry area, type the alphanumeric label used to uniquely identify the element in
the IVR script.
Labels can contain a maximum of 21 characters, and must be unique within an IVR script.

n In the Permission to record, select one of the four options:

o Keep prior setting: Keep prior setting for automatic and agent-initiated recording

o Not asked: No automatic recording, but allows an agent to initiate recording

o Granted: Follows Agent & Queue recording settings for automatic recording, and allows an
agent to initiate recording

o Denied: No automatic recording, and does not allow an agent to initiate recording
When Record % of calls is applicable, then IVR, Queue, and Agent voice recording percentages are
applied.

n In the Automatic Call Recording, based on the settings in Permission to record, one of the
following four options get automatically selected, or you can select an option to override the
default:

o Keep prior setting: Keep prior setting for automatic recording

o Record this call: The current call is recorded

o Do not record this call: The current call is not automatically recorded

o Record % of calls: IVR %, Queue %, and Agent % probabilities are used to determine if the
call is recorded automatically or not

n In the Allow agent to initiate recording, based on the settings in Permission to record, one
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of the following three options get automatically selected, or you can select an option to override
the default.

o Keep prior setting: Keep prior setting for agent-initiated recording

o Yes: Allow the agent to initiate recording of this call

o No: Do not allow the agent to initiate recording of this call

Set Agent The Set Agent object facilitates direct agent access. Set Agent checks if the ANI or case number asso-
ciated with an incoming call has corresponded with an agent on previous calls, and provides call rout-
ing choices based on the search result. For details, see our content on Direct Agent Routing.
Set Agent allows you to look up agents based on the following parameters:

n Case created by: Find the agent who created the case.

n Case last worked by: Find the agent who last worked on the case.

n Case assigned to: Find the agent who is assigned to the case.

n Channel linked to: Find the agent who is linked to the channel the call was channeled through.

n None: Find an agent by name. By selecting this option, the option to Choose Agent shows up.
Click the link, and select an agent from the list.

Set Agent may return empty if there is no agent associated with ANI or case number.
Exit points:
The Set Agent object uses the returning value from the search above to transfer control to the script
sequence specified within the following exit points:

n agent found equals true if the caller's phone number or the case lookup retrieves an agent who
previously corresponded with the contact.

n agent not found equals true if the caller's phone number or the case number does not retrieve
any agent who worked with the contact.

Transfer to
Agent

The Transfer to Agent object connects the caller to the agent.

n Use this object with Set Agent to find agents based on case lookup, and then transfer the call.

n Use this object without Set Agent to transfer calls directly to the agent with a personal channel.
The agent must be assigned with a personal channel.

Transfer to Agent object provides options which support transferring a call to an agent even if their
status is:
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n busy

n on break

n working offline

n logged off
If you do not select any option, then the call is transferred only if the agent status is Available.
If transfer is successful, change agent status to busy: this option is enabled by default. The agent
is offered the post processing state after terminating the call.
The object supports separate logic as to why a call may not reach the target agent depending on the
agent’s real-time state.
Exit points:
The Transfer to Agent object uses the following exit points:

n Busy equals true if the agent status is busy.

n on break equals true if the agent is on break.

n working offline equals true if the agent is working offline.

n logged off equals true if the agent is logged off.

n rejected by agent equals true if the agent rejected the call.

n invalid agent id equals true if the agent found from ANI or case lookup is found invalid.

n ring no answer equals true if the agent's phone rang but the agent failed to answer.

Transfer to
Agent Voice
Mail

The Transfer to Agent Voicemail object allows a caller to deposit a voicemail for an agent. It assumes
the agent is already set through the Set Agent object or Get Value object. The following parameters dic-
tate the call flow.
Parameters:

n Name: In the Name text entry area, type the alphanumeric label used to uniquely identify the
element in the IVR script for the Forward to agent element. It can contain a maximum of 21
characters, and must be unique within an IVR script.

n Personal Invite: You can set different greetings to inform the caller the available options. The
options available under Personal Invite indicate the agent-specific greeting that will be played
back to the caller when the call routes through this primitive. The following options act as
templates for the actual prompts:

o AgentPersonalGreeting: Plays the personal recording made by the agent through a
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verification call.

o AgentPersonalrecording_1 to AgentPersonalrecording_6: An agent can also record a
maximum of 10 personal recordings using the 8x8 Agent Console and any one of the first six
of these personal recordings can be played back to the caller. This is done when the
administrator sets the Personal Invite to one of these options. The agent's recording
functionality in 8x8 Agent Console is accessible via Menu > My Recording. Agents can
record personal greetings using the My Recording functionality.

n Impersonal Invite: If the personal recording of the agent is not available, the IVR system falls
back on the Impersonal Invite message. These are the audio prompts that are available to 8x8
Contact Center through the Home > Audio Files interface.

n Digit to opt out: A caller is forced to deposit a voice mail when the “Digit to opt out” is set to
false. When it is set to true then the caller has the option of leaving a voicemail or going back to
the IVR system via the “opt out exit” point. This is similar to “resume” in the “ForwardToAgent”
primitive in the legacy 8x8 Contact Center. When opt out is set to true, the caller can press any
DTMF key to navigate to the “opt out” exit point.

Exit Points:

n opt out: allows the caller to opt out of voicemail.

n agent not configured for VM: If the Activate agent’s voice mail check box in the Phone tab of
the Agent configuration in 8x8 Configuration Manager is not checked, then the caller is directed to
the agent not configured for VM exit point even when the agent ID is set.

n invalid agent id: If the agent ID is not set before this primitive is encountered, the caller is
directed to this exit point.

Forward to
agent Note:Due to the constraints of the Forward to Agent object, we recommend using the

Set Agent and Transfer to Agent objects to set up direct access to agents. Please note
the Forward to Agent object will be obsolete on new 8x8 Contact Center subscriptions
past the 8.1 release.

If your 8x8 Contact Center uses the direct agent access feature, in the Menu script object described
earlier in this table, you can use the Forward to Agent object to forward the caller to an agent's phone.
The Forward to Agent object does not function unless contained in the extension exit point of a Menu
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object.
8x8 Contact Center rings the agent's phone for the number of seconds specified in the Interaction
offer timeout. For details, refer to Create Accounts and Configure Properties.
Parameters:

n In the Label text entry area type the alphanumeric label used to uniquely identify the element in
the IVR script for the Forward to agent element.
Labels can contain a maximum of 21 characters, and must be unique within an IVR script.

n In the Message list, if agent voicemail is activated, then choose the audio file the IVR script plays
immediately before forwarding the caller to the agent's voicemail.

n In the Invalid Extension Message list, choose the audio file the IVR script plays if the caller
supplies an invalid three-digit agent extension.

Exit points:
The Forward to agent object uses the value of the extension entered by the caller to transfer control to
the script sequence specified within the following exit points:

n resume equals true if the caller enters <*> instead of leaving a voice message.
Use the resume label to transfer a caller who does not leave a message to another location in the
IVR script.

n too many invalid equals true if the caller dials an invalid agent extension three times.

Test Condi-
tion of
Queue 

Use this object to check the condition of a queue before entering a queue. Test queue provides a set
of conditions which, when met, triggers specified actions. The test queue object gives the IVR
designer much more routing flexibility by allowing testing queue status repeatedly.
Parameters:

n In the Object tag text entry area, type the alphanumeric label used to uniquely identify the
element in the IVR script.
Labels can contain a maximum of 21 characters, and must be unique within an IVR script.

n In the Queue name list, choose the phone queue to test the condition.

n Use the Queue Conditions area to determine routing choices based on agent availability or queue
performance. For Queue Conditions, select one or more options below. The following options are
presented when you enable There are NO agents:

o Available: Select this option to route the call differently, or to provide the caller with choices
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when there is no qualified agent available to immediately accept the interaction.

o Available or Busy: Select this option to route the call differently, or to provide the caller with
choices when there is no qualified agent available to immediately accept the interaction. The
agents may be temporarily busy and cannot immediately take the call.

o Available, busy, or working offline: Select this option to route the call differently, or to
provide the caller with choices when there is no qualified agent available to immediately
accept the interaction. The agents may be temporarily busy or working offline and cannot
immediately take the call.

o Available, busy, working offline, or on break: Select this option to route the call
differently, or to provide the caller with choices when there is no qualified agent available to
immediately accept the interaction. The agents may be temporarily busy, working offline, or
on break and cannot immediately take the call.

o Logged in (assigned but may not be enabled): Select this option to route the call
differently, or to provide the caller with choices when there is no qualified agent logged in
(assigned but may not be enabled) to immediately accept the interaction. Qualified agents
refer to agents set up to receive interactions from the queue specified in the Queue name
list.

o To evaluate the condition of a selected queue and then route the call based on the test
results of that performance, perform one or all of the following tests:

n Select The number of calls waiting ahead of this call is greater than -----, then
enter the maximum number of calls that can be ahead of the current call.

n Select Current call has been waiting in this queue for more than --- (seconds),
then enter a time the current call has spent in its queue exceeds a configurable
threshold. Each incoming call gets its own copy of an IVR script to receive treatments.
The call being treated is referred to as the Current call.

n Select The longest wait time for any call in this queue is greater than ---
(seconds), then enter the maximum time that a call in the queue has waited in the
queue.

n Select The instantaneous expected-wait-time calculation exceeds --- (seconds),
then enter a time duration in seconds.

Exit points:
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Test Queue has two exit points:

n Condition Matched

n Condition not Matched
The Test Queue object transfers control to the script sequence specified under the exit points based
on the following test results:

n There are no qualified agents available in the queue.

n There are no qualified agents available or busy in the queue.

n There are no qualified agents available, busy, or working offline in the queue.

n There are no qualified agents available, busy, working offline, or on break in the queue.

n There are no qualified agents logged in.

n There are n number of calls in the queue ahead of this call, where n is the number specified in the
test.

n The current call has been waiting in this queue for more than specified time.

n There is a call waiting longer than the specified time in the queue.

n The instantaneous expected wait time calculation for a call exceeds the specified time.
The expected wait-time calculation is useful only when there are more than 20 qualified agents
assigned to the queue and active. Mathematical uncertainty with fewer than 20 active, similarly-
skilled agents may produce unexpected results.

One of the many ways the condition matched and condition not matched exit points can be used is to
either trigger another test, provide the caller with a choice of waiting in the queue when no agent is
available, leave a voicemail, or inform the caller of an approximate waiting time, and then forward to
the queue.
For example, if there is a call in the queue that has waited longer than 120 seconds, you can insert the
Play object under the Condition matched exit point to play a message informing the caller of an expec-
ted waiting time for the call to be answered. You can then use the Forward to Queue object to route the
call to a queue.

Forward to
queue

Use the Forward to Queue object to forward a phone interaction to a specific phone queue.
Parameters:

n In the Object tag, type the alphanumeric label used to uniquely identify the element in the IVR
script.
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The object tag can contain a maximum of 21 characters, and must be unique within an IVR script.

n In the Queue name list, choose the target phone queue to receive the call.
For more information about modifying the default queue forwarding behavior, see the information
about the Take the Overload path if area below.

n In the Queue timeout enter the number of seconds that call waits in the queue (5 to 20000).

n Use the Queue Conditions area to determine routing choices based on agent availability or queue
performance. For Queue Conditions, select one or more options below. The following options are
presented when you enable There are NO agents:

o Available: Select this option to route the call differently, or to provide the caller with choices
when there is no qualified agent available to immediately accept the interaction.

o Available or Busy: Select this option to route the call differently, or to provide the caller with
choices when there is no qualified agent available to immediately accept the interaction. The
agents may be temporarily busy and cannot immediately take the call.

o Available, busy, or working offline: Select this option to route the call differently, or to
provide the caller with choices when there is no qualified agent available to immediately
accept the interaction. The agents may be temporarily busy or working offline and cannot
immediately take the call.

o Available, busy, working offline, or on break: Select this option to route the call
differently, or to provide the caller with choices when there is no qualified agent available to
immediately accept the interaction. The agents may be temporarily busy, working offline, or
on break and cannot immediately take the call.

o Logged in (assigned but may not be enabled): Select this option to route the call
differently, or to provide the caller with choices when there is no qualified agent logged in
(assigned but may not be enabled) to immediately accept the interaction. Qualified agents
refer to agents set up to receive interactions from the queue specified in the Queue name
list.

o To evaluate the condition of a selected queue and then route the call based on the test
results of that performance, perform one or all of the following tests:

n Select The number of calls waiting ahead of this call is greater than -----, then
enter the maximum number of calls that can be ahead of the current call.
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n Select The longest wait time for any call in this queue is greater than ---
(seconds), then enter the maximum time that a call in the queue has waited in the
queue.

n Select The instantaneous expected-wait-time calculation exceeds --- (seconds),
then enter a time duration in seconds.

Exit points:

n In Queue is true if a call has entered the queue. You can define the in-queue treatments for each
queue. Callers are served with the treatments and options defined under each queue while
waiting to be served. You can add Loop and initial action under In Queue:

o Initial Action: Under In Queue, select to add an initial action, such as announcing the Flu
clinic details. Add a Play object and select an audio file to be played to callers once they
enter the queue.

o Loop: Under In Queue, add a Loop object. Inside a loop, you can define multiple in-queue
treatments using time intervals. These treatments are repeated for a specified number of
times, or for a given duration.

n Queue Timeout is true if the call waiting exceeds the timeout period set.

n Overload is true if any of the overload paths are met.
The Forward to Queue object transfers control to the script sequence specified under the
overload exit point as follows:

o There are no qualified agents available in the queue.

o There are no qualified agents available or busy in the queue.

o There are no qualified agents available, busy, or working offline in the queue.

o There are no qualified agents available, busy, working offline, or on break in the queue.

o There are no qualified agents logged in.

o There are n number of calls in the queue ahead of this call, where n is the number specified
in the test.

o There is a call waiting longer than the specified time in the queue.

o The instantaneous expected wait time calculation for a call exceeds the specified time.
The expected wait-time calculation is useful only when there are more than 20 qualified
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agents assigned to the queue and active. Mathematical uncertainty with fewer than 20
active, similarly skilled agents may produce unexpected results.
The overload exit point can be used to provide the caller with a choice of waiting in the queue
when no agent is available, or to leave a voicemail.
For example, in the Forward to Queue object's overload exit point, insert the Forward to voice
mail object to route the call based on the caller’s response to a prompt of the form "Press 1
to leave a message or remain on the line to speak to the next available agent"; if the caller
does not press 1, the script transfers the call to the queue specified in the Queue Name list.

Loop and
Time Inter-
val

These new in-queue-only objects control the pattern of announcements, queue music, and conditional
contact center tests while waiting in queue.

n Loop: Under In Queue, add a Loop object. Inside a loop, you can define multiple in-queue
treatments using time intervals. These treatments are repeated for a specified number of times,
or for a given duration.

Parameters:

n Object tag: Enter the alphanumeric label used to uniquely identify the element in the IVR Script.

n Loop repeat count: Select the number of times to repeat the treatments defined in the loop.
Exit Points:
Time Interval: The Intervals inside a Loop can be used to define multiple prompts. Use a Time Interval
to define the length of an in-queue action. For example, define an interval to be 60 seconds long and
select to play an in-queue prompt for 20 seconds. The queue music plays for the rest of the interval dur-
ation.

Callback The Callback object allows callers waiting in a call queue to opt out of the queue and be called back
when an agent becomes available. This feature fetches the caller's phone number from the calling line
ID, the absence of which requires the caller to input the callback number before exiting the queue. The
system retains the queue position of the call and offers an outbound call to an available agent serving
the queue. When the agent accepts the call, the call is dialed out to the caller using the callback num-
ber. The call is routed through an outbound queue. For details, see our content on queued callback.
Parameters:

n Queue name: Select an existing outbound queue to route the call.

n Call back CLI/CN: Select a channel number for outbound caller ID. Using the option [Current
Channel], you can display the original channel number, which the caller used as the caller ID for
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the callback. This option is selected by default. If you wish to display any other channel number
during the callback, you can select from the list of available channels.

n Dial plan: Select from an existing dial plan.

n In Callback parameters, select the number of callback tries, specify the delay time between tries
in seconds or minutes, and enter the duration (in seconds, minutes, or hours) after which the
callback request needs to be canceled.

o Callback tries: Select the number of attempts to call back. The call failure is determined by
the following factors:

n Agent did not answer the call.

n Agent answered, but the outbound leg dials out and experiences a busy network.

n RNA (Ring no answer)

o Callback retry delay: Specify the callback retry attempts in seconds or minutes.

o Cancel callback after: Enter the duration in seconds, minutes, or hours. The requested
callback remains in an outbound queue for the duration of that time (up to maximum six
hours). Any callback attempt is prevented after the time expires. The callback request is
removed from the outbound queue after Cancel Callback duration has expired.

Exit Points:

n Callback Queued: Informs the caller that the callback request is queued for further processing.

n Invalid Phone Number: Informs the caller that the number entered is invalid, and can offer
options for further corrective actions.

Forward to
voice mail
Queue

Use the Forward to voice mail object to transfer phone interactions to a selected voicemail queue.
If the Forward to voice mail object is inserted under the overload exit point of a Forward to Queue
object, the caller can choose between waiting in the queue or transferring to voicemail.
Parameters:

n In the Object Tag text entry area, type the label used to uniquely identify the element in the IVR
script.
Labels can contain a maximum of 21 characters, and must be unique within an IVR script.

n In the Invite Message list, choose the audio file that directs the caller to press 1 to leave a
voicemail message.
The audio file must direct the caller to press 1 to leave a voicemail; no other number will work.
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If the Access to voice mail is mandatory option, described below, is selected, then the IVR script
forcibly transfers the call to voicemail.

n In the Queue name list, choose the voicemail queue that receives calls transferred to voicemail.

n Select Access to voice mail is mandatory to have the IVR script forcibly transfer calls to the
voicemail queue.

Exit points: None

Forward to
External IVR 

Use the Forward to External IVR object to forward a phone interaction to an external IVR server. This
redirects an incoming call to an external SIP URI address, or a phone number, which lands on an
external IVR system. You can complete a self-service authentication on an external IVR server, and
resume the call as desired by the customer. The entry point for an incoming call remains the 8x8
Contact Center IVR, with external IVR as an additional tree node within it.
The object allows data exchange between the external IVR server and the 8x8 Contact Center server
through a RESTful API interface. The data flow requires a SIP connection.
Parameters:

n In the Object tag text entry area, type the alphanumeric label used to uniquely identify the
element in the IVR script.
Labels can contain a maximum of 21 characters, and must be unique within an IVR script.

n In the Phone number text entry area, type the complete phone number the IVR script dials when
transferring a phone interaction.
The Phone number text entry area accepts only the numeric characters 0-9.

o In the United States, phone numbers, must be of the form (1 + three-digit area code + seven-
digit phone number).
In the United States, when typing numbers into text entry areas, always preface the area
code with 1.

o Outside the United States, must be of the form (Country Code + phone number).
Exit points:
Resume: Provides the capability to resume within the 8x8 Contact Center IVR tree on detecting a hang-
up event on the External IVR server, and redirects a call to a predefined or assigned destination.

Forward to
External
Number

Use the Forward to external number object to forward a phone interaction to a phone number that is
not managed by 8x8 Contact Center.
Parameters:
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n In the Label text entry area, type the alphanumeric label used to uniquely identify the element in
the IVR script.
Labels can contain a maximum of 21 characters, and must be unique within an IVR script.

n In the Phone number text entry area, type the complete phone number the IVR script dials when
transferring a phone interaction.
The Phone number text entry area accepts only the numeric characters 0-9.

o In the United States, phone numbers, must be of the form (1 + three-digit area code + seven-
digit phone number).
In the United States, when typing numbers into text entry areas, always preface the area
code with 1.

o Outside the United States, must be of the form (Country Code + phone number).
Exit points: None

Label Use the Label object in combination with the Goto object, described later in this table, to redirect call
processing to any location in the IVR script. The Goto object redirects the interaction to the parameter
of a Label object.
Parameters:
In the Label text entry area, type the alphanumeric label used to uniquely identify the element in the
IVR script.
Labels can contain a maximum of 21 characters, and must be unique within an IVR script.
Exit points: None.

Goto Use the Goto object to redirect the script to continue running at some labeled location in the script.
Parameters:
In the Destination list, choose a labeled script location.
Exit point: None

Set Variable The ability to set variables allows programming abilities within IVR scripts, enabling better caller exper-
ience. You can use variables to remember the user input and use them to drive the call flow. You can
create variables to store values of string and number types, and reference them anywhere and any
number of times in the script.
8x8 Contact Center allows two types of variables in IVR:

n System Variables: These are predefined variables which cannot be edited:
$QueuePosition: Returns the current position of a call within the queue.
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$callerPhoneNumber: Returns the caller's phone number based on caller ID.
$callbackPhoneNumber: Returns the call back number input by the caller.

n User-Defined Variables: These are variables defined by users. You can initialize these variables
with a certain value, and modify them later.

Parameters:

n Object Tag: Enter a label to uniquely identify the element in the IVR script.

n Variable: Select a predefined variable from the drop-down list, or create a new variable.

n Value: Select a desired value for the variable.
For example, to offer callers suitable choices based on the queue position, set a variable and check:

n If the queue position is greater than 10, offer to call back when an agent is available.

n If the queue position is less than 10, play promotional messages and retain callers in the queue.
Exit Points: None

Test Vari-
able

The Test Variable object allows you to test an already defined variable and test it against a set value.
To test a variable, select either a system variable or a user-defined variable, and test it against a spe-
cific value. For example, test how many calls are ahead of a call using the system variable $QueuePos-
ition. If there are more than ten calls ahead of this call, announce the position to the caller, and offer
the caller to receive a call back. If there are fewer than 10 calls ahead of this call, keep the caller in the
queue.
To access the Test Variable object within the script, click Add next to a node, and select the Test Vari-
able object from the Insert Object list.
Exit Points:

n True: equals true if it meets the condition set for the variable

n False: equals true If it does not meet the set condition

Randomize The Randomize object allows us to randomly pick callers and offer a different treatment from the
norm. For example, in a customer survey program, you may want to randomly select 50% of callers, and
direct them to a survey. You will need to use the randomize object that randomly picks callers and
offers a specific treatment based on the path chosen.
Parameters:

n Object tag: Enter the alphanumeric label used to uniquely identify the element in the IVR Script.

n Path A Percentage: Slide the pointer on the scale to indicate the percentage of callers to be
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directed to the Path A treatment.
Exit Points:

n Path A: Allows you define the treatment for callers randomly directed to path A.

n Path B: Allows you to define the treatment for callers not chosen for path A.

Hang up Use the Hang up object to disconnect a phone interaction.
The IVR disconnects a phone interaction if the call has not been forwarded to a queue, voicemail, or an
external number, and the script flow contains no further script objects.
In the Label text entry area, type the alphanumeric label used to uniquely identify the element in the
IVR script.
Labels can contain a maximum of 21 characters, and must be unique within an IVR script.
Exit points: None

Default Ter-
mination

The IVR tree has two objects:

n Main IVR

n Default Terminating Node
The default terminating node is the last node in the IVR tree, and cannot be deleted from the tree. You
can only add and remove IVR objects between the first and last nodes. The Default Terminating node
catches all calls that would drop on reaching a non-terminating exit criterion, such as Play or Label in
the IVR script, and routes them with four exit options:

n Forward to Queue: Directs the call to a queue

n Forward to Voice Mail: Directs the call to a voicemail queue

n Forward to External Number: Forwards the call to an external phone number

n Hang up: Terminates the call
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IVR phone script examples

An 8x8 Contact Center IVR script plays audio files to prompt a caller for information and uses the caller's responses to
route the interaction to a specific phone queue.

The following procedure illustrates scripts in 8x8 Configuration Manager that contain increasingly complex
combinations of IVR script objects and control flow features:

n Build a Simple Greeting and Routing Script

n CreateMenus of Options

n UseCaller Information to Process Interactions

n Enable a Phone Channel and Associated IVR Script

Before you begin
The procedure in this section assumes that you have used 8x8 Configuration Manager to create:

n At least one phone queue; for details on creating phone queues, refer toCreate Inbound PhoneQueues.

n At least one voicemail queue; for details on creating voicemail queues, refer toCreate Voicemail Queues.

n At least one contact center schedule; for details on creating schedules, refer toDefine Business Hours and
Schedules.

Best Practice:Before editing a 8x8 Contact Center IVR script, disable the IVR channel.

To disable the phone channel:

1. From the Configuration Menu, openChannels.

2. Go to the Phone tab.

3. Find the desired channel, and click .

4. In the Properties tab, clear This channel is enabled.

5. ClickSave.

Build a Simple Greeting and Routing Script
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Perform the procedure in this section to build a simple IVR script that:

n Checks a schedule for the contact center's current hours of operation.

n Plays a greeting message to the caller.

n Routes the call to a queue if the contact center is open.

n Offers the caller the chance to leave a voicemail message if the contact center is closed.

To select a schedule, play a greeting, and route a call to a queue:

1. From the Configuration Menu, open Scripts.

2. Go to the Phone tab.

3. Find the desired script, and click .

4. Open the Script tab.

5. Click an object to see [add].

6. In the object add list, select Schedule.

7. In the object configuration area:

a. For the Label text entry area, type <BusHours>.

b. For the Select Schedule list, choose a previously defined schedule.
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c. ClickSave.
8x8 Configuration Manager inserts the Schedule object below the MainIVR label.

8. If a call arrives when the contact center is open, play a greeting message:

a. In the Schedule object, select the open exit point.

b. In the object Add list, choose Play.

c. In theName text entry area, type <PlayWait01>.

d. In the Played Message list, chooseWait for next agent.
The procedure refers to audio files from the 8x8 Contact Center default set of audio files. Your IVR scripts
may reference one or more default audio files, or reference the customized audio files you uploaded to 8x8
Configuration Manager.

e. ClickOK.
8x8 Configuration Manager inserts the Play object below the open exit point.

9. Choose the queue that the caller is routed to.

a. Select the Play object under schedule.

b. Click add.

c. Select Forward to Queue.

d. In the Label text entry area, type <PhoneQ01>.
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e. In theQueue name list, choose a phone queue.

f. ClickOK.
8x8 Configuration Manager inserts the Forward to Queue object below the Play object.

10. If the call arrives when the contact center is closed, route the call to a voicemail queue.

a. In the Schedule object, select the closed exit point, then in the object selection list, choose Forward to
Voice Mail Queue.

b. In the Label text entry area, type <Vmail01>.

c. In the Invite Message list, choose Voice mail invite.

d. In theQueue name list, choose a voicemail queue.

e. Select Access to voice mail is mandatory.

f. ClickOK.
8x8 Configuration Manager inserts the Forward to Voice Mail Queue object below the Close label.

Create Menus of Options

The procedure in this section illustrates how to implement menus of options, and builds on the IVR script example in
Build a Simple Greeting and Routing Script.

To script a set of menu options:
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1. In the script you created in the procedure in Build a Simple Greeting and Routing Script, delete the current open
hours script logic. In the script:

a. Select the Forward to queue object <PhoneQ01>, then clickRemove.

b. Select the Play object <PlayWait01>, then clickRemove.

2. When the contact center is open, play a menu of options.

a. In the schedules object, select the open exit point.

b. In the object add list, chooseMenu.

c. In the Label text entry area, type <OpenMenu01>.

d. In the Invite Message list, chooseOptional queue Selection.
When a caller first connects to the contact center, the Menu object's Invite message audio file orients them to
the set of menu choices. In most cases, this implies the need for an invite message that has been customized
for your contact center.

e. In the Invalid message list, choose Invalid selection.
If a caller provides an invalid response to the invite message, the Invalid message audio file informs them
that 8x8 Contact Center cannot interpret their response.

f. In the Empty message list, chooseWait for next agent.
If a caller does not respond to the prompt within ten seconds, the Emptymessage audio file informs them to
respond.

Version 9.14 350

IVR phone script examples



g. ClickOK.
8x8 Configuration Manager inserts the Menu object below the Open label.

3. Configure the message played when the caller responds to the initial menu by pressing 1:

a. In theMenu object, select the 1 exit point.

b. In the object selection list, choose Play.

c. In the Label text entry area, type <CallRecordWarn>.

d. In the Played message list choose theCall monitoring warning audio file.

e. ClickSave.
8x8 Configuration Manager inserts the Play object below exit point labeled 1.

4. Configure the queue the caller is routed to if they respond to the initial menu by pressing 1:

a. In theMenu object and under the 1 exit point, select the Play object.

b. In the object add list, choose Forward to queue.

c. In theName text entry area, type <PhoneQ02>.

d. In theQueue name list, select a phone queue.
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e. ClickOK.
8x8 Configuration Manager inserts the Forward to Queue object below exit point labeled 1.

5. Continue to the next example, UseCaller Information to Process Interactions, to build on this script.

Use Caller Information to Process Interactions

Use the procedure in this section to prompt a caller for information that is used to find a caller's record in the Local CRM
database, then use information contained in that record to determine how to route the call. The following procedure
builds on the IVR script example inCreateMenus of Options.

To create an IVR script that prompts a caller, tests for the caller's Local CRM record, and routes the call:

1. Prompt the caller for information, such as an account number. In theMenu script object, select the exit point
labeled 2, then in the object selection list, chooseGet Value.
8x8 Contact Center displays the parameters for the GetValue object in the object configuration area:

a. In the Label text entry area, type <GetAccountNumber>.

b. In the Invite Message list, choose Enter mandatory account number.

c. In the Invalid message list, choose Invalid selection.

d. In the Empty message list, choose Invalid selection.
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e. In theData to collect list, chooseCustomers: Account Number.

f. Select Entry is mandatory.

g. ClickOK.
8x8 Configuration Manager inserts the Get Value object below the exit point labeled 2.

You can also use the GetANI script object to look in the Local CRM for existing customers.

2. Add a Label object to the portion of the script that processes customer accounts.

a. In theGetValue object, select theContact found exit point.

b. In the object add list, choose Label.

c. In the Label text entry area, type <AcctFound>.

d. ClickOK.
Labeling the portion of the script that processes customer account interactions enables other script objects to
use the Goto script object to transfer control jump to that portion of the IVR script.

3. Check the customer's status. Select the Label object, then in the object selection list choose Picklist.
8x8 Contact Center displays the parameters for the Picklist object. In the object configuration area:

a. In the Label text entry area, type <ChkCustID>.

b. In theData to test list, chooseRecord Type.

c. In the Select operator list, choose Is equal to.
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d. In the Select values list, chooseCustomer.

e. ClickOK.

The 8x8 Configuration Manager inserts the Picklist object below the found label.

n The configuration of your Local CRM determines the types of data the Picklist script object can test for.

n Use the Picklist script object's matched and unmatched labels to use the result of the Picklist's comparison
operation to route the call.

n The Label script object enables other objects to use a Goto script object to transfer control to the Picklist script
sequence.

n You can also use the GetANI function to use the caller's Automatic Number Identification (ANI) to look for
existing Local CRM data.

Enable a Phone Channel and Associated IVR Script

Perform the following procedure to enable a phone channel and the channel's IVR script.

To enable the Phone channel:

1. From the Configuration Menu, openChannels.

2. Go to the Phone tab.

3. Find the desired channel, and click .

4. In the Properties tab, select This channel is enabled.
For details, refer toConfigure Phone Channel Properties.

5. ClickSave.
8x8 Contact Center puts the IVR channel and associated script into service.

You can nowmake test phone calls to the phone channel to validate the operation of the IVR script.
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Copy and paste IVR script objects

While defining or editing an 8x8 Contact Center IVR script in 8x8 Configuration Manager, 8x8 Contact Center
administrators have the flexibility to copy and paste IVR script objects, reducing the time spent writing the script. You
can use the copy and paste icons to copy any part of the IVR tree and paste it to a desired area. You must then apply
the changes for them to take effect. The copy-and-paste feature is especially useful if you introduce similar call
treatments with slight variations. You can write once, and copy asmany times as you desire within the script.

To copy and paste a part of the IVR object:

1. From the Configuration Menu, open Scripts.

2. Go to the Phone tab.

3. Find a script and click .

4. Go to the Script tab.

5. Select an object, and clickCopy.
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6. Select an IVR tree node you wish to paste the copied object to.

7. ClickPaste. The segment is pasted immediately.

8. ClickSave to apply the changes.
OR
ClickRevert to remove all changes since the last save.
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Create inbound phone scripts

8x8 Contact Center inbound phone scripts are grouped under Scripts > Phone in 8x8 Configuration Manager. 8x8
Contact Center administrators can create a user-defined script or use the system default script:

System default script
IVR script default: The default phone script provided by the system. You can copy and then edit the default script
when creating a new user-defined script.

User-defined script
A phone script created by the user. It can be Inbound phone, Outbound phone, or Post Call Survey script. You can
create, edit, or delete a user-defined phone script by going to Scripts > Phone.

To create or edit a user-defined phone IVR script:

1. From the Configuration Menu, open Scripts.
Scripts are grouped bymedia in separate tabs: Phone, Chat, Email, and Social.

2. Go to the Phone tab.

3. Click orAdd new phone script.

4. Enter the properties for the phone script.
The following table summarizes the options under Scripts > Phone > Properties:

Phone/
Chat/Email
Script
Property

Description

Script Type n Phone: Select a script type: Inbound phone, Post Call Survey, or Outbound phone.

n Chat and Email: A read-only reminder of the script type. It displays if it is a phone, chat,
or email script.
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Phone/
Chat/Email
Script
Property

Description

Script Name Enter a unique name for the script.

Category A category helps you organize your scripts better. For example, if you have multiple scripts
serving Support and Sales needs, you can group scripts under separate categories. You can
select an existing category or create a new one.

To create a new category:

1. Select Edit Categories from the drop-down menu.

2. In the Category dialog box, add a new category by clicking .

Copy script
from

Choose this option to place a copy of the default or an existing IVR script into this channel.
This option appears when you are creating a new script.

Comment Add comments or additional notes, if desired.

This script is
enabled

Select to place this script definition into service.

Assigned
Channels
/Assigned
Queues

n When you select Script Type > Outbound Phone, you must assign one or more new
outbound phone queues.

n When you select Script Type > Post Call Survey or Script Type > Inbound phone, you
must assign one or more channels to the script.

Note: It is not mandatory to assign a channel while creating a script.

To assign new channels:

1. Click on the link to bring up the list of channels.

2. Select the desired channels from the list.

3. Click Assign.
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Phone/
Chat/Email
Script
Property

Description

Note:All channels in the list are associated with a script whether default or
user-defined. If you assign and save a new script, the old script is
permanently replaced by the new selected script.

Note: It is recommended to restrict your assignment to 100 channels at a
time.

5. ClickSave.
Upon saving the properties, 8x8 Configuration Manager takes you to the Script tab, where you can define the
script.

6. In the Script tab, clickMainIVR.
The [add] option appears.

7. Add the desired IVRObjects such as Schedule, Check ANI, and Get Value.
See Summary of Phone IVR Script Objects for the complete list of available objects and their description.

8. ClickSave.

9. To edit the details, click any object and select edit. An edit window opens up. To view the details, double-click any
object. The View details window appears. You can also click edit from inside the View details window.

10. To undo the changes clickRevert.
For a primer on writing IVR scripts, refer to the guide on Interactive Voice Response for samples, refer to IVR
Phone Script Examples.

11. Click the on the script page to generate a PDF image and save it locally. The PDF printout is generated

containing the script name, date, and time of print. Supervisors and administrators can review and modify the
script as needed.
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Note:When creating or modifying a script, disable the script by clearing This script is enabled in
the channel's Properties tab. This ensures that 8x8 Contact Center does not run an incomplete
script. After completing the script, enable it again.
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Create outbound phone scripts

In many contact centers, queued inbound calls are more important than queued outbound calls. In situations where
there is an ample supply of 8x8 Contact Center queued outbound calls waiting, all agents are kept busy all of the time.
When a new inbound call comes in, chances are, the caller has to wait for an agent to finish their less important
outbound call. Using an outbound phone script, you can now reserve a number of agents, in the available and idle state,
to improve the probability of quickly attending to a new inbound call. While there are fewer than the assigned number of
reserved available and idle agents, no queued outbound calls will be presented to agents. Whenever the available and
idle agents reserve is exceeded then the most idle agent will receive a queued outbound call.

Reserve idle agents for inbound queues
In 8x8 Contact Center, to improve handling of inbound queues when queued outbound calls are less important,
administrators must define an outbound phone script in 8x8 Configuration Manager and assign it to an outbound phone
queue. In the outbound phone script, specify the inbound queue you wish to prioritize and the number of reserved
agents at a time to be prevented from handling queued outbound calls.

Note: This feature only applies to outbound calls that are assigned to go through an outbound queue. a
click-to-dial call is a direct outbound call that does not go through a real outbound queue.

To reserve agents for an inbound queue:

1. From the Configuration Menu, open Scripts. Scripts are grouped bymedia in separate tabs: Phone, Chat, and
Email.

2. Go to the Phone tab and clickAdd new phone script.
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3. In Script type drop-downmenu, select Outbound phone.

4. Enter a Script name for the script.

5. InAssigned Queues, link the outbound phone script to the outbound phone queue the agents are going to serve,
and clickSave.

6. Go to the Script tab.

7. In Test Queue, select the inbound phone queue you like to protect and test the availability of its agents.

8. Specify theNumber of agents to reserve and save.

Whenever an outbound interaction such as a customer callback needs to be made, it will be offered to the longest
idle agent only if there are enough reserved idle agents for that queue. For example, if you designate four agents
as reserved in an inbound queue, the outbound interaction will be offered to the longest idle agent whenever the
fifth agent becomes available in the queue.
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Assign scripts to channels

An 8x8 Contact Center chat script defines the behavior from the time a website visitor enters the website, initiates and
completes a chat. For details on chat scripts, refer toCreate a Chat Script. For a chat channel to be operational, 8x8
Contact Center administrators must link it to a chat script that defines the chat flow process.

You can assign a script to the channel in 8x8 Configuration Manager in two ways:

n From the Scripts page

n From the Channels page

From the scripts page
1. From the Configuration Menu, open Scripts.

2. Go to a media tab, such as Phone, Email, or Chat.

3. Select a script from the list, and double-click to open.

4. In the Properties tab, clickAssigned Channels.
The list of existing channels appears.

5. Select a desired channel, and clickAssign.

From the channels page
1. From the Configuration Menu, openChannels.

2. Go to a media tab, such as Phone, Email, or Chat.

3. Select a channel from the list, and double-click to open.

4. In the Properties tab, select a script from the list of scripts.

Note: In phone and email channels, a default script is automatically assigned if you do not select
any user-defined scripts.

5. ClickSave.
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Enable Direct Agent Routing (DAR)

8x8 Contact Center's Direct Agent Routing (DAR) is a powerful and flexible set of script functions to allow agent’s call
handling. In addition to legacy DAA call handling, DAR provides a powerful and flexible set of script functions which
allows refined selection and control of calls to be directed to an individual agent. The following newDirect Agent
Routing (DAR) objects and enhancements are introduced in 8x8 Configuration Manager:

n Get Value is extended to be able to capture an agent’s assigned DAA number. The caller is prompted to input a
valid DAA number which is then validated.

n Set Agent finds agents based on:
o Channel linked to Direct-In-Dial (DID) number

o Look up Local CRM for case created by, case last worked by, and case assigned to
o Set a fix agent selection

n Transfer to Agent directs a call to an agent. It can be used in conjunction with Set Agent to find an agent or by
itself. This supports separate logic as why a call may not reach the target agent depending on the agent’s real-time
state.

n Transfer to Agent Voicemail transfers call to an agent’s voicemail typically if Transfer to Agent is not
successful.

DAA call handling constraints
The following list presents the DAA constraints which are now overcome by the newDAR.

n DAA requires callers to enter an agent’s DAA number exclusively during IVRMenu treatments.

n DAA calls are always presented to an agent regardless of the agent’s current state.

n Unanswered DAA calls may be directed to an agent’s voicemail with primitive opt-out controls.

n Queue calls are presented to agents who are Available even if they are on a DAA call.

n Forward to Agent logic is difficult to comprehend due to its implied action within IVRMenus.
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Features
n Identify the agent the customer should talk to based on:

o Who created the case associated with the customer

o Who is assigned to the case

o Who last worked on the case

o Agent DID number that was shared with the customer

n Transfer the customer call to the right agent based on agent status, and change agent status to busy after
accepting the call

n Control agent’s status during a DARCall

n Allow the caller to leave a voicemail for the agent if the agent is not available

n Allow caller to take an option to divert if they prefer not to leave a voicemail

n Ability to adjust post-processing time for direct-to-agent calls from five seconds to a maximum of 60 minutes

Limitations
DAR calls do not yet support Transaction Codes.

Requirements
The 8x8 Contact Center agent must be assigned a Direct Access Number to be eligible for Direct Agent Routing. For
details on setting up Direct Agent Routing, see our content on creating user-defined phone IVR scripts.

Process flow for direct agent routing
A typical process flow for Direct Agent Routing involves the following steps:

1. Get input such as case ID or Account number (GetValue) from the caller or caller ID (Check ANI). The system then
searches CRM for matching records.

2. On finding a matching customer or case record, pick agent who worked on the case or created the case or is
assigned to the case. For details on options, refer to Set Agent object.

3. If agent is found, transfer the call to the agent. You can transfer to agent irrespective of agent's current status

OR
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4. If agent is not available, transfer to agent's voicemail.

The following table summarizes the newDAR objects:

DAR
Object

Description

Set Agent Set Agent object facilitates direct agent routing. Before using Set Agent object in your script, you must
get value (account number or case number) from the caller or check ANI. If these objects succeed in
finding a match, you can then use Set Agent object to pick the agent you wish to reach based on the
following parameters.

n Case created by: Find the agent who created the case.

n Case last worked by: Find the agent who last worked on the case.

n Case assigned to: Find the agent who is assigned to the case.

n Channel linked to: Find the agent who is linked to the channel the call was channeled through. Use
this option to direct an incoming call to an agent directly.

n None: Find an agent by name. By selecting this option, you can select a specific agent to direct the
call to using Fix Agent.

n Fix Agent: Click the Choose Agent link and select an agent from the list.

Transfer The Transfer to Agent object connects the caller to the agent.
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DAR
Object

Description

to Agent -Use this object with Set Agent. For this to work, you must have picked an agent using Set Agent.

-Use this object without Set Agent to transfer calls directly to the agent with a personal channel. The
agent must be assigned with a personal channel.

Transfer to Agent object provides options which support transferring a call to agent even if status is:

n busy

n on break

n working offline

n logged off

If you do not select any option, then the call is transferred only if the agent status is Available.

Transfer
to Agent
Voicemail

This object allows a caller to leave a voicemail for an agent. It assumes the agent is already chosen
using Set Agent object or Get Value object.

Get Value Use the Get Value object to request the caller to provide an agent's extension number. On selecting this
option, the checkbox 'Entry is mandatory' is checked automatically and greyed out. You will be given the
option to set the maximum length of extension. By default, it takes 8 digits.

Generate report on direct agent calls
The agent is not offered any post-processing activity for a DAA call. 8x8 Contact Center supervisors can track DAA calls
through the Detailed Transactions Activity report.

To generate the Detailed Transactions Activity report:

1. In 8x8 Agent Console, select Report from the menu.

2. Generate a report using the existing reporting template.

3. Select New Report on the top right corner.

4. Select Detailed Transaction Activitymaster report from the list.

5. ClickNext.

6. Enter the desired data and time range.

7. ClickSelection Window and select the desired queues.
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8. Select Save andRun.
A new report generates and opens in Excel. Look under Type to find DAA calls.
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Enable Text to speech

The 8x8 Contact Center IVR engine converts text to speech using the Say object in 8x8 Configuration Manager. The
Say object relays static free text or dynamic value of a variable (phone number, queue position) to the caller. These text
to speech announcements can play dynamic or static data in multiple languages.

Features
n Convert static text or dynamic value of a variable to speech using the Say object in IVR.

n Announce text to speech in multiple languages.

n Offer basic and prime text to speech services.

8x8 Contact Center offers two levels of Text to Speech service with the following options:

n Basic Text to Speech

n Prime Text to Speech

Text to Speech Options Basic Prime

Languages English (US), French, Italian, German, Span-
ish

40+

For a list of language supported, click
here.

Voices 1 60+

Datatype Not supported digit, number, phone, currency,date, time

Character limit 130 210

Number of Say instances
allowed in IVR

unlimited unlimited

Languages Supported in Prime

n Arabic

n Bahasa

n Basque

n Cantonese
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n Catalan

n Czech

n Danish

n Dutch

n English (AU)

n English (GB)

n English (India)

n English (Ireland)

n English (Scotland)

n English (South Africa)

n English (US)

n Finnish

n French (Canada)

n Galician

n German

n Greek

n Hebrew

n Hindi

n Hungarian

n Italian

n Japanese

n Korean

n Mandarin (China)

n Mandarin (Taiwan)

n Norwegian

n Polish

n Portugese (Brazil)

n Portugese (Portugal)

n Romanian

n Russian
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n Slovak

n Spanish (Castillan)

n Spanish (Columbia)

n Spanish (Mexico)

n Swedish

n Thai

n Turkish

n Valencian
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Enable Queued Callback

The 8x8 Contact Center Queued Callback allows callers waiting in a call queue to opt out of the queue and be called
back when an agent becomes available. This feature which is configured in 8x8 Configuration Manager, detects the
caller phone number or allows the caller to input the callback number before exiting the queue. The system offers an
outbound call to an available agent serving the queue. When the agent accepts the call, the call is dialed out to the
caller using the callback number. The call is routed through an outbound queue.

Features
n Allows callers to opt out of the queue and be called back when an agent becomes available.

n Detects the caller phone number, or allows the caller to input the callback number before exiting the queue.

n Caller can input the desired callback number or caller's phone number (ANI) is used.

n Callback is initiated as soon as an agent is available.

Use case
At AcmeHealth, callers have an option to avoid long call waiting times and receive a call back from the advise nurse
team for a better experience. In addition to the exit choices of operator assistance and leaving a message for the care
team, the caller is given a choice to be called back by the advise nurse team. If a caller opts to be called back, they are
prompted to input the call back phone number. This number is then restated for confirmation. The following diagram
shows the updated call flow for Queued Callback.
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To enable call back, 8x8 Contact Center IVR offers the following scripting capabilities.

n Get Value supports an additional parameter to collect caller's phone number

n Callback object supports calling the customer back after the caller exits the queue, by initiating an outbound call
when an agent serving the queue is available.

AddCallback option to IVR

To add a callback option to the existing IVR script:

1. Follow the steps 1 through 3 explained in In-Queue Treatments and Controls.

2. Modify the Say statement that announces the exit queue choices to include the option for callback.
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3. Under Get Digit, add an option to Get Value. For Data to Collect, select customers: Phone Number.

4. Add a few Say statements to announce the call back number input by the caller.

5. With Get Digit choices, allow the caller to confirm the phone number or prompt to enter the phone number again.

6. Add a label for callback execution.

7. Under the label for Callback, add the Call back object and select the following parameters:

n Queue name: Select an existing outbound queue to route the call.

n Call back ANI: Select a channel number for outbound caller ID.

n Dial plan: Select from an existing dial plan.

n Expiration time: Set an expiration time for call back. After the specified period, the call back is abandoned.

n Under Dial back parameters, you can specify the number of retries and the duration for time out.

o Try to reach callback party: Select the number of attempts to call back. The call failure is determined
by the following factors:

- Agent did not answer the call.

- Agent answered, but the outbound leg dials out and experiences a busy network.

- RNA (Ring no answer)

o Minimum delay between tries: Specify the time delay between tries.

Version 9.14 374

Enable Queued Callback



o Cancel callback after: Enter the duration after which call back request needs to be canceled.
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8. Save the script and assign it to a channel.
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Enable Post Call Survey

A Post Call Survey is a questionnaire presented to the caller at the end of a call, typically to collect feedback about the
quality of service offered by the company. Companies use a survey to gather feedback from customers, and analyze the
collected data to help improve their services. You can get feedback on the overall product quality or service quality, get
to know the customer satisfaction, and take corrective actions. Here are a few typical survey questions:

n Customer Satisfaction: "How satisfied are you with the overall experience of our service?"

n Agent Performance: "How do you rate the service quality of the agent who served you on the call?"

n First Call Resolution: "Was the issue resolved at first call or did you call more than once?"

n Net Promoter Score: "Would you recommend our service to your family or friends?"

Features
n Offers a questionnaire to the caller at the end of a call to collect feedback about the quality of service.

n Provides IVR-controlled surveys which are defined by an IVR script. The behavior and questions in IVR-controlled
surveys are not controlled by agents.

n Provides agent-assisted surveys which are offered by agents via transferring a call to an inbound phone queue or a
dedicated Post Call Survey channel.

n Provides stand-alone/Independent surveys which are taken by customers voluntarily and is directed to the survey
from a web page.

n Offers surveys to callers while they are on a call, at the end of the call, or call back at a later time.

n Presents survey questions as scale, yes/no, and voice comment questions.

For details about use cases and survey questions, see our 8x8 Contact Center Post Call Survey User Guide.
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Enhanced Data Augmentation

In 8x8 Contact Center, data collected by External CRMs and third party integrations can now be used in a meaningful
way. The 8x8 Data Augmentation API allows you to tie data between external applications and call data. It facilitates
greater resolution on what drives call volumes and handling times. Prior to this release, the two nodes: 8x8 IVR, and
forward to external IVR, have been limited in terms of data variables.

Features
n Allows 8x8 customers to tie data between external applications and call data.

n Facilitates routing calls to the correct queues based on data collected.

n Drives down call misroutes and call handling times.

n Results in richer data and better insights in 8x8 Analytics for Contact Center.

Use cases
The followings are some common use cases for Data Augmentation:

n Route calls to queues by name, ID, or intention of the call

n Use for advanced Auto Attendant systems

n Route to different stores, locations, or offices

n Route to the last agent who handled the call previously (by integrating to a system that recorded the last
interaction)

An example workflow
1. A variable is created based on the call flow or data need.

2. Call arrives at the 8x8 Contact Center.

3. The call is then forwarded to external IVR (eIVR).

4. eIVR asks questions or queries a background integration or CRM, based on caller inputs.

5. The intent of the call is assessed by eIVR.
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6. eIVR assigns a queue ID value to the call.

7. eIVR posts the queue ID value to VCCAPI.

8. Calls are terminated in eIVR.

9. The call is resumed in VCCwith the queue ID value assigned.

10. A phone script tests to see if the variable matches.

11. The call is then routed to a queue based on data collected from eIVR.

Steps to forward calls to an external IVR (eIVR)
The following steps explain how you can forward calls to an external IVR such as intelligent IVR. Using the phone script
in the 8x8 Configuration Manager, forward an incoming call to the external IVR, assign a queue ID inside the intelligent
IVR, check the queue ID inside the phone script, and forward the call to the right queue.
Step 1: Forward calls to an external IVR

When a call comes in to a Contact Center channel, the first step is to forward the call to an external IVR. In the 8x8
Configuration Manager, go to Scripts > Phone to create or edit a new script. For details, see our documents on how to
create an inbound phone script. When creating or editing a phone script, use the Forward to External IVR object to
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forward the phone interaction to an external IVR server such as intelligent IVR.

1. Go to Scripts from the main menu in 8x8 Configuration Manager.

2. Select Phone > Add new phone script.

3. In the Script tab, add Forward to External IVR.

n In theObject tag text entry area, type the alphanumeric label such as iIVR.
Labels can contain a maximum of 21 characters, and must be unique within an IVR script.

n In the Phone number text entry area, type the complete phone number the IVR script dials when transferring
a phone interaction.
The Phone number text entry area accepts only the numeric characters 0-9.

o In the United States, phone numbers, must be of the form (1 + three-digit area code + seven-digit phone
number).
In the United States, when typing numbers into text entry areas, always preface the area code with 1.

o Outside the United States, must be of the form (Country Code + phone number).

4. ClickOK.

Step 2: Assign a queue ID inside the external IVR

Within the external IVR such as intelligent IVR application, the caller selects a menu choice that assigns a queue ID or
variable, then sends the call back to the 8x8 IVR. The queue ID can be assigned based on:
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n An integration between 8x8 and eIVR solutions

n A menu selection

n The caller identity verification

The simple menu below shows the selection to attach the variable. The caller selects 1 or 2 to be directed to either the
Sales or Support queue. A queue ID is assigned and the call is sent back to the Contact Center. Inside the intelligent
IVR integration, multiple variables can be attached based on the customer needs, such as queue names or phone
numbers. 8x8 uses the basic authentication method or SIP call ID as the primary key to correctly identify the caller and
apply the right variable to the call.

Step 3: Check the queue ID in the 8x8 phone script

When the call returns to the 8x8 IVR, it goes back to the resume path with variables attached. Resume provides the
capability to resume within the Contact Center IVR tree on detecting a hang-up event on the external IVR server, and
redirects a call to a predefined or assigned destination. For details, see our content regarding how to Forward to
External IVR.
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Use the phone script Test Variable object to run a simple variable test with a true or false statement. If the queue ID
matches the variable assigned in the external IVR, the call is routed to the correct queue. You can also check a call by
name or a phone number. The simple task below shows the ability to take action based on a variable returned by 8x8
Data Augmentation API:

1. In the Script tab, add the Test VariableObject.

2. Set theCondition and use the newly created variables in the Test Variable. To test a variable, select either a
system variable or a user-defined variable, and test it against a specific value. For example, you can test the
position of your call in the queue, the caller phone number, or the call back phone number by selecting a system
variable. Type $ to list the system variables or type _ to list user variables. For details see Test Variable object.

3. ClickOK.

Step 4: Forward the call to the right queue

If the variable test is passed, we forward the call to the correct queue within the same script using the Forward to Queue
object.
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1. In the Script tab, add the Forward to QueueObject.

2. Enter the Object tag, Queue timeout, and Queue Condition. For details, see Forward to Queue object.

3. ClickOK.
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Create a chat script

An 8x8 Contact Center chat script defines the path of a chat interaction from its initiation until it is accepted by an
agent. Using chat scripts, 8x8 Contact Center administrators can define how to present a chat, when to present it, what
information they need to collect before initiating the chat, and which queue to direct the chat interaction to. They can
create a new script and assign it to any number of channels. Chat scripts are grouped under Scripts > Chat in 8x8
Configuration Manager. The enhanced chat script allows you to design and control the chat flow in a contact center. To
see the chat workflow diagram, refer toChat Overview.

Let's say Bob, a contact center administrator at AcmeJets, wants to define a chat workflow that allows website visitors
to initiate a chat with friendly representatives from his company. To enable a smooth chat flow, Bob must create a chat
script that enables the following workflow:

1. Allow web page visitors during business hours to click the chat button and initiate a chat.
OR
Invite visitors to chat once they have spent some time on the page.

2. When they click the chat button, present a short pre-chat form that helps identify the customer's interests.

3. Once the customer submits the pre-chat form, direct the chat interaction to an appropriate chat queue.

4. If the wait is too long, allow the customer to skip waiting in the queue and send an offline message.

5. Present the customer with a chat window they can use to interact with a representative.

6. Allow the visitor to send an email message, if reached during closed hours.

To achieve the above goals, Bob must create a chat script like the one below. The objects can be entered in any order,
as 8x8 Contact Center arranges them in the correct order.

To create a chat script:

1. From the Configuration Menu, open Scripts.

2. Go to theChat tab.

3. Click orAdd new chat script.

4. Follow the steps below:

Configure Chat Script Properties

1. Go to the Properties tab.
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2. Enter the properties for the script.
The following table summarizes the options under Scripts > Chat > Properties:

Phone/
Chat/Email
Script
Property

Description

Script Type n Phone: Select a script type: Inbound phone, Post Call Survey, or Outbound phone.

n Chat and Email: A read-only reminder of the script type. It displays if it is a phone, chat,
or email script.

Script Name Enter a unique name for the script.

Category A category helps you organize your scripts better. For example, if you have multiple scripts
serving Support and Sales needs, you can group scripts under separate categories. You can
select an existing category or create a new one.

To create a new category:

1. Select Edit Categories from the drop-down menu.

2. In the Category dialog box, add a new category by clicking .

Copy script
from

Choose this option to place a copy of the default or an existing IVR script into this channel.
This option appears when you are creating a new script.

Comment Add comments or additional notes, if desired.
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Phone/
Chat/Email
Script
Property

Description

This script is
enabled

Select to place this script definition into service.

Assigned
Channels
/Assigned
Queues

n When you select Script Type > Outbound Phone, you must assign one or more new
outbound phone queues.

n When you select Script Type > Post Call Survey or Script Type > Inbound phone, you
must assign one or more channels to the script.

Note: It is not mandatory to assign a channel while creating a script.

To assign new channels:

1. Click on the link to bring up the list of channels.

2. Select the desired channels from the list.

3. Click Assign.

Note:All channels in the list are associated with a script whether default or
user-defined. If you assign and save a new script, the old script is
permanently replaced by the new selected script.

Note: It is recommended to restrict your assignment to 100 channels at a
time.

3. ClickSave.

Create the Chat Script

1. Go to the Script tab.
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2. ClickChat. The [add] option appears. For a complete list of objects and their descriptions, refer to Summary of
Chat Script Objects.

3. Click [add].

4. Select Schedule from the chat objects.
This object performs a particular sequence of script operations when the contact center is open or closed.

a. Enter a name for theObject Tag.

b. Select an existing schedule from the list of Select Schedule.

c. ClickOK.

5. Click [add] next toOpen and then:

a. Select Forward to Queue, enter a name for the object tag, select a queue, and clickOK.
This object forwards a chat interaction to a specific chat queue, such as the sales or main queue.

b. Select CVB Online, enter a name for the object tag, and clickOK.
CVB Online refers to a chat design element, such as a chat button, chat invitation, chat form, or chat window,
which can be used on your website during the business hours.

c. Select Greeting Message and clickOK.
This object displays the greeting message to invite customers to the chat session. Append <@skipQueue@>
to your message to offer the option to skip queue in the chat window.

d. Select Skip queue, enter the relevant parameters, and clickOK.
This object gives customers the option to opt out of waiting in the chat queue and send an email offline. It can
only be triggered in the greeting message object.

6. For theCVB Online, click [add]:

a. Select Online button, enter a name for the object tag, and clickOK.

b. Select Invitation, enter a name for the object tag, and clickOK.

c. Select Pre-chat form, enter a name for the object tag, and clickOK.

d. Select Chat Window, enter a name for the object tag, and clickOK.

7. ClickClose, then click [add].

a. ClickCVB Offline, enter a name for the object tag, and clickOK.
This object refers to a chat design element, such as a chat button or chat form, that activates on your website
during closed hours.

b. Click add offline button next toCVB Offline, enter a name for the object tag, select a button, and clickOK.

8. ClickSave to save your chat script.
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9. To edit the details, click any object and select edit. An edit window opens up. To view the details, double-click any
object. The View details window appears. You can also click edit from inside the View details window.

10. To undo the changes clickRevert.

11. Click the on the script page to generate a PDF image and save it locally. The PDF printout is generated

containing the script name, date, and time of print. Supervisors and administrators can review and modify the
script as needed.

For details, refer to Summary of Chat Script Objects.

Note:As long as you have all the objects in the script, the sequence does not matter. 8x8 Contact
Center arranges the script in the correct order.

Run and Use the Script
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1. Go to theCode tab.

2. Select the chat channel from the list.

3. ClickGenerate Code. The code appears in the window.

4. Copy and paste the code to a page where you want to insert a chat button on your website.

Note: This script does not interfere with the button layout. It must be included in the same page and
within the body section of the web page, preferably just before the ending tag.
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5. Click the Chat button you just created. TheChatwindow opens.

SeeChat Overview to learn about Embedded Chat Design.
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Summary of chat script objects

The following table summarizes the 8x8 Contact Center chat objects available in the chat scripts and accessible via 8x8
Configuration Manager:

Chat
Script
Object

Description

Schedule Use the Schedule object to perform a particular sequence of script operations when the contact center is
either open or closed.
Parameters:

n In the Label text entry area, type the alphanumeric label used to uniquely identify the element in the
IVR script.

n Labels can contain a maximum of 21 characters, and must be unique within a script.

n In the Select schedule list, choose a schedule definition.
Exit points:
The Schedule object uses the Select schedule value to transfer control to the script sequence specified
within the following exit points:

n open equals true if the phone interaction has been received within the selected schedule's open
hours.

n close equals true if the phone interaction has been received outside the selected schedule's open
hours.

n #1 through #6 equal true if the schedule specified in Select Schedule includes an exception
condition, numbered 1 through 6, and today's date is within the exceptions from and to dates.

For details on creating schedules, refer to Define Business Hours and Schedules.

Skip
Queue

Use this object to give the customers the option to opt out of waiting in the chat queue and send an email
offline. This option can only be triggered in the greeting message object.

n In the Object tag, type the alphanumeric label used to uniquely identify the element in the script.
The object tag can contain a maximum of 21 characters, and must be unique within a script.

n Email Prompt Msg: The prompt message offered to a customer waiting in the chat queue. It can
appear as a link in the chat window (for example, "All our agents are busy helping other customers.
Would you like to send us an email?").
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Chat
Script
Object

Description

n Select form: Select an offline form from the list. An offline form presents an option to send an
email message during the chat's offline hours.

n Send info by: Shows whether you want to send the information you collected in the form using an
email channel or a dedicated email.

o Email channel: Select this option to choose an email channel. The email channel directs the
customer's email to the right agent.

o Plain email: Select a dedicated email to send the customer's email to.

n Email Channel: If you choose to use a Channel, you must select an email channel from the list.

n Forced email header message: Specifies the Subject line in the email message sent by a
customer skipping the chat queue.

Exit Point: None

Forward
to Queue

Use the Forward to queue object to forward a chat interaction to a specific chat queue, such as the
sales or main queue.
Parameters:

n In the Object tag, type the alphanumeric label used to uniquely identify the element in the script.
The object tag can contain a maximum of 21 characters, and must be unique within a script.

n In the Queue name list, choose the target chat queue to receive the chat.
Exit points: None

CVB
Online

Chat Visual Block Online refers to a chat design element, such as a chat button or chat form which can
be used on your website during business hours.
Parameters:

n In the Object tag, type the alphanumeric label used to uniquely identify the element in the script.
The object tag can contain a maximum of 21 characters, and must be unique within a script.

Exit points: None

CVB Off-
line

Chat Visual Block Offline refers to a chat design element, such as a chat button or chat form that activ-
ates on your website during closed hours.
Parameters:

n In the Object tag, type the alphanumeric label used to uniquely identify the element in the script.
The object tag can contain a maximum of 21 characters, and must be unique within a script.

Exit points: None
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CVB
Default

Chat Visual Block Default refers to a chat design element, such as a chat button or chat form available by
default from 8x8 Contact Center.
Parameters:

n In the Object tag, type the alphanumeric label used to uniquely identify the element in the script.
The object tag can contain a maximum of 21 characters, and must be unique within a script.

Exit points: None

Greeting
Message

Use this object to type a greeting message to invite the customers to the chat session. Use
@skipQueue@ to present the message that is previously set in the skip queue.
Parameters:

n In the Object tag, type the alphanumeric label used to uniquely identify the element in the script.
The object tag can contain a maximum of 21 characters, and must be unique within a script.

n In the Greeting Message, type the message you like to appear in the chat window. For example:
<We will be with you shortly. click here to send an email.>

n Use auto-translation: This option is selected by default and is used to automatically translate the
greeting messages using Google Translate. If this option is disabled, you can bypass the automatic
translation, and let the user provide a customized translation instead.

Exit points: None

Test
Condition
of Queue

Use the Test Queue object to check the condition of a queue before entering a queue. Test queue
provides a set of conditions which, when met, trigger specified actions. The test queue object gives the
IVR designer much more routing and announcement flexibility by allowing them to repeatedly test queue
status.
Parameters:

n In the Object tag, type the alphanumeric label used to uniquely identify the element in the script.
Labels can contain a maximum of 21 characters, and must be unique within a script.

n In the Queue name list, choose the phone queue to test the condition.

n Use the Condition Matched check boxes to determine routing choices based on agent availability
or queue performance.

o To route the chat differently, or to provide the customer with choices when there is no qualified
agent available to immediately accept the interaction, select there are no enabled agents
waiting.
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o To route the chat differently, or to provide the customer with choices when there is no qualified
agent logged in to immediately accept the interaction, select there are no assigned agents
logged in.
Qualified agents refer to the agent setup to receive interactions from the queue specified in the
Queue name list.

o To evaluate the condition of a selected queue, and route the chat based on the test results of
that performance, select Enable queue overload tests below.
Perform one or all of the following tests:

n Number of chats in queue ahead of this chat: Enter the maximum number of chats that
can be ahead of the current chat.

n there is a chat in this queue that has been waiting longer than (seconds): Enter the
maximum time that a chat is waiting in the queue.

n the instantaneous expected wait-time calculation exceeds: Enter a time duration in
seconds.

Exit points:
Test Queue has two exit points:

n Condition Matched

n Condition not Matched
The Test Queue object transfers control to the script sequence specified under the exit points based on
the following test results:

n There are no enabled agents waiting in the queue.

n There are no assigned agents logged in.

n There are <n> number of chats in the queue ahead of this chat, where <n> is the number specified in
the test.

n There is a chat waiting longer than the specified time in the queue.

n The instantaneous expected wait time calculation for a chat exceeds the specified time.
The expected wait-time calculation is useful only when there are more than 20 qualified agents
assigned to the queue and active. Mathematical uncertainty with fewer than 20 active similarly-
skilled agents may produce unexpected results.

Some of the many ways the exit points can be used are to trigger another test, provide the customer with
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a choice of waiting in a queue when no agent is available, leave a voicemail, or inform the customer of an
approximate waiting time, and then forward to queue.
For example, if there is a chat in the queue that has waited longer than 120 seconds, you can insert the
Play object under the Condition matched exit point to play a message informing the customer of an expec-
ted waiting time for the chat to be answered. You can then use the Forward to Queue object to route the
call to a queue.

Chat as a
Pop-up

Allows the pop-up chat window to appear. The pop-up chat applies to the Pre-Chat Survey and the Chat
Window options.
Parameters:

n In the Object tag, type the alphanumeric label used to uniquely identify the element in the script.
The object tag can contain a maximum of 21 characters, and must be unique within a script.

Exit points: None
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Using script variables in chat channels

Before initiating a chat interaction in 8x8 Contact Center, customer information such as account numbers or case
numbers collected via the pre-chat form, can be used to determine routing of the chat interaction. 8x8 Contact Center
administrators can collect customer data, store them into system and user-defined variables, and use values stored in
these variables to direct the interaction to the appropriate queue all using 8x8 Configuration Manager. It improves the
efficiency of handling chat interactions.

Let’s say your company wants to route interactions based on the customer language. Collect the preferred language
choice in a variable, and use this data in the IVR to direct them to the appropriate language queue.

Or, let’s say your company wants to route interactions based on the department such as Sales or Support, you can
collect this information during the pre-chat, and use it to route the interaction to the right queue.

In this topic, we’ll demonstrate the usage of script variables in chat channels based on the following use case.

AcmeJets Inc. is a premium jet service company that serves its customers via chat channels. When a customer initiates
a chat, AcmeJets collects basic information such as customer name, account number, and the preferred language for
chat. AcmeJets serves customers in English and Spanish, and have dedicated queues for each language. They want to
direct customers to the appropriate queue based on the language choice. Additionally, the company wants to
personalize their conversation for best customer satisfaction.

Assumptions
Let’s assume that AcmeJets contact center has:

n Configured a chat channel

n Configured chat queues

n Designed chat elements (chat button, pre-chat form, and chat window)

To support the use case, follow the steps discussed here:

Step 1: Create a new pre-chat form or edit an existing pre-chat form

In this step, we create a new pre-chat form which collects a customer’s name, and preferred language for chat. Store
the values in a custom variable and a translation variable respectively. Important: For custom variables, note down the
variable names to be used in chat scripts.
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1. Log in to the 8x8 Configuration Manager.

2. Go toChat Design > Form.

3. Click +Pre-chat to begin creating a pre-chat form.

4. Enter a name and description for the pre-chat form.

5. Add your first question to collect customer information.

a. Format: Select <Open-ended>.

b. Question: Enter the question: <Enter your name>.

c. Variable: Note that the variable name is automatically generated. Edit as you want <_name>.
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d. ClickAdd.

6. Add a question to collect the customer's language preference.

a. Format:Select <Translation>.

b. Question: Enter the question: <Enter your language>

c. Select language choices from the list: Select <English> and <Spanish>.

d. Variable: Note that the system variable ($language) is automatically populated. You are not allowed to edit
the system variable names.
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e. ClickAdd.

7. Optionally, add a question to gather either account number or case number. Select the format CRM field.

8. ClickNext>> to proceed to define the visual design of the pre-chat form. Select the colors and labels. Save your
preferences.

Step 2: Create a chat script

In this step, you will define a script that determines the routing of each chat interaction from your customers. When a
customer initiates a chat session, they are prompted to submit data through the pre-chat form. Based on this data, they
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are then directed to the appropriate queue.

1. Go to Scripts from the main menu in Configuration Manager.

2. Select Chat > Add new chat script.

3. In the Properties tab, enter a name, category, and comment. Optionally, add the chat channel you wish to apply
the script to. Save the properties.

Step 2a: Add a custom variable to the variables list
If you added custom variables in your pre-chat form, you must add them to the variable list here. By default, the View
variables lists all system variables. To add a custom variable you have already added in your chat design,

1. In the Script tab, clickView variables. A list of system variables shows up.

2. ClickAdd new and enter the custom variable name defined in the pre-chat form.

Important: Ensure the custom variable defined in the pre-chat form is added here.

Step 2b: Begin crafting the script
The chat script will embed a greeting message which includes the customer name. Use a test variable to identify the
language choice and direct them to the right queue.
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1. Add Test variable > Tests if the variable value of language equals Spanish. Tests if a customer selects to chat in
Spanish.

n If True, add Forward to Queue. choose to forward it to the queue serving customers chatting in Spanish
language.

n If False, add Forward to Queue, choose to direct the interaction to the queue serving customers in English.

2. Add a greeting message to the customers. Example: Welcome to AcmeJets. We will be with you shortly.

3. Add all the chat visual block elements you have defined.

n Chat button (Triggers chat interaction)

n Pre-chat form (Collects information from the customer; Add the newly defined pre-chat form here.)

n Chat-window (Allows a customer to interact with the agent)
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4. Save the script.

5. In theCode tab, select the chat channel to apply this script to.

6. ClickGenerate Code. Copy the code and embed in your website which hosts the chat.

Step 3: Verify the chat workflow

1. To verify the chat workflow, simply initiate a chat as a customer.
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2. In the pre-chat form presented, enter your name and select the language - English.

3. ClickSubmit.

4. Log in as an agent serving customers in English. You should now receive the interaction in English.

5. Trigger a second chat interaction as a customer and select Spanish in the pre-chat form and submit.

6. Log in as an agent serving customers in Spanish. You should now receive the interaction in Spanish.

7. If you received interactions via the correct queues, your setup is correct and complete.
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Create an email script

An 8x8 Contact Center email script is used to route incoming email interactions to the correct email queue. 8x8 Contact
Center administrators can create a new script and assign it to any number of channels. Email scripts are grouped under
Scripts > Email in 8x8 Configuration Manager.

You can create a user-defined script or use a system default script. 8x8 Contact Center offersEmail script default.
The default email script is provided by the system. You can copy and then edit the default script when creating a new
user-defined script.

To create or edit an email script:

1. From the Configuration Menu, open Scripts.
Scripts are grouped bymedia in separate tabs: Phone, Chat, and Email.

2. In the Email tab, click orAdd new email script.

3. Enter the required properties for the script.
The following table summarizes the options under Scripts > Email > Properties:

Phone/
Chat/Email
Script
Property

Description

Script Type n Phone: Select a script type: Inbound phone, Post Call Survey, or Outbound phone.

n Chat and Email: A read-only reminder of the script type. It displays if it is a phone, chat,
or email script.

Script Name Enter a unique name for the script.

Category A category helps you organize your scripts better. For example, if you have multiple scripts
serving Support and Sales needs, you can group scripts under separate categories. You can
select an existing category or create a new one.

To create a new category:

1. Select Edit Categories from the drop-down menu.
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Phone/
Chat/Email
Script
Property

Description

2. In the Category dialog box, add a new category by clicking .

Copy script
from

Choose this option to place a copy of the default or an existing IVR script into this channel.
This option appears when you are creating a new script.

Comment Add comments or additional notes, if desired.

This script is
enabled

Select to place this script definition into service.

Assigned
Channels
/Assigned
Queues

n When you select Script Type > Outbound Phone, you must assign one or more new
outbound phone queues.

n When you select Script Type > Post Call Survey or Script Type > Inbound phone, you
must assign one or more channels to the script.

Note: It is not mandatory to assign a channel while creating a script.

To assign new channels:

1. Click on the link to bring up the list of channels.

2. Select the desired channels from the list.

3. Click Assign.

Note:All channels in the list are associated with a script whether default or
user-defined. If you assign and save a new script, the old script is
permanently replaced by the new selected script.

Note: It is recommended to restrict your assignment to 100 channels at a
time.

Version 9.14 405

Create an email script



4. ClickSave.
Upon saving the properties, 8x8 Configuration Manager takes you to the Script tab, where you can define the
script.

5. In the Script tab, clickEmail Routing.
The [add] option appears.

6. Add the desired objects.
See Summary of Email Script Objects for the complete list of available objects and their description.

7. ClickSave.

8. To edit the details, click any object and select edit. An edit window opens up. To view the details, double-click any
object. The View details window appears. You can also click edit from inside the View details window.

9. To undo the changes, clickRevert.
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10. Click the on the script page to generate a PDF image and save it locally. The PDF printout is generated

containing the script name, date, and time of print. Supervisors and administrators can review and modify the
script as needed.

Note:When creating or modifying a script, disable the script by clearing This script is enabled in the
channel's Properties tab. This ensures that 8x8 Contact Center does not run an incomplete script.
After completing the script, enable it again.

11. For a primer on writing IVR scripts, refer to the guide on Interactive Voice Response. For examples, refer to
Email Script Examples.
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Summary of email script objects

The following table summarizes the 8x8 Contact Center email script objects. You can access the email scripts by going
to Scripts > Email > Script from the Configuration Menu. Click Email Routing, and then click [add] to see the drop-down
menu.

Email
Script
Object

Description

Schedule Use the Schedule object to perform a particular sequence of script operations when the contact center
is either open or closed.
Parameters:

n In the Label text entry area, type the alphanumeric label used to uniquely identify the element in
the IVR script.

n Labels can contain a maximum of 21 characters, and must be unique within a script.

n In the Select schedule list, choose a schedule definition.
Exit points:
The Schedule object uses the Select schedule value to transfer control to the script sequence spe-
cified within the following exit points:

n open equals true if the phone interaction has been received within the selected schedule's open
hours.

n close equals true if the phone interaction has been received outside the selected schedule's open
hours.

n #1 through #6 equal true if the schedule specified in Select Schedule includes an exception
condition, numbered 1 through 6, and today's date is within the exceptions from and to dates.

For details on creating schedules, refer to Define Business Hours and Schedules.

Check
CRM

Use the Check CRM email script object to check the value of the Local CRM for existing customer
information: new customer, new case, or followup fields.
Parameters:
In the Label text entry area type the alphanumeric label used to uniquely identify the element in the
email script. Labels can contain a maximum of 21 characters and must be unique within an email
script.
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Exit points:
The Check CRM script object transfers control to the script sequence specified within the following
labeled conditions:

n new customer equals true if the email interaction's From field contains an email address that is
not in the Local CRM.

n new case equals true if the email interaction's From field contains an email address that is in the
Local CRM, and the email does not contain an existing case number in the Subject line.

n followup equals true if the email interaction's From field contains an email address that is in the
Local CRM, and the email contains an existing case number in the Subject line.

For details on the Local CRM, refer to Configure Local CRM.

Check Pri-
ority

Use the Check Priority email script object to inspect the priority of the incoming mail message.
The Check Priority object inspects the incoming email message's header for the value of X-Priority,
Importance, and Priority. If 8x8 Contact Center cannot locate these areas in the message, it assigns the
message a priority equal to 3 – Normal.
Parameters:

n In the Label text entry area, type the alphanumeric label used to uniquely identify the element in
the email script. Labels can contain a maximum of 21 characters, and must be unique within an
email script.

n In the Priority value list, choose the priority setting of the incoming email message, where 1 is
the highest priority and 5 is the lowest priority.

n Select Negate comparison to make inspection true if the priority specified in the Priority value list
does not match the priority of the incoming mail message.

Exit points:
The Check Priority script object transfers control to the script sequence specified within the following
labeled conditions:

n matched equals true if the Negate comparison is not selected, and the email interaction's priority
equals the value of Priority.

n not matched equals true if the Negate comparison is not selected, and the email interaction's
priority does not equal the value of Priority.

Check Use the Check Recipient email script object to inspect the To or CC areas of the incoming mail for a
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Recipient name or other text string.
Parameters:

n In the Label text entry area, type the alphanumeric label used to uniquely identify the element in
the email script. Labels can contain a maximum of 21 characters, and must be unique within an
email script.

n In the Select recipient field list, choose whether the Email script inspects the To or Cc
addressee field of the incoming email message.

n In the Select operator list, choose a comparison operator. Choices available are Contains,
Begins with, Ends with, or Is equal to.

n In the Use pattern as a POSIX extended regular expression text entry area, type a pattern as a
text string or a POSIX extended regular expression.

n Select Negate comparison to make the recipient check true if the Email Script does not find the
string specified in the Pattern text entry area.

n Select Case sensitive to enable the pattern search to differentiate between upper and lowercase
characters.

Exit points:
The Check Recipient script object transfers control to the script sequence specified within the fol-
lowing labeled conditions:

n matched equals true if the Negate comparison is not selected, and the email message's recipient
equals the value of Pattern.

n not matched equals true if the Negate comparison is not selected, and the email message's
recipient does not equal the value of Pattern.

Check
Sender

Use the Check Sender email script object to inspect the From area of the incoming mail for a name or
other text string.
Parameters:

n In the Label text entry area, type the alphanumeric label used to uniquely identify the element in
the email script. Labels can contain a maximum of 21 characters, and must be unique within an
email script.

n In the Select operator list, choose a comparison operator. Choices available are Contains,
Begins with, Ends with, or Is equal to.
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n In the Use pattern as a POSIX extended regular expression text entry area, type a pattern as a
text string or a POSIX extended regular expression.

n Select Negate comparison to make the recipient check true if the email script does not find the
string specified in the Pattern text entry area.

n Select Case sensitive to enable the pattern search to differentiate between upper and lowercase
characters.

Exit points:
The Check Sender script object transfers control to the script sequence specified within the following
labeled conditions:

n matched equals true if the Negate comparison is not selected, and the From area of the email
message equals the value of Pattern.

n not matched equals true if the Negate comparison is not selected, and the From area of the email
message does not equal the value of Pattern.

Check Sub-
ject

Use the Check Subject email script object to inspect the Subject area of the incoming mail for a par-
ticular text string.
Parameters:

n In the Label text entry area, type the alphanumeric label used to uniquely identify the element in
the email script. Labels can contain a maximum of 21 characters, and must be unique within an
email script.

n In the Select operator list, choose a comparison operator. Choices available are Contains,
Begins with, Ends with, or Is equal to.

n In the Pattern text entry area, type a pattern as a POSIX extended regular expression.

n Select Negate comparison to make the recipient check true if the string specified in the Pattern
text entry area is not found.

n Select Case sensitive to enable the pattern search to differentiate between upper and lowercase
characters.

Exit points:
The Check Sender script object transfers control to the script sequence specified within the following
labeled conditions:

n matched equals true if the Negate comparison is not selected, and the Subject area of the email
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message equals the value of Pattern.

n not matched equals true if the Negate comparison is not selected, and the Subject area of the
email message does not equal the value of Pattern.

Check
Flood

Use the Check Flood email script object to detect an unusually high volume of similar incoming email
messages, due to a denial of service attack or spamming an email channel. The Check Flood object is
intended to detect such emails with the help of two parameters: time interval (the duration of an
observation window), and the maximum number of emails needed to trigger the flood detection. For
example, when an email is processed, the Check Flood object determines if other similar emails have
been created in the system in the last x number of minutes, where x is the time interval.

Note:We consider emails similar when they have the same sender (From), the same
recipient (To), and the same subject (Subject) fields.

Parameters:

n In the Object tag text entry area, type the alphanumeric label used to uniquely identify the element
in the email script. Object tags can contain a maximum of 21 characters, and must be unique
within an email script.

n In the Time Interval list, choose the time period during which the email script counts the number
of email messages arriving at the email queue. Choices available are Disabled, 15 minutes, 30
minutes, 45 minutes, 1 hour, 2 hour, 3 hour, 4 hour, 6 hour, 12 hour, and 1 day.

n In the Maximum number of emails list, choose the maximum number of incoming emails that
occur within the time period specified in the Time Interval list. Choices available are 2, 5, 10, 20,
or 50 emails.

Exit points:
The Check Flood script object uses the values of Time Interval and Maximum number of emails to
transfer control to the script sequence specified within the following possibilities:

n flood detected equals true if the Maximum number of emails that appear to be similar have been
received within the Time Interval or the similar emails have reached the threshold. For example, 6
number of similar emails were found where the maximum number to trigger is set to 5 or more.

n first email equals true if the most recently received email message appears to be new, that is no
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similar email was found before this email.

n other emails equals true if the most recently received email message is similar to at least one
other email processed within the specified Time Interval, but the quantity of these messages has
not yet exceeded the value of the Maximum number of emails. For example, 4 number of similar
emails were found where the maximum number to trigger is set to 5.

Check
Spam

Use the Check Spam email script object to enable the script to perform different operations depending
on the incoming email message's status as spam or not spam.
Parameters:
In the Label text entry area, type the alphanumeric label used to uniquely identify the element in the
email script. Labels can contain a maximum of 21 characters, and must be unique within an email
script.
Exit points:
The Check Spam script object transfers control to the script sequence specified within the following
labeled conditions:

n is spam equals true if 8x8 Contact Center classifies the email message as spam.

n is not spam equals true if 8x8 Contact Center does not classify the email message as spam.
For details on the 8x8 Contact Center spam threshold level, refer to Summary of Profile Settings.

Check
Virus

Use the Check virus email script object to enable the script to perform different operations depending
on the incoming email message's status as infected or not infected.
8x8 Contact Center uses McAfee VirusScan to inspect incoming email messages.
Parameters:
In the Label text entry area, type the alphanumeric label used to uniquely identify the element in the
email script. Labels can contain a maximum of 21 characters, and must be unique within an email
script.
Exit points:
The Check Virus script object transfers control to the script sequence specified within the following
labeled conditions:

n infected equals true if 8x8 Contact Center detects a virus in the email message.

n not infected equals true if 8x8 Contact Center does not detect a virus in the email message.

Forward to
Queue

Use the Forward to queue email script object to check how many incoming messages are waiting in
the queue, and if a maximum number is exceeded begin forwarding messages to a different email
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queue.
Parameters:

n In the Object tag area, type the alphanumeric label used to uniquely identify the element in the
email script. The object tag can contain a maximum of 21 characters, and must be unique within
an email script.

n In the Select queue list, choose which email queue receives forwarded messages.

n In the Maximum number of emails waiting text entry area, type the integer number of emails
that can accumulate in the current email queue before the script begins forwarding messages to
the queue specified by the Select queue list.
A 8x8 Contact Center email queue can contain a maximum of 900 messages. If an email queue
contains more than 900 messages, and the email queue's email script includes the Forward to
queue script object, then 8x8 Contact Center initiates overflow processing.

Exit points:
The Forward to queue script object transfers control to the script sequence specified within the fol-
lowing labeled conditions:

n routed equals true if the email queue does not contain more messages than specified by the
Maximum number of emails waiting text entry area, or no more than 900 messages.
8x8 Contact Center places the new message in the current email queue.

n overload equals true if the email queue contains more messages than specified by the
Maximum number of emails waiting text entry area, or more than 900 messages.
8x8 Contact Center places the new message in the queue specified in the Select queue list.

Label Use the Label email script object to insert a named point into the email script. The labeled script object
can then be accessed by other script statements, such as the Goto script object, described later in this
table.
Parameters:
In the Label text entry area, type the alphanumeric label used to uniquely identify the element in the
email script.
Labels can contain a maximum of 21 characters, and must be unique within an email script.
Exit points: None

Goto Use the Goto Email script object to direct the script to continue running at some labeled location in the
script.
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Parameters:

n In the Name text entry area, type the alphanumeric label used to uniquely identify the element in
the email script.
Labels can contain a maximum of 21 characters, and must be unique within an email script.

n In the Destination list, choose a labeled script location.
The Goto object can reference object labels located "lower" in the email script.

Exit points: None

Reply to
Email

Use the Reply to Email email script object to define the email's Subject, From, CC, BCC, etc.
Parameters:

n In the Label text entry area, type the alphanumeric label used to uniquely identify the element in
the Email Script. Labels can contain a maximum of 21 characters.

n In the From text entry area, type the return address for the outgoing email message.
You must type a valid email address or select Use channel email address as From to save the
Reply to Email email script object.

n Select Use channel email address as From to place the email channel's address in the outgoing
email message's From area.
You must select Use channel email address or type a valid email address in the From text entry
area to save the Reply to Email email script object.

n In the CC text entry area, to send a carbon copy of the outgoing email message to one or more
additional recipients, type the recipients' properly-formatted email address. The CC text entry area
allows you to type up to 80 characters.

n In the BCC text entry area, to send a blind carbon copy of the outgoing email message (a copy
whose email address is concealed from other addressees) to one or more additional recipients,
type the recipients' properly-formatted email address.
The BCC text entry area allows you to type up to 80 characters.

n In the Subject text entry area, type an optional subject line for the outgoing email message.
The Subject text entry area allows you to type up to 40 characters.

n In the Content text entry area, type the message contents.
Exit points:
The Reply to email script object transfers control to the script sequence specified within the following
labeled conditions:
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Email
Script
Object

Description

n sent equals true if 8x8 Contact Center did not receive an error when it sent the reply email
message.

n not sent equals true if 8x8 Contact Center received an error when it sent the reply email message.

Delete
Email

Use the Delete Email email script object to delete the email message being processed by the Email
script.
Because the Delete Email script object deletes the current email message, use the object as the final
action in an email script.
Parameters:
In the Label text entry area, type the alphanumeric label used to uniquely identify the element in the
Email Script. Labels can contain a maximum of 21 characters.
Exit points: None.

Stop Pro-
cessing

Use the Stop Processing email script object to stop performing the email script.
Parameters:
In the Label text entry area, type the alphanumeric label used to uniquely identify the element in the
email script.
Labels can contain a maximum of 21 characters.
Exit points: None

Check Pick-
list

Use Check Picklist to filter emails based on the customer type and send them to their respective
queues for better customer experience. For example, if a company wishes to prioritize their premium
customers and offer to assist them quickly, agents can prioritize and route the emails from customers
based on their account type, say Platinum, Gold, and Bronze. Emails received from Platinum customers
can be routed to a dedicated queue for faster processing. To take advantage of the check picklist
object, you must first define the desired Customer field of picklist data type in the Local CRM and then
select this field in the email script.
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Email script examples

An 8x8 Contact Center email script uses the information contained in an email message to route the message to one or
more email queues. Use 8x8 Configuration Manager to create email scripts.

The following procedure illustrates how to combine 8x8 Contact Center email script objects with script object control
flow features:

n Delete email messages that contain viruses.

n Inspect an email message subject line.

n Route email messages to queues.

n Insert stop processing objects into email scripts.

n Enable an email channel.

Before you begin
The procedure in this section assumes that you have used 8x8 Configuration Manager to create at least one email
queue. For details on creating email queues, refer toCreate Email Queues.

Best Practice:Before editing a 8x8 Contact Center script, disable the email channel.

To disable the email channel:

1. From the Configuration Menu, openChannels.

2. Go to the Email tab.

3. Find the desired channel, and click .

4. In the Properties tab, clear This channel is enabled.

5. ClickSave.
For details on email channels properties, refer toConfigure Email Channel Properties.

Delete Email Messages that Contain Viruses

If your email server does not provide protection against email viruses, include the Check Virus script object at the top of
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all your email scripts to help protect your contact center from malicious email messages.

Note: If your server already protects against email viruses, do not use the Check Virus object.

To inspect the email messages for viruses:

1. From the Configuration Menu, open Scripts.

2. Go to the Email tab.

3. Find the desired script, and click .

4. In the Script tab, clickEmail Routing, then click [add].

5. In the Insert object selection list, select Check Virus.

6. Enter anObject tag, such as <CV01>, and clickOK.
8x8 Configuration Manager adds the Check Virus script object to the script. The Check Virus script object contains
the exit points labeled infected and not Infected.

7. Delete any email messages infected by viruses:

a. Under theCheck Virus script object, click [add] next to infected.

b. In the Insert object selection list, select Delete Email.

c. Enter an Object tag, such as <Delete Infected>, then clickOK.

Use the same script design principles to incorporate the Check Spam and Check Flood objects into an email script.
Inspect an Email Message Subject Line

Use the Check Subject in the email script to inspect the subject line of incoming email messages for a particular string.

To inspect an email message's subject line:

1. In the above example, click [add] next to not infected.

2. In the script object selection list, select Check Subject.

3. Enter an Object tag, such as <CS01>.

4. In the Select Operator list, chooseContains.

5. In the Pattern text entry area, type <ADV>.

6. ClearUse pattern as a POSIX extended regular expression andNegate comparison.

7. Select Case Sensitive.
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8. ClickOK.
8x8 Configuration Manager inserts the Check Subject script object below not infected.

Route Email Messages to Queues

Use the comparison results returned by the Check Subject to route email messages.

To use the results Check Subject to route the message:

1. Delete email messages that contain a certain string, such as <ADV>, in the subject area.

a. Under Check Subject, click [add] next tomatched.

b. Select Delete Email from the Insert object list.

c. Enter an object tag, such as <DelADV>, then clickOK.
The email script deletes all incoming email messages that contain <ADV> in the subject line.

2. For all messages that do not contain <ADV> in the subject area, route the message to an email queue.

a. Under Check Subject, click [add] next to not matched.

b. Select Forward to queue from the Insert object list.
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c. Enter an object tag, such as <EmailQ01>.

d. In the Select Queue list, choose an email queue.

e. InMaximum number of emails waiting, type <100>, and clickOK.

3. If the message does not exceed the value specified byMaximum number of emails waiting, then stop script
processing:

a. Under Forward to queue, click [add] next to routed.

b. Select Stop processing from the Insert object list.

c. Enter an Object tag, and clickOK.
After routing the message, the script stops.

4. If the message exceeds the value specified byMaximum number of emails waiting (in the email queue), then send
the email to an overload queue:
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a. Under Forward to queue, click [add] next to overload.

b. Select Forward to Queue from the Insert object list.

c. Enter an Object tag.

d. Enter the Maximum number of emails waiting.

e. ClickOK.
Use the Forward to Queue script object to specify a secondary email queue that receivesmessages that
exceed the primary queue's Maximum number of emails waiting setting.

f. Click to Save your script.

Insert Stop Processing in Email Scripts

The procedure discussed inRoute Email Messages to Queues illustrates the use of the Stop processing email script
object to end the operation of an email script.

Insert Stop processing objects at all points where you intend the script to stop. Doing so ensures that the script always
behaves as designed.
Enable an Email Channel

Perform the procedure in this section to enable an email channel, and run the channel's email script.

To enable the email channel:

1. From the Configuration Menu, openChannels.

2. Go to the Email tab.

3. Find the desired script, and click .

4. In the Properties tab, select This channel is enabled.

5. ClickSave.
The 8x8 Contact Center puts the email channel and associated script into service.
You can now send test messages to the email channel to validate the operation of the script. For details on email
channel properties, refer toConfigure Email Channel Properties.
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Create intelligent IVR

8x8 Contact Center provides speech recognition and natural language processing on all incoming calls. A set of pre-
built templates can be modified to easily implement solutions, such as appointments, bill reminders, and inbound IVR
call treatment with integrations.

The intelligent IVR supports:

n Automated speech recognition (ASR)

n Natural language processing (NLP)

Features
The Intelligent IVR provides the following advantages:

n Allows customer requests without using Dual-tone multi-frequency (DTMF) interface.

n Increases efficiency of agents.

n Reduces cost of business.

n Improves customer experience.

Check out the instructions in the following pages to learn how to set up intelligent IVR.

n Studio ReferenceGuide

n Studio API Documentation

n Nodes or building blocks in call flows
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Configure Local CRM

The 8x8 Contact Center's local Customer Relationship Manager or Local CRM, gives you the ability to manage
customer and case data. Use the CRM page in 8x8 Configuration Manager to define the Customer and Case fields to
identify and characterize interactions. For your contact center, you have the option to use Local CRM or a third-party
CRM such as Salesforce or Zendesk that 8x8 Contact Center supports out of the box.

Note:Youmust select either the Local CRM or a third-party integration for customer relationship
management. They cannot be used together.

Features
n Manage customer and case data in your contact center using the Local CRM. It is perfect for organizations that do

not already use a CRM.

n Deliver screen pops of critical customer information to make every agent interaction more efficient.

n Solve customer problemsmore quickly and increase customer satisfaction.

n Integrate and combine information from other software and sources in the same screen.

n Define custom fields in the CRM to suit the needs of your organization.

Configure Local CRM
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To configure Local CRM, clickCRM in the Configuration Menu. In the Fields tab, the Predefined column identifies the
default set of customer and case fields.

Configuring Local CRM involves:

n Understanding customers, cases, follow-ups, and tasks

n Understanding types of CRM Fields

n Configuring CRM fields

n Configuring case notification

n Configuring CRM properties

n Importing data into CRM
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Understand Customers, Cases, and Tasks

8x8 Contact Center provides customer and case management capabilities using its Local CRM. The Local CRM
provides a model for managing the contact center's interactions with customers and stores the contact center's
customer, case, and follow-up data.

The phone, chat, and email scripts in 8x8 Contact Center can use information such as phone number, case number, or
email ID, to locate and display a customer or case record stored in the Local CRM. To manage customer relationships,
the Local CRM provides the following hierarchy of standard objects:

n Customer

n Case

n Follow-up

n Task

Customer
A customer object allows creating customer instances with unique account numbers. A customer record stores
information such as name, address, and phone numbers, and offers the capability to customize the customer object
with custom fields.

Case
A case object describes customer feedback, queries, or issues. Agents can create cases to systematically track and
solve customer issues. Agents can quickly create, update, and view cases. Theymay indicate the status of a case as
open or closed. The standard definition of a case allows adding additional attributes to a case by stating its status,
visibility, severity, and priority.

For example, a support agent at AcmeJets creates a case when a customer calls in reporting scheduling issues with
private jets. The support agent captures and records the customer-reported issue by creating a case.

Follow-up
A case may have multiple follow-ups before it is resolved. Each communication regarding the case from its creation
until it is closed may be recorded as individual follow-up instances. This may include notes as well as email
communications regarding the case. The Follow-up object allows tracking how a case is resolved by creating multiple
follow-up records.
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Task
A Task refers to a call, email, meeting, chat, or any other type of contact made with a customer. A task organizes and
helps agents track all interactions associated with a customer. The task object serves to create and manage all tasks
agents plan to perform or have performed, such asmaking calls or sending mails. For example, agents can create a
task to schedule a phone call to a customer, and set a reminder. A reminder pops up a fewminutes before the
scheduled call.

Integrate with External CRM
The 8x8 Contact Center also supports integration with External CRMs, such as NetSuite and Salesforce. If your 8x8
Agent Console integrates with an External CRM, your contact center supervisor provides you with the information you
need to use the CRM to manage your customers, cases, and follow-up activities.
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Understand types of CRM fields

8x8 Contact Center administrators can view, create, and configure Local CRM fields in 8x8 Configuration Manager.
Once configured, agents can access the CRM information via 8x8 Agent Console. 8x8 Contact Center supports
customization abilities in the Local CRM for your convenience and better usability.

The CRM fields are categorized into three types in 8x8 Configuration Manager:

n System-Predefined Fields: View-only system fields. You cannot create, edit, or delete System-Predefined
Fields. They are marked by yes (System) under the Predefined column in 8x8 Configuration Manager.

n Predefined Fields: You can view and edit predefined fields, but cannot create or delete them. They are marked
by yes under the Predefined column in 8x8 Configuration Manager.

n Custom Fields: You can create, view, edit, or delete custom fields. They are marked by no under the Predefined
column in 8x8 Configuration Manager.

To view the system-predefined fields:

1. From the Configuration Menu, openCRM.

2. Go to the Fields tab.
The system-predefined fields are visible under all tabs: Customer Fields, Case Fields, Follow-up Fields, and Task
Fields.
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The following table summarizes the options available when creating or editing a field underCRM > Fields:

CRM Field
Option

Description

Data Type Choose the type of data to add:

n Text

n URL

n Number

n Date

n Pick List
As you select a data type, 8x8 Configuration Manager enables or disables Add Field options.

Note:Once you save a data type, you cannot change it.

Field Name Type the name of the custom field. It can be a maximum of 32 alphanumeric characters.

Display
Label

Type the label that the 8x8 Contact Center displays for this field in 8x8 Agent Console. It can be a
maximum of 32 alphanumeric characters.

Default
Value

For Text, URL, Number, and Date data types.
Type the default value of the CRM Field. It can be a maximum of 85 alphanumeric characters.

Maximum
Length

For Text, URL, and Number data types.
Type the maximum number of characters that an agent can type into this field. The value varies
based on the data type of the field, as follows:

n Text: Up to 4000 characters (4000 bytes)

n URL: 200 characters

n Number: 255 characters

Mandatory For Text and Number data types.
Select this option to make the field mandatory.

Value Must
be Unique

For Text and Number data types.
Select this option to require the Agent to supply a unique value for the field.

Read Only Select to prevent users from modifying the value of this field.

Hidden Select to hide this field on 8x8 Agent Console.
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CRM Field
Option

Description

Show on
Customer
View

This feature is not accessible via the Customer Fields tab.
Select to see this option to be visible in customer view.

Pick List
Values

This option is available for the Pick List data type only.
Click Edit Pick List Values from the drop-down menu, and enter the desired values for pick list
field. For example, if your pick list field is Car Type, your values could be Sedan, SUV, Van, and
Pickup Truck.

Existing
Records
Value (N/A)

This option is available only for the Pick List data type.
While adding pick list values, you can select one of the values for the existing customer records.
This automatically populates existing records, with the selected value visible on 8x8 Agent
Console.

Include this
value in Pick
List

This option is available only for the Pick List data type.
This option includes the pick list value in the list.

Show as a
tree

This option is available only for the Pick List data type.
Selecting this option will present the choices in a tree (multi-level) format in 8x8 Agent Console.

3. Enter the field properties, and Save.
Follow the above instructions to create newCase, Follow-up, and Task fields.
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Configure CRM fields

The 8x8 Contact Center Local CRM allows administrators to create custom fields, such as customer instances with
unique dates of birth or dates of employment. A customer record stores information such as name, address, and phone
numbers, and offers the capability to customize the customer object with custom fields. Use the Fields tab in 8x8
Configuration Manager to specify a custom field for the Local CRM.

Note:You can create up to twenty custom fields within each CRM object: Customer, Case, Task, or
Follow-up.

Create New CRM Customer Fields

1. From the Configuration Menu, openCRM.

2. Go to the Fields tab.

3. Click Customer Field.

The Add NewCustom Field (Customer) page appears.

4. Enter the field properties, and Save.
Follow the above instructions to create newCase, Follow-up, and Task Fields.
For a summary of the options, refer to Types of CRM Fields.

Note:You can create up to twenty custom fields within each CRM object: Customer, Case, Task, or
Follow-up.

Customize the Display Order of CRM Fields

You can change the display order of CRM fields. The CRM fields appear under the Customer, Case, Task, and Follow-
up objects in 8x8 Agent Console. This feature is available to both custom and predefined fields. The system-predefined
fields cannot be moved. For example, in Customer Fields, you can only move the customertype predefined field, in
addition to the custom fields you have created.

To customize the display order of the CRM fields:
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1. From the Configuration Menu, openCRM.

2. Go to the Fields tab.

3. Select a predefined or custom field and drag it to the desired row, then drop.
The new order appears in 8x8 Agent Console.

Make Mandatory CRM Fields

You can make any existing or new predefined and custom field asmandatory. Mandatory fields can be added to
Customer, Case, Task, and Follow-up objects. When creating new customer records or cases in 8x8 Agent Console for
example, agentsmust enter data into fields that are mandatory (such as Name, Email, or Address). Mandatory fields
cannot remain blank.

Note:System-predefined fields are view-only and cannot be edited.

To make a mandatory predefined or custom field:

1. From the Configuration Menu, openCRM.

2. Go to the Fields tab.

3. OpenCustomer Fields, Case Fields, Follow-up Fields, or Task Fields.

4. Click to add a custom field, or to edit an existing field.

5. Enter the field properties.
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6. Select theMandatory check box.

7. ClickSave.

In 8x8 Agent Console, a red * appears next to the mandatory field to indicate that a value must be added.

Hide CRM Fields

You can hide any existing or new predefined and custom fields. The hidden fields can be part of theCustomer, Case,
Task, and Follow-up objects.

To hide a CRM field:

1. From the Configuration Menu, openCRM.

2. Go to the Fields tab.

3. OpenCustomer Fields, Case Fields, Follow-up Fields, or Task Fields.

4. Click to add a custom field, or to edit an existing field.

5. Enter the field properties.

6. Select theHidden check box.
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7. ClickSave.
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Configure case notification

8x8 Contact Center supervisors can receive an email notification if a customer case has been inactive for some time.
CRM escalation rules allow you to configure case notification in 8x8 Configuration Manager for cases that have been
open but not updated within the specified time.

To configure case notification:

1. From the Configuration Menu, openCRM.

2. Go to the Escalation Rules tab.

3. Select the Enable notification check box.

4. Enter the number of days and hours that a case must be closed before sending an email notification to the
supervisors.

5. Enter the supervisor's email address.

6. Select the day and time to receive the notification.

7. ClickApply.

The following table summarizes the options underCRM > Escalation Rules:

Escalation Rules Option Description

Enable notification (Time
to Close Notification)

If enabled, 8x8 Contact Center sends an email notification to the supervisor if a
case has not been closed within the time specified time.

If the case is not closed in Select the time interval, in hours and days, that a case must be closed.

Send an email notification
to

Enter an email address to which 8x8 Contact Center sends the email notification
when a case has not been closed within the specified period.
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Escalation Rules Option Description

Notification Frequency Select the frequency with which 8x8 Contact Center sends email notifications
about unclosed cases to the specified email address.

Enable notification (Stall
Time Notification)

If enabled, 8x8 Contact Center sends an email notification to the supervisor if a
case has been stalled (no activity) for the duration time specified.

If there was no case
activity for more than

Select the time interval, in hours and days, during which a case activity must occur.

Send an email notification
to

Enter an email address to which 8x8 Contact Center sends the email notification
when a case has been inactive for the specified duration of time.

Notification Frequency Select the frequency with which 8x8 Contact Center sends email notifications
regarding cases that are not closed or do not have any activities.

An email notification is sent to the supervisor.

Version 9.14 435

Configure case notification



Configure CRM properties

8x8 Contact Center administrators configure the Properties tab in 8x8 Configuration Manager to specify CRM behavior
in the following areas:

n To define time limit to reopen closed cases

n To assign reopened cases to agents

n To display case and follow-up records using HTML in 8x8 Agent Console

n To disable opening files attached to emails by clicking attachment

To configure CRM Properties:

1. From the Configuration Menu, openCRM.

2. Go to the Properties tab.

3. Configure the desired setting, and clickApply.

The following table summarizes the options underCRM > Properties:

CRM Properties
Option

Description

Closed case -
automatic re-
opening time-
limit

Select the time interval that a closed case automatically reopens within a specified time limit.
Specify one of the three possible values:

n Never: Never opens a closed case automatically.

n Always: Always reopens a closed case in the event of a customer follow-up via email.

n Time limit: Specifies the maximum amount of time a case can be closed before it
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CRM Properties
Option

Description

automatically reopens.
If a follow-up is received within the time limit, the case reopens automatically. The case
remains closed if a follow-up is received after the time limit. For example, if you set the time
limit to 10 days, a case that is closed today can potentially be reopened within the next ten
days in the event of a customer follow-up by email. Once the time limit expires, the system
creates a follow-up case, but will not reopen the case.

Note:When you change a parameter's value, it takes effect immediately.

Automatically
assign re-
opened cases
to next agent
handling the
case

If enabled, assigns reopened cases to the next receiving agent automatically. Reopened
cases normally retain their previous agent assignment.
If disabled, assigns reopened cases to the agent who handled the case previously.

Display cases
and follow-ups
using HTML
when available 

If enabled, supports HTML formatting during the following tasks:

n Creating and editing case records.

n Creating follow-up records.

n Creating notification emails.
If disabled, an agent is restricted to plain-text data while creating or notifying case and follow-
up records.

Disable file
open on
clicking
attachment

If selected, the email attachment sent by the CRM customers cannot be opened from within
8x8 Agent Console. Agents can still save the attachment, but are prevented from opening the
insecure attachments.
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Understand CRM import

If 8x8 Contact Center administrators receive customer data in a CSV file, they can import the data to their 8x8 Contact
Center customer file using the Imports tab of the CRM page in 8x8 Configuration Manager. To import data from a CSV
file, map each column name from the CSV file to an existing customer contact field. If you have additional fields that do
not map to the existing fields in the contact record, you must create custom fields to hold this data.

The data import feature allows a maximum of 50,000 records to be loaded per session, and the records are loaded in
increments of 100. Use the Imports tab to view the progress of the current import, including error message for records
that cannot be loaded.

To prevent any failure, complete the following tasks before importing:

n Match the columns in the CSV file with the existing CRM fields.

n Create custom fields for additional fields in the CRM page.

n Verify that the email information is unique for each record.

n Confirm that the records with pick list valuesmatch the pick list values defined in the CRM field of pick list data
type.

n Enter dates in MM/DD/YYYY format.

n Verify you have data for all mandatory fields, such as First Name and Last Name.

n Confirm the data length of mapping column in the CSV file matches the data length of the mapped customer field
in the CRM.
The following table provides the data length of CRM customer fields:

CRM Customer Field Data Length

First Name 30

Last Name 30

Email 40

Company 50

Voice 38

Fax 38
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CRM Customer Field Data Length

Alternative 38

Password 15

Comments 400

Primary Address, Secondary Address
Street (line 1)
CityStreet (line 1)
State
Zip
Country

50
50
40
30
15

Custom field - Text
Custom field - Number

up to 4000 (4000 bytes)
255
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Import customer data into Local CRM

8x8 Contact Center administrators follow the procedure below via 8x8 Configuration Manager to import customer data
into Local CRM.

To import customer data into Local CRM:

1. From the Configuration Menu, openCRM.

2. Go to the Import tab.

3. ClickChoose Files to select the Comma-Separated Value (CSV) file containing your customer information from
your file system.

4. ClickNext.
The mapping screen appears. This screen allows you to map a column in the CSV file to a field in the customer file
of the 8x8 Contact Center CRM. The column names from the CSV file are available in the pull-down menu, as
shown below. Select a column name of the CSV file from the pull-down menu, and map it to the matching field in
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the 8x8 Contact Center customer file.

5. ClickNext.
The summary page opens and shows the mappings selected.

6. ClickStart to initiate the import.
OR
ClickBack to modify the settings.
On initiating the import, the progress is displayed on the screen. The import is committed to the database in
increments of 100 records at a time. Statistics about the import are displayed as well.

7. You can save the import report on the local file system.
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About 8x8 Auto Dialer with campaign management

8x8 Auto Dialer with campaign management enables retrieving data from your Local CRM or importing data from an
External CRM, creating campaigns, running campaigns, and tracking responses.

8x8 Contact Center supports preview, progressive, and predictive dialing modes to better manage outbound
telephone-based campaigns to meet your business needs. Automate your outbound dialing and maximize the
productivity of your contact center agents. Empower your agents to connect with prospects and customersmore
effectively, and boost conversion rates as well as customer satisfaction. The progressive and predictive dialing modes
call numbers automatically from campaign calling lists, screen for busy signals, voicemail, no-answers, and
disconnected numbers, connecting agents to only live-answered calls.

Learnmore about the dialingmodes.

A campaign enables you to search, generate, and feed a campaign call list to an outbound phone queue, facilitating
automated outbound dialing. Campaigns pull data from the customer object of the Local CRM, or any CRM object,
such as lead, account, or contact containing phone data from the Salesforce CRM. Campaigns are assigned to
outbound phone queues, while agents assigned to these queues are offered campaign calls.

Note: 8x8 Auto Dialer supports generating campaign call lists directly from the Salesforce CRM if 8x8
Contact Center integration for Salesforce is set up. For all other External CRM integrations, the data
must be imported from the External CRM into the Local CRM to generate campaign call lists.

Features
8x8 Auto Dialer provides capabilities to generate a campaign call list, create, run, and recycle campaigns. The Dialer
allows you, as an administrator, to:

About 8x8 Auto Dialer with campaign management
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n Manage and automate outbound dialing campaigns extracting data directly from yourLocal CRM or imported from
an External CRM application.

n Support blended call centers; agents can be setup to process inbound and outbound calls with priorities, skills, and
skill levels.

n Define global properties for campaign management, which include selecting CRM objects and fields, and
uploading audio messages for campaigns.

n Assign a campaign to an outbound queue.

n Upload and assign pre-recorded messages to campaigns.

n Search and retrieve records from the Local CRM or Salesforce CRM to generate a campaign call list, and feed the
list to an outbound queue.

n Map transaction codes to automated disposition actions to schedule a call back, or try to call again.

n Control and monitor campaigns.

Limitations
n 8x8 Auto Dialer is limited to customers who use the Local CRM and Salesforce CRM.

n Available only to agents who are logged in to the Salesforce CRM Multi Channel interface. CTI Connect is not
supported.

Dialer campaigns work in cycles
A key characteristic of nearly all dialer campaigns is that it is rare to reach the desired number of contacts after a single
pass through a list. Therefore, campaign lists are recycled again and again using disposition codes from earlier cycles to
alter selection and sort strategies to create new campaigns.
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Dialing modes

The dialing mode of a campaign determines the pace at which calls are dialed out and connected with contacts.
Whether you want to connect calls to agents first and then dial out to the contacts or want to connect agents to live
answered calls, the dialing modes offer options to meet your business needs.

Prior to the 8x8 Contact Center 9.12 release, the 8x8 Auto Dialer was available in preview dialing mode. In the 9.12
release, we have introduced progressive and predictive dialing modes.
What is preview dialing mode?

In preview dialing mode, agents are presented with customer records for preview before dialing out. The agent is given
a choice to select the phone number and start the call, reject the call or skip the call if allowed, and view the next
customer record. If no choice has been made within a certain predefined time limit, the system automatically dials out
to the customer, provided the dial call action is configured within the campaign properties. If the agent chooses to skip
the call, the next record is presented, and the procedure is repeated, until the records in the campaign have been
exhausted.

The preview dialing mode is most suited to campaigns which require preparation before the conversation. For example,
In a complex sales call where the agent needs to decide the best approach to the call preview dialing is more suited.

The diagram below shows the call flow in preview dialing mode. The agent previews the customer record and begins the
call. The agent may preview and reject the call which forces the agent to go on break, The agent may skip (if allowed)
the offered call and move to the next record.

Preview dialing allows agents to view the information they need to serve customers efficiently with a complete history of
previous customer interactions and notes to review before calling them. This experience may vary if you are using
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Salesforce in the Outbound Setup. Preview dialing provides agents with enough context to complete the interaction,
instead of expecting agents to gather context during the call.

Preview dialing allows the system to initiate the call if the agent does not, and enhances agent productivity via answer
machine detection, persistent agent connection, automatic transaction codes for unanswered calls, and carrier call
blocking on the Do Not Call lists prior to connection.

The 8x8 Preview Dialer:
What is progressive dialing mode?

8x8 Progressive Dialer is an automated telephone dialing system that only connects agents to calls answered by a live
person. The system automatically paces dialing and only dials when an agent becomes available. The dialer screens
out busy lines, answering machines, and no answers automatically so that agents are connected to a live caller.

The progressive dialing method is straightforward. In everymoment we compute the number of agents who are
available and can receive calls at this moment. The corresponding number of calls are made.

The 8x8 Progressive Dialer:

n Automates the time-consuming process of dialing numbers and removes the need for manual dialing.

n Reduces wait time, eliminates errors in manual dialing and dramatically increases productivity.

n Connects only live answered calls to agents.

n Ensures each connected outbound call is delivered to an available agent.

n Detects calls with busy signals, answering machines, and disconnected numbers and dispositions them
automatically with wrap-up codes.

n Supports sequential dialing of up to 22 phone numbers for each contact on the call list.

The diagram below shows the progressive dialing mode call flow.
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The progressive dialing mode is more efficient than the previewmethod, since it connects agents to live calls and
automatically screens failed calls. On the other hand, agents do not have the opportunity to preview and prepare for the
call.
What is predictive dialing mode?

8x8 Predictive Dialer initiates outbound calls based on a preset dialing ratio before the agent is free to handle the next
call. Predictive dialing is the most productive and most aggressive dialing mode. In predictive dialling mode the system
dials multiple records simultaneously and connects answered calls to agents. Unanswered calls are automatically
dispositioned with appropriate wrap-up codes.

The predictive dialer uses a complex algorithm to keep agents as productive as possible. It predicts the rate at which it
will find live calls and adjusts the number of calls being overdialed so that an agent is available to handle the calls. As
soon as an agent finishes one call they can move on to the next call right away. If you want to maximise agent talk-time,
the predictive dialing mode typically provides the best results. This will greatly improve agent efficiency and campaign
productivity.

The diagram below shows the progressive dialing mode call flow.

Features
8x8 Predictive Dialer offers the following features:

n Dials more calls than the number of agents available, only ever presenting live answered calls to the agents.

n Estimates howmany calls need to be placed, in order to get idle agents busy on live calls as quickly as possible.

n Automates the dialing of the campaign calls, in quick succession.

n Supports sequential dialing of up to 22 phone numbers for each contact on the call list.
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n Allows campaign admins to customize (from default 3%) the Abandoned Rate which refers to the rate at which
calls are being abandoned due to non-availability of agents.

n Allows campaign admins to customize (the default 15) seconds of ring-time; Usually when answer-rate is low,
customers want to increase ring time.

n Detects unanswered calls, such as answer machines, bad numbers, number busy or unanswered and automatically
dispositions them.

n Allows campaign admins to customize howmany retry attempts the system will make for unanswered calls and
abandoned calls.

n Improves agent efficiency and campaign productivity via automatic answer machine detection, persistent agent
connection, and carrier call blocking.

n Monitors the calling statistics in real time using the pacing algorithm.

n Supports safe harbor audio messages for abandoned calls.

Risks
While delivering a significant performance boost to contact centres, predictive dialing may result in connected calls with
live individuals which do not have available agents. In this scenario, the dialer allows you to mitigate the risk by playing
a pre-recorded safe harbor message. The message typically should identify the company running the campaign or the
company they are calling on behalf of, provide a free or standard cost call back number, and contain no marketing or
sales information.

n Abandoned call: If the live call fails to connect to an available agent within two seconds, but plays a pre-recorded
safe harbour message, it is considered as an abandoned call.

n Silent call: If the live call fails to connect to an available agent within two seconds and doesn't play a pre-recorded
safe harbour message, it drops. It is considered as a silent call.

Predictive dialers are routinely used in telemarketing, market research, debt collection, and customer service follow-up.

Next steps
After reviewing the capabilities of each dialing mode, you are now ready to begin configuring the 8x8 Auto Dialer. Learn
how to set up the dialer.
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Configure the 8x8 Auto Dialer

As an 8x8 Contact Center administrator, configuring an 8x8 Auto Dialer requires you to define outbound queues, set an
appropriate dialing mode for each outbound queue, define global properties for outbound campaigns, and then create
campaigns by assigning them to the outbound queues.

Configuring the 8x8 Auto Dialer involves the following steps:

n Step 1: Set up an outbound phone queue

n Step 2: Add custom phone fields in the Local CRM (Optional)

n Step 3: Define global properties for outbound campaigns

n Step 4: Create and control campaigns

If your tenant is provisioned with 8x8 Auto Dialer, the Configuration Menu shows the following tabs:

n Outbound Setup allows you to define global properties for managing all campaigns.

n Campaigns allows you to create and control campaigns.
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Step 1: Set up an outbound queue for dialer

Every 8x8 Contact Center outbound campaign is directed via an outbound queue. The queue must define the dialing
mode which determines how calls are handled when this queue is assigned to a campaign. It can be set to preview,
progressive, or predictive mode.

To add an outbound queue and set up the dial mode:

1. Log into 8x8 Configuration Manager.

2. From the menu, go toQueues.

3. Select to add an outbound queue.

4. Define the following queue properties.

5. Enter a name, set a default priority, indicate the percentage of calls on this queue to be recorded.

6. Dial Mode (for campaigns): Select the dialing mode for campaigns from the drop-down list of choices. Dial
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mode defines how calls will be handled when this queue is assigned to a campaign.

Note: This progressive or predictive dial mode when applied to a queue impacts the dialingmode in
call back scenarios via the API or the IVR.

n Preview dialer: Offers agents the preview of the customer record before dialing out, either automatically or via
agent action.

n Progressive dialer: Reacts to agent state and uses available data to make calls on behalf of agents in the
background. Dials at a 1:1 ratio (one call for every agent in available status), making calls until a live customer
answers. There is a reduced risk of abandonment but higher agent wait times.

n Predictive dialer: Monitors all agents status for high-performance outbound dialing, predicting the availability
of agents before they end their current call in order to reduce wait times asmuch as possible. This mode offers
built-in compliance checks for abandonment rate.

7. If you select progressive or predictive dial mode, you will be presented with a Dialer compliance warning. At the
prompt for dialer compliance, click accept. To learn more about the rules and regulations for dialer compliance
click here.

Note: The compliance warning is presented only the first time you use that mode prompting for your
acceptance.

8. Abandon percentage: When you set the dial mode to predictive, you need to specify an acceptable percentage
for abandoned calls. In Predictive mode the dialer will automatically lower the dialing pace when this threshold is
exceeded to decrease the number of dialed calls in order to decrease the percentage of abandoned calls. If the
rate drops far enough below the target then the opposite is true and the dialer will continue to increase the pace
until the maximum percentage is reached or all agents are busy.

Note: This field is applicable to predictive dialingmode only.

9. Select the audio file for agent whisper. This audio is played to the agent on accepting a call from the queue,
typically used to quickly remind the agent about the intent or context of the call. Learn how to add an audio file for
agent whisper.
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10. ClickSave to save the queue properties.

11. Proceed to the remaining steps to identify members serving the queue, to add rules for interaction priority, and to
set an SLA for the queue.
A message displays that the queue is created successfully. Learnmore about creating an outbound phone queue.
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Step 2: Add custom phone fields in the Local CRM
(Optional)

By default, the Customer object in 8x8 Contact Center Local CRM offers two predefined voice phone fields: Voice, and
Alternative. You can add additional phone fields to the Customer object to improve the chances of contact with the
customer during a campaign. Let’s say a debt collection company has to track an individual, theymay have phone
numbers of relatives listed as well.

To add a custom field to the Local CRM:

1. Log in to 8x8 Configuration Manager.

2. Go toCRM from the menu.

3. In the Customer Fields list, click + Customer Field. TheAdd a Custom Field (Customer) page appears.

4. Select Text for data type of phone fields.

5. Enter the field properties, and clickSave. You have now created a custom field. Repeat this task to add more
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custom phone fields if needed.

Learn more about how to configure custom CRM fields.

You will need to mark the new custom fields as phone fields in the Outbound Set up to ensure they are included in
campaigns and dialed in a specified order. Learn more.
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Step 3: Configure the outbound setup

For campaigns to function successfully, they need to connect to the 8x8 Contact Center Local CRM or Salesforce CRM,
extract data from a specific CRM object, and generate a target call list.

Note: 8x8 Auto Dialer supports generating campaign call lists directly from the Salesforce CRM if 8x8
Contact Center integration for Salesforce is set up. For all other External CRM integrations, the data
must be imported from the External CRM into the Local CRM to generate campaign call lists.
Learn about the prerequisites and how to import the customer list in CSV format and how to add
customers using the CRM API.

Outbound setup enables you to define global properties for campaigns by:

1. Specifying the target CRM properties

2. Defining CRM objects and fields relevant to campaigns

3. Uploading pre-recordedmessages to be accessed by campaigns

4. Mapping transaction codes to disposition actions

Step 3: Configure the outbound setup
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Specify target CRM properties

A campaign requires a call list of customers or contacts for automated outbound dialing. To generate a call list, you
must access and extract data from the Customer object of 8x8 Contact Center Local CRM or any object in the
Salesforce CRM. To access data from your CRM, you must configure CRM information under Outbound Setup >
Properties.

The Properties tab in 8x8 Configuration Manager enables you to:

n Select a target CRM to extract the call list data.

n

Note: 8x8 Auto Dialer supports generating call lists from Local CRM and Salesforce CRM only. For
all other External CRMs, the datamust be imported to the Local CRM.

n Provide and validate the login credentials of your Salesforce CRM account.

To extract customer data from your Local CRM:

1. From the Configuration Menu, openOutbound Setup.
The Properties tab opens.

2. Select Local from the Target Type. Target type specifies the CRM application that stores the data used for
campaigns.

Note: For the 8x8 Contact Center CRM, username and password information are not required.

3. ClickSave.

To extract data from your Salesforce CRM account:

Note: 8x8 Auto Dialersupports generating campaign call lists directly from the Salesforce CRM if 8x8
Contact Center integration for Salesforce is set up.
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1. Select Salesforce from the Target Type drop-down list.

2. Enter your SalesforceCRM User Name andCRM Password to log in to the account. For Salesforce, add the
security token to the password. 1

3. Click Login Test to validate Salesforce account credentials. If the username and password are correct, the login
test passes.

4. ClickSave.

1Obtain your authentication token from the original Salesforce email communication or from your Salesforce administrator.
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Add CRM objects and fields

You can create campaigns by extracting call list data from the Customer object in the 8x8 Contact Center Local CRM,
or any object in your Salesforce CRM provided the object has a phone field. To generate a call list based on an object,
you should configure the object with its desired fields in the 8x8 Configuration Manager Outbound Setup. Let's say your
customer record has three phone fields and you want to select them all for campaigns; additionally you want to display
the customer name and email address in the transaction panel for agents to access the facts quickly; you will need to
add these CRM fields in the Outbound setup for campaigns.

Outbound Setup > CRM Objects enables you to define CRM objects and fields to be used in campaigns.

To add a CRM object:

1. From the Configuration Menu, openOutbound Setup.

2. Go to theCRM objects tab.

3. Click Object.

If you selected to generate call list data from the Local CRM, then you can only select the data from the Customer
object. If you selected Salesforce CRM, you can select any object.

4. Enter an object name forName in CRM.
The data type for the object is automatically populated.
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Note:Youmust enter the object name as it appears in the CRM.

5. Enter a value for Label to Show Agents in 8x8 Agent Console.
The following table summarizes the options underCRM Objects:

CRM Objects
Option

Description

Add Object Lets you add an object from your CRM. If enabled, automatically populates the CRM
Objects field while creating a campaign. If disabled, prevents creating a campaign based
on the CRM object. Enter the following information to add a CRM object:

n Name in CRM: Enter the name of the object from your CRM. Make sure the object
name matches the value in the CRM.

n Data Type: Select the most appropriate data type from the drop-down list.

n Label to Show Agents: Enter a label to show on the transaction panel of 8x8 Agent
Console.

n Phone Field: Applies to a phone field only. If checked, displays the phone number to
the agent on the transaction panel.

n Default Phone: Applies to a phone field only. If checked, dials the number if an agent
fails to select a number.

n Transaction Field: Applies to any field. Shows the field on the transaction panel of
8x8 Agent Console.

n Revert Edits: Reverses edits before the last save.

Add Field Lets you add a field under the selected object. You can add any number of fields to filter
your campaign call list. If disabled, prevents filtering a call list based on the CRM field.
Enter the following information to add a CRM field under an object:

n Name in CRM: Enter the field name from your CRM. Make sure the name matches
the value in Field Name.

n Data Type: Select the most appropriate data type from the drop-down list.

n Label to Show Agents: Enter a label to show on 8x8 Agent Console.

n Phone Field: Applies to a phone field only. If checked, displays the phone number to
the agent.
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CRM Objects
Option

Description

n Default Phone: Applies to a phone field only. If checked, dials the number if an agent
fails to select a number.

n Transaction Field: Applies to any field. If checked, shows the field on the
transaction panel of 8x8 Agent Console.

n Revert Edits: Reverses the edits before the last save.

Move Up Moves a CRM object or field up from its current position.

Move Down Moves a CRM object or field down from its current position.

Delete Deletes a selected object or field. For more information on deleting objects and fields, see
how to delete CRM objects below.

Note:You cannot delete an object without deleting its fields.

Save/Revert/Revert
Edits

n Save: Saves all changes.

n Revert: Reverses all changes before the last save.

n Revert Edits: Reverses the previous edit.

Add a CRM field to the Outbound Setup

To add a CRM field:

1. From the Configuration Menu, openOutbound Setup.

2. Go to theCRM objects tab.

3. Click next to theObject in the top row. Notice that another field is added.

4. Enter a name inName in CRM for the field.

Note:Youmust enter the field name as it appears in the CRM.
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5. Select Data Type to match the CRM field data type. If you do not find an exact match, enter the most appropriate
data type. The Dialer supports the Boolean, Integer, Text, Date, and DateTime data types.

Note:Booleanmay be used for check box values.

6. Enter a value for Label to Show Agents in 8x8 Agent Console.

7. Check the Phone Field to indicate if the data is a phone number. Phone Field is used to populate the list of phone
numbers for a particular contact. The number shows on the control panel of 8x8 Agent Console.

Note: If you add a custom phone field, youmust identify it as a phone field to include it in
campaigns. Learnmore.1

1After adding a custom phone field in the Local CRM, you must add it and identify it as a phone field in the Outbound
Setup. This marks the phone number for dialing during a campaign. If the Customer object has five phone fields three
of which are custom fields, and you want to dial all these numbers during a campaign, the custom fieldsmust be
identified as phone fields. 
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8. Check theDefault Phone to assign a default phone number if a contact hasmore than one number. A default
phone number initiates an outbound call if an agent fails to select a particular number from the list. The number
shows on the control panel of 8x8 Agent Console.

9. Check the Transaction Field for the field data to show on the control panel of 8x8 Agent Console and in the
External Transaction Data field of Campaigns.
For example, you can select key information such as company name and phone number to show on the control
panel, minimizing the agent's effort to retrieve this information from the contact record details. Custom objects and
fields are supported as well. You can add any number of fields to filter your campaign call list.

Note: For custom objects and fields, suffix the object and field namewith <_c>, such as in
<Client_c>.

Version 9.14 461

Add CRM objects and fields



Custom phone fields in campaigns
The following steps are essential to ensure the custom phone fields are included in campaigns and dialed in a specified
order.
Tag the custom field as a phone field in the Outbound Setup

After adding a custom phone field in the Local CRM, you must add it and identify it as a phone field in the Outbound
Setup. This marks the phone number for dialing during a campaign. If the Customer object has five phone fields three
of which are custom fields, and you want to dial all these numbers during a campaign, the custom fieldsmust be
identified as phone fields.

Go toOutbound Setup > CRM Objects. In this tab, you can define the fields to be used in campaigns.

Note: Customer object is chosen by default for the Local CRM.

To mark a custom field as a phone number field:

1. Click at the end of any row to add a Customer field.

2. Select the custom field you added in the Local CRM previously.

3. Add a label and click the checkbox to mark it as a phone field. This is required to confirm the field as a phone field.
Enable this field for use in campaigns.

4. Optionally, enable Transaction field to select the fields to be shown to agents in the Control Panel > Transaction
information.
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5. Click Test to validate the fields added and clickApply to confirm the changes.

Customize the dialing order of phone fields (Optional)

Let’s say you have multiple phone numbers associated with each customer record and you want the dialer to try calling
all the listed numbers during a campaign to improve the chances of contact. With sequential dialing, the dialer can now
dial upto 22 phone fields. You will also need to determine the order in which they should be dialed. You want to reach a
customer on their business number first, if unsuccessful, dial their home phone; if unsuccessful, dial their mobile
number and so on; you need to list the phone fields in the order of business phone, home phone, and mobile phone by
simply dragging and dropping the rows as desired in the Outbound Setup > CRM fields.

To customize the dialing order of the phone fields:

1. From the Configuration Menu, go toOutbound Setup > CRM Fields.

2. Select the predefined or custom phone field and drag it to the desired row, then drop. Drag and drop all the fields
necessary in the desired order.
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3. ClickApply.

Delete a CRM object

To delete CRM objects:

1. From the Configuration Menu, openOutbound Setup.

2. Go to theCRM objects tab.

3. Select a field or object from the list.

4. Click orDelete. The field is deleted from the list.

5. ClickSave.

6. Select the object and clickDelete after deleting all the fields under the object.

Note: If an object is referenced in a campaign, theDelete button is disabled.

7. ClickSave.
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To delete a CRM field:

Select the field, and clickDelete.

Note: If a field is referenced in a campaign, theDelete button is disabled.
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Upload pre-recorded messages for campaigns

During a campaign call, an 8x8 Contact Center agent can access and play pre-recorded messages defined for that
campaign to ensure a uniform delivery of the campaign message to all customers. In the Outbound Setup, you can
upload a set of pre-recorded messages which can be accessed by campaigns. When you create a campaign in 8x8
Configuration Manager, you can assign messages specific to the campaign.

Abandoned calls in predictive campaigns need to play a message, typically stating the company the call is from and a
standard call back number. This abandoned message must be played within two seconds of a live answer for
compliance.

Note:Supports audio files inWAV format only.

To upload a pre-recorded message in Outbound Setup:

1. Go toOutbound Setup > Audio Files.

2. Select Outbound Setup Files in the Directories section.

3. ClickMenu.
The menu provides options to add, delete, or rename a folder. You can add files to folders only.
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4. Select Add Folder.
You are prompted to enter a name for the new folder.

5. Enter a folder name, and select Create.
The folder appears under the Outbound Setup Files.

Note:Do not include special characters in the folder names.

6. Select the folder, clickMenu, and select Add File.

7. Enter aName andDescription of the audio file.

Version 9.14 467

Upload pre-recorded messages for campaigns



8. ClickChoose File and select an audio file of the message to upload.

Note:You can upload audio files inWAV format only.

9. ClickPlay Audio to play and check content of the message.

10. ClickSave. The audio file appears in the Audio File Items pane.

To upload an abandoned message:

1. Select theAbandoned message files folder, clickMenu, and select Add File.

2. ClickChoose File and select an audio file of the message to upload. Note: You can upload audio files in WAV
format only.

3. ClickPlay Audio to play and check the content of the message.

4. ClickSave. The audio file appears in the Audio File Items pane.
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Map disposition code

Campaign calls seldom reach the desired number of contacts after a single pass through a list. Therefore, campaign
lists are recycled using disposition codes from earlier cycles to alter selection and sort strategies to create new
campaigns. The transaction codes, which indicate call outcomes, can be used to determine how a campaign call needs
to be processed further. 8x8 Contact Center administrators can map transaction codes to automated disposition actions
in 8x8 Configuration Manager for better processing of campaign calls.

Every attempted campaign call may be labeled with a disposition action for follow-up. The supported disposition actions
are Try Again, Schedule Call Back, and Do not Call.
The following table summarizes the resulting disposition actions with examples:

Disposition
Action

Resulting Action

Schedule
Call back 

n Prompts an agent to schedule a callback time.

n Sends a reminder to the agent before the scheduled time if the agent is logged in to their 8x8 Agent
Console or Salesforce account.

n Sends a past-due reminder If the agent logs in past the scheduled time.

n The agent has to manually place an outbound call at the scheduled time.
For example, if you mapped a 'Busy, Callback' code with a 'Schedule Call Back' action, when an agent
selects the 'Busy, Callback' code, the agent is immediately prompted to schedule a time for the call-
back. A reminder is sent half an hour before the scheduled time.

Try Again  n Offers a call to the contact based on the Retry properties defined for that campaign.

n Retries the call as often and as many times as defined in the Retry properties.

n Drops the record from the campaign list after going through the stated number of retry attempts.
For example, if you failed to reach a contact, you mapped a ‘Reached Voicemail' code with a 'Try Again'
action, the campaign offers a call to the same contact based on the retry properties defined for that
campaign.

Do not Call allows marking records, and updating a CRM field with Do not Call disposition information.
For example, the Lead object in Salesforce CRM has a standard Do not Call field. During a campaign
call, you can update this field automatically by mapping a transaction code with Do not Call disposition
action.
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The disposition actions get recorded in the Campaign Transaction Details report. A supervisor can monitor this report,
and follow up with suitable actions.

To access the Disposition Action tab:

1. Go toOutbound Setup > Disposition Action. The tab opens the existing transaction code lists assigned to
queues.

Note:Disposition actions apply to transaction code lists assigned to queues only. You cannot map
code lists assigned to agent groups.

2. Select a code from the list, and assign an appropriate Disposition Action from the drop-down list. The supported
actions are Try Again, Schedule Callback, and Do not Call. Select None where other actions do not apply.
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Create a campaign

A campaign is an outbound phone-based dialer that enables you to search, generate, and feed a call list to an
outbound queue, facilitating automated outbound dialing. As and 8x8 Contact Center administrator, you can create a
campaign based on the customer object in your 8x8 Contact Center Local CRM or any object defined in your Salesforce
CRM, provided the object has a phone field. You can then define a search strategy to further filter the target call list. On
initiating a campaign, the campaign manager fetches the target call list from the CRM and feeds records to an
outbound phone queue. The agents assigned to the queue are offered campaign calls. If the campaign is in preview
dialing mode, an agent previews a record, and then accepts, rejects, or skips the call. A call can be initiated
automatically after the preview, if no action is taken, and if the auto dial feature is selected. If the campaign is in
progressive or predictive dialing modes, the calls are dialed out to the customers first, when answered live, are then
offered to the available agents.

The Campaigns tab in the 8x8 Configuration Manager lets you quickly create, execute, and manage campaigns.
Additionally, you can sort and filter campaigns based on custom searches.
Prerequisites for creating a campaign

Here is a checklist of tasks you should complete before creating a campaign:

n Create and identify an outbound phone queue to assign the campaign.

n Assign agents to the outbound phone queue.

n Create a transaction code list to capture campaign call outcomes and assign it to the outbound queue.

n Identify and set up CRM objects and fields from the 8x8 Contact Center CRM, or Salesforce CRM in Outbound
Setup.

n Upload audio files.

n Identify and map call outcomes that require disposition actions.

Create a campaign
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n Optionally you can:

o Determine a daily calling schedule for the campaign.

o Determine the campaign search and sort strategy.

o Identify a CRM field to capture the call outcome through transaction codes for recycling a campaign.

o Identify a CRM field to capture the Do not Call disposition.

o Identify supervisors to monitor and/or control a campaign.

Main tasks
Creating a campaign involves the following tasks:

1. Define campaign properties

2. Assign audio files to a campaign

3. Set preferences for abandoned campaign calls

4. Assign supervisors to a campaign

5. Define campaign search criteria

6. Specify a sort order for a campaign
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Define campaign properties

8x8 Contact Center administrators define properties of a new campaign via Campaigns page Properties tab in 8x8
Configuration Manager. Select an outbound queue to assign the campaign to, define the scheduling attributes (start
and end time of campaigns), and specify the number of retry attempts and more.

To define properties for a campaign:

1. In the Configuration Menu, clickCampaigns.

2. Click to add a new campaign.

3. In the Properties tab, enter or select values for the following properties of the new campaign:

Campaign
Property

Description

General
Properties

n Campaign Name: Enter a campaign name.

n Queue: Select the outbound queue to which the campaign is directed.

n Dial Plan: Select one of the default dial plans or a custom dial plan from the drop down list of
choices.

Note: To ensure successful dialing of a campaign, select the appropriate dial
plan based on the geographical region of the phone numbers included in the
campaign. For example, if the contacts in your campaign are based in the US,
use the US North American Numbering plan or a custom plan.

n Caller ID: Select the phone channel number configured for the tenant to be presented as the
outbound caller ID, or select Anonymous.

n CRM Objects: Select a CRM object from the list configured in the Outbound Setup.

Note:A campaign can extract data from only one CRM object.
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Campaign
Property

Description

n This campaign is enabled: Select to enable the campaign.

n Answer Machine Detection: If AMD service is provisioned for your tenant, the 8x8 Contact
Center administrators can activate it for the desired campaigns. When selected,
AMD identifies calls answered by a machine instead of people and allocates the calls
answered by people to the available agents. For a machine-answered call, AMD sends a one-
way message to the call routing to end that call and resolve it automatically. For details, see
our content on how to enable AMD.

n Show skip button: If selected, it offers agents the choice to skip a call by clicking the Skip
button on 8x8 Agent Console's Control Panel. For details, see our content on how to skip
campaign calls while on Auto Answer.

n Automatically apply Transaction Code to system ended calls. If this feature is
provisioned for your tenant, the 8x8 Contact Center administrator can activate it for the
desired campaigns. When selected, it automatically assigns transaction codes to campaign
calls when the destination party is not available to answer the call, or the call cannot be
completed, such as when there is a busy tone or dead line. This also includes identifying
calls that are answered by a machine. For details, see our content on how to automatically
apply transaction codes (Auto-TCL).

n Override mandatory Transaction Code selection: If selected, you can let the system
enter system-defined transaction codes, such as blocked number instead of the mandatory
codes selected manually by agents.

n Dynamic Campaign: If selected, you can add or remove records from an active campaign.
The new numbers can then be dialed within five minutes while maintaining the original list.
Removing a campaign record does not delete it from the list but will keep the record for the
future reports. For details, see our content on dynamic campaigns.

n Carrier Call Blocking: If selected, it detects TCPA-listed phone numbers for US customers
and checking whether or not the phone number is listed on a Do Not Call (DNC) or mobile
block list. If listed, the call is terminated by the carrier and an appropriate Session Initiation
Protocol (SIP) code response is sent back to the interaction router. The call is then handled
by our Auto-TCL and completed. For details, see our content on Carrier Call Blocking.

Preview
Properties

n Preview Timeout: Define a time limit for previewing records before accepting a campaign
call. You can select the agent's default preview time or enter a desirable preview time.
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Campaign
Property

Description

n Timeout Action: Allows the system to follow one of the options below:

o Dial Call: To place a call to the previewed party automatically once the preview time
elapses.

o No Action: To allow the agent to start, reject, or skip the call.

Note:By default, the No action option is selected.

Start and
End Time
(Optional)

Select Start and End Date and Time values to schedule a campaign. You can specify a start date
and an end date. If start date and time is not provided, you must start the campaign manually. If
end date is not provided, the campaign stops after processing all the records.

n Start Date: Specify a date to initiate the campaign.

n Start Time: Specify a time of the day to initiate the campaign.

n End Date: Specify a date to end the campaign.

n End Time: Specify a time of the day to end the campaign.

Note:A scheduled campaign follows the tenant time zone.

Daily Call
Start &
End Time
(Optional)

Enable and select a daily schedule to further control the time campaign calls are offered to agents
daily. This setting ensures the calls are offered based on a default schedule, or a custom
schedule, and uses either the area code or the time zone of a destination number.
For example, if a campaign follows a default schedule with a daily start and end time configured
at 9:00 and 17:00, the application initiates calls daily only between 9:00 AM and 5:00 PM. The
current time at the destination is computed based on the area code of the destination number or
the time zone specified.

n Enabled: Select to enable the daily call start and end time.

n Schedule: Select a default schedule, or a custom schedule.

n Area Code (US & Canada only): Select this option to offer calls based on the area code of
the outbound phone number.

n Time Zone: Selecting a time zone from the drop down menu offers calls in the specified
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Campaign
Property

Description

time zone. Select from 35 different time zones catering to all over the world.

Note:Default or custom schedule refers to the schedule specified for the tenant
underHome > Schedules.

Retry
Properties
(Optional)

Define retry attempts for unsuccessful campaign calls. You can define the retry frequency and
the maximum number of retry attempts before dropping the number from the call list. 
When a campaign runs, the disposition action Try Again places retrial calls based on values
defined in Retry Properties.

Auto
Update
(Optional) 

Select a CRM field to be updated with transaction code report text or short codes. This data may
be used to filter a campaign for further processing.

Note: The CRM field must be included in the Outbound Setup. Youmay create a
new CRM field to capture the disposition of each attempted campaign call. For each
campaign cycle, create a new CRM field to capture the disposition for the cycle.
Otherwise, the disposition from the next campaign cycle overwrites the disposition
in the current cycle.

Do not
Call
(optional)

Select a CRM field to be updated with Do not Call disposition information.

4. ClickSave.
You created a campaign successfully. Optionally, you may assign supervisors, create a search query, label a sort
order, and assign pre-recorded messages to the campaign.

Note:On initiating a campaign, you cannot modify properties of the campaign.
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Enable autodial campaign calls after preview

Campaign calls can automatically dial numbers when an agent who has spent all the preview time has not taken any
action. At the end of the preview time if no action is taken, calls are initiated automatically eliminating the need for
manual action by the agent. The 8x8 Contact Center administrators can enable autodialing for each campaign when an
agent’s preview countdown ends. The minimum preview duration is 15 seconds.

To set up autodial for campaign calls after preview:

1. Log in to 8x8 Configuration Manager as an administrator.

2. Navigate toCampaigns from the menu.

3. Select to edit a campaign and scroll down to Preview Properties.

4. For the Preview Timeout (sec), select useAgent Offer Timeout. The default is 15 seconds.

5. For Timeout Action, select theDial Call option.
Timeout action allows the system:
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n Dial Call: To place a call to the previewed party automatically once the preview time elapses.

n No Action: To allow the agent to start, reject, or skip the call.

Note:By default, the No action option is selected.
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Enable Answer Machine Detection (AMD) service

In 8x8 Contact Center when the dialer is used in its aggressive mode, it can call more numbers than available agents to
maximize agent efficiency. The dialer needs a service which detects the calls answered by a machine instead of people
and filters them. We have introduced the Answer Machine Detection (AMD) service to identify such calls and allocate
the calls answered by people to the available agents. When the AMD service identifies a machine-answered call, it
sends a one-waymessage to the call routing to end that call and resolve it automatically. AMD is a learning service and
it needs some time to build an effective library of known audio samples before it reaches the maximum efficiency. Once
the library is created, the AMD service resolves a machine-answered call quicker than the manual effort of an agent.

AMD resolves a machine-answered call when the following acceptance criteria are met:

n There is an active interaction on an outbound call (non-active interactions include wrong numbers, numbers not in
use, system messages).

n The call has a campaign ID from an AMD-enabled campaign.

n The elapsed time of an identified call can be terminated within the locally-configured threshold (two seconds in UK
and US).

Once AMD is provisioned for a tenant, the 8x8 Contact Center administrators can activate it for desired campaigns
under Campaigns.

To enable AMD in 8x8 Configuration Manager:

1. Log in to 8x8 Configuration Manager and go toCampaigns.

2. Click to create a new campaign or edit an existing campaign.

3. Under Properties, select Answer Machine Detection.

4. ClickSave.

AMDworks in conjunction with our newAuto-TCL. The transaction code for such calls appears as "Answer
machine detected" in CRM Cases or under Historical reports.
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Note: The AMD service is only applicable to the calls routed via campaigns, but not the outbound
calls placed by an agent.
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Enable Carrier Call Blocking (CCB) Service

8x8 Contact Center is able to detect TCPA-listed phone numbers via Carrier Call Blocking (CCB) service. This feature is
available for US customers only. The Telephone Consumer Protection Act (TCPA) designed to safeguard consumer
privacy restricts telemarketing communications via calls, SMS texts, and fax. To comply with TCPA, we have
introduced Carrier Call Blocking (CCB) service for campaign calls which allows the campaign manager in the Dialer to
apply special routing to two carriers: Brightlink and RSquared. They will then run dialer calls through a service that
checks whether or not the phone number is listed on a Do Not Call (DNC) or mobile block list. If listed, the call is
terminated by the carrier and an appropriate Session Initiation Protocol (SIP) code response is sent back to the
interaction router. The call is then handled by our Auto-TCL and completed.

Once CCB is provisioned for your tenant, the contact center administrators can activate it for the desired campaigns. If
CCB is enabled, the campaign dialer checks whether the outbound call’s phone number is listed on TCPA list.

To enable CCB in 8x8 Configuration Manager:

1. Log in to 8x8 Configuration Manager and go toCampaigns.

2. Click to create a new campaign or edit an existing one.

3. Select Carrier Call Blocking.

4. Select Automatically apply Transaction Code to system ended calls. Transaction codes record the
outcome of each interaction using codes such as "Successful call", "Call back", "Do not call back", "Reached
voicemail", "Faulty number", etc.

5. Select Override mandatory Transaction Code selection to allow the system enter system-defined transaction
codes such as "Mobile number blocked" or "DNC blocked" instead of mandatory transaction codes selected by
agents.

6. ClickSave.

When you run a campaign, the campaign dialer begins calling numbers fed from the CRM. When it detects a
TCPA-listed phone number, the CCB terminates the call. A transaction code such as "Mobile number blocked" or
"DNC blocked" is then generated by the system and recorded in the call log via Auto-TCL.
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Automatically Apply Transaction Codes (Auto-TCL)

8x8 Contact Center automatically assigns transaction codes to campaign calls when the destination party is not
available to answer the call, or the call cannot be completed, such as when there is a busy tone or dead line. This
feature also identifies the calls that are answered by a machine. Auto-TCL works with AnsweringMachine Detection
(AMD) service to identify such calls and automatically disposition them. It then moves onto the next call with minimal
agent disruption. This feature allows 8x8 Contact Center agents to be more efficient with their time. Auto-TCL feature
must be provisioned to the tenant. Administrators can then set it up in 8x8 Configuration Manager.

If Auto-TCL is provisioned for your tenant, you can enable it at the campaign level.

To set up Auto-TCL for campaigns:

1. Log into 8x8 Configuration Manager and go toCampaigns.

2. Click to edit or create a new campaign.

3. Under Properties, select Automatically apply Transaction Code to System ended calls. Transaction codes
record the outcome of each interactions using codes such as "Answer machine detected", "Call rejected", "Mobile
number blocked", "Temporary failure", etc.

4. Select Override Mandatory Transaction Code selection to let the system enter system-defined transaction
codes such as "Blocked number", instead of the mandatory codes selected manually by agents.
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Note: Auto-TCL supports campaign calls only.

In 8x8 Agent Console, the call log or task under a customer logs the automatic transaction code such as "Answer
machine detected".
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Update live (dynamic) campaigns

In 8x8 Contact Center, Dynamic Campaigns allow administrators to add or remove records from an active campaign via
campaign API. Prior to this release you could not add or remove records from a campaign after it started running. This
supports integrated lead capturing systemswhich feed new prospects into the corresponding campaign in real time so
they can be dialed within five minutes. Removing a campaign record does not delete it from the list but keeps the record
for future reports.

For API configuration details, see our support article on how to configure 8x8 Contact Center dynamic campaign API.

Features
n Ability to add a record to an active campaign via campaign API. The new record appears at the end of the record

set.

n Ability to remove a record from an active campaign via campaign API.

n Ability to return a list of active records.

n Ability to return the status and information of a specific record.

n A record that is on a Do Not Call list (DNC) cannot be added into the campaign. An error message is returned for
that particular record on the multi-status response.

n Ability to schedule a callback for a maximum of seven days in advance via campaign API.

n Ability to schedule a maximum of five million records to be uploaded via campaign API.

n Copying a campaign with the Dynamic Campaign option does not copy this option for the new campaign.

To set up Dynamic Campaigns:

1. Log in to 8x8 Configuration Manager and go toCampaigns.

2. Click to edit an existing campaign or create a new one.

3. Select Dynamic Campaign.

4. ClickSave.

You can filter campaigns in the campaign list using the newly introduced columns: Campaign ID andDynamic
Campaign. Right-click on the campaign list and select to show the desired columns. For example, Dynamic
Campaign appears in the campaign columns, but is not selected by default.
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Check out how you can Skip Campaign calls during a campaign.
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Skip campaign calls while on Auto Answer

8x8 Contact Center offers agents the option to skip the campaign calls during a campaign. To give the agents this
capability, 8x8 Contact Center administrators must enable the option in 8x8 Configuration Manager underCampaign
> Properties .

To set up the Skip Campaign option:

1. Log in to 8x8 Configuration Manager.

2. Go toCampaigns > Properties and click to create or edit an existing campaign.

3. Select Show Skip button.
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The campaign list also indicates if displaying skip button for agents is enabled or disabled for each campaign.
Make sure the Show Skip button is selected in the column settings.
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In 8x8 Agent Console and during a campaign call, if the Skip button is enabled, it offers agents the choice to skip a
call by clicking the Skip button on their Control Panel.
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Assign audio files to campaigns

During a campaign, an 8x8 Contact Center agent can play pre-recorded audio messages defined for the campaign to
ensure a uniform delivery of the campaign message across all campaign calls. If as an 8x8 Contact Center
administrator, you have uploaded audio files of pre-recorded messages during Outbound Setup, you can assign those
messages to the campaign now using 8x8 Configuration Manager. An agent accepting campaign calls can access and
play pre-recorded messages at any point during the call. On reaching a voicemail, an agent can play a pre-recorded
message, then immediately switch back to available status, and attend the next interaction.

To assign a pre-recorded message to a campaign:

1. Log in to 8x8 Configuration Manager.

2. Go toCampaign > Audio Files.

3. In the Audio Files pane, select a folder. The voice messages in this folder appear in the list.

4. Select the voice message you would like to assign to the campaign.
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5. Click Assign above the check boxes.

A dialog box appears with a message confirming the assignment.

6. To un-assign an audio file, select the file from the Assigned Audio Files window, and select Un-assign from the
menu.

7. ClickDone.

Assigning abandonedmessages to campaigns

A campaign call is considered abandoned if a live answered call is not accepted by an agent. Abandoned calls in
predictive campaigns need to play amessage within two seconds of a live answer for compliance.Themessage
typically should identify the company running the campaign or the company they are calling on behalf of, provide a
free or standard cost call back number, and contain nomarketing or sales information.

To assign an abandoned message to a campaign:

1. Go toCampaign > Audio Files.

2. In the Audio Files pane, select Abandoned Message files. The voice messages in this folder appear in the list.
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3. Select the voice message you would like to assign to the campaign.

4. Click Assign above the check boxes.

A dialog box appears with a message confirming the assignment.

5. To un-assign an audio file, select the file from the Assigned Audio Files window, and select Un-assign from the
menu.

6. ClickDone.

Version 9.14 491

Assign audio files to campaigns



Set preferences for abandoned campaign calls

An abandoned 8x8 Contact Center campaign call is a live answered call which fails to connect to an available agent
within two seconds, but plays a pre-recorded safe harbor message. As an 8x8 Contact Center administrator select an
abandoned message for the campaign in the Dialer tab , set the number of attempts to retry an abandoned call, define
the duration of ring time, and enable sequential dialing. To edit a campaign, go to the Dialer tab in 8x8 Configuration
Manager to define the following properties:

n Ring Time: Ring time is the duration that passes from the time an outgoing call is initiated until the called party
answers the call. Ring time for campaignsmust be set to a minimum of 15 seconds.

Note: The ring time can only be set at the start of a campaign, if it is adjusted during a live campaign
it does not impact the remaining calls.

n Sequential Dialing: Set your campaign calls to sequentially dial all phone numbers associated with the customer
record improving chances of contact with the customer. You can define up to 22 phone fields and customize the
order to fit your dialing needs. Let’s say customer Tom’s record has three phone numbers listed - business number,
home number, and mobile number. Sequential dialing places a call to the business number first; If unsuccessful,
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dials the home number; If unsuccessful, dials the mobile number. The order of dialing can be customized in the
Outbound Setup. Learn more.

n Abandoned Audio Message: Select an audio file to play a safe harbor message for abandoned calls. When
progressive or predictive dialing is adopted, an abandoned message must be played to the called party (where
compliance requires) within two seconds of them starting to speak to avoid creating silent calls. A silent call is when
a call is answered by the called party, but no agent is available to take the call and no message is played to the
customer.

The content of the Abandoned Message typically should identify the company running the campaign or the
company they are calling on behalf of, provide a free or standard cost call back number, and contain no marketing
or sales information. Learn how to upload audio files.

Note: Youmust assign an audio file to the campaigns as described in step 6.

n Abandoned Retry Properties: Set the maximum number of attempts to retry calling an abandoned campaign
call. A configurable limit on the number of retry attempts can now be specified, with a maximum of 10 retry
attempts. Let’s say you set the retry limit on abandoned calls to three times; for every campaign call that is
abandoned, the dialer waits 72 hours before retrying that customer. After three retry attempts, the dialer stops to
dial that customer. This excludes the original attempt where the call is abandoned triggering the retry attempts.
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Assign supervisors to campaigns

An 8x8 Contact Center campaign supervisor controls and monitors real time campaign status. A supervisor can run
campaign reports to get statistical information on the campaign calls processed. 8x8 Contact Center administrators can
assign the following campaign supervising privileges to supervisors via 8x8 Configuration Manager at any time during
the campaign's life cycle.

n Monitor: Allows a supervisor to monitor real-time statistics of the campaigns theymonitor.

n Control: Allows a supervisor to start, schedule, pause, purge, resume, and purge campaigns they control.

To assign Supervisors to a campaign:

1. Click the Supervisors tab for a campaign.
A list of supervisors appears.

2. Select theMonitor check box to allow supervisors to access real-time statistics about the campaigns.

3. Select theControl check box to allow supervisors to start, pause, purge, and stop a campaign through the
Campaign Management tab in their 8x8 Supervisor Console.

Note:You can alter supervisor assignments even after initiating a campaign.
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4. ClickSave.

Campaign supervisorsmanage campaigns using the monitoring tool in the Supervisor console. They can review the
status of the campaigns, begin, schedule, pause, and purge campaigns. Additionally, they can access keymetrics by
accessing historical reports for campaigns. Supervisors generate historical reports of the campaigns they supervise. For
details, go tomonitoring campaigns.
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Define search criteria to filter campaign call list

An 8x8 Contact Center campaign call list can be filtered based on a custom search query. 8x8 Contact Center
administrators can define a query and generate a custom call list based on specific CRM fields and values under the
CRM object. Let's say you wish to filter only customers with last names between A and L, use the search criteria to get
the filtered list.

The 8x8 Configuration Manager filter option allows you to define a custom search query. You can validate a query by
running the test query.

Note:You cannot alter a campaign filter after initiating the campaign.

To define search criteria for a campaign:

1. Click the Search tab for a campaign.

2. Select a field name from the drop-down list and enter a value. You can nest multiple search criteria to create a
complex query.

3. Click to nest search criteria. Let's say a complex query retrieves customer records with <Credit Rating greater

than 700>, <Expense in the last 6 months greater than 30000>, <Expense in the last year greater than 100000>,
and <Income Range between 3 and 4>.
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4. Click Test to validate the search criteria. If the test passes, you have defined a valid filter. If the test fails, check for
any errors and redefine the filter.

5. ClickSave.

Filter campaign lists based on DoNot Call preferences
While creating a campaign filter, you can filter those numbers from Local CRM records that are registered with the
Telephone Preference Service (TPS) and Corporate Telephone Preference Service (CTPS), to be compliant with TPS
and CTPS. This feature is currently supported for UK phone numbers, but will be extended to other countries in future
releases.

This feature helps customers to be TPS/CTPS compliant, but does not guarantee it. Customers are responsible for
their own compliance. It is recommended not to run campaigns longer than 28 days.

Note: The Telephone Preference Service (TPS) is a UK register of domestic telephone numbers whose
users have indicated that they do not wish to receive sales andmarketing telephone calls.
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Note: The Corporate Telephone Preference Service (CTPS) is a list of organizations (limited
companies, public limited companies and Scottish partnerships) who have registered their wish not to
receive unsolicited direct marketing calls.

To filter campaign list based on Do Not Call lists:

1. Log in to 8x8 Configuration Manager.

2. OpenCampaigns and select a campaign from the list, or clickEdit.

3. Go to the Filter tab.

4. Make sure check Do Not Call lists is selected.

5. Click Test to check your filter criteria.
For details, see our content on how to define campaign search criteria.
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Specify sort order

8x8 Contact Center administrators can sort a campaign call list based on applicable CRM fields. The call list takes
priority based on the sort order you specified. When a campaign runs, calls are placed based on the sorted order. For
example, using the 8x8 Configuration Manager, you can sort a call list by the descending order of your business
expenses in the last six months. The calls are placed to the customers bearing the highest expenses first.

Note:You cannot modify the sort order after initiating a campaign.

To specify sort order for a campaign call list:

1. Click the Sort tab for a campaign.

2. Select a field from the drop down list, and select the sort order.

Note:You can sort any text field in the ascending or descending order.

3. Click to nest more sort criteria.

4. ClickSave.
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Control a campaign

After creating a campaign, the 8x8 Contact Center administrator can manually start or schedule the campaign. If you
defined scheduling attributes in the 8x8 Configuration Manager campaign properties, the campaign runs as it is
scheduled. If not, you must start the campaign manually. As an administrator or a privileged supervisor, you can start,
pause, purge, or stop a running campaign at any time. You can execute a new campaign either bymanually starting it
or scheduling it.

Note:Campaigns are controlled by administrators and privileged supervisors only. An administrator
controls the campaigns from 8x8 ConfigurationManager, while a supervisor controls campaigns from
the CampaignManagement tab of 8x8 Agent Console.

To run a campaign manually:

1. ClickCampaigns in the Configuration Menu.

2. Select the desired campaign, and click to manually start the campaign.

Note: The status changes from New toManually Started. For details on campaign status, refer to
Understand Campaign Status.

To run a scheduled campaign:
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1. ClickCampaigns.

2. Select a campaign and clickControl > Schedule to initiate a campaign on schedule.

Note: For a campaign to run on schedule, youmust have specified a schedule in the Campaign
Properties tab. For details on scheduling a campaign, refer to Define Properties.

Pause a campaign
Pausing a campaign stops the campaign temporarily retaining calls in the queue. Calls in the queue continue to be
offered to agents until completed. You can resume or abort a paused campaign.

To pause a campaign:

1. Select a campaign, and clickControl > Pause to pause the campaign.

2. ClickControl > Resume to resume the paused campaign.

Purge a campaign
Purging a paused campaign aborts the campaign by flushing all calls in the queue. You can resume a purged
campaign. Resuming feeds calls back to the queue.

To purge a campaign:

1. Select a campaign, and clickControl > Purge to pause the campaign.

2. ClickControl > Resume to resume the paused campaign.

Based on how a campaign is controlled, the campaign status changes accordingly. For details, refer toUnderstand
Campaign Status.
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Understand campaign status

An 8x8 Contact Center campaign can assume varying statuses based on how it is managed. The campaign status
informs 8x8 Contact Center administrators if the campaign is ready to run, scheduled to run, running, stopped, or
completed running.

To view a campaign status, go toCampaigns in the 8x8 Configuration Manager. You can see a list of all your
campaigns with their corresponding status.

The following table summarizes the various campaign statuses:

Campaign
Status

Description

New A newly-created campaign that has not been scheduled to start. You should manually start this cam-
paign.

Manual
Running

A campaign that is manually started and is currently running.

Manual
Stopped

A campaign that is manually stopped by clicking Stop.

Scheduled A campaign with a scheduled start time that has not been reached.

Scheduled
Running

A campaign that has reached scheduled start time and is currently running.

Paused A campaign that, when paused, stops feeding calls to the outbound queue until resumed. The cam-
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Campaign
Status

Description

paign retains calls already in the queue and offers them to the agents.

Purged A paused campaign that, when purged, removes all calls from the queue. You can resume purged cam-
paigns.

Schedule
Stopped

A campaign that has reached the scheduled stop time and is currently stopped.

Completed  A campaign whose records have been successfully processed.
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Manage a campaign

As an 8x8 Contact Center administrator, once you create a campaign in 8x8 Configuration Manager, you can perform
the following functions:

n Edit a campaign

n Control a campaign

n Copy a campaign

n Delete a campaign

Edit a campaign
You can edit a campaign's settings before running it. Once a campaign runs, you cannot edit any of its properties except
changing the supervisor assignments.

To edit a campaign:

1. ClickCampaigns in the Configuration Menu.

2. Choose the campaign you wish to edit, and click Edit.

3. Make the necessary edits, and clickSave.

Control a campaign
After creating a campaign, you can manually start or schedule the campaign. SeeControl a Campaign for details.

Copy a campaign
You might want to copy a campaign and run it again, in cases such as:

n The campaign call list was not processed as expected.

n There were too many dropped calls or skipped calls.

To copy a campaign:
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1. ClickCampaigns in the Configuration Menu.

2. Select a campaign you wish to copy, and clickCopy. A new copy of the campaign is created, and shows in the
updated list of campaigns.

Delete a Campaign
After completing campaigns, you may want to remove them if you no longer need them. Deleting a campaign removes
all historical information related to the campaign.

To remove a campaign:

1. ClickCampaigns in the Configuration Menu.

2. Select a campaign from the list, and clickDelete. The campaign is removed from the list.
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Broadcast messages

Use the 8x8 Contact Center broadcast feature to send messages to one or more agent functional groups. This feature
allows the administrator to mass-communicate a message to the agents using 8x8 Configuration Manager.

To broadcast a message:

1. From the Configuration Menu, clickBroadcast.

2. ForGroup, select a group or All Groups from the list.

3. ForAlert Level, select low, medium, high, or pop-up.

4. ForOnly send to logged-in agents, choose whether you want to send the message to the agents who are
logged in or to all agents.

5. ForMessage, type what you like to broadcast to agents.

6. ClickBroadcast to send the message.
The following table describes the options underBroadcast:

Broadcast
Option

Description

Group Select agent functional groups you are sending the broadcast to. It can be a specific group or
all groups.
For details on creating 8x8 Contact Center Groups, refer to Create Agent Functional Groups.

Alert Level Sets the importance or type of alert sent to agents: Low, Medium, or High alert, or Pop-up.

Only send to
logged-in
agents

If you select Yes, it only sends the broadcast to the agents who are logged in.
If you select No, it sends the broadcast to all agents. The agents who are not logged in at the
time of broadcast will see the message the next time they log in to 8x8 Agent Console.

Broadcast messages
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Broadcast
Option

Description

Message The broadcast message that is sent to all or all logged-in agents.

7.
Note:You cannot undo or delete amessage once it is broadcast.
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Integrate with External CRM

8x8 Contact Center offers integration capabilities with local and external Customer Resource Management (CRM)
systems. Integrating with an External CRM enables you to expand the capabilities of 8x8 Contact Center CRM, and to
incorporate your existing CRM system data into your tenant's interaction processing workflow. The integration supports
voice and chat channels, allowing you to access data from External CRM through an integrated 8x8 Agent Console.

8x8 Contact Center provides out-of-the-box integration with:

n NetSuite

n Salesforce

n Zendesk

n Microsoft Dynamics

n Local CRM

Additionally, 8x8 Contact Center supports custom integration with your CRM.

8x8 Contact Center’s ability to integrate with External CRM offers the following benefits:

n Provides out-of-the-box integration with minimal configuration.

n Increases agent productivity with integrated one-click dialing out of the CRM application.

n Informs an agent about the caller by popping the caller's account information to the agent as soon as a call is
offered to an agent.

Features
The CRM integration allows you to perform your CRM account activities using the integrated 8x8 Agent Console with
the following features:

Integrate with External CRM
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n Multimedia interaction support

n Fully integrated 8x8 Agent Console

n Complete Telephony Integration

n Single Sign-On functionality

n Visibility to queue status and agent presence

n Availability of custom landing pages

n Customer CRM records appear via screen pop during inbound interactions

n Integrated Chat Management

n Ability to save chat transcripts

n Ability to use click-to-dial directly from native Salesforce account

n Ability for agents to toggle between 8x8 Agent Console and CRM accounts

n Support for screen pop for outbound campaign calls

n Support for screen pop for web callback transactions

n Creates Auto Logs for all transactions automatically

The core feature set is common to all CRMs supported by integration, but varies slightly.
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Overview of integration functionality

8x8 Contact Center administrators use 8x8 Configuration Manager to find and configure the following options:

n 8x8 CRM API: Specify the access credentials and rights an External CRM uses to access the Local CRM
database.
The external system can access data from the Local CRM for purposes of producing customized reports or
synchronizing database data between the two systems.

n CRM Triggers: Configure 8x8 Contact Center to transmit URLs that include activity parameters to an external
HTTP server whenever an agent creates, edits, or deletes a customer, case, follow-up, or task record in the Local
CRM. The HTTP server uses the URL received from 8x8 Contact Center to run an interaction-specific
synchronization, such as a database synchronization.

n Screen pop: Configure 8x8 Contact Center to transmit a URL to an External CRM product when an agent is
offered, accepts, or completes an interaction. The External CRM responds by sending an HTML document
containing supplementary information about the interaction to the agent's browser as a pop-up.

n API Token: Create and copy the secure access tokens required to enable an external system to access the
following Local CRM data:

n Statistical reporting data

n Recording API

n External IVR API

n Real-time statistics reporting data
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Configure External CRM API access

To access 8x8 Contact Center CRM data, 8x8 Contact Center administrators can use 8x8 CRM API in 8x8
Configuration Manager. The 8x8 CRM API component of the integration suite enables you to develop external
programs to access data for customers, cases, tasks, follow-up records, and FAQs.

The 8x8 CRM API uses HTTP or HTTPS to transmit requests and receives responses formatted as Extensible Mark-up
Language (XML). All these API queries are authenticated by account access credentials.

Note: For APIs customization in the 8x8 Contact Center, check with your system administrators or
developers to ensure that the system SSL libraries are updated to support TLS 1.2 or better. Affected
products may include, but are not limited to, older distributions of Linux-based operating systems (using
old versions of OpenSSL) or Java Runtime Environments (JRE) older than 1.8.

To configure 8x8 CRM API:

1. From the Configuration Menu, open Integration.

2. Go to theCRM API tab.

3. Specify the account credentials and access rights used by an external process to access the Local CRM database.

The following table summarizes the options under Integration > CRM API:
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CRM API
Option

Description

Enable CRM API
Access

Select to enable a third-party process to access the Local CRM database.
The third-party process uses the credentials entered for 8x8 CRM API username and password.

CRM API user-
name

Do not reuse a user account name. Type a username created exclusively to service 8x8 CRM API
XML access to the Local CRM database.

Password,
Retype Pass-
word

Type the password required to access the Local CRM database.

Used Identify Select the user account name associated with activities performed by the 8x8 CRM API.
In reports, interaction activity performed by the 8x8 CRM API matches the value of Used Identify.

Access Rights Choose the operations the third-party process allows to perform on the Local CRM.

n Select Add to enable the third-party process to create a new CRM database record.

n Select Modify to enable the third-party process to change an existing Local CRM database
record.

n Select Get to enable the third-party process to read the Local CRM database record.
The Add, Modify, and Get permissions can be selected for each the following categories of Local
CRM database records, including:

n Customers

n Cases

n Followups (No Modify option)

n Tasks

n FAQ
Access Rights specify the operations 8x8 CRM API is allowed to perform: The 8x8 CRM API does
not inherit the access rights of the user specified in the Used Identify list.

Note: The 8x8 CRM API cannot delete data from the Local CRM.

To completely configure bi-directional exchange of information to and from an external process and the Local
CRM database, use the CRM Triggers page to transmit URLs to a third-party process when the Local CRM database
records are modified. For details on CRM Triggers, refer toConfigure External CRM Triggers.
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Configure External CRM Triggers

If your businessmaintains an External CRM database that is not integrated with 8x8 Contact Center, administrators
can use the 8x8 CRM API to query and fetch the data in Local CRM and synchronize with the External CRM database.
Admins design 8x8 CRM API to synchronize a Local CRM database with the External CRM using the CRM Triggers. A
CRM trigger is a URL that targets a script on an external HTTP server. The CRM Triggers notify admins of the changes
to the 8x8 Contact Center Local CRM and invoke a script for further action. The CRM Triggers also pass parameters
which can be used for further data mining.

When you create a new customer in the Local CRM via the user interface application, the script is executed with the
appropriate parameter value (such as the customer account ID) sent with an HTTP method. The script then uses that
parameter value to access the object data using 8x8 CRM API, and populate the External CRM with it. The script may
use the data for synchronization, auditing purposes, and creating simple dashboards.

A CRM Trigger invokes the 8x8 Contact Center script when:

n A new case is created, edited, or deleted

n A new follow-up is created, edited, or deleted

n A new customer is created, edited, or deleted

n A new task is created, edited, or deleted

Note: The CRM Trigger is only executed when the above actions are requested via 8x8 Agent Console
application. Other scenarios such as 8x8 CRM API requests, bulk customer creation via 8x8
ConfigurationManager or CSV import, and CRM objects created via auto-log feature, do not execute
CRM Triggers.

Set up the CRM Triggers
8x8 Contact Center administrators can set up CRM Triggers via 8x8 Configuration Manager for changes to CRM objects
under specified events. The URL executes when those events occur, and those parameters are passed to the script
targeted by the URL.
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Note:When configuring a CRM Trigger:
-We require you to use a secure https URL.
- A retry mechanism is triggered when 8x8 Contact Center calls the configured URL but does not
receive an http-response code (200).

The following table summarizes the CRM objects, corresponding events that invoke CRM Triggers, and parameters
passed to the script:

CRM Object Events Parameters

Customer n Create

n Edit

n Delete

n Account ID

Case n Create

n Edit

n Delete

n Account ID

n Case ID

Followup n Create

n Delete

n Account ID

n Case ID

n Followup
ID

Task n Create

n Edit

n Delete

n Account ID

n Task ID

Use the CRM Triggers tab to transmit URLs pointing to scripts from 8x8 Contact Center to an external process when the
8x8 Contact Center CRM database records are modified. The external process uses the URL to synchronize its
database records with the 8x8 Contact Center CRM database.

To set up CRM Triggers:

1. From the Configuration Menu, open Integration.

2. Go to theCRM Triggers tab and enter values.
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Note:  Only UI updates on Local CRMObjects can trigger CRM Trigger. The changes on Local
CRM via API or CSV do not trigger callbacks.

The following table summarizes the options under Integration > CRM Triggers:

CRM
Triggers
Option

Description

Customer To enable 8x8 Contact Center to notify a third-party process of changes to customer account data,
type a URL for the Create, Edit, and Delete areas under Customer.
When an agent creates, edits, or deletes customer data in the Local CRM database, 8x8 Contact
Center transmits a formatted string to the URL specified for the customer.
For customer data, the formatted string has the following format: ?AccountID=aaa, where aaa
specifies the customer account identifier.

Case To enable 8x8 Contact Center to notify a third-party process about changes to case data, type a
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CRM
Triggers
Option

Description

URL for the Create, Edit, and Delete areas under Case.
When an agent creates, edits, or deletes case data in the Local CRM database, 8x8 Contact
Center transmits a formatted string to the URL specified for the case.
For case data, the formatted string has the following format: ?AccountID=aaa&CaseID=ccc,
where:

n aaa specifies the customer account identifier.

n ccc specifies the case identifier.

Followup To enable 8x8 Contact Center to notify a third-party process about changes to case follow-up
data, type a URL for the Create, Edit, and Delete areas under Followup.
When an agent creates or deletes follow-up data in the Local CRM database, 8x8 Contact Center
transmits a formatted string to the URL specified for the follow-up.
For follow-up data, the formatted string has the following format:
?AccountID=aaa&CaseID=ccc&FollowupID=fff, where:

n aaa specifies the customer account identifier.

n ccc specifies the case identifier.

n fff specifies the follow-up interaction identifier.

Task  To enable the 8x8 Contact Center to notify a third-party process about changes to Task data, type
a URL for the Create, Edit, and Delete areas under Task.
When an agent creates, edits, or deletes task data in the Local CRM database, 8x8 Contact Center
transmits a formatted string to the URL specified for the task.
For task data, the formatted string is of the format: ?AccountID=aaa&TaskID=ttt, where:

n aaa specifies the customer account identifier.

n ttt specifies the case identifier.

3. ClickSave.
8x8 CRM API configuration allows an external process to access the Local CRM database and exchange
information to and from an external process and the Local CRM database. For details on 8x8 CRM API, refer to
Configure External 8x8 CRM API Access.
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Overview of data exchange

8x8 Contact Center administrators go to Integration > CRM API and Integration > CRM Triggers in 8x8 Configuration
Manager to configure data, such as customer, case, follow-up, or task data.

The following sequence describes the two-way exchange of data between 8x8 Contact Center and an external process:

1. An agent uses 8x8 Agent Console to update customer, case, follow-up, or task information contained in the Local
CRM database.
If a URL has been specified for the interaction under CRM Triggers, then 8x8 Contact Center transmits a
formatted URL that includes the customer, case, or follow-up information.
For details on formatted strings transmitted by 8x8 Contact Center to an external process, refer toConfigure
External CRM Triggers.

2. The external process receives the formatted string, then uses the 8x8 CRM API to read additional information
about the interaction from the Local CRM database.
For details on configuring the 8x8 CRM API to enable an external process to access the Local CRM database,
refer toConfigure External 8x8 CRM API Access.

3. The external process updates its database with the information read from the Local CRM.

4. The external process sends the Local CRM database any information required to synchronize the two databases.
For example, the external processmay use internal logic to revise the priority of the case.
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Example of a CRM trigger

The following 8x8 Contact Center example illustrates a trigger specification in 8x8 Configuration Manager by going to
Integration > CRM Trigger tab.

In the above image:

n <myServer.net> specifies a valid HTTPS server

n <acct_add.php> specifies a PHP script that creates a log file of the account ID written to myfile.txt

The following example shows a PHP script invoked by the 8x8 Contact Center CRM trigger illustrated in the above
image.
/* acct_add.php – log creation of new accounts*/

<?

if(is_file('myfile.txt')) {

  $fp = fopen('myfile.txt','a+');

}

else {
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  $fp = fopen('myfile.txt','w');

}

if($fp) {

  $now = date( "[m/d/Y H:i:s] – ", time());

  fwrite($fp, $now.'AccountID: '.$AccountID." – action: CREATE CUSTOMER\n");

  fclose($fp);

}

The script reads the account ID referenced by an agent interaction, and writes the account ID to a file called myfile.txt.
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Define screen pop settings for External CRM

A screen pop presents customer data to an 8x8 Contact Center agent automatically during an interaction, eliminating
the need to manually search for the customer data. During an inbound call, 8x8 Contact Center looks up the caller ID in
the existing customer data. On finding a record with a matching number in the Phone field, 8x8 Contact Center fetches
and pops the record details to the agent presented with the interaction. If the search does not yield a matching record, it
pops a new record entry screen.

A screen pop is presented for:

n Inbound transactions, including phone, voicemail, chat, and email media

n Outbound campaign phone transactions

n Transactions involving web callback

To enable an External CRM integration for a tenant, you have to configure screen pop settings in 8x8 Configuration
Manager. You need to select a target CRM, specify events that trigger screen population of customer data, and specify
screen pop window properties. An agent has to then save the login credentials of the External CRM account in the
agent’s profile. Integration enables searching for records containing phone data matching caller ID, and pops up the
corresponding record(s) for specific events.

The events triggering a screen pop may be one or more of the following:

n An agent is offered an interaction.

n An agent has accepted an interaction.

n An agent has completed an interaction.

Use Integration > screen pop to configure the contents and appearance of the messages sent to theWeb browser
associated with a particular interaction.
To display the screen pop page

1. From the ConfigurationMenu, open Integration.

Version 9.14 520

Define screen pop settings for External CRM



2. Go to the screen pop tab.

3. Select the CRM of your choice from the available options. For other details refer to the table below.
The following table summarizes the options under Integration > Screen Pop:

Screen Pop
Option

Description

Enable Screen
Pop

If enabled, screen pop is offered during an interaction.

Target Type Select a third-party CRM product.
The selection of a product enables and disables other features on the screen pop page.

Integration If you have selected NetSuite, then choose one of the following:
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Screen Pop
Option

Description

Type n Legacy

o Displays External CRM information in a separate browser window.

n SSO

o Allows the External CRM user to enter 8x8 Contact Center via NetSuite's website.

o Provides Single Sign-On; the user presents the authentication information only once
per NetSuite session.

If the Target type specifies Salesforce, then choose one of the following:

n Legacy

o Displays information from the Salesforce database in a separate browser window.

o Provides less integration with Salesforce than Enhanced mode.

n Enhanced
If you choose Enhanced, 8x8 Configuration Manager disables the Size and Position area
described later in this table.

o Displays information from the Salesforce database in a frame with 8x8 Agent
Console window.
The agent can optionally move the Salesforce frame to a separate browser window.

o Provides more complete integration with Salesforce than Legacy mode.

Account If the Target type is NetSuite or custom, then type the account name required to access the
data the third-party CRM incorporates into the screen pop message.

Service Name  Service name is the URL used to log in to your External CRM account.

Login URL Enter the login URL starting with <https://>

Branding URL The custom URL provided by your CRM if you have customized your help desk to match your
brand’s look and feel.

URL  For the Custom target type only. Type the URL where 8x8 Contact Center sends information
about the interaction reported on by the screen pop.

Enable
Customization

This option instructs the On Demand Contact Center to execute a custom XML Salesforce
integration script using the specified Script URL.

Script URL If Customization is enabled, the Script URL must contain a valid URL that points to the location
of the custom script. Once the Script URL is specified and the screen pop page is saved, all
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Screen Pop
Option

Description

features and functionality of the standard integration are replaced with the custom
functionality. Agents see the changes with their next login.

Use Remote
Login

This option enables Single Sign-On security settings in the Zendesk account.

API Token Enter a valid API token to enable searching of the CRM.

Use Client
Login Session
to pop 

Select the option to enable support for the Salesforce security setting: Lock sessions to the IP
address from which they originated. Check the Launch native login window at agent login
setting to have 8x8 Agent Console automatically launch a Salesforce login window when the
agent logs in to 8x8 Agent Console. If the Launch native login window at agent login is not set,
the agent must manually log in to Salesforce using the next tab of the same browser window
used for the 8x8 Agent Console session.

Launch native
login window
at agent login

This option enables the native login window to launch when the agent logs in.

Select and
assign all
agents

Enable this option to grant access to all agents for Salesforce integration, or click (choose
agents) to grant the permission to a selected group of agents.

Landing
Pages 

8x8 Contact Center enables the custom landing page, and provides three built-in landing tabs
from the 8x8 Contact Center CRM:

n Enable Custom: If enabled, enter a title for the landing page, and a URL to navigate to.

n Enable 8x8 CRM

Note:Availability of the tabs depends on the External CRM the tenant is
integrated with.

Trigger an
Auto Log
Window after
interactions

n For these Media: Select media for auto log from Phone, Voice Mail, and Chat. Auto Log
Window is offered after Interactions. You can disable auto log for certain media by
clearing the check box of the option.

n Select the type of log window for auto log from the following choices:

o No screen pop: Prevents screen pop for auto log.
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Screen Pop
Option

Description

o Pop the log for edit: Offers the ability to edit auto logs.

o Pop the log for view: Limits auto log to view mode.

Trigger a
Popup
Window

n For these events:

o When agent is offered transaction: 8x8 Contact Center displays a screen pop when
an agent is presented with a new interaction.

o When agent accepts transaction: 8x8 Contact Center displays a screen pop when an
agent accepts a new interaction.

o When agent completes transaction: 8x8 Contact Center displays a screen pop when
an agent has completed an interaction.

n For these media: Choose 8x8 Contact Center channels that use screen pop. The choices
are Phone, Voicemail, Chat, and Email.

Window
Properties 

If enabled by the administrator, the agents can see and configure the setup under Agent's
Profile > External Setup. The following options are available in this section:

n Open new window for screen pop: This option allows agents to see screen pop, and the
new Salesforce URL launches in new windows instead of tabs within the 8x8 Agent
Console window. This option opens a new window for each transaction and each new
URL. 

n Use single window only: This option allows only one single window to display screen
pop notifications and URL launch.

n Hide result listing if one search result is found: The application supports multiple
search results displayed on screen pop. With the option enabled, the tab with one result
listed will not be open. The screen pop window still will pop with the search result record.
Note that with this option enabled, if multiple results are found, tab is open with all the
result records listed. If the Salesforce window is collapsed, it will be automatically
expanded.

n Show toolbar:

o If the Target type is Salesforce, and the Integration Type is Legacy, then click yes to
display the Internet Explorer toolbar at the top of the stand-alone pop-up window.

o If the Integration Type is Enhanced, 8x8 Contact Center ignores the value of Show
toolbar.
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Screen Pop
Option

Description

n Size and position:

n In the width and height text entry areas, type the size as an integer number pixels of
the screen pop window.

n In the top and left text entry areas, type the screen position as an integer number of
pixels of the screen pop window's upper-left corner.

4. Save your settings.
For detailed instructions on setting up an external integration such as NetSuite or Salesforce, refer to the
respective CRM integration guides on our documentation page.
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Overview of screen pop

In 8x8 Contact Center, screen pop describes the mechanism that enables a third-party CRM to display supplementary
information in an HTML page that pops into the 8x8 Contact Center agent's browser.

8x8 Contact Center screen pop directly supports the following CRM applications:

n NetSuite: Use Integration > Screen Pop in 8x8 Configuration Manager to specify the NetSuite account ID used to
access the NetSuite CRM. The agent email address and password (used to log in) are set in the agent's profile in
8x8 Agent Console.

n Salesforce: Configure Integration > Screen Pop in 8x8 Configuration Manager, and set up the external username
and password in the agent's profile in 8x8 Agent Console.

n Zendesk: Configure Integration > Screen Pop in 8x8 Configuration Manager, and set up the external username
and password in the agent's profile in 8x8 Agent Console.

n Microsoft Dynamics: Configure Integration > Screen Pop in 8x8 Configuration Manager, and set up the external
username and password in the agent's profile in 8x8 Agent Console.

n Custom CRM: 8x8 Contact Center allows custom CRM integration. For more information regarding custom
CRMs, consult the 8x8 Support team.

Screen Pop Event Types

A screen pop is triggered by events or by steps in the process of handling an interaction. You can configure screen pop
for one or more events. There are three events that can cause a screen pop:

n Agent is offered an interaction, but has not yet accepted.

n Agent accepts an interaction (for example, is connected to a caller).

n Agent completes an interaction (for example, hangs up after a call).

Screen Pop Data Exchange

The following sequence must be performed to enable 8x8 Contact Center to transmit a screen pop request to a third-
party CRM.

1. 8x8 Contact Center uses the information you entered in the screen pop tab to transmit interaction parameters to
the third-party CRM as an HTTP POST message.
The following table summarizes screen pop parameters transmitted by 8x8 Contact Center in HTTP Post
message:
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screen pop parameter Description

Channel 8x8 Contact Center channel name that received the interaction

Queue 8x8 Contact Center queue name that received the interaction

ANI For phone channels, the caller's ANI information

Wait Time The length of time this interaction waited before being accepted by an agent

Event Interaction statuses: offered, accepted, or completed

Media 8x8 Contact Center phone, voicemail, chat, and email channels

ExtVar1, ExtVar2 Optional CRM-specific variables

2. The third-party CRM uses the received information to access its database, construct a pop-up message about the
interaction, then transmit the pop-up message to 8x8 Agent Console, processing the interaction.
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Example of a screen pop

The following example illustrates how to configure an 8x8 Contact Center screen pop via 8x8 Configuration Manager.

In the above image:

n <myServer.net> specifies a valid HTTP server.

n <ScriptPop.php> specifies a PHP script that displays either of two HTML pages.

The following example shows a PHP script invoked by the screen pop configuration illustrated in the above image.

<?php

/* scriptPop.php – This script should return a web page depending on the phone

number dialed */

$channel=$_POST[‘Channel’];

if (is_null($channel)) {

  printf(“No channel data was given”);

}

else {

  switch ($channel) {

  case ‘18005551212’:
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    header(‘Location: http://www.8x8.com’);

    break;

  default:

    header(‘Location: http://www.example.com’);

    break;

}

}

The script evaluates the Call ANI:

n If the interaction arrived on the 800-555-1212 phone channel, then the 8x8 homepage opens up in a new browser
window.

n If the call arrived on a different channel, then the script opens http://www.example.com in a new browser window.
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Access control for Salesforce integration

As an 8x8 Contact Center administrator, you can control the number of agents who access 8x8 Contact Center
Integration with Salesforce. Access to the integration is controlled in 8x8 Configuration Manager.

In 8x8 Configuration Manager, admins can grant access to a selective group of agents. During provisioning 8x8 Contact
Center, your sales agent assigns the desired number of users allowed to use 8x8 Contact Center Integration with
Salesforce. To check the number of authorized Salesforce users, go to Home > Profile.

To grant access to 8x8 Contact Center Integration with Salesforce:

1. From the Configuration Menu, open Integration.

2. Go to the Screen Pop tab.

Note:Youmust have enabled and configured 8x8 Contact Center Integration with Salesforce.
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3. Under Agents, select the Select and assign all agents check box.

Note: The check box is disabled if the number of named users assigned to the tenant exceeds the
provisionedSalesforce Users Limit.

4. To select agents individually, click choose agents.

5. Select the desired agents from the list of agents configured in the tenant.

6. ClickAssign.

Note: If the number of selected agents exceeds the Salesforce user limit, you get an error message
indicating the limit. Youmust readjust the selection accordingly.

7. Save your settings.
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NetSuite Single Sign-On

8x8 Contact Center integration with NetSuite Single Sign-On and (SSO) capability allows a user of NetSuite CRM to
enter 8x8 Contact Center via NetSuite website, eliminating the need to remember or enter 8x8 Contact Center user
credentials. The user presents the authentication information only once per session. NetSuite's Single Sign-On
eliminates the need for a separate login for 8x8 Agent Console.

Notes:
- There is no iframe for this release. 8x8 Contact Center appears in a separate window.
- SSO is the only option for new customers. The existing customers cannot go back to non-SSO once it
is selected.

Features
n Easy installation using SuiteBundler.

n SuiteSignOn for time saving convenience and secure Single Sign-On.

n Improved security; NetSuite user credentials and password are not stored in user interface.
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n Enhanced user experience; users can seamlessly sign in to 8x8 Contact Center from the NetSuite dashboard
without the need to remember or enter 8x8 Contact Center user credentials.

o Full functionality of 8x8 Contact Center and NetSuite.

o No need to refresh 8x8 Contact Center while using NetSuite.

Limitations
We can associate only one 8x8 Contact Center tenant with each 8x8 Contact Center Suitebundle. Contact 8x8
professional services for the available workaround.

Requirements
You must have NetSuite SSO enabled for your NetSuite account to proceed with the installation. In order to enable
SSO, contact the NetSuite support team at www.netsuite.com.

To learn how to install and configure NetSuite SSO, refer to theNetSuite SSO Installation Guide.
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Generate authentication tokens for 8x8 Contact Center
APIs

API access tokens are used to authenticate individual calls to read or write 8x8 Contact Center data, from outside the
standard 8x8 Contact Center agent or admin interface. 8x8 Contact Center administrators create and copy secure
tokens used to access 8x8 Contact Center data such as:

n Statistical data for reporting

n Audio recordings data

n External IVR such as web callback

n Real-time statistical data

To generate data and action request tokens:

1. Log in to 8x8 Configuration Manager.

2. Go to Integration > API Token.

3. ClickNew Token to generate data- and action-request tokens for security reasons.

4. Highlight and copy the tokens.

5. Use the token to authenticate your API requests.
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Status codes overview

8x8 Contact Center status codes enable contact center supervisors to track how an agent functions through a workday.
When an 8x8 Contact Center agent is logged in to 8x8 Agent Console, the agent accepts or rejects interactions, takes
breaks, works offline or logs out. Supervisorsmight want to knowmore details or reasons for an agent changing the
status or rejecting an interaction. Agent statuses, such asOn Break orWork Offline, do not point out the specific
reasons for the status change by the agent. Status codes can be defined to bridge this information gap. The status
codes associate an agent’s status change with probable reasons for the change, and enable supervisors or managers to
track the work pattern of agents.

For example, you can define status codes such as Attend Meeting or Complete CaseWork as probable reasons for an
agent to work offline.

Using the status codes functionality:

n An administrator predefines a list of status codes used to describe probable reasons for an agent’s status change
actions.

n An agent selects a reason for the status change from a predefined list of status codes when changing their status.

n A supervisor analyzes an agent’s working pattern and contributes to improving call center’s throughput.

When do you use status codes?

If your contact center's workflow requires a close supervision of agent's time, then you may define status codes to
achieve that goal. The most common reasons to use status codes are:

n To knowwhy an agent rejects an interaction.

n To knowwhy an agent works offline.

The following table lists an agent's actions for which you can define status codes, as well as examples of corresponding
status codes.

Status codes overview
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Agent Status action Examples of Status Codes

Take Break Lunch

Short Break

Restroom

Work Offline Attend Meeting

Project Work

Training

Outbound Call

Logout End of shift

PC Reboot

Reject Phone

Reject Chat

Reject Email

Working on a Case

Technical Issue

Not Ready for Interaction

Nearing Break Time

How do you define status codes?

Before you define status codes, you need to understand your company's workflow. If your company hasmultiple
workflows, you can create a separate status code list for each. For example, if your company has separate workflows for
Support and Sales, you can define a separate code list for each department.

Each status code list contains a set of codes or reasons for a specific status change. A list of status codes can be
assigned to a group of agents with the limitation that they only access one list of status codes. Within the agent group,
specific agents can be enabled or disabled to have access to the status code list.

Defining status codes requires you to:

n Identify valid and acceptable reasons for status change.

n Identify groups or agents to apply status codes.

n Determine the need for multi-language translation of status codes.

n Create a status code list.

Creating a status code list involves the following tasks:

n Create status code lists by defining properties.

n Create individual status codes in the list to define possible reasons for actions.

n Translate status codes to a secondary language.

n Assign status codes to agent groups and specific agents.

How do agents use status codes?
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In 8x8 Agent Console, agents assigned to a status code list are presented with individual status codes in the list. The
agent must choose a code from the presented list that describes the reason for the status change, and only then are
they allowed to proceed with the action. For example, when an agent who is active changes their status to Work Offline,
a list of status codes associated with the action (such as Attend Meeting orWorking on a Project) are presented to them
in a drop-down list.
How do supervisors use Status Codes?

Supervisors can track how agents spend their time by generating the following historical reports:

n Agent: Status change details: The report gives detailed information on an agent’s status changes, time at which
an agent changed status, and an associated reason, if any. When the supervisor browses through the report, they
get information about how often the agent changed their status, as well as the reason for the status change.

n Agents: Time on Break/Offline with status codes: The report indicates how an agent spends time on each
task while working offline or on break. The report summarizes information on time spent by each status code, by
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status, by agent, and by date. A sample report is shown below:
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Create status codes

8x8 Contact Center administrators create status codes for 8x8 Contact Center agents via 8x8 Configuration Manager.
Status codes offer a mechanism to track agent activity during work hours. With codes, you can define reasons for
changing status, such as lunch, attend a meeting, or taking a break. These codes can be invoked for status change
actions, such as Take Break, Work Offline, Logoff, and Reject Phone.

Creating a new status code list involves:

n Configuring properties of the codes list.

n Defining individual codes.

n Translating codes to secondary languages (optional).

n Assigning the codes to agent groups (required) and specific agents (optional).

Configure Properties of a Status Code

1. From the Configuration Menu, open Status Codes.

2. Click orAdd. The Properties tab opens.

3. Enter the required values in the Properties tab.
The following table summarizes the options under Status Codes > Properties:
Properties
Options

Description

Active Select the check box to put this code list into service.

Name
(Required)

Enter a name for the new code list.

Description Enter a brief description of the purpose of the code list.

Category  A category distinguishes multiple code lists, and attributes a code list to a specific group. For
example, you can create categories for Sales, Support, Services, and more. You can then assign
each code list to a particular category.
In the Category list, do one of the following:

n Choose Edit Categories to create a new code category.

n Choose an existing code category.
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Properties
Options

Description

Sort Order  Select the order in which the codes should appear in 8x8 Agent Console:

n Manual allows organizing the order of the codes manually.

n Automatic organizes the codes alphabetically.

Admin
Notes

Type information that enables administrators to understand the purpose of the code list.

Primary
Language
(Required) 

Select a primary language in which the codes are written. This information is required to create a
list.

Note:After saving the code list, you cannot change the Primary Language setting.

Secondary
Language

Select the languages to translate the codes to. This option allows you to set up codes in
languages other than English.

4. ClickSave.

Define Status Codes

In the Codes tab, you can define individual status codes and assign them to an agent’s action or status change. These
codes are invoked when an agent performs one of the following actions:

n Take Break

n WorkOffline

n Log Out

n Reject Phone

n Reject Chat

n Reject Email

To define status codes:

1. From the Configuration Menu, open Status Codes.

2. Click to Edit a status code.

3. Go to theCodes tab, and enter the required values.
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The following table summarizes the options under Status Codes > Codes:
Status Codes Field
Name

Description

Active Select to activate the code.

Menu Text  Type the string that 8x8 Agent Console displays when displaying the code, such as
Attend Meeting.

Report Text  Type the string that 8x8 Agent Console displays when listing the code in a report,
such as Attend Meeting.

Short Code  Type the string that 8x8 Agent Console uses when displaying the code's short
identifier, such as Mtg.

Status Action categories Choose an optional primary category for the code:

n Take Break

n Work Offline

n Log Out

n Reject Phone

n Reject Chat

n Reject Email

Used If an agent has applied a code in their 8x8 Agent Console, then 8x8 Configuration
Manager adds a check mark to that code and its parent list. After a code has been
used, the code and its code list cannot be deleted.
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4. Select a status action check box to assign the code to an agent's action, such as Take Break, Work Offline, etc.

5. Repeat the above steps to create more codes.

6. ClickSave.

Translate Status Codes (Optional)

The Translations tab allows you to translate codes from the primary language to the secondary languages supported by
8x8 Contact Center. You must specify a secondary language in the Properties tab to enable translation. This procedure
is optional based on your company’s needs. Use the Translations tab to configure secondary language options for
individual status codes.

1. From the Configuration Menu, open Status Codes.

2. Click to Edit a status code.

3. Go to the Translations tab.

4. Select a code from the read-only list of codes in the Translations tab.

5. Select a secondary language from the drop-downmenu.

6. Enter the translated Menu Text1, Report Text2, and Short Code3 in the secondary language of your choice.
The following table summarizes the options under Status Codes > Translations:

1Menu Text is the string 8x8 Agent Console displays when displaying the code in the secondary language
2Report Text is the string 8x8 Agent Console displays when listing the code in a report.
3Short Code is the string 8x8 Agent Console uses when displaying the codes' short identifier.
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Translations Option Description

Secondary Languages Choose one of the secondary languages selected in the status codes
Properties tab.
When you select a secondary language, 8x8 Configuration Manager changes
the title of Menu Text.

Primary Language Read-only list of status code descriptions in the code's primary language.

Menu Text (secondary
language ID)

Choose a secondary language, and type the string in that language. 8x8 Agent
Console displays the menu code in the secondary language.

Report Text Choose a secondary language, and type the string in that language. 8x8 Agent
Console displays the report text in the secondary language.

Short Code Choose a secondary language, and type the string in that language. 8x8 Agent
Console uses the short code when displaying the codes' short identifier.

Active Shows the Active list of the status codes.

7. Repeat the above process for each of your secondary languages.

8. ClickSave.

Assign to Agents or Groups

After creating the codes, choose the agent groups, and specify individual agents within each group to assign the code
list to. Use the Assignments tab for this purpose.

1. From the Configuration Menu, open Status Codes.

2. Click to Edit a status code.

3. Go to theAssignments tab.
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All agent groups in your contact center show. Groups that are currently assigned to other status lists are grayed
out.

4. Select a group from the list. A menu appears on the same line.

5. Activate agents by checking the check box next to each name.
OR
ClickActivate All to select all agents in the group.

6. ClickSave to save the settings for the code.
You have now defined a status code list.

7. To verify the behavior, log in to 8x8 Agent Console as an agent belonging to the group. Change your status to
invoke the status codes.

Edit and delete status codes
You can edit or delete existing code lists at any time.

To edit a status codes list:

1. From the Configuration Menu, open Status Codes.
A list of existing codes appears.

2. Select the code list you want to edit, and click .

3. Navigate through the tabs to make the desired changes.

4. Save your changes.

To delete an existing status code list:

1. Select a code list from the list, and click .

You are prompted to confirm your action.

2. ClickOk to delete the list.

Note:You cannot recover a deleted list.
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Transaction codes overview

8x8 Contact Center transaction codes offer a means to apply call disposition to inbound as well as outbound
interactions. Each inbound or outbound interaction in a call center has some purpose and disposition. Transaction
codes can be defined to collect call disposition information from the agents at the time of the call and supervisors can
report on this information for analysis and to determine further processing.

For example, an ACME sales representative, who is processing a sales campaign for a new product, places outbound
calls to prospect customers. The representative can record the result of each interaction with predefined transaction
codes, such as Successful Sale, Prospect Interested - Call back, Prospect not Interested - Do not call back, Reached
Voicemail, and Faulty Number. Further in the sales process, you can define transaction codes to identify various stages
of the sales process, and apply the codes to convey the status and result of each interaction.

Using the transaction codes functionality:

n An administrator predefines a list of transaction codes used to describe the purpose of an interaction, or probable
outcomes for an interaction.

n An agent applies a call disposition from the predefined list of transaction codes during the processing or post-
processing stage of an interaction.

n A supervisor reports on call disposition for further analysis and to determine further processing.

When do you use transaction codes?

Transaction codes are mainly used to:

n State the purpose of interactions.

n Indicate the outcome of inbound and outbound interactions.

Transaction codes overview

Version 9.14 545



State the Purpose of Interactionswith Transaction Codes

Each interaction from and into your call center has a purpose. You can define transaction codes to state the purpose of
these interactions. When an agent processes an interaction, they can indicate the purpose of the interaction by
selecting one of the transaction codes available.

For example, in a call center which combines Sales, Support, and Service calls, you can indicate the purpose of each
interaction using a set of transaction codes, such as Sales Call, Support Call, and Service Call.

Indicate the Outcome of Interactionswith Transaction Codes

Transaction codes allow your call center agents to record the purpose and outcome of inbound and outbound
interactions. You are labeling an interaction with codes for further analysis or follow-up.

For example, when a ACME sales representative places sales calls, they can indicate the outcome of each interaction
with predefined transaction codes, such as Successful Sale, Prospect Interested - Call back, and so on. At the end of
the day, when the management runs a transaction report, the report indicates statistical information about sales, as
well as transaction codes that prompt follow-up actions. For records that are labeled Prospect Interested - Call back,
agents need to place follow-up calls. Records that are labeled Prospect not Interested - Do not call backmust be filtered
from the list.

Typically, you can define transaction code lists for a sales team to understand howmany calls theymade, howmany
resulted in sales, howmany resulted in faulty numbers, etc.

The following table lists the uses of transactions codes with corresponding examples:

Reasons for Using Transaction
Codes

Examples of Transaction Codes

State the purpose of an interaction Sales Call
Service Call
Support Call

Indicate the outcome of an inter-
action

Prospect Interested – Call Back
Prospect not Interested – Do not Call
Back
Reached Voicemail – Try Again
Faulty Number

How do you create transaction codes?

Understanding the process flow of your company provides a good basis for defining transaction codes. You may create
multiple transaction code lists to define the purpose and outcomes of interactions for a particular process. For example,
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sales campaign interactionsmay have multiple outcomes that differ from support-related interactions. An agent can
select one or more outcomes for an interaction.

Each transaction code list contains a set of codes to identify the call disposition. A transaction code list can be assigned
to an agent group or to a queue. You can apply multiple disposition code lists to an agent group or a queue. When an
agent accepts a call, all code lists assigned to the agent group or queue are presented in separate tabs. An agent may
select one or more codes from a single list and/or save desired codes from multiple lists. A call coded from multiple lists
shows as a separate record.

To define transaction codes for disposition, you must:

n Identify probable purposes and outcomes of an interaction.

n Identify queues or agent groups to apply the transaction code list to.

n Determine the need to translate transaction codes to a secondary language.

n Create a transaction code list.

To create transaction codes, you must:

n Create a transaction code list by defining properties.

n Define individual transaction codes in the list.

n Determine the need to translate transaction codes to a secondary language.

n Assign codes to agent group(s) or queue(s).

How do agents use transaction codes?

During the processing of an interaction, a transaction code list is presented to an agent in 8x8 Agent Console under the
following circumstances:

n The agent is a member of the group assigned with the code list.

n The agent is a member of the queue(s) assigned with the code list(s).

From the presented code list, an agent selects transaction codes:

n Before initiating the call.

n During the call.

n At the end of the call, during post-processing.

An agent assigned to a call disposition list is presented with the code list during an interaction. The agent may select
and save one code or multiple codes from a list anytime during the interaction or post-processing. When an agent is a
member of the group or queue assigned with multiple lists, all lists are presented to the agent in separate tabs when
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they accept a call. The agent may select and save codes from multiple lists. The selected codes appear in historical
reports.
How do supervisors use transaction codes?

Supervisors generate historical reports to get call disposition information for analysis and to determine the need for
follow-up actions based on transaction codes, also known as wrap-up codes. The following reports list transaction codes
used during agent interactions:

n Agents: Detailed accepted transactions with wrap up codes: This report lists wrap-up codes used by an
agent during all of their inbound accepted interactions. Wrap-up codes indicate call disposition information. You
may find multiple instances of the same call to indicate multiple wrap-up codes applied to the same call.

n Agents: Detailed outbound transactions with wrap up codes: This report lists dial codes as well as wrap-up
codes. Dial codes are caller ID-related codes, which appear before dialing the call. An agent can apply only one dial
code to a call, but can apply multiple wrap-up codes.
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n Agents: Transactions grouped by wrap up codes: The report groups transactions by wrap-up codes, queue,
channel, media, and agent.
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Create Transaction codes

8x8 Contact Center administrators create Transaction codes in 8x8 Configuration Manager.

Creating 8x8 Contact Center Transaction code list involves:

n Configuring properties of the code list.

n Defining individual codes.

n Translating codes to secondary languages (optional).

n Assigning the codes to an agent's groups or queues.

Configure Transaction Code Properties

1. From the Configuration Menu, open Transaction Codes.

2. Click orAdd. The Properties tab appears.

3. Enter the required values in the Properties tab.
The following table summarizes the options under Transaction Codes > Properties:

Properties Option Description

Active Select the check box to put this code list into service.

Name (required) Enter a name for the transaction code list.

Description Enter a description for the transaction code list.

Category Refers to a category of lists, such as Sales, Marketing, or Support. Within a single
category, you can group multiple transaction code lists. You can create a new category or
add a list to an existing category.
In the Category list, do one of the following:

n Choose Edit Categories to create a new transaction code category.

n Choose an existing transaction code category.

Secondary
Languages

Select other languages to translate the codes into.

Sort Order Refers to the order in which the codes within the list are sorted when presented to an
agent.
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Properties Option Description

n Choose Manual to list transaction codes yourself in a specific order.

n Choose Automatic to have 8x8 Contact Center sort transaction codes in
alphabetical order.

Required If enabled, the agent has to select a transaction code for all phone calls.

Multiple-choice If enabled, the agent has to select multiple codes from the transaction codes list.

Assignment Type Select an Agent Group or Queue to assign the list to. This option enables the members
of the group or queue to access the list during phone calls.

Primary Language
(required)

Select the primary language in which the codes are written. This information is required to
create a list.

Note:After saving the list, you cannot change the Primary Language
setting.

Admin Notes Type information that enables administrators to understand the purpose of the code list.

4. ClickSave.

Define Transaction Codes

You can define individual transaction codes in the Codes tab.

1. From the Configuration Menu, open Transaction Codes.

2. Click to Edit a transaction code.
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3. Go to theCodes tab and enter the required values.

4. Enter values for the following fields:

n Menu Text: The code text that appears in the code list in 8x8 Agent Console

n Report Text: The code text that appears in the reports

n Short Code: A short identifier for a code

The following table summarizes the options under Transaction Codes > Codes:

Codes Option Description

Active Select Active to activate the specific transaction codes.

Menu Text Type the string that 8x8 Agent Console displays when displaying the code, such as
Prospect Interested – Call Back.

Report Text Type the string that 8x8 Agent Console displays when listing the code in a report,
such as Prospect Interested – Call Back.

Short Code Type the string that 8x8 Agent Console uses when displaying the code's short
identifier, such as Int.

Used If an agent has used a code in their 8x8 Agent Console, then the code is marked with
in the

Used

column. After a code has been used, the code and its code group

cannot be deleted.

5. Repeat the above steps to create more codes.

6. ClickSave to save the codes.
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Translate Transaction Codes (Optional)

The Translations tab allows you to translate codes from the primary language to the secondary language supported by
8x8 Contact Center. You must specify a secondary language in the Properties tab to enable translation. This procedure
is optional.

1. From the Configuration Menu, open Transaction Codes.

2. Click to Edit a transaction code.

3. Go to the Translations tab.

For every transaction code you have created in the Codes tab, you find a new row under the secondary language.

4. EnterMenu Text, Report Text, and Short Code in the secondary language.
The following table summarizes the options under Transactions Codes > Translations:

Translations Option Description

Secondary
Languages

Choose one of the secondary languages selected in the transaction codes Properties tab.
When you select a secondary language, 8x8 Configuration Manager changes the title of
the Menu Text text entry area described later in this table.

Primary Language A read-only list of transaction codes created in the Codes tab, and as written in the
primary language.

Menu Text
(secondary
language ID)

Choose a secondary language, and type the string in that language. 8x8 Agent Console
displays the menu code in the secondary language.

Report Text Choose a secondary language, and type the string in that language. 8x8 Agent Console
displays the report text in the secondary language.
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Translations Option Description

Short Code Choose a secondary language, and type the string in that language. 8x8 Agent Console
uses the short code when displaying the code's short identifier.

Active Shows the Active list of transaction codes.

5. Select Save to save the translated codes.

Assign the Agent Groups and Queues

The Assignment tab enables you to select agent groups or queues to assign the code list. Based on your choice of
assignment type in properties, the list of agent groups or queues setup in the tenant show up.

1. From the Configuration Menu, open Transaction Codes.

2. Click to Edit a transaction code.

3. Go to theAssignments tab and enter the required values.

4. Select an agent group or a queue from the list.
OR
Select theAssign All check box to assign all groups or queues in the list.

5. ClickSave to finish defining the code list.

Note:A transaction code list is not functional until activated and assigned.
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Edit and Delete Transaction Codes
You can edit or delete existing transaction code lists at any time.

To edit a transaction codes list:

1. From the Configuration Menu, open Transaction Codes.
A list of existing codes appears.

2. Select the code list you want to edit, and click .

3. Navigate through the tabs to make the desired changes.

4. Save your changes.

To delete an existing transaction code list:

1. Select a code list from the list, and click .

You are prompted to confirm your action.

2. ClickOk to delete the list.

Note:You cannot recover a deleted list.
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Outbound phone codes overview

Outbound Phone Codes offer a means to set a unique calling line identifier (caller ID) for outbound calls. You can
define outbound phone codes to assign caller ID to outbound calls from your tenant. You can also use outbound phone
codes to identify the purpose of each outbound call.

When placing an outbound call, you can use outbound phone codes to set the calling line identifier displayed to the
called party. If your 8x8 Contact Center provides technical support services to multiple companies on the same tenant
but on different channels, you must ensure that the correct caller ID is applied to each company. This helps the
customers of each company to identify a number with the company, and provides the best callback experience. You can
define transaction codes to assign caller ID to outbound calls from your tenant. When an agent initiates an interaction,
they set a caller ID to an outbound call, thus identifying the right callback number.

Note:Assigning calling line identifier is not supported by all telecommunication carriers.

For example, ACME uses their 8x8 Contact Center to provide technical support services for two companies: Kids Zone
for the Kids Entertainment company, and EMAC for Credit Recovery Services. ACME has two phone channels; one for
callers to Kids Zone and one for callers to EMAC. The administrator defines transaction codes to map a phone number
for each company. Before placing an outbound call to a customer of Kids Zone, the agent selects the code for Kids
Zone. At the receiving end of the call, the phone number mapped with the code is displayed.

The following topics are discussed in this chapter:

n Creating outbound phone codes

n Assigning codes at the agent level

Using the outbound dial codes functionality:

Outbound phone codes overview
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n An administrator predefines a list of outbound phone codes to identify the calling line identifier to outbound calls.

n An agent assigns a calling line identifier to an outbound call from the predefined list of outbound phone codes
before initiating the call to ensure the best callback experience for customers.

To create transaction codes, you must:

n Create a transaction code list by defining properties.

n Create individual transaction codes in the list.

n Translate codes to secondary languages.

n Assign codes to agent group(s) or queue(s).

How do agents use Outbound Phone Codes?

During the processing of an interaction, an Outbound Phone Code list is available to an agent in 8x8 Agent Console
under the following circumstances:

n The agent is a member of the group that is assigned the code list.

n The agent is directly assigned the code list(s).

An agent assigned an Outbound Phone code list is shown the list before initiating an outbound call. The agent must
choose a code to dial out. The calling line identifier associated with the selected code sets the caller ID to the call.
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Create outbound phone codes

8x8 Contact Center administrators create outbound codes in 8x8 Configuration Manager. Creating an Outbound Phone
Code list involves:

n Configuring properties of the code list.

n Defining individual codes.

n Translating codes to secondary languages (optional).

n Assigning codes to agent groups.

Configure Outbound Phone Code Properties

1. From the Configuration Menu, openOutbound Phone Codes.

2. Click orAdd to create a new list. The Properties tab opens.

3. Enter the following properties. Some fields are required, while others are optional.

Properties
Options

Description

Active Select the check box to put this code list into service.

Name
(Required)

Enter a name for the new code list.

Description Enter a brief description of the purpose of the code list.

Category  A category distinguishes multiple code lists, and attributes a code list to a specific group. For
example, you can create categories for Sales, Support, Services, and more. You can then assign
each code list to a particular category.
In the Category list, do one of the following:

n Choose Edit Categories to create a new code category.

n Choose an existing code category.

Sort Order  Select the order in which the codes should appear in 8x8 Agent Console:

n Manual allows organizing the order of the codes manually.

n Automatic organizes the codes alphabetically.
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Properties
Options

Description

Admin
Notes

Type information that enables administrators to understand the purpose of the code list.

Primary
Language
(Required) 

Select a primary language in which the codes are written. This information is required to create a
list.

Note:After saving the code list, you cannot change the Primary Language setting.

Secondary
Language

Select the languages to translate the codes to. This option allows you to set up codes in
languages other than English.

4. ClickSave to save the properties.
The Codes tab opens.

Define Outbound Phone Codes

In the Codes tab, you can define individual status codes and assign them to an agent’s action or status change.

1. From the Configuration Menu, openOutbound Phone Codes.

2. Click to Edit an outbound phone code.

3. Go to theCodes tab and enter the required values.

The following table summarizes the options underOutbound Phone Codes > Codes:

Version 9.14 559

Create outbound phone codes



4. Repeat the above steps to create more codes.

5. Select Save to save the codes.

Translate Outbound Phone Codes (Optional)

The Translations tab allows you to translate codes from the primary language to the secondary language supported by
8x8 Contact Center. You must specify a secondary language in the Properties tab to enable translation. This procedure
is optional.

1. From the Configuration Menu, openOutbound Phone Codes.

2. Click to Edit a status code.

3. Go to the Translations tab.

4. Select a code from the read-only list of codes in the Translations tab.

5. Select a secondary language to translate the code to.
The following table summarizes the options underOutbound Phone:

Translations
Options

Description

Secondary
Languages

Choose one of the secondary languages selected in the outbound codes Properties tab.
When you select a secondary language, 8x8 Configuration Manager changes the title of
the Menu Text text entry area described later in this table.

Primary Language Read-only list of outbound codes descriptions in the code's primary language.

Menu Text
(secondary

In the Secondary Languages list, choose a secondary language, and type the string in
that language. The 8x8 Agent Console displays the menu code in the secondary language.

Version 9.14 560

Create outbound phone codes



Translations
Options

Description

language ID)

Report Text In the Secondary Languages list, choose a secondary language, and type the string in
that language. The 8x8 Agent Console displays the report text in the secondary language.

Short Code In the Secondary Languages list, choose a secondary language, and type the string in
that language. The 8x8 Agent Console uses the short code when displaying the codes'
short identifier.

Active Shows the Active list of outbound codes.

6. Select Save to save the translated codes.

Assign to Agents or Groups

After creating the codes, choose the agent groups and specify individual agents within each group to assign the code
list to. Use the Assignments tab for this purpose.

1. From the Configuration Menu, openOutbound Phone Codes.

2. Click to Edit a status code.

3. Go to theAssignments tab.

4. Select an agent group from the list. The list is assigned to your choice of agent groups.

5. ClickSave to complete the code list definition.
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Note:AnOutbound Phone Code list is not functional until activated and assigned.

Edit and delete outbound phone codes
You can edit or delete existing code lists at any time.

To edit an outbound phone codes list:

1. From the Configuration Menu, openOutbound Phone Codes.
A list of existing codes appears.

2. Select the code list you want to edit, and click .

3. Navigate through the tabs to make the desired changes.

4. Save your changes.

To delete an existing status code list:

1. From the Configuration Menu, openOutbound Phone Codes.
A list of existing codes appears.

2. Select a code list from the list, and click .

You are prompted to confirm your action.

3. ClickOK to delete the list.

Note:You cannot recover a deleted list.
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Assign Outbound phone codes at agent level

8x8 Contact Center administrators define Outbound Phone Code List in 8x8 Configuration Manager. The Assignment
tab allows you to assign the code list to the members of the existing agent groups. You can assign different code lists to
individual agents.

To assign an Outbound Phone Code list at the agent level:

1. From the Configuration Menu, openAgents.

2. Select the specific agent from the list.

3. Go to the Phone tab.

4. InOutbound Phone Codes, select the desired code list.

Notes:
-TheDefault to Group [GroupName] shows the agent's group assigned to a code list. The agent
is assigned to the list automatically.
-NONE removes the agent from the default code list assignment.
-Outbound Phone Code Lists assigned at the agent level override group level settings.

5. ClickSave.
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Wallboards overview

The 8x8 Contact Center Wallboard presents real-time metrics of your contact center operations on a desktop, display
TV, or monitor on a contact center floor. 8x8 Contact Center administrators can get key statistics to answer questions,
such as:

n How productive are my agents?

n What is the number of interactions waiting in a queue?

n What is the current longest waiting interaction in a queue?

n What is the current SLA activity?

n What is the total number of accepted transactions since the beginning of the day?

The metrics provide an insight into queue traffic, longest-waiting interactions in a queue, agent productivity status, and
more. Access to these metrics allows agents and supervisors to respond to increased call volume quickly and maintain
the service levels of your business.

You can choose from readily-available stats, or generate custom stats to suit your business requirements. Whether as a
supervisor or an agent, you can look at the metrics and make instant adjustments to serve your customers better.

Features
The 8x8Wallboard offers the following benefits:

n Get a bird’s-eye view of call center performance, and track agent availability

n Get real-time metrics on contact center operations

n Apply business intelligence to the decision-making process

n Manage customer demand proactively, and reduce waiting time for customers

Wallboards overview
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n Access dozens of pre-calculated stats built out of predefined queries

n Customize stats to suit business needs by building custom queries

n Display data on web browsers, such as Internet Explorer, Chrome, or Firefox

n Configure thresholds against key performance indicators to show alerts for potential or actual slips in performance

n Set up audio and visual alerts on breached thresholds

n Filter data to suit individual needs

n Get metrics in tabular format for easier navigation

n Make use of separate login access to the wallboard

Requirements
n Wallboard Configuration: Login access to 8x8 Configuration Manager, with permissions to configure

Wallboards.

n Wallboard Access: Access to login credentials for 8x8 Configuration Manager.
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Configure a wallboard

8x8 Contact Center administrators configureWallboards in 8x8 Configuration Manager.

Configuring an 8x8 Contact Center Wallboard involves:

n Defining wallboard general properties.

n Specifying desired metrics.

n Defining thresholds for better supervision (optional).

n Selecting skills/queues for which you need metrics.

Once configured, you can run a wallboard with a simple click. Typically, a contact center monitors critical data on agent
status.

Setting up an 8x8Wallboard is simple and quick. Determine the keymetrics for your business, select the data from the
readily-available stats or define custom stats, and run the wallboard. With just a few clicks, you are on your way to
monitor your contact center performance in real time.

Set up a wallboard

To set up a wallboard:
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1. From the Configuration Menu, openWallboard.

2. Click orWallboard.

3. Go to theGeneral tab.

4. Enter aName andDescription for the wallboard.

5. Select the desired time zone from the Time Zone drop-down list.

6. ClickSave to open the Fields tab.
The current time of the selected time zone appears on the top-right corner of the wallboard.

The GMT-6 Central visible at the bottom indicates the selected time zone.
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Specify desired metrics

8x8 Contact Center provides out-of-the-boxmetrics generated from predefined queries. Additionally, 8x8 Contact
Center administrators have the flexibility to generate custom metrics using the available stats. Go to theWallboard >
Fields tab in 8x8 Configuration Manager to see the list of available real-time stats with their brief descriptions. For
example, you can track the number of agents waiting for interactions in a queue, or the number of agents processing
interactions in a queue (in available or processing statuses).

To specify the desired metrics for a wallboard:

1. From the Configuration Menu, openWallboard.

2. Click to edit an existing wallboard.

3. Go to the Fields tab.
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4. Select the desired stats from a list of available fields.

Note:You can also generate custommetrics by defining custom fields. See Customize a
Wallboard.

5. Enter aDisplay Name that replaces the standard field name on the wallboard.

6. Drag and drop the fields to change the display order of the fields on the wallboard.

7. Save the settings.
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Define thresholds

The next step in configuring an 8x8 Contact Center Wallboard is to set up thresholds which alert you in the event of
potential or actual slips in performance. 8x8 Contact Center administrators can set up audio and visual alerts in 8x8
Configuration Manager, and vary the alert type based on the severity of the situation. For example, you can set up a
threshold alert to monitor the service levels of your contact center. If the performance of a skill or queue falls below the
set Service Level Agreement (SLA), you set up an alert so you can look at the activity level of agents belonging to the
queue, identify areas for improvement, and act quickly to recover. You can also set up a threshold to monitor the
waiting time for interactions. If the waiting time in a queue exceeds a certain time, the threshold alert can trigger. You
can define thresholds for each media type and configure custom thresholds for each skill.

To define threshold for inbound phone media:

1. From the Configuration Menu, openWallboard.

2. Click to edit an existing wallboard.

3. Go to the Threshold tab.

4. Select a media type, such as Inbound Phone.

5. Select a Field Name.

6. To specify a threshold value, enter the required parameters and arguments.

7. Select a color from the color chart to highlight a breached threshold.
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8. Specify an alert sound pattern.

9. ClickSave to save the threshold settings.
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Select queues

In the final step of adding 8x8 Contact Center Wallboard, 8x8 Contact Center administrators must select which queues
require metrics. Optionally, they can select predefined thresholds for each queue via 8x8 Configuration Manager.

To select queues:

1. From the Configuration Menu, openWallboard.

2. Click to edit an existing wallboard.

3. Go to theQueues tab.

4. Select the queues individually, or clickAssign All to pull their stats.

5. Specify a desired threshold from the drop-down list of choices.

Note:Youmust have specified the threshold settings previously.

6. Save the queue selections.
The wallboard configuration is now complete. You are ready to run a wallboard.
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Share wallboard authentication

8x8 Contact Center wallboard administrators can bypass the need for login credentials to run a wallboard. Instead, they
can click a URL shared by the contact center administrator to launch a wallboard. The URL provides direct access to the
wallboard. For details on using login credentials, refer toRun aWallboard.

To share direct wallboard access:

1. From the Configuration Menu, openWallboard.

2. Click to edit a wallboard.

3. Go to theURL tab.

4. ClickShare.

5. Enter the email addresses of wallboard administrators that you like to share the wallboard with.
You can see a wallboard URL.

6. ClickSend.
A message notifies the wallboard URL is shared successfully via email. Wallboard administrators receive an email
notification with a link to launch the wallboard.

7. ClickRevoke and Recreate to retire the URL and create a new one.
If an email recipient uses the revoked link, a message indicates the URL is invalid.
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Note:Alternatively, you can click from the list of wallboards to open the ShareWallboard dialog box.
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Customize a wallboard

8x8 Contact Center administrators customize a wallboard via 8x8 Configuration Manager based on their business
requirements:

n Set up custom queries and generate custom stats.

n Set up custom thresholds.

n Brand your contact center's wallboard by adding your company's logo.

n Use a custom font and sound for your wallboard display.

Customize Metrics

If you need more stats than what is readily available, you can build custom fields by defining custom queries. For
example, if you wish to track agents unable to answer interactions at a given time, you can define a custom field as
follows:

Number of agents Busy = Offered + Processing + Post-processing

To define a custom field:

1. From the Configuration Menu, openWallboard.

2. Click to add a newwallboard, or to edit an existing one.

3. Go to the Fields tab.

4. Click orCustom Field.

5. Enter the custom field details:

Field Name Description

Display Name The custom field name that is displayed on the wallboard.

Description A brief description of the metrics.

Field Type Select a data type from a choice of Number, Seconds, and Percent.
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Field Name Description

Note: The data type of the custom field must match the data type of
deriving fields.

Field Definition Based on the requirements:

1. Select from the available fields drop-down or enter a number value.

2. Select an operator (-,+, -, *, or /).

3. Select another field or enter a number value.

Note:You can add any number of arguments.

Customize Threshold

Within each media type, you can set up a custom threshold for each queue to suit your requirements. If the waiting time
for an interaction in a queue exceeds two minutes, set up a first level threshold alert. If the time exceeds 3 minutes, set
up an emergency alert. On breaching thresholds, the wallboard gives corresponding alerts.

Customizing threshold is a two-step process:

1. Set up a custom threshold with desired values and alerts. Time values are entered in seconds.

2. Apply this threshold to desired queues.

On running a wallboard with custom threshold, the alerts trigger on breaching the threshold for the selected queues.

To set up a custom threshold:

1. From the Configuration Menu, openWallboard.

2. Click to edit the desired wallboard.

3. Go to the Threshold tab.
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4. Click orCustom Threshold.

5. Enter aName for your custom threshold.

6. Click a Field Name, then specify a value in the parameters.

7. Select a color from the color chart forBackground Color.

8. Select a Sound alert from the drop-down list.

9. Add more fields as desired.

10. ClickSave.

To apply the threshold to a queue:

1. Go toWallboard > Queues.

2. Select the desired queue.

3. Select the custom threshold from the Threshold Option drop-down.

Brand Your Contact Center Wallboard

Brand your contact center wallboard by adding your company logo.

To brand your wallboard with your company logo:

1. From the Configuration Menu, openHome.

2. Go to the Profile tab.

3. In the Tenant – Logo area, upload your company logo.

4. Save the changes.

Customize Wallboard Display
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You can control the font size of the wallboard display, or mute the audio alerts on your wallboard.

To change the control settings:

1. Run your wallboard.

2. Click the tools at the corner of the wallboard screen.

3. Use + and – to increase or decrease the display font size.

4. Select Mute all to mute the sound.
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Run a wallboard

8x8 Contact Center administrators can run a wallboard from theWallboard tab while logged in to 8x8 Configuration
Manager , or log in to the wallboard directly and select to run a wallboard from there. The login credentials for 8x8
Configuration Manager also allow direct access to the wallboard.

Requirements
n Login credentials: You must have 8x8 Configuration Manager's login credentials to access wallboards.

n Browser requirements: Google Chrome, by default, blocks pop-ups and limits you to run a single wallboard at a
time. To run multiple wallboards simultaneously, in your Chrome settings, select Allow all sites to show pop-ups.

To access a wallboard via the Configuration Menu:

1. From the Configuration Menu, openWallboard.

2. Select a wallboard, and click .

The wallboard runs in a new browser tab.

To access a wallboard via direct wallboard access:

1. In the 8x8 Configuration Manager login screen, selectWallboard Access.
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2. Enter your 8x8 Configuration Manager login credentials, and click Login.
TheWallboard launches and displays the list of configured wallboards.

Note: The number of wallboards you can run simultaneously depends on your subscription.

3. Select a wallboard, and clickRun.
As a wallboard administrator, you can bypass the need for login credentials to run a wallboard. For details, refer to
ShareWallboard Authentication.

Note:A Chrome limitation prevents 8x8 Contact CenterWallboards from playing the alert sound
notification when the threshold is met. To work around it:
1. Open a new Chrome browser and enter chrome://flags/#autoplay-policy.
3. Press enter. TheAutoplay policy option appears.
2. Select No user gesture is required from the drop-down list.
4. Press RELAUNCH NOW. The sound is audible the next time you relaunchGoogle Chrome.
See Chrome Autoplay Policy Changes for more information.
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Brand your wallboard

Using 8x8 Configuration Manager, 8x8 Contact Center administrators can brand their contact center wallboard by
adding their company logo.

To brand your wallboard with your company logo:

1. From the Configuration Menu, openHome.

2. Go to the Profile tab.

3. In the Tenant – Logo area, upload your company logo.

4. Save the changes.
When you run a wallboard, your company logo appears on the wallboard.
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Chat overview

With 8x8 Contact Center, administrators can improve customer engagement by proactively offering web chat with live
agents. You decide when and where to offer a chat based on web page hover time or your organization’s chat capacity.
Customer information from the web interaction can be used to drive screen pops to the agent to make the interaction as
efficient as possible.

In 8x8 Agent Console, chat interactions provide a means of responding in real time to customer inquiries. Depending on
the configuration of your contact center, the contact center's chat access page can be configured to either allow or
require a customer to supply an account number or other information to identify themselves before beginning the chat
interaction. 8x8 Contact Center uses this information to look up our Local CRM for a matching customer record. When
you accept the new chat session, 8x8 Agent Console opens the matching customer details record. If the customer has
not supplied any identifying information before beginning the chat, you can use the chat window to ask the customer for

Chat overview
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the information you need to create a new customer or case record.

n A (Legacy Implementation): The chat channel was implemented using Support Center functionality. The
Support Center contained a link to the chat channel, which in turn could be hosted on your web page. We have
retired Support Center functionality, but providing new tools and interfaces for Chat via our new implementation.

n C (New Implementation): We offer chat, SMS, and social media channels with better chat workflow and design.
Host your contact center’s chat channel on your web page, independent of Support Center. You can design a
proactive web chat interface according to your company’s requirements, build a chat script to define a logical
workflow for your chat channel, and finally, generate a code snippet to be placed in your website. For details about
chat, see our documents for the Embedded Chat Channels. To take advantage of social media to service
customers, such as Facebook and Twitter, see our guide about Social Media Integration.

The chat interactions directed from A or C implementation flow through the specified 8x8 Contact Center chat queue,
and then to the available contact center agents.

n B (Legacy Implementation): Agents can process a single chat at a time, the traditional way, on 8x8 Agent
Console.

n D (New Implementation): Agents can processmultiple chats concurrently. Agents can process up to six customer
chats concurrently, if configured by the administrator.
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Features
n Customers can enter a web chat with live agents.

n Decide when and where to offer a chat based on your company's need and the resources.

n Interact with customers efficiently by pulling out their information on a screen pop.

n Respond in real time to customer inquiries.

n Allow customers to supply account information to identify themselves before beginning the chat interaction.

n Look up the Local CRM and open a matching customer record using the customer's account information.

n Use the chat window to ask customers information for a new customer or case record.

n Handle customer chats in any of the supported languages of agents, or use the automatic translation tool.

n Associate each 8x8 Contact Center agent with one primary and one or more secondary languages of fluency.

Multi-chats (multiple concurrent chats)

Multi-chats or multiple concurrent chats feature in 8x8 Contact Center allows an agent to handle up to six concurrent
chats with customers at any time. There is no limit on the number of concurrent chats among agents. For details, see
our content on how to configuremulti-chats.

Multilingual support for chat

In multilingual support for chat, customers can choose to chat in one of the supported language by 8x8 Contact Center.
Agents can handle customer chats in any of the supported languages they speak, or use the automatic translation tool.
Each 8x8 Contact Center agent is associated with one primary and one or more secondary languages of fluency. For
details see our content on how to configuremultilingual support for chat. The multilingual chat flow can be represented
as follows:
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WCAG 2.1 support for chat

Websites, tools, and technologies are designed and developed so that people with disabilities can use them. Web
Content Accessibility Guidelines (WCAG) offer recommendations on how to increase the usability of your website, and
how to make it accessible to people with disabilities. Web accessibility encompasses all disabilities that affect access to
theWeb, including:

n auditory

n cognitive

n neurological

n physical

n speech

n visual

Note:WCAGCompliance is limited to 8x8 Contact Center web chat only. All other features and
applications in the 8x8 Contact Center are not yet WCAG compliant.
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To comply with WCAG 2.1, 8x8 Contact Center introduces enhancements to the web chat experience, thus allowing
8x8 customers to beWCAG 2.1 AA compliant. Learn more1

For details on how to make your chat WCAG compliant, see our content on chat design enhancements forWCAG 2.1
compliance.

This chapter involves:

n Understanding a case study for embedded chat design

n Designing and configuring embedded chat

n Configuring for web content accessibility

n Creating a chat script

n Configuringmulti-chats

n Handlingmultilingual chats

n Enabling Co-browsing via chat

1(Learn more about the compliance levels > Level A: Minimal compliance; Level AA: Acceptable compliance; Level
AAA: Optimal compliance)
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Case study - embedded chat design

Bob is the 8x8 Contact Center administrator at the AcmeJets contact center. He wants to create an online chat channel
to support website visitors. He anticipates the website traffic to be heavy during peak hours, and therefore, the agents
should be able to handle multiple chats to meet the demand. He plans to collect some identity information, such as
customer names and account numbers, to identify existing customers so that agents can process interactions
efficiently. This information can be collected from the customers even before they are connected to the agents, allowing
agents to serve them faster and better.

To complete this plan, Bob needs to:

n Create a Chat Form via 8x8 Configuration Manager to place on the company’s website in order to invite the
customers to chat.

n Create a chat script to define the chat workflow.

n Enable AcmeJets agents to processmultiple chats with customers and other agents on the same tenant. He knows
that, by default, agents can handle only one chat at a time.

n Train his agents how to use Multi-Chat.
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The following diagram represents configuration tasks Bob must do to get started with this project:

Here is what Bob has in mind for the agents:
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To plan his work better, Bob has prepared the following checklist:

Task Description How to Complete Completed

1 Create an online chat button to use during the business oper-
ational hours.

Create an online chat button N/A

2 Create an offline chat button to direct visitors during offline
hours.

Create an offline chat button N/A

3 Create a chat invitation to proactively invite website visitors to
a chat.

Design a chat invitation N/A

4 Create a chat form to gather information from a customer
before initiating a chat.

Design a chat form

5 Create an Offline form to send an email message during chat
offline hours.

Design a chat form

6 Create a chat window to serve as the interface between the
customer and the agent during the chat.

Design a chat window N/A

7 Design the chat flow. Create a chat script

8 Enable agents to have more than one chat. Configure Multi-Chat or number
of concurrent chats
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Task Description How to Complete Completed

9 Train agents to use Multi-Chat. Handle multiple chats in 8x8
Agent Console
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Configure embedded chat design

The chat functionality in 8x8 Contact Center is now enhanced with better chat workflow and design. 8x8 Contact Center
administrators can design a custom chat to match their corporate requirements and create a custom chat script to
control the chat flow using 8x8 Configuration Manager.

A chat workflow can be represented as follows:

1. A customer visits a website.

2. A chat invitation pops up, proactively inviting the visitor to chat.
OR
The visitor clicks a chat button on the website to initiate a chat.

3. The visitor is then presented with a pre-chat survey form to collect some preliminary information.

4. The visitor fills and submits the information. Based on the information submitted, the system checks if it belongs
to an existing customer.

5. An agent accepts the chat interaction, and begins a live chat session.

6. When the chat channel is offline, the visitor is presented with an option to send an email message using an offline
form.

7. If the visitor drops out of a chat process, then the chat interaction enters a default termination.
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The following image shows the chat script diagram:

8x8 Embedded Chat offers chat visual block elements used on your website for a chat interaction:

n Button: A chat button that initiates a chat interaction

n Invitation: A chat invitation that pops proactively, inviting website visitors for a chat

n Form: A pre-chat survey form that gathers customer information

n Window: A chat window used by the end user to chat with an agent

Configuring Embedded Chat Design in 8x8 Configuration Manager involves:

n Designing a chat button

n Designing a chat invitation

n Designing a pre-chat survey form

n Designing a chat window

To configure Embedded Chat Design, log in to 8x8 Configuration Manager and go to the Chat Design tab. You are
ready to design visual elements for chat on your website.
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Design a chat button

A chat button in 8x8 Contact Center is an interface for a customer to initiate a chat. 8x8 Contact Center administrators
can design a chat button to be offline or online using 8x8 Configuration Manager. An online chat button can be used
during the business operational hours for chat, while an offline button can be used to direct visitors during offline hours.
Chat design offers default offline and online chat buttons for use. To customize a chat button, you can create a new
button from scratch, or copy a default button and make the desired changes.

To create an online chat button:

1. From the Configuration Menu, openChat Design.

2. While in theButton tab, click orOnline.

3. Enter aName andDescription for the new chat button.

4. Browse and upload an image for the button.

Note: The file sizemust not exceed 1MB.

5. Enter the name for theButton label. This field mandates a label for the button that complies with WCAG. For the
visually impaired, the screen reader reads out the label for better comprehension.

6. ClickSave to create a new chat button.

To create an offline chat button:
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1. From the Configuration Menu, openChat Design.

2. While in theButton tab, click orOffline.

3. Enter aName andDescription for the new offline chat button.

4. Browse and upload an image for the button.

Note: The file sizemust not exceed 1MB.

5. Enter the name for theButton label. This field mandates a label for the button that complies with WCAG. For the
visually impaired, the screen reader reads out the label for better comprehension.

6. ClickSave to create a new chat offline button.
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Design a chat invitation

A chat invitation in 8x8 Contact Center serves to proactively invite website visitors to a chat. 8x8 Contact Center
administrators can program and present the chat invitation to their website visitors after visitors have spent some time
browsing the website. 8x8 Contact Center chat design offers a default chat invitation. To create a custom chat invitation
via 8x8 Configuration Manager, you can build a new invitation from scratch, or copy a default invitation and make the
desired changes.

To create a custom chat invitation:

1. From the Configuration Menu, openChat Design.

2. Go to the Invitation tab.

3. Click orAdd new invitation.

4. Enter aName andDescription for the new chat button.

5. Add or change the user interface elements of the invitation by addingWindow title, Button label, andMessage.
The chat invitation preview is shown.

6. Select toUse default colors. The default colors are designed to help the visually challenged such as the color-
blind.
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Note:Users for whomWCAG compliance is a non-priority, may select colors of their choice and
overwrite the default colors.

7. Choose the Logo customization file to select the logo of your choice for your chat invitation.

8. Enter a Logo label. This field mandates a label for the logo that complies with WCAG. For the visually impaired,
the screen reader reads out the label for better comprehension.

9. ClickSavewhen you are satisfied with look and feel of the invitation form.
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Design a chat form

8x8 Contact Center offers two types of chat forms: pre-chat survey forms and offline forms.

n A pre-chat survey form serves to gather information from a chat user before initiating a chat. Using the form, 8x8
Contact Center administrators can collect credentials, such as account number or case number, from an existing
user. This information can be used to search for existing customer records in the Local CRM and present it when an
agent accepts the chat.

n An offline form presents the option to send an email message during the chat's offline hours.

You can use the default form or create a custom form. To create a custom form, you can create a new form from
scratch, or copy the default form and make the desired changes.
Pre-Chat Survey Form

A pre-chat survey form can include questions with open-ended or preset answers. To design a pre-chat form, you must
both add survey questions and design the visual details of the form.

To create a custom pre-chat form:

1. From the Configuration Menu, openChat Design.

2. Go to the Form tab.

3. Click or Pre-Chat.

4. EnterName andDescription.
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5. Select a Format from the following choices:

n Translation: Indicates a language choice question. It offers customers the languages that are supported in
the chat, such as English, Russian, and German. You can select multiple language(s) for the customer to
choose from, but only one of them can be set as default. When you select a language as default, that
language is pre-selected in the pre-chat form offered to the customer. To make the browser language the
priority language in the pre-chat form, you must Overwrite default with browser language.
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When the browser language is not available for translation, the default language is used. If there is no default
language and no browser overwrite, the customer has to select a language from the drop-down list.

For example, if the pre-chat default language is Spanish, and the customer's browser is also in Spanish, there
is no need for the customer to select the language. However, if the pe-chat default language is set as
Spanish, but the browser is in French, French becomes the new default language. If French language is not
available for translation, Spanish will remain the default language.

n CRM field: Select from the available default or custom Local CRM fields.

Note:You are allowed to add only one CRM field and one translation question in a pre-chat
survey form. Once you add the questions, the option is disabled in the Formats list. You can
change or edit the questions at any time.

n Open ended: Add an open-ended question, such as <Enter your nickname>.

n Single answer: This is a multiple-choice question. You must provide choices and allow the chat user to
select a single answer.

6. Enter theQuestion that will be added to the form.

7. Select if the question isMandatory.
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8. Select the option to Include a separator at the end.

9. Enter anAutocomplete from the drop-down list, adding an autocomplete attribute for each question on the form
makes it easier to fill out forms and assists users with cognitive disabilities. It helps screen readers to explain what
a specific question is about.

10. ClickAdd to add the question to the survey form.

11. Repeat the above steps to add more questions.

12. ClickNext.
The second part of the Form page configuration requires you to specify the visual details of the form.

13. Add the desired visual requirements, such as window title, background color, and font color.

14. Select Use default colors for WCAG. The default colors are designed to help the visually challenged.

15. Enter a value for Logo label. The new field requiring a logo label has been added for screen readers to comply
with WCAG.

16. ClickSave. Your custom pre-chat survey form is now ready.

Offline Form

The offline form ismeant to interface with visitors who wish to send a message when the chat channel is offline.

To create a custom offline form:

1. From the Configuration Menu, openChat Design.

2. Go to the Form tab.

3. Click orOffline.
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4. EnterName andDescription.

5. Select a Format from the following choices:

n CRM field: Select from the available default or custom Local CRM fields.

n Open ended: Add an open-ended question, such as <Enter your nickname>.

n Single answer: This is a multiple-choice question. You must provide choices and allow the chat user to
select a single answer.

6. Select if the question isMandatory.

7. Select the option to Include a separator at the end.

8. Enter anAutocomplete from the drop-down list, adding an autocomplete attribute for each question on the form
makes it easier to fill out forms and assists users with cognitive disabilities. It helps screen readers to explain what
a specific question is about.

9. ClickAdd to add the question to the survey form.

10. Repeat the above steps to add more questions.

11. ClickNext.
The second part of the Form page configuration requires you to specify the visual details of the form.

12. Add the desired visual requirements, such as window title, background color, and font color.

13. Select Use default colors for WCAG. The default colors are designed to help the visually challenged.

14. Enter a value for Logo label. The new field requiring a logo label has been added for screen readers to comply
with WCAG.

15. ClickSave.
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Design a chat window

The 8x8 Contact Center chat window is the interface between a customer and the agent during the chat. 8x8 Contact
Center administrators can use the default chat window or create a custom window. To create a custom window, you can
create a new form from scratch, or copy the default form and make the desired changes.

To create a custom chat window:

1. From the Configuration Menu, openChat Design.

2. Go to theWindow tab.

3. Click orAdd New Window.

4. EnterName andDescription.

5. Enter a value forWindow title.

6. Select Offer the Co-browsing request into the Chat window.
Notice that Start Co-browsing session appears in theChatwindow. For details regarding Co-browsing, see our
content onCo-browsing via Chat.

7. Select Use default colors for WCAG. The default colors are designed to help the visually challenged.

8. Select a file for Logo customization.

9. Enter a value for Logo label. The new field requiring a logo label has been added for screen readers to comply
with WCAG.
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10. ClickSave.
You have defined all the Chat Visual Block (CVB) elements. The next step is to add them in a chat script to
complete the workflow.
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8x8 web chat complies with WCAG 2.1

When websites, tools, and technologies are designed and developed so that people with disabilities can use them, they
are considered web accessible. Web Content Accessibility Guidelines (WCAG) offer recommendations on how to
increase the usability of your website, and how to make it accessible to people with disabilities. Web accessibility
encompasses all disabilities that affect access to theWeb, including:

n auditory

n cognitive

n neurological

n physical

n speech

n visual

Prior to this release, 8x8 Contact Center customers who areWCAG 2.1 compliant were restricted from using the web
chat solution due to the lack of compliance. In this release, we have enhanced the 8x8 Contact Center web chat
experience to comply with theWCAG 2.1 guidelines allowing better readability, navigability, and interactivity with our
web chat elements.

Note:WCAGCompliance is limited to 8x8 Contact Center web chat only. All other features and
applications in the 8x8 Contact Center are not yet WCAG compliant.

To comply with WCAG 2.1, 8x8 Contact Center introduces enhancements to the web chat experience, thus allowing
8x8 customers to beWCAG 2.1 AA compliant. Learn more1

Features
n Better and readable user-interface (UI) even on aggressive zoom

n Ability to navigate via keyboard tab/enter

1(Learn more about the compliance levels > Level A: Minimal compliance; Level AA: Acceptable compliance; Level
AAA: Optimal compliance)  
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n Compliance with screen readers

n Color palette with good contrast ratio and color-blind friendly

These enhancements are designed to improve usability for all and accessibility of content for the disabled. For
example, a field with an asterisk is called out asmandatory by screen readers. Adding an alternate text for an image
informs the user, who may be visually impaired what the image is about.

Enhancements in Chat Design for WCAG compliance
As an admin of 8x8 Contact Center, you will notice enhancements while designing the following web chat elements:

n Chat button: A chat button in 8x8 Contact Center is an interface element for a customer to initiate a chat. While
designing a chat button, the newButton Label field nowmandates a label for the button. For the visually
impaired, the screen reader reads out the label for better comprehension. For example, adding a button label Chat
now, informs users that clicking the button initiates a chat session.

n Invitation: The chat invitation form which invites website visitors to initiate a chat, has now introduced default
colors compliant with WCAG. The default colors are designed to help the visually challenged such as the color-
blind. Additionally, a new field requiring a logo label has been added for screen readers.

Note:Users for whomWCAG compliance is a non-priority, may select colors of their choice and
overwrite the default colors.
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n Pre-chat form: Using a pre-chat survey form, 8x8 Contact Center administrators can collect basic information such
as name, email, account number or case number, from an existing user. This information can be used to search for
existing customer records and present it when an agent accepts the chat. While designing this form, you can now
add an autocomplete attribute for each question on the form. The autocomplete attribute makes it easier to fill out
forms, assisting users with cognitive disabilities. It helps screen readers to explain what a specific question is
about.

Additionally, the form uses default colors compliant with WCAG. The default colors are designed to help the
visually challenged. A new field requiring a logo label has been added for screen readers.
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See the image below for better color contrast and helper text on the form.

n Chat Window: The 8x8 Contact Center chat window is the interface between a customer and an agent during the
chat. Customers use this chat window to communicate with agents. This window now uses default colors compliant
with WCAG. The default colors are designed to help the visually challenged. A new field requiring a logo label has
been added for screen readers.

Note:WCAGCompliance is limited to 8x8 Contact Center web chat only. All other features and
applications in the 8x8 Contact Center are not WCAG compliant.
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Note:Existing 8x8 Contact Center users who have implemented the web chat solution, will need to
review and enhance the chat design elements forWCAG compliance, and republish.

Version 9.14 608

8x8 web chat complies with WCAG 2.1



Create a chat script

An 8x8 Contact Center chat script defines the path of a chat interaction from its initiation until it is accepted by an
agent. Using chat scripts, 8x8 Contact Center administrators can define how to present a chat, when to present it, what
information they need to collect before initiating the chat, and which queue to direct the chat interaction to. They can
create a new script and assign it to any number of channels. Chat scripts are grouped under Scripts > Chat in 8x8
Configuration Manager. The enhanced chat script allows you to design and control the chat flow in a contact center. To
see the chat workflow diagram, refer toChat Overview.

Let's say Bob, a contact center administrator at AcmeJets, wants to define a chat workflow that allows website visitors
to initiate a chat with friendly representatives from his company. To enable a smooth chat flow, Bob must create a chat
script that enables the following workflow:

1. Allow web page visitors during business hours to click the chat button and initiate a chat.
OR
Invite visitors to chat once they have spent some time on the page.

2. When they click the chat button, present a short pre-chat form that helps identify the customer's interests.

3. Once the customer submits the pre-chat form, direct the chat interaction to an appropriate chat queue.

4. If the wait is too long, allow the customer to skip waiting in the queue and send an offline message.

5. Present the customer with a chat window they can use to interact with a representative.

6. Allow the visitor to send an email message, if reached during closed hours.

To achieve the above goals, Bob must create a chat script like the one below. The objects can be entered in any order,
as 8x8 Contact Center arranges them in the correct order.

To create a chat script:

1. From the Configuration Menu, open Scripts.

2. Go to theChat tab.

3. Click orAdd new chat script.

4. Follow the steps below:

Configure Chat Script Properties

1. Go to the Properties tab.
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2. Enter the properties for the script.
The following table summarizes the options under Scripts > Chat > Properties:

Phone/
Chat/Email
Script
Property

Description

Script Type n Phone: Select a script type: Inbound phone, Post Call Survey, or Outbound phone.

n Chat and Email: A read-only reminder of the script type. It displays if it is a phone, chat,
or email script.

Script Name Enter a unique name for the script.

Category A category helps you organize your scripts better. For example, if you have multiple scripts
serving Support and Sales needs, you can group scripts under separate categories. You can
select an existing category or create a new one.

To create a new category:

1. Select Edit Categories from the drop-down menu.

2. In the Category dialog box, add a new category by clicking .

Copy script
from

Choose this option to place a copy of the default or an existing IVR script into this channel.
This option appears when you are creating a new script.

Comment Add comments or additional notes, if desired.
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Phone/
Chat/Email
Script
Property

Description

This script is
enabled

Select to place this script definition into service.

Assigned
Channels
/Assigned
Queues

n When you select Script Type > Outbound Phone, you must assign one or more new
outbound phone queues.

n When you select Script Type > Post Call Survey or Script Type > Inbound phone, you
must assign one or more channels to the script.

Note: It is not mandatory to assign a channel while creating a script.

To assign new channels:

1. Click on the link to bring up the list of channels.

2. Select the desired channels from the list.

3. Click Assign.

Note:All channels in the list are associated with a script whether default or
user-defined. If you assign and save a new script, the old script is
permanently replaced by the new selected script.

Note: It is recommended to restrict your assignment to 100 channels at a
time.

3. ClickSave.

Create the Chat Script

1. Go to the Script tab.
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2. ClickChat. The [add] option appears. For a complete list of objects and their descriptions, refer to Summary of
Chat Script Objects.

3. Click [add].

4. Select Schedule from the chat objects.
This object performs a particular sequence of script operations when the contact center is open or closed.

a. Enter a name for theObject Tag.

b. Select an existing schedule from the list of Select Schedule.

c. ClickOK.

5. Click [add] next toOpen and then:

a. Select Forward to Queue, enter a name for the object tag, select a queue, and clickOK.
This object forwards a chat interaction to a specific chat queue, such as the sales or main queue.

b. Select CVB Online, enter a name for the object tag, and clickOK.
CVB Online refers to a chat design element, such as a chat button, chat invitation, chat form, or chat window,
which can be used on your website during the business hours.

c. Select Greeting Message and clickOK.
This object displays the greeting message to invite customers to the chat session. Append <@skipQueue@>
to your message to offer the option to skip queue in the chat window.

d. Select Skip queue, enter the relevant parameters, and clickOK.
This object gives customers the option to opt out of waiting in the chat queue and send an email offline. It can
only be triggered in the greeting message object.

6. For theCVB Online, click [add]:

a. Select Online button, enter a name for the object tag, and clickOK.

b. Select Invitation, enter a name for the object tag, and clickOK.

c. Select Pre-chat form, enter a name for the object tag, and clickOK.

d. Select Chat Window, enter a name for the object tag, and clickOK.

7. ClickClose, then click [add].

a. ClickCVB Offline, enter a name for the object tag, and clickOK.
This object refers to a chat design element, such as a chat button or chat form, that activates on your website
during closed hours.

b. Click add offline button next toCVB Offline, enter a name for the object tag, select a button, and clickOK.

8. ClickSave to save your chat script.
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9. To edit the details, click any object and select edit. An edit window opens up. To view the details, double-click any
object. The View details window appears. You can also click edit from inside the View details window.

10. To undo the changes clickRevert.

11. Click the on the script page to generate a PDF image and save it locally. The PDF printout is generated

containing the script name, date, and time of print. Supervisors and administrators can review and modify the
script as needed.

For details, refer to Summary of Chat Script Objects.

Note:As long as you have all the objects in the script, the sequence does not matter. 8x8 Contact
Center arranges the script in the correct order.

Run and Use the Script
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1. Go to theCode tab.

2. Select the chat channel from the list.

3. ClickGenerate Code. The code appears in the window.

4. Copy and paste the code to a page where you want to insert a chat button on your website.

Note: This script does not interfere with the button layout. It must be included in the same page and
within the body section of the web page, preferably just before the ending tag.
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5. Click the Chat button you just created. TheChatwindow opens.

SeeChat Overview to learn about Embedded Chat Design.
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Summary of chat script objects

The following table summarizes the 8x8 Contact Center chat objects available in the chat scripts and accessible via 8x8
Configuration Manager:

Chat
Script
Object

Description

Schedule Use the Schedule object to perform a particular sequence of script operations when the contact center is
either open or closed.
Parameters:

n In the Label text entry area, type the alphanumeric label used to uniquely identify the element in the
IVR script.

n Labels can contain a maximum of 21 characters, and must be unique within a script.

n In the Select schedule list, choose a schedule definition.
Exit points:
The Schedule object uses the Select schedule value to transfer control to the script sequence specified
within the following exit points:

n open equals true if the phone interaction has been received within the selected schedule's open
hours.

n close equals true if the phone interaction has been received outside the selected schedule's open
hours.

n #1 through #6 equal true if the schedule specified in Select Schedule includes an exception
condition, numbered 1 through 6, and today's date is within the exceptions from and to dates.

For details on creating schedules, refer to Define Business Hours and Schedules.

Skip
Queue

Use this object to give the customers the option to opt out of waiting in the chat queue and send an email
offline. This option can only be triggered in the greeting message object.

n In the Object tag, type the alphanumeric label used to uniquely identify the element in the script.
The object tag can contain a maximum of 21 characters, and must be unique within a script.

n Email Prompt Msg: The prompt message offered to a customer waiting in the chat queue. It can
appear as a link in the chat window (for example, "All our agents are busy helping other customers.
Would you like to send us an email?").
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Chat
Script
Object

Description

n Select form: Select an offline form from the list. An offline form presents an option to send an
email message during the chat's offline hours.

n Send info by: Shows whether you want to send the information you collected in the form using an
email channel or a dedicated email.

o Email channel: Select this option to choose an email channel. The email channel directs the
customer's email to the right agent.

o Plain email: Select a dedicated email to send the customer's email to.

n Email Channel: If you choose to use a Channel, you must select an email channel from the list.

n Forced email header message: Specifies the Subject line in the email message sent by a
customer skipping the chat queue.

Exit Point: None

Forward
to Queue

Use the Forward to queue object to forward a chat interaction to a specific chat queue, such as the
sales or main queue.
Parameters:

n In the Object tag, type the alphanumeric label used to uniquely identify the element in the script.
The object tag can contain a maximum of 21 characters, and must be unique within a script.

n In the Queue name list, choose the target chat queue to receive the chat.
Exit points: None

CVB
Online

Chat Visual Block Online refers to a chat design element, such as a chat button or chat form which can
be used on your website during business hours.
Parameters:

n In the Object tag, type the alphanumeric label used to uniquely identify the element in the script.
The object tag can contain a maximum of 21 characters, and must be unique within a script.

Exit points: None

CVB Off-
line

Chat Visual Block Offline refers to a chat design element, such as a chat button or chat form that activ-
ates on your website during closed hours.
Parameters:

n In the Object tag, type the alphanumeric label used to uniquely identify the element in the script.
The object tag can contain a maximum of 21 characters, and must be unique within a script.

Exit points: None
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Chat
Script
Object

Description

CVB
Default

Chat Visual Block Default refers to a chat design element, such as a chat button or chat form available by
default from 8x8 Contact Center.
Parameters:

n In the Object tag, type the alphanumeric label used to uniquely identify the element in the script.
The object tag can contain a maximum of 21 characters, and must be unique within a script.

Exit points: None

Greeting
Message

Use this object to type a greeting message to invite the customers to the chat session. Use
@skipQueue@ to present the message that is previously set in the skip queue.
Parameters:

n In the Object tag, type the alphanumeric label used to uniquely identify the element in the script.
The object tag can contain a maximum of 21 characters, and must be unique within a script.

n In the Greeting Message, type the message you like to appear in the chat window. For example:
<We will be with you shortly. click here to send an email.>

n Use auto-translation: This option is selected by default and is used to automatically translate the
greeting messages using Google Translate. If this option is disabled, you can bypass the automatic
translation, and let the user provide a customized translation instead.

Exit points: None

Test
Condition
of Queue

Use the Test Queue object to check the condition of a queue before entering a queue. Test queue
provides a set of conditions which, when met, trigger specified actions. The test queue object gives the
IVR designer much more routing and announcement flexibility by allowing them to repeatedly test queue
status.
Parameters:

n In the Object tag, type the alphanumeric label used to uniquely identify the element in the script.
Labels can contain a maximum of 21 characters, and must be unique within a script.

n In the Queue name list, choose the phone queue to test the condition.

n Use the Condition Matched check boxes to determine routing choices based on agent availability
or queue performance.

o To route the chat differently, or to provide the customer with choices when there is no qualified
agent available to immediately accept the interaction, select there are no enabled agents
waiting.

Version 9.14 618

Summary of chat script objects



Chat
Script
Object

Description

o To route the chat differently, or to provide the customer with choices when there is no qualified
agent logged in to immediately accept the interaction, select there are no assigned agents
logged in.
Qualified agents refer to the agent setup to receive interactions from the queue specified in the
Queue name list.

o To evaluate the condition of a selected queue, and route the chat based on the test results of
that performance, select Enable queue overload tests below.
Perform one or all of the following tests:

n Number of chats in queue ahead of this chat: Enter the maximum number of chats that
can be ahead of the current chat.

n there is a chat in this queue that has been waiting longer than (seconds): Enter the
maximum time that a chat is waiting in the queue.

n the instantaneous expected wait-time calculation exceeds: Enter a time duration in
seconds.

Exit points:
Test Queue has two exit points:

n Condition Matched

n Condition not Matched
The Test Queue object transfers control to the script sequence specified under the exit points based on
the following test results:

n There are no enabled agents waiting in the queue.

n There are no assigned agents logged in.

n There are <n> number of chats in the queue ahead of this chat, where <n> is the number specified in
the test.

n There is a chat waiting longer than the specified time in the queue.

n The instantaneous expected wait time calculation for a chat exceeds the specified time.
The expected wait-time calculation is useful only when there are more than 20 qualified agents
assigned to the queue and active. Mathematical uncertainty with fewer than 20 active similarly-
skilled agents may produce unexpected results.

Some of the many ways the exit points can be used are to trigger another test, provide the customer with
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Chat
Script
Object

Description

a choice of waiting in a queue when no agent is available, leave a voicemail, or inform the customer of an
approximate waiting time, and then forward to queue.
For example, if there is a chat in the queue that has waited longer than 120 seconds, you can insert the
Play object under the Condition matched exit point to play a message informing the customer of an expec-
ted waiting time for the chat to be answered. You can then use the Forward to Queue object to route the
call to a queue.

Chat as a
Pop-up

Allows the pop-up chat window to appear. The pop-up chat applies to the Pre-Chat Survey and the Chat
Window options.
Parameters:

n In the Object tag, type the alphanumeric label used to uniquely identify the element in the script.
The object tag can contain a maximum of 21 characters, and must be unique within a script.

Exit points: None
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Using script variables in chat channels

Before initiating a chat interaction in 8x8 Contact Center, customer information such as account numbers or case
numbers collected via the pre-chat form, can be used to determine routing of the chat interaction. 8x8 Contact Center
administrators can collect customer data, store them into system and user-defined variables, and use values stored in
these variables to direct the interaction to the appropriate queue all using 8x8 Configuration Manager. It improves the
efficiency of handling chat interactions.

Let’s say your company wants to route interactions based on the customer language. Collect the preferred language
choice in a variable, and use this data in the IVR to direct them to the appropriate language queue.

Or, let’s say your company wants to route interactions based on the department such as Sales or Support, you can
collect this information during the pre-chat, and use it to route the interaction to the right queue.

In this topic, we’ll demonstrate the usage of script variables in chat channels based on the following use case.

AcmeJets Inc. is a premium jet service company that serves its customers via chat channels. When a customer initiates
a chat, AcmeJets collects basic information such as customer name, account number, and the preferred language for
chat. AcmeJets serves customers in English and Spanish, and have dedicated queues for each language. They want to
direct customers to the appropriate queue based on the language choice. Additionally, the company wants to
personalize their conversation for best customer satisfaction.

Assumptions
Let’s assume that AcmeJets contact center has:

n Configured a chat channel

n Configured chat queues

n Designed chat elements (chat button, pre-chat form, and chat window)

To support the use case, follow the steps discussed here:

Step 1: Create a new pre-chat form or edit an existing pre-chat form

In this step, we create a new pre-chat form which collects a customer’s name, and preferred language for chat. Store
the values in a custom variable and a translation variable respectively. Important: For custom variables, note down the
variable names to be used in chat scripts.

Version 9.14 621

Using script variables in chat channels



1. Log in to the 8x8 Configuration Manager.

2. Go toChat Design > Form.

3. Click +Pre-chat to begin creating a pre-chat form.

4. Enter a name and description for the pre-chat form.

5. Add your first question to collect customer information.

a. Format: Select <Open-ended>.

b. Question: Enter the question: <Enter your name>.

c. Variable: Note that the variable name is automatically generated. Edit as you want <_name>.
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d. ClickAdd.

6. Add a question to collect the customer's language preference.

a. Format:Select <Translation>.

b. Question: Enter the question: <Enter your language>

c. Select language choices from the list: Select <English> and <Spanish>.

d. Variable: Note that the system variable ($language) is automatically populated. You are not allowed to edit
the system variable names.
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e. ClickAdd.

7. Optionally, add a question to gather either account number or case number. Select the format CRM field.

8. ClickNext>> to proceed to define the visual design of the pre-chat form. Select the colors and labels. Save your
preferences.

Step 2: Create a chat script

In this step, you will define a script that determines the routing of each chat interaction from your customers. When a
customer initiates a chat session, they are prompted to submit data through the pre-chat form. Based on this data, they
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are then directed to the appropriate queue.

1. Go to Scripts from the main menu in Configuration Manager.

2. Select Chat > Add new chat script.

3. In the Properties tab, enter a name, category, and comment. Optionally, add the chat channel you wish to apply
the script to. Save the properties.

Step 2a: Add a custom variable to the variables list
If you added custom variables in your pre-chat form, you must add them to the variable list here. By default, the View
variables lists all system variables. To add a custom variable you have already added in your chat design,

1. In the Script tab, clickView variables. A list of system variables shows up.

2. ClickAdd new and enter the custom variable name defined in the pre-chat form.

Important: Ensure the custom variable defined in the pre-chat form is added here.

Step 2b: Begin crafting the script
The chat script will embed a greeting message which includes the customer name. Use a test variable to identify the
language choice and direct them to the right queue.
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1. Add Test variable > Tests if the variable value of language equals Spanish. Tests if a customer selects to chat in
Spanish.

n If True, add Forward to Queue. choose to forward it to the queue serving customers chatting in Spanish
language.

n If False, add Forward to Queue, choose to direct the interaction to the queue serving customers in English.

2. Add a greeting message to the customers. Example: Welcome to AcmeJets. We will be with you shortly.

3. Add all the chat visual block elements you have defined.

n Chat button (Triggers chat interaction)

n Pre-chat form (Collects information from the customer; Add the newly defined pre-chat form here.)

n Chat-window (Allows a customer to interact with the agent)
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4. Save the script.

5. In theCode tab, select the chat channel to apply this script to.

6. ClickGenerate Code. Copy the code and embed in your website which hosts the chat.

Step 3: Verify the chat workflow

1. To verify the chat workflow, simply initiate a chat as a customer.
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2. In the pre-chat form presented, enter your name and select the language - English.

3. ClickSubmit.

4. Log in as an agent serving customers in English. You should now receive the interaction in English.

5. Trigger a second chat interaction as a customer and select Spanish in the pre-chat form and submit.

6. Log in as an agent serving customers in Spanish. You should now receive the interaction in Spanish.

7. If you received interactions via the correct queues, your setup is correct and complete.
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Configure multi-chats

8x8 Contact Center multi-chat allows an agent to handle up to six concurrent chats with customers at any time. There is
no limit on the number of concurrent chats among agents. Using the Interactions tab in 8x8 Configuration Manager, 8x8
Contact Center administrators can configure the maximum number of concurrent chats with customers for each agent.
They can also enable agent-to-agent chat from within the Interactions tab. There is no limit on the number of agent-to-
agent chats.

To define maximum number of concurrent chats with customers:

1. From the Configuration Menu, openAgents.

2. Find an agent and click .

3. Open the Interactions tab.

4. Select Max # of concurrent chats from the list.

5. Select Enable agent to agent chat.
It allows this agent to chat with other agents. There is no limit on the number of concurrent chats among agents.

6. ClickSave.
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Handle multilingual chats

An insurance customer in Rome, Italy initiates a chat with a support representative in New York. Using the automatic
translation tool, the agent is able to handle the chat request in English while the customer uses their native Italian. The
tool translates chat conversations between customers and agents, giving them the flexibility to communicate in their
respective native languages. If this chat is handled by an agent who happens to speak Italian, they can choose to
handle the conversation without the aid of the translation tool.

8x8 Contact Center introducesmultilingual support for chat. Customers can choose to chat in any of the supported
languages. Agents can handle customer chats in any of the supported languages they know or use automatic
translation tool. Each 8x8 Contact Center agent is associated with one primary and one or more secondary languages
of fluency.

n If the chat request is in one of these languages, agents can chat in the requested language.

n If the chat request is not in their primary or secondary language, agents can use the automatic translation tool.

With Multilingual support for chat:

n Administrators can provide language choice in embedded chat.

n Customers can choose to chat in a language of their choice.

n Agents can handle customer chats in any of the supported languages.

Supported languages
8x8 Contact Center offers chat translation support for:

English, Russian, German, Japanese, Spanish, French, Chinese, Portuguese, Italian, and Polish.

Configuremultilingual support for chat
To configure multilingual support for chat, administrators must:

n Configure a pre-chat form in the embedded chat flow.

n Offer language choice for customers in the pre-chat form.

n Include the pre-chat form in the chat script that controls the chat flow.

n Indicate the primary and secondary languages of agents.
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Step 1: Configure a pre-chat form to offer language choice.

In your embedded chat flow, you must add a pre-chat form which offers language choice for customers. Using this form,
customers select a language to chat in. Follow the steps described here to design a pre-chat form.

1. From the Configuration Menu, openChat Design.

2. Click the Form tab.

3. Select to edit an existing pre-chat form or create a new one. For details, refer toDesign a Chat Form.

4. Select Translation under Format. This offers customers a language choice question. A list of languages
supported for chat translation shows up.

5. Enter aQuestion, such as <Select a language you wish to chat in>.

6. Select the language choices that you want to offer your customers to chat in.
You can choose the language for translation to be Set as default.

7. ClickAdd. The question is added to the form.

8. Add more questions as desired.

9. ClickNext to define the visual details of the form.

10. Add the desired visual requirements, such as window title, background color, or font color.

11. ClickSave. Your custom pre-chat form is now ready with the chat translation choice.

Step 2: Add or edit the chat script to include pre-chat form.

In this step, make sure the pre-chat form is included in the chat flow, which is controlled by a chat script. You must
include a pre-chat form with the language choice in the chat script.
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1. From the Configuration Menu, open Scripts.

2. Go to theChat tab.

3. Edit or add a chat script. For details, refer toCreate a Chat Script.

4. Under theCVB Online object, click [add].

5. From the menu, select the pre-chat form you just created with the chat translation option.

6. Save the script.

Note:Your chat script must contain a chat button to initiate chats, a pre-chat form to indicate
language choice, a chat window for typing chat messages, and a chat queue to forward the chat
requests.

7. Assign this script to the desired chat channel.

Step 3: Define primary and secondary language for agents.

Selecting a primary and one or more secondary languages for agents indicates their ability to chat in these languages.
Automatic translation is available to agents based on their primary and secondary languages:
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n If the language of the chat request matches the agent's primary language, automatic translation is disabled.

n If the language of the chat request matches the agent's secondary language, automatic translation is available but
turned off. The agent can turn it on.

n If the language of the chat request doesn't match the agent's languages, automatic translation is turned on by
default.

To indicate languages of fluency for users:

1. From the Configuration Menu, openAgents.

2. Select to edit an agent.

3. In the General tab, notice two fields:

o Primary Language: Select a language of primary fluency. This is the default language of chat for users.
o Secondary Language: Select one or more languages of secondary fluency. If a chat request is in any of the

secondary languages, they can chat in this language or use the automatic translation tool.

4. Save the language settings.

Multilingual chat flow
The multilingual chat flow can be represented as follows:
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1. A customer visiting a website initiates a chat by clicking the chat button.

2. A pre-chat form is presented to the customer to indicate language choice.

3. The customer fills in the form, selects a language to chat in, and submits the chat request.

4. The request enters the chat queue in 8x8 Contact Center and is offered to an agent.
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5. On receiving a chat, the control panel indicates the language of choice for the chat.
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6. On accepting the chat, agents can process the chat using their language of fluency, or use the automatic
translation tool.

Note:Automatic translation is available only in the absence of languagematch or a secondary
languagematch. In case of primary languagematch, automatic translation is disabled.
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7. By using the translation tool, messages from the customer are translated to agent's primary language, and vice
versa.
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Enable Co-browsing via chat

8x8 Contact Center Co-browsing allows customer support agents to assist customers remotely via a shared browser.
With Co-browsing, 8x8 Contact Center administrators can empower a website or any browser-based application, and
offer live, hands-on assistance to customers. A customer in need of assistance must initiate the remote session,
generate a unique session code, communicate it to an agent via phone or chat. The agent then uses the code to
establish a remote session. Co-browsing session co-exists with a call or a chat for communicating the session code.
Agents and customers can request and or allow co-browsing sessions via chat.

To enable co-browsing for a chat session, administrator must enable this feature in 8x8 Configuration Manager. To
enable the co-browsing feature, go toChat Design > Window and then select Offer the Co-browsing request into
the Chat window. Notice that Start Co-browsing session appears in theChatwindow. SeeHow to design a chat
window.

Enable Co-browsing in 8x8 ConfigurationManager
To enable Co-browsing for a chat session, administrator must enable this feature in 8x8 Configuration Manager.

To enable Co-browsing during a chat:

1. Log in to 8x8 Configuration Manager.

2. Navigate toChat Design.

3. OpenWindow tab.

4. Open an existing Chat window.
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5. Select Offer the Co-browsing request into the Chat window.

Notice that the Start Co-browsing session icon appears in the chat window.

6. ClickSave.
When this feature is enabled, both customers and agents can invite the other party to Co-browsing during a chat
session. Once the administrator enables Co-browsing for chat, agents can invite customers for Co-browsing during
a chat session in 8x8 Agent Console. For details, see our content onCo-browsing in Agent guide.
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GLOSSARY

A

Administrator
The person who uses the
Configuration Manager to configure
the contact center's resources and
behaviors. An Administrator can be
the Primary Administrator with
unrestricted access to all the
configuration objects or a Role Based
Administrator with full or partical
configuration rights.

Agent
Agents use the Agent Console to view
and manage customer interactions.
Virtual Contact Center supports
Regular agents and Supervisor
agents.

Agent Console
Virtual Contact Center's browser-
based graphical user interface (GUI)
used by Agents to manage customer
interactions.

Application Programming
Interface (API)
An application programming interface
(API) defines the way an external
program can request services from

another program. See also, Virtual
Contact Center Integrations.

Automatic Call Distribution
(ACD)
ACD uses the number called and
programmable call distribution logic to
route incoming telephone calls to
agents with the skills necessary to
efficiently process the interaction.

Automatic Number
Identification (ANI)
ANI identifies the origination number
of a call offered to an Agent.

B

Billing Telephone Number
(BTN)
For customers with multiple separate
telephone numbers, the BTN
consolidates those multiple numbers
under a single phone number for
billing purposes.

C

Call Treatment Choice
Refers to choices within a schedule
which allows a time based selection of
treatment choices when interactions
enter a Virtual Contact Center tenant.

Caller Name (CNAM)
An enhanced Caller ID feature that
displays both the number and name
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Glossary: Calling Line Identifier (CLI) – CRM API

for an incoming voice call. To provide the value-added CNAM service, the carrier uses the
originating caller's phone number to locate the caller's name in the carriers' names database,
then transmits both the number and name to the CNAM-enabled customer.

Calling Line Identifier (CLI)
The intended display number of the calling party. In some network configurations, the CLI
contains the calling party's Billing Telephone Number (BTN) or Charged Party Number
(CPN) to be displayed instead.

Channel
Phone, email, or Web chat interactions arrive at a tenant on a channel. Virtual Contact
Center uses skills based routing rules to place interaction requests into the appropriate
Queue.

Collaborate
See Desktop Sharing.

Computer Telephony Integration (CTI)
CTI allows data associated with an incoming call or chat request to be presented to the
responding agent in real-time. Virtual Contact Center CTI typically presents this data as a
"screen pop".

Configuration Manager (CM)
The portion of the Virtual Contact Center application used by the contact center's
administrator to define and configure the resources and operational behaviors of the center's
tenant.

Contact Center
A contact center that enables agents to be located in different geographical locations yet
managed as if they were located in the same physical location.

Contact Center Integrations Suite
An optional package containing the CRM API, Screen Pop, Triggers, and Reporting API
components.

CRM API
The CRM API component of the Virtual Contact Center Integrations enables third-party
processes to access the internal CRM data.
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Custom Role
An administrator defined role with custom privileges is called a custom role. Any role other
than the system defined Super User role is referred to as the custom role.

Customer Relationship Management (CRM)
The Virtual Contact Center CRM stores the contact center's customer, case, and follow-up
data. Numerous third-party CRM products also exist. Two examples of third-party CRM
applications are Salesforce and NetSuite.

D

Desktop Sharing
If authorized, an agent can use the Collaborate Desktop Sharing feature to view and control
a customer’s remote computer for purposes of providing assistance.

Direct Agent Access
In an IVR script, direct agent access permits a caller to reach an agent directly rather than
through skills-based routing logic.

E

Email Script
A set of instructions that determine and direct the treatment and routing of an incoming
email interaction.

G

Group
A group is a collection of agents created for management or reporting purposes. Groups can
be functional (for example, Technical Support) or organizational (for example Supervisor
Mary’s Team). Each agent can be assigned to only one group, and cannot view or access
information about other groups or group members.

I

Interactive Chat Response (ICR)
Interactive Chat Response specifies the message sent in response to a new chat interaction.
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Interactive Voice Response (IVR)
IVR enables touch tones to guide customer interaction with the contact center. For example,
an IVR script could direct a caller to Press 1 to be connected to Sales or Press 2 to be
contacted to Support.

Intra Day Scheduler
Refers to the functionality of the tenant that allows creating multiple recurring choices within
a day.

IVR Script
A set of instructions that prompts callers to choose options, then uses those choices to
determine the optimal routing of an incoming phone interaction. See also, Interactive Voice
Response.

O

Outbound Phone Codes
Outbound Phone codes offer a means to set a specific calling line identifier (caller ID) and
optional outbound queue for outbound calls from your tenant. Outbound Phone Codes also
may be used to track the purpose of an outbound call.

P

Primary Administrator
An adminstrator with unrestricted access to all the configuration objects in the Configuration
Manager.

Q

Queue
A queue is an ordered collection of interactions waiting to be served by agents qualified to
respond to these interactions. In addition to enabling the call center administrator to
customize how incoming interactions are prioritized and routed, queues also ensure that
interactions are never lost or discarded.
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R

Reporting API
The Reporting API component of the Virtual Contact Center Integrations enables third-party
processes to access statistical reporting data, and status information.

Responsible Organization (RespOrg)
The entity that controls and maintains a phone number. Telephone carriers are the most
common type of RespOrg. 8x8's provisioning department processes the RespOrg orders
required to direct your contact center's phone numbers to your Virtual Contact Center client

Role
A role defines a set of privileges to configure a Virtual Contact Center tenant. A role can be
system defined or administrator defined.

Role Based Administrator
An administrator who assumes a role with full or partial configuration rights to the Virtual
Contact Center.

Role Based Management
Role Based Management is the functionality of Virtual Contact Center that allows a tenant
to distribute the configuration management functionality among multiple roles.

S

Screen Pop
The Screen Pop component of the Virtual Contact Center Integrations enables third-party
CRMs to display information in the Agent Desktop. See also, Computer Telephony
Integration.

Service Level Agreement (SLA)
A commitment to process some number of interactions within a specific period of time.
Service Levels are generally defined as X percent of interactions answered within Y seconds
measured over Z minutes. In the Configuration Manager, use a queue's SLA tab to generate
an alert whenever interaction processing levels fall below a specified commitment level.
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Skill
A qualification that associates a particular queue to an agent.

Skill Levels
For each agent, Virtual Contact Center uses high, medium, and low skill level identifiers to
prioritize the distribution of interactions across the pool of available agents.

Status Codes
The Status Codes feature enables agents to supply supplemental information about why
they changed their state. Status Codes provide enhanced workforce planning and
management. For example, status codes could be created for different categories of breaks
such as Break for Lunch, Break for Meeting, and so on.

Super User
The system defined role with unrestricted access to configure all administrative areas of the
Configuration Manager. Primary Administrator inherits the Super User role automatically.
Multiple administrators can be assigned to the Super User role. Privileges to the Super User
role cannot be edited or revoked.

Supervisor
An agent with the supplementary privileges required to create FAQ categories and answers,
monitor agent interactions in progress, listen to recordings of previous interactions, and
create reports for the agents groups they supervise.

T

Tenant
Your unique and secure contact center instance running on a 8x8 platform. You use the
Configuration Manager to create and configure all aspects of your contact center's resources
and operational behaviors, including groups, incoming channels, queues, agents, routing
scripts, skills, monitoring, recording, and reporting.

Transaction Code
The Transaction Codes feature enables agents to supply supplemental information about
the reason for or outcome of an interaction. Transaction codes provide enhanced metrics or
enable the calling line ID on an outbound call to be modified. For example, transaction codes
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could be created for different categories of sales activities such as Initial Contact, Prospect,
Customer Satisfied, and so on.

Triggers
The Triggers component of the Virtual Contact Center Integrations invokes a remote third-
party process whenever an agent creates, deletes, or edits internal CRM record.

V

Voice over IP (VoIP)
The use of the Internet Protocol (IP) to carry telephone calls.

W

Wallboard
The 8x8Wallboard for Virtual Contact Center presents real time metrics of your contact
center operations allowing supervisors to manage customer demand proactively.

Web Application Programming Interface (WAPI)
Deprecated term for the optional 8x8 Integrations package.

Weekly Schedule
Defines recurring day-of-week/time-of-day treatment choices. These are typically normal
business hours. Schedules follow the defined weekly pattern unless superseded by date-
specific Special Events.
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